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Lyrrus Incorporated, dba Gvox.
PROGRAM LIMITED USE LICENSE AGREEMENT

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE INSTALLING THE INCLUDED SOFTWARE. 
INSTALLING THE SOFTWARE INDICATES YOUR ACCEPTANCE OF THESE TERMS AND CONDITIONS. IF YOU DO NOT AGREE WITH THEM, 
YOU SHOULD PROMPTLY RETURN THE SOFTWARE UN-INSTALLED, AND YOUR MONEY WILL BE REFUNDED.

LICENSE

Lyrrus Incorporated, dba Gvox. has developed and provides the computer software program contained on this CD-ROM (the 'Program') and licenses its use. 
You assume responsibility for the selection of the Program to achieve your intended results, and for the installation,use and results obtained from the Program.

a. Permissible Uses

(i) Lyrrus Incorporated, dba Gvox. hereby grants you a personal, non-transferable and non-exclusive right and license to use the Program under the terms stated 
in this Agreement. Title and ownership of the Program and the related documentation remain in LyrrusIncorporated.

(ii) You may use the Program only on computers that you exclusively use.

(iii) You may not transfer or assign the Program or this license to any other person without the prior written consent of Lyrrus Incorporated, dba Gvox.

(iv) You acknowledge that you are receiving only a LIMITED LICENSE to use the Program and related documentation and that Lyrrus Incorporated, dba 
Gvox. retains title to the Program and documentation. You further acknowledge that Lyrrus Incorporated, dba Gvox. has a valuable proprietary interest in the 
Program and documentation.

b. Restrictions

(i) You may not use, copy, reproduce, modify, alter, or transfer the program or any copy or merged portion, in whole or in part, except as expressly provided in 
this license. (You may make a single copy of the Program for archival backup purposes in support of your use of the Program.)

(ii) You acknowledge that the program contains trade secrets of Lyrrus Incorporated, dba Gvox. In order to protect such trade secrets, you may not decompile, 
reverse engineer, disassemble or otherwise reduce the Program to a human perceivable form. You may not modify, adapt, translate, rent, lease, loan, resell for 
profit, distribute, network, or create derivative works based on all or any part of the program or documentation.

(iii) You and your employees and agents are required to protect the confidentiality of the Program. You may not electronically transfer the Program or accompa-
nying documentation from one computer to another over a network. You may not distribute or otherwise make the Program or documentation available to any 
third party, by time sharing or otherwise, without the prior written consent of Lyrrus Incorporated.

(iv) IF YOU USE, COPY, REPRODUCE, MODIFY, ALTER, OR TRANSFER POSSESSION OF THE PROGRAM OR ANY COPY OR MERGED 
PORTION, IN WHOLE OR IN PART, EXCEPT AS EXPRESSLY PROVIDED IN THIS LICENSE, YOUR LICENSE WILL THEREBY TERMINATE 
AUTOMATICALLY.

TERM

The license is effective until terminated. You may terminate the license at any time by destroying the Program and related documentation, together with all 
copies thereof. This license will also terminate immediately if you fail to comply with any term or condition contained herein. Upon such termination, you 
agree to return to Lyrrus Incorporated, at your own expense, the Program and related documentation, together with all copies and merged portions of the 
Program or related documentation in any form.

EXPORT

You acknowledge that the laws and regulations of the United States may restrict the export and reexport of the Program. You agree that you will not export or 
reexport the Program or related documentation in any form without prior written consent of Lyrrus Incorporated, dba Gvox. and appropriate United States and 
foreign government approval.
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machine readable form without the written consent of Lyrrus Incorporated, dba Gvox. Lyrrus Incor-
porated, dba Gvox. makes no warranties either express or implied with respect to this manual or with 
respect to the software described in this manual, its quality, performance, merchantability or fitness 
for any particular purpose. Lyrrus Incorporated, dba Gvox. reserves the right to make improvements 
or changes in the product described in this manual at any time and without notice. All specifications 
are subject to change without notice.
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Tutorial Chapter One

This tutorial will teach you about Encore’s most commonly used features.  You may use this 
tutorial with Encore “out of the box”, with no previous set ups.

In this tutorial, you’ll open a standard MIDI file, edit it on a piano staff and play it back on your MIDI 
instrument. You’ll add a vocal staff and record some music.  Finally, you’ll format and print your 
sheet music.  You’ll learn many things to help you in your everyday work with Encore.

Allow yourself sufficient time to do the tutorial.  You can stop at any point, save your work, and come 
back to it later.

Note:  Encore operates identically on Windows and Macintosh, though its dialog boxes vary slightly 
in appearance.  In this book, illustrations of the Encore user interface vary from chapter to chapter, 
representing both Windows XP and Mac OS X. Keystrokes are listed as [Windows/Mac].  References 
to a Mac OS [command] key indicate the key marked (). 

Running Encore
The first time you run Encore, you will see the Score window, the Toolbar and the Notes palette.  The 
Score window contains a blank piano staff.  You’ll create your scores here.  The Score window’s 
Toolbar gives you access to tools (arrow, eraser, pencil) and provides 
information about the score (current voice, measure number, and MIDI Thru 
channel).  It also has buttons for playing and recording music.  You will use 
many of these tools as you work through the tutorial.

The Notes palette lets you select notes and rests to enter in the score.  There are several other palettes 
with other tools and symbols.  

Music gets into Encore in several ways.  You can enter music one note at a time with your mouse in 
much the same way that you would write music with a pen and manuscript paper.  You can record 
music using a MIDI keyboard, a MIDI application, a QWERTY keyboard or other controller, either in 
real or step time.  Or, you can open and automatically transcribe a song file saved in either the Master 
Tracks Pro, Standard MIDI or MusicXML  file format.  The tutorial describes some of these methods, 
but you’ll begin by opening a Standard MIDI file.

Opening a File
Encore can open song files saved in any one of these formats:  native Encore files, MusicTime files, 
Rhapsody files, Master Tracks Pro files, and Standard MIDI files. When you open a Master Tracks 
or Standard MIDI sequence file, Encore assigns each track of the file to its own staff.  In addition, 
Encore will automatically guess the durations of the notes and rests and beam the appropriate notes 
when Auto Guess/Beam in the Setup menu is on.

1.	 Choose Open from the File menu. The Open File dialog appears.

2. 	Navigate to the folder on your hard disk where you placed the Encore documentation and open 
the folder. 

3.	 Open the subfolder called Example Files. 
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4.	 Windows only: In the lower left corner of the Open File dialog there is a selection labeled “List 
Files of Type:”.  The default selection is “Scores (.*enc; *.mus; *.mto; *.rhp).”  Click on this 
selection to display additional file types. The complete list will include MIDI Files (.*mid; *mff), 
MT Pro Files (*.mts), MusicXML and All Files (*.*).  Select MIDI Files from the drop down list 
and the Open Files Dialog will change to display only MIDI Files.

	 Note: The first time you use the Open File dialog Encore will display Score files. Once you change the 
file type display, the Open File dialog will keep that selection until you either change the file selection 
type or quit Encore.  

5.	 Windows and Mac: Open the file “Johnny.mid.” There is a brief pause while Encore converts the file 
and guesses the durations.

Johnny.mid is a simple piano arrangement of “When Johnny Comes Marching Home.”  The right and 
left hand parts were recorded together into a single track using a MIDI sequencer and then saved as 
a Standard MIDI file.  Opening the MIDI file in Encore converted that single track into a single staff 
(each track in a sequence file is assigned to a new staff).

After checking the range of notes used, Encore selects a clef for each staff.  For Johnny.mid, Encore 
assigned a treble clef to the staff.  Although this clef was correct for this example, you may need to 
change the initial clef for your own files in the future.

Changing the Starting Clef
1.	 Click once to the right of the word ‘Notes’ in the Notes palette. 
	 The Clefs palette appears.

2.	 Click the bass clef in the Clefs palette. 
	 Clicking on the bass clef in Clefs Palette automatically selects the pencil tool in the 

Score Window.  The mouse pointer also changes to a bass clef when moved over the 
Score window.  This change in cursor shape indicates not only the selected symbol but 
also that you are in pencil entry mode.

3.	 Move the bass clef pointer over the treble clef in the first measure of Johnny.mid 
and click. 

	 The clef will change throughout the score and notes will be changed to 
new staff positions to match the change in clef.  You can change the clef at any point 
within your score by clicking at the location where you want to indicate the change.

Revert To Saved
Before continuing with the tutorial, we need to restore the original clef and return our 
score to how it looked after you first opened it. 

You could click the treble clef icon in the Notes palette and change the clef in the first measure back 
to the original treble clef, but if you experimented with the clef tool and did this, you’ll need to erase 
those clefs as well. 

The simple way to discard all of the changes made since opening the file is to select “Revert To 
Saved” from the File Menu.

1.	 Select “Revert To Saved” from the file menu. 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Encore will ask you if you wish to “Discard all changes to the  current score.”

2.	 Click the “Yes” button. 
	 Encore will open, guess and beam Johnny.mid again.  

Many operations in Encore have an undo option, but Revert To Saved allows you to discard many edit 
operations and restart with the last saved version.  Save your scores after making significant changes 
and use Revert To Saved to restore your file to those saved versions when needed.  You should also use 
Save As and create new files periodically.  Saving versions of your scores as you work on them can 
allow you to restart at any point where you made significant changes and prepare alternate arrange-
ments and layouts.

Splitting the Staff
Now we will split the left and right hand parts onto their own staves.  First, you must decide what 
note to use as the split point.  In this case, the lowest note in the right-hand part is the Bb2 below 
middle C.

Next, select the staff you wish to split.  Most editing in Encore requires selecting the item or items 
that need to be edited.  There are several ways to select music and each technique will be used during 
this tutorial.  So, to split a staff, you first need to select the staff.

1.	 Click the arrow button in the Toolbar.

2.	 Click the arrow pointer in the margin directly to the left of the first measure. 
	 The first staff becomes highlighted. The Split Staff operation will split the staff throughout the score, 

so only the first staff needs to be selected.

3.	 From the Score menu, choose Split This Staff. 
	 The Split Staff dialog box appears.  A staff can 

be split two ways.  You can move all of the notes 
below a specified note onto a new staff, or you can 
move the notes associated with a particular voice or 
voices onto a new staff.  For this tutorial, the staff 
will be split by selecting a note upon which to base 
the split point. 

4.	 Enter the split point in the highlighted text box. 
	 As mentioned earlier, the lowest note in the 

right-hand part is the Bb2 below middle C; 
therefore, you want to move all of the notes below 
Bb2 onto the new staff containing the left-hand 
part.  The text box defaults to “C3”, where C is the 
note and 3 represents the octave.  MIDI notes range 
from a low of C-2 (C minus 2) to G8 with C3 being 
middle C.  The octaves are numbered from each C 
to the B above it.  So, the Bb below middle C (C3) is Bb2.
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You can enter the split point in two ways.  The easiest way is to simply play the note on your MIDI 
instrument while the text box is highlighted (you may need to select the text box first). That note will 
then appear in the text box.  You can also type in the note using your computer’s keyboard.  Enter a 
“B”, then a lower-case “b” for the flat sign and the number “2”.  You could also enter the enharmonic 
A#2, using the pound/number sign (#) for the sharp sign.

Note: Encore will display an A#2 when you use MIDI to enter the split point.

5.	 Choose a clef for the new staff.
	  By default the bass clef should be selected.  If it is not, click the radio button next to Bass.

	 There should be a mark in the checkbox labeled Keep Notes in a Piano Staff (Windows) or Create a 
Piano Staff (Mac).  Encore treats a piano staff in much the same way as a single staff.  A piano staff in 
Encore is special because it allows you to use more than one staff for the same instrument.  Cutting 
and pasting in a piano staff affects both staves.  When you assign a MIDI channel to a piano staff, 
both treble and bass staves use the same MIDI channel.  When you assign a MIDI program to a piano 
staff, it also affects both staves.  You can elect to split notes to another staff and NOT keep them in a 
piano staff but, since this is a piano part, this tutorial will keep the notes in a piano staff.

6.	 Click OK. 
	 The new piano staff appears, complete with a brace.

Setting the Key Signature
MIDI and Master Tracks Pro files opened in Encore always display initially in the key of C Major.  
You will need to assign a key signature to your score and, for our tutorial, you will now change the 
key signature to G minor for “When Johnny Comes Marching Home.”    

1.	 Using the arrow pointer, click on the first measure to the left of the first note.

2.	 From the Measures menu, choose Key Signature. 
	 The Key Signature dialog box appears. The measure range you 

selected is displayed at the top of the dialog. To apply the key 
signature to the entire score, click on the button to the right of 
the number range (arrow to double barline). 

3. 	Click on the Bb/g button 
	 The Key Signature dialog is set up in the Circle of Fifths.  

Starting from the top and going clockwise, each button adds a 
sharp. Going counter-clockwise, each button adds a flat.  The 
key signature will be displayed in the center of the circle.

This dialog provides you with several other options, including the ability to transpose 
the notes in accord with the key change.  In this instance, you know the pitches are 
correct, so you just want to set the key.  For this tutorial, change only the key signature.  
Additional information about the Key Signature dialog can be found in “The Menus” 
chapter of this manual.

4.	 Click OK. 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The piano staff is now displayed in the key of G minor.

Creating a Pickup Bar (Anacrusis)
If you’ve scanned the score, you may have noticed that something important is missing:  the first 
note!  The first note was left out intentionally to demonstrate how to create a pickup bar.  The word 
“when” in “When Johnny Comes Marching Home” begins the song but is placed into a measure of 
its own with a single beat.  This measure is commonly called a “pickup bar” and requires some extra 
steps to create.  You’ll need to add a measure, define it as a pickup bar and enter the note used to start 
“When Johnny Comes Marching Home.”

Adding a Measure
1.	 Using the arrow pointer, click on any blank space 

in measure 1. 
	 The blinking insertion cursor will appear where 

you clicked.  If you clicked on a note or rest, try 
again until you see the cursor.

2.	 From the Measures menu, choose ADD MEASURE. 
	 The ADD MEASURE dialog box appears.  Change the 

top line in the dialog to read, “Add 1 measure(s) 
before measure 1.”  The number of measures to 
add will default to 1 and the measure in which you placed the cursor will be indicated in the measure 
box at the end of the sentence.  The lower half of the dialog allows you to add the measure to one staff 
or to all staves.  Since we are using a song with only one piano staff, there is no need to make any 
selection; either will work for the purposes of this tutorial.

3.	 Click OK. 
	 A new blank measure appears.

You could just enter the notation into this blank measure, call it a pickup bar, and be done with it.  
However, if you simply entered  a single eighth note, you’d hear that eighth note, then five silent beats 
(since it’s in 6/8 time), and then the rest of the piece.  To create a true pickup bar you need to change 
the Time Signature to correctly play only one eighth note for the first measure.

Changing the Time Signature
1.	 Select the first measure. 
	 So far you’ve seen how to select a staff in a system (click to the left of the staff) and how to select 

a staff throughout an entire piece (double-click to the left 
of the staff). To select an entire measure, double-click in a 
blank space in the measure (that is, an area with no notes or 
rests).  The measure will become highlighted to show the 
measure is selected.
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2.	 With the curser in the first measure, choose Time 
Signature from the Measures menu. 

	 The SET TIME SIGNATURE dialog box appears.  The 
range of measures you selected (from Measure 1 to 
Measure 1) appears in the text boxes at the top of 
the dialog.

3.	 Click the radio button labeled OTHER. 
	 Several commonly used time signatures are 

displayed as buttons in the SET TIME SIGNATURE 

dialog box.  OTHER allows you to create additional 
time signatures.

4.	 Enter the number 1 in the upper text box and an 
8 in the lower text box next to OTHER. 

	 This will set the time signature of the first measure to 1/8, exactly enough for the pickup bar and no 
more.

5.	 Click OK. 
	 You will now have a Time Signature in the first measure of 1/8 and a Time Signature in the second 

measure of 6/8.  This is not precisely what you need but we had you click OK to better demonstrate 
how the option for “Pickup Bar” affects a Time Signature change in Encore.

Assigning a Measure to be a Pickup Bar
A pickup bar should show the time signature for the next measure even when the measure used for the 
pickup does not contain the same number of beats.

1. 	With the first measure still selected, choose TIME 

SIGNATURE from the Measures menu again. 
	 The range of measures should still be from 

Measure 1 to Measure 1 and the time signature 
indicated as 1/8.

2. 	At the bottom of the Set Time Signature dialog, 
click in the box next to Pickup Bar.  A  3 should 
appear in the checkbox.

3. 	Click OK to close the dialog with this change. 
	 Now the time signature in the first measure will 

say 6/8 but, in fact, the time signature of the first 
measure is still 1/8.  In addition, the time signature 
in the next measure will have been removed.  Selecting “Pickup Bar” will always hide the time 
signature you select, and display the time signature from the next measure instead.

Entering a Note
Now that you’ve created the needed pickup bar, you need to enter the note missing from “Johnny.
mid”.

1.	 Get the Notes palette up on your screen. 
	 If the Clefs palette is still showing, you can just click to the left of the word Clefs to get back to the 
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Notes palette.  In fact, you can access any of Encore’s palettes this way.  Click to the right of the 
palette name to cycle through the palettes in order. Click to the left of the name to go in reverse order.

You can also open multiple palettes by choosing them individually from the Palette sub-menu under 
the Windows menu or by selecting “Show All Palettes” under the Windows menu.  The pallets will 
appear, then you can drag them to a convenient on-screen location.  Encore will record the location of 
the palettes so that they reappear in the same locations the next time you use the program.

2.	 Click the eighth note icon. 
	 The pencil button in the Toolbar is automatically selected.  When you move the mouse pointer over 

the Score window it will look like an eighth note.

3.	 Place the Note pointer on the D above middle C in the pickup bar and click once. 
	 A “D” with the duration of an eighth note appears in the score. You should hear the note play when 

you place it in the score.  Encore’s AUTO SPACE feature (Setup menu) is on by default, so the note will 
be placed where it belongs in the measure.  There will be more about AUTO SPACE later in the tutorial.

If you make a mistake while entering the note, select “Undo Add Item” from the Edit menu, press 
command-z [ctrl-z], delete, backspace or select the eraser tool and click directly on the note to remove 
it. Re-select the pencil when you are done and return to the start of this section.

Now you need to place a rest in the bass staff. The eighth note should still be selected in the Notes 
palette.

Entering a Rest
1.	 Press the [R] key on your computer’s keyboard. 
	 The eighth note had been selected in the Notes palette.  When you press the [R] key, a rest of the 

same duration is selected. If you press [R] again, the eighth note will again be selected. Make sure the 
rest is selected when you’re finished toggling between the two.

2.	 Move the rest pointer over the bass staff in the pickup bar and click once.  
	 An eighth-note rest appears on the staff.  If you try to enter another rest in the pickup bar, you should 

hear a warning sound from your computer.  With AUTO SPACE on, you cannot enter more notes or rests 
into a measure than are allowed by that measure’s time signature.  (Remember, the pickup bar is 
displaying a time signature of 6/8, but it is really a 1/8 measure.)

Creating a Staff Name
The Staff Sheet lets you set each staff’s playback status (enabled, muted, or soloed), playback key, 
MIDI channel, MIDI program, and MIDI volume.  You can also give each staff a name and choose 
one of four font sizes for the staff’s display.

First, give the staff a name.

1.	 Choose STAFF SHEET from the Windows menu. 
	 The Staff Sheet window appears.  Staff 1 is the only staff with any data in it. (Remember, Encore 
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treats a piano staff as a single staff.)

2.	 Click in the text field below “Name.” 
	 The STAFF NAME dialog box appears.

3.	 Enter the word “Piano” into the text box. 
	 You can also set the font, font size, and style on a PC by 

clicking the FONT button.  On a Mac, simply choose the desired 
font, size and style from the displayed pop-up menus.  The 
staff name will appear on the score as well as in the Staff Sheet 
dialog when you are done.

4.	 Click OK. “Piano” now appears in the Staff Sheet and on the 
score to the left of the first system.

Selecting the MIDI Channel and Instrument or MIDI Program
Set the MIDI channel for staff 1.

1.	 Click in the text field below the heading “Chn.” 
	 The “Chn” (channel) column should already display “1.”  This 

means that staff 1 will play back on MIDI Channel 1.  For more 
information about playback devices, refer to the MIDI 
Setup section of this manual.

	 When you click the Channel field, the Staff MIDI Device 
and Instrument Settings dialog box appears.

2.	 Select a MIDI channel and Playback Device. 
	 The Staff MIDI Device and Instrument Settings dialog box allows you to assign a playback device 

and MIDI channel to each of the eight possible voices in a staff.  So far, you’ve only entered notes in 
voice 1, so that’s the only one you have to worry about.  If you have a MIDI instrument that makes 
something approximating a piano sound, set voice one to that instrument’s MIDI channel.  Then 
select the device as your MIDI interface or Built in Synth 1 or 2

3.	 Click the instrument name or number of your choice (preferably one that will result in a piano 
sound on your MIDI playback device).

4.	 Click OK. 
	 The device and program name you selected now appear in the Program Name column of the Staff 

Sheet.
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	 You can also quickly choose an instrument by clicking on the program name field and a pop up menu 
will appear with a list of all the instruments available. 

	 Note- MIDI channel 10 is reserved for percussion sounds

MIDI Playback
The music may not be completely formatted yet for printing, but you have now entered everything 
you need for a simple piano score.  You’re ready to play the score using MIDI. 

Encore’s default MIDI set up assigns MIDI out to the built in synthesizer of your computer.  If you 
are using an external or other MIDI source, please follow the instructions in the MIDI Setup section 
of this manual.

Try playing back the file.  Click with the arrow pointer in any blank space in the pickup bar to 
place the insertion cursor and set the start point.  Encore will always play from the beginning of the 
measure that contains the insertion cursor.  You can either click the Play button in the Toolbar, or 
press your computer’s [spacebar] to start playback.  Click the Play button, the stop button or press the 
[spacebar] again to stop playback.  If you are having problems with MIDI playback, go to the MIDI 
Setup section of this manual and make sure everything is configured properly.

Tip: You can use the Staff Sheet to select MIDI programs and set staff volume, reverb and panning 
(left or right speakers) while Encore is playing.  First, to begin playback click the Play button.  Next, 
open the CHOOSE INSTRUMENT dialog box.  If you click different program names, the correspond-
ing MIDI program change numbers will be transmitted in real time and you can audition different 
instrument sounds on your synthesizer before you click OK.

Changing the MIDI Volume
1.	 Click on the “Vol” heading in the Staff Sheet while the score is playing. 
	 Staff MIDI Device and Instrument Settings dialog box appears.

2.	 Drag the volume fader to adjust the staff’s volume. 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	 When you have a score with multiple staves, you can set individual volumes for each staff, provided 
that the staves are assigned to different MIDI channels.

Please note: Not all MIDI synthesizers or instrument selections respond to MIDI volume messages.  
Consult your instrument’s manual if you’re not sure.  The Staff Sheet uses Controller 7 messages to 
change volume.

Adding Measure Numbers
When you played back the score, you may have heard 
some measures that didn’t sound correct.  The first of 
these, in measure 8, was caused by an intentionally 
misplayed note in the MIDI file.  Before fixing it, it 
would be a good idea to show some measure numbers 
in the score to help you locate the correct measure.

1.	 Choose MEASURE NUMBERS from the Measures menu. 
	 The MEASURE NUMBERS dialog box appears.

2.	 Click the checkbox labeled Enable Measure 
Numbers.

3.	 Click the radio button labeled EACH SYSTEM. 
	 The measure numbers will appear only on the first 

measure of each system.

4.	 First Bar Is A Pickup Bar should already be checked. 
	 This checkbox is linked to the SET TIME SIGNATURE 

dialog where you already defined the first bar as a 
pickup.  Measure numbering will actually begin with the 
second bar, the first full measure.

5. Click OK. 
	 The measure numbers appear on the score, starting with the first measure of the second system.

Dragging to a New Pitch
Encore allows you to drag notes horizontally to change their placement or vertically to change their 
pitch. The third A note in Measure 8 on beat 5 (the one that’s part of a beamed pair of eighth notes) 
should be a Bb, so you’ll need to drag it up a half step.

1.	 Using the arrow pointer, click and hold on the note’s head.  
	 The note should sound briefly when you click on it.

2.	 Drag the note up a half step to Bb and release the mouse button. 
	 The Bb will sound when you drag the note up.

If you want to check your work, place the insertion cursor in Measure 8 and play the score.  Playback 
will start from the beginning of Measure 8.

Entering an Accidental
You may have noticed another wrong note in Measure 14.  That’s because the note was played as a 
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natural when it should have been a sharp.  The Notes palette is also 
used to add or remove accidentals.

1.	 Click the sharp icon (#) in the Notes palette. 
	 The pencil button in the Toolbar is selected automatically and the 

mouse pointer looks like a sharp sign when you move it over the score.  
You can also select the sharp sign from your computer’s keyboard by 
pressing the [S] key.

2.	 Go to measure 14 in the score and click on the head of the F note in 
the second chord. 

	 The F# sounds and a sharp sign is added to the note.

Shift-Selecting Notes

Here’s an alternate method for adding a sharp sign using a selection technique called “shift-selecting”.

1.	 With the sharp sign and the pencil tool still selected, click the note’s head a second time. 
	 The sharp sign is removed.

2.	 Select the arrow pointer. Click the arrow button in the Toolbar or press [A] on your computer’s 
keyboard.

3.	 Press and hold the [shift] key down.

4.	 While holding the [shift] key, click on the head of the F note with the arrow pointer. 
	 The note becomes highlighted.  You have just selected a single note.

5.	 Release the [shift] key and press the [S] key on your computer’s keyboard. 
	 A sharp sign is added to the note.

6.	 Click anywhere on the score to deselect the note and remove the highlight.

Moving Accidentals
You can also nudge the sharp sign to the left.

1.	 With the sharp sign and pencil tool selected, press and hold the [shift] key.

2.	 Click on the head of a note displaying a sharp sign. 
	 The sharp sign moves slightly to the left.  You can click up to 7 times before the sign returns to its 

original position.

You can change many notes in one operation using a letter shortcut.  First select the notes in your 
score.  Use either the “shift select” technique above or draw a selection around the notes.

If you use the shift-selection technique you can add additional notes to your selection by continuing 
to hold both the mouse button and [shift] key down while moving the arrow tool over each note you 
wish to add to the selection.
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If you select an area by clicking and dragging with the arrow tool, you can add to the selection by 
holding the [shift] key down after the first selection and selecting in new areas.

The following are the shortcut letters for selecting or changing the accidentals in Encore.

	 S for Sharp
 	 F for Flat 
	 N for Natural 
	 Shift + S for double sharp 
	 Shift + F for double flat

When notes are selected in your score, these letter keys will add or remove the indicated accidental 
for each selected note.  

Note:  If the key signature or a previous note in a measure already displays the selected accidental, 
standard music notation does not repeat the indication.  Encore will not add accidentals to a selected 
note if the indication is already in affect.  You can, however, force accidentals onto notes if needed.  
Such indications are usually called “courtesy accidentals.”  The subject of courtesy accidentals is 
covered elsewhere in this manual.

Changing Durations 
The same technique for removing or adding accidentals to a selection can also be used to change the 
duration for selected notes.  In this next section you will not only change durations but also copy 
notes and chords, tie them and learn to use the Align Playback and Align Spacing operations after 
editing.

Measure 4 in “When Johnny Comes Marching Home” was played incorrectly in the MIDI File.  The 
measure should actually look identical to Measure 3.  The first step will be to select and change the 
eighth note played with the left hand to a dotted quarter note.

1.	 Select the D note in the top staff of Measure 4. 
	 You should now be familiar with two selection techniques.  You can use the arrow tool to click and 

drag a selection around the D note or you can use the shift-select technique and click directly on the D 
note while holding down the [shift] key to select the note.

2.	 Press the number 3 key on your computer keyboard. 
	 The selected D note will change from an eighth note to a quarter note.

3.	 Press the letter “D” on your computer keyboard. 
	 The selected D note will change from a quarter note to a dotted quarter note.

	 Now we need to change the duration of the Bb and F in the bass clef from an eighth note to a quarter 
note.

1.	 Select the Bb and the F in the bottom staff of Measure 4 using the same techniques as mentioned 
above.

2.	 Press the number 3 key on your computer keyboard.  The selected notes will change from eighth 
notes to quarter notes.

	 Next we need to change the duration of the rest in the bass clef from a quarter note rest to an eighth 
note rest. 
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1.	 Select the quarter note rest that’s to the right of the quarter note chord in the bottom staff of 
Measure 4 using the same techniques as mentioned above.

2.	 Press the number 4 key on your computer keyboard.  
	 The selected rest will change from a quarter to an eighth.

As you may have noticed, the number keys on your computer keyboard will change the duration for 
all selected notes. The letters “D” and “T” can be used to add or remove dots and tuplet indications to 
the selection. The following are the values for each number key.

	 1 = Whole Note 
	 2 = Half Note 
	 3 = Quarter Note 
	 4 = Eighth Note 
	 5 = Sixteenth Note 
	 6 = Thirty-second Note 
	 7 = Sixty-fourth Note 
	 8 = One Hundred and Twenty-eighth Note
	 D = adds or removes the dotted indication 
	 T = converts to the tuplet indication.

To remove a tuplet indication, press a number key to select the desired duration.  For more 
information about tuplets and how to change the tuplet indication, refer to the Using The Palettes 
chapter of this manual.

While notes are selected, these number keys will change all selected notes to the values indicated 
above.  However, changing note durations using number keys does not correct for extra beats or other 
timing problems that might result in the process.  

Changing duration using number keys on a selection does not correct for spacing, either.  Two 
additional operations, Align Playback and Align Spacing fix playback and spacing problems.  More on 
those operations follows later.  

For now, let’s complete the steps needed to make Measure 4 look like 
Measure 3.

Copying a Note Using The Control/Option Key
The next step is to add the F note needed to create the correct chord in 
Measure 4. You could insert the note using the pencil tool but there is a 
method for copying a note that you will learn instead.

1.	 Select the arrow tool from the Toolbar section of the Score window.

2.	 Hold down the [control (win)/option(mac)] key and click on the D note 
in Measure 4.

3.	 Continue to hold down both [control (win)/option(mac)] and the mouse 
button and drag the D note up one space to the F note location on the 
staff.

You have just copied the D note and created a chord.
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If you make a mistake and drag to the left or right instead of first moving vertically, the note you copy 
will remain a D note and get copied to a new location in the measure. If that happens, select “Undo 
Move” from the Edit Menu and try again.

Remember:  When moving notes with the arrow tool the first direction in which you move decides if 
you are moving to a new pitch location (vertical movement) or time location (horizontal movement).

Erasing Notes and Rests
You now have a two-note chord identical to the chord that begins in Measure 3 but there are extra 
rests in Measure 4 that need to be removed before you can create the second chord and tie the two 
together.

Encore lets you remove notes or rests in several ways.  You can use the eraser tool and click on each 
note or rest one at a time, or you can make a selection and remove everything in the selection.

Using the eraser tool when Auto Space is on will change the spacing of the measure as each note 
or rest is erased.  If you erased the two quarter note rests in Measure 4 using the eraser, each erase 
operation would move the eighth note at the end of Measure 4 closer to the start of the measure.

For this excerise, go to the setup menus and turn off Auto Space by scrolling down to it and releasing 
the mouse button.  Auto Space will then be unchecked.  Now when you make a selection and remove 
notes or rests in a measure, the remaining notes no longer adjust automatically.

In our example, we want to keep the eighth note at the end of Measure 4 and only remove the quarter 
note rests.

1.	 Select the Arrow tool (if it isn’t already selected) and select both quarter rests on the top staff.  
You can use the same shift-select technique for rests as you did for notes, but it may be easier in this 
example to click and drag with the mouse to create the selection.

2	 Select “Clear” from the Edit Menu or press the [delete] key on your computer keyboard. 
	 The two selected quarter note rests will be removed and the eighth note will remain at the end of the 

measure.

3	 Repeat as above for the dotted quarter rest on the bottom staff. 

Copying a Chord Using The Control/Option Key
Now you have the space needed for the chord you are going to create to duplicate the tied chord in 
Measure 3.  As before, you will use the [control (win)/option(mac)] key to copy.  This time you will 
copy both notes together and create a second chord.

1.	 Select the arrow tool from the Score Window’s toolbar.

2.	 While holding down the [control (win)/option(mac)] key, click on either note for the chord you 
created in measure 4 and drag to the right. 

	 If you make a mistake and drag vertically, Encore will think you wish to add another note to your 
chord. If that happens select “Undo Move” from the Edit Menu and try again.

When finished you should have a copy of your first chord to the right of the first chord in the same 
measure.  The exact placement does not matter, as you will use another operation later to correctly 
adjust the spacing for the measure.
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You are almost ready to tie your two chords together, but you should first change the duration for 
the second chord to a quarter note chord.  By now you should be familiar with the steps.  Select the 
second chord and use the letter “D” key on your computer keyboard to remove the dotted indication.

For the notes on the bass staff, let’s try a more traditional approach.

1	 Select the arrow tool from the Score Window’s toolbar.

2	 Drag select both the quarter note chord and the eighth note rest.

3	 Go to the Edit menu and select copy (or right click/copy or use [cmd]+[c])

4	 Place the cursor after the eighth rest.

5	 Go to the Edit menu and select paste (or right click/paste or use [cmd]+[v]).

You have now copied the first half of the measure and pasted it in the second half using the universal 
copy and paste method. 

Creating Ties
Now that you’ve created the two chords needed in Measure 4, you need to add the ties between them.  
Encore can automatically draw ties between consecutive notes of the same pitch.

1.	 Select the chords to be tied.

2.	 Choose TIE NOTES from the Notes menu. Ties appear between the notes.

A shortcut for adding or removing ties is to select the notes you wish to tie and use [control/
command] + “T”.

Note:  To tie notes between two different systems or across a page, you must use the shift-select 
technique or adjust the number of measures per system until both notes are in the same system.  After 
dragging a selection around notes, the tie operation will only tie notes within that selection.

Adjusting Ties
If you don’t like the appearance of the ties, you can edit them.

1	 From the View menu, choose Show Control Points.
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When you return to the score, small, rectangular ‘handles’ have 
appeared in the middle of each of the ties.  These are the control points.  
Ties, text, slurs and several other graphic elements that appear on your 
score have control points associated with them.  The control points let 
you ‘grab’ to make various types of adjustments.  For example, you 
can use the arrow pointer to pull ties up or down, tweak the appearance 
of slurs or resize text boxes.

Tip:  Control points can be turned on and off by pressing [control/command] + [apostrophe].

Note: The control points do not need to be showing in order to adjust the graphics.  It’s just easier if 
you can see them.

Aligning Playback
The notation you see in the Score window and the MIDI data that Encore plays back are closely 
linked, but they are two separate entities.  Whenever you make changes to the durations of notes or 
make other edits to your score, you should align the MIDI playback to the on-screen notation.  In 
certain instances, Encore might not let you enter more notes or rests into an edited measure until you 
have aligned the playback.

1.	 Select measure 4. Double-click in any blank space in Measure 4.

2.	 Choose ALIGN PLAYBACK from the Measures menu.

3.	 Click anywhere in the score to deselect Measure 4.

Align Spacing
The next step after editing a measure and using Align Playback is to correct the spacing in the 
measure.

When you first opened Johnny.mid, Encore automatically justified the notes and rests after guessing 
and beaming.  This occurred because “Auto Space” was enabled in the Preferences.

While editing individual measures in your score, we instructed you to disable Auto Space since the 
Align Spacing operation should be used as a final step to ensure correct spacing for the entire system.  
Align Spacing compares all of the notes for each instrument playing during the selected measure(s) 
and then aligns the spacing for all instruments.

When editing measures after recording or opening MIDI files, Auto Space will continue to adjust 
the spacing as notes are added or removed from a measure but only an Align Spacing operation will 
correctly space the entire system.  It is considered a good habit to periodically select and use Align 
Spacing while working on a section. You could use “Select All” and justify an entire score in one 
operation, but it is better to use Align Spacing only for a selected range of measures clearly visible on 
the screen.  This lets you see the exact changes the Align Spacing operation made to those measures 
and also allows you to Undo those changes if you wish to keep the previous spacing.  Or, you may 
decide to make some further manual changes after using Align Spacing.

While the Align Spacing operation can do a fine job of spacing musical phrases, music notation is 
subjective, so review the changes and make the final judgment yourself.

1.	 Select Measure 4. Place the cursor in Measure 4. 
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2.  Choose ALIGN SPACING from the Measures menu. 
	 The SPACING dialog box appears.

Encore’s spacing dialog has options for “Adjust Measure 
Widths” and “Adjust Measures Per System” but these will 
only be available if you select entire systems.  Adjust for 
Lyrics and All Staves will be selected by default. Keep those 
choices active and continue. On a Mac, click the “Engraver’s 
Spacing” radio button.

3.  Click OK. 
	 The notes in Measure 4 are justified.  Because “All Staves” was selected, the changes made in the top 

staff also affected the lower staff and both staves were adjusted together.

Note:  Copying notes and chords using the control /option key is fast and simple but the operation 
should always be followed with both an Align Playback and an Align Spacing operation.  In 
addition, notes should not be dragged to other measures, and it is also best to avoid drastically 
changing the order of notes.  You can drag left or right to copy notes and chords but do not drag the 
notes past other notes or chords in the process.  If you need to change the order of notes in a measure 
it is better to erase notes that are out of order and reenter them.

Inserting a Measure
“When Johnny Comes Marching Home” has (at least) 4 verses.  Encore not only allows you to add 
repeats, it also gives you the option of playing them via MIDI as notated.

But before you can add the repeats you’ve got to insert a new measure to use for the repeat ending.

1.	 Click in Measure 16 to place the insertion 
cursor.

2.	 From the Measures menu, choose ADD 

MEASURE. 
	 The ADD MEASURE dialog box appears.

3.	 Choose Add 1 measure before Measure 16.

4.	 Click OK 
	 Measure 16 is now a new, empty measure.  What was previously Measure 16 is now Measure 17.

Copying a Measure
Next you’re going to copy Measure 17 and paste it into Measure 16.
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1	 Double-click between the staves of Measure 17 to select the entire measure.

2	 From the Edit menu, choose COPY.

3	 Place the insertion cursor in the treble staff of Measure 16.

4	 From the Edit menu, choose PASTE. 
The notation from measure 17 appears in Measure 16.

Before continuing some additional changes are needed in Measure 16.  The end of Measure 16 will 
be used to lead into the second and third verses in our example and the note created in the pickup bar 
needs to be placed at the end of Measure 16.

When you copied Measure 17 into Measure 16, you copied the ending quarter note rest in Measure 17 
as well.  That rest needs to be changed to an eighth note rest and an eighth note “D” added to the end 
of the measure in the top staff.

1	 Select the quarter note rest at the end of Measure 16 and use the number 4 key on your 
computer keyboard to change the duration to an eighth note rest.  

2	 Next, remove the selection by clicking in any empty space in Measure 16. 
 
3	 Select the pencil tool and an eighth note from the note palette. 
 
4	 Add an extra D note at the end of Measure 16 after the eighth note rest. 
 
5	 Align Playback for that measure.

Beaming Notes
When you open a MIDI or Master Tracks Pro file or enter notes into a new blank measure, the 
appropriate notes will be beamed automatically.  (AUTO GUESS/BEAM can be turned off in the Setup 
menu.)  Beamed notes are grouped according to where they fall relative to the beat.  (You can use the 
BEAM GROUP command in the Notes menu to select and then beam the notes of your choice regardless 

of where they fall relative to the beat.)

Sometimes in the course of editing a file you will need to beam notes 
whose durations have been changed.  A case in point is the group 
consisting of an eighth note chord, an eighth-note rest, and an eighth note 
in the new Measure 16.

1.	 Using the arrow pointer, draw a selection rectangle around 
the group to be beamed.

2.	 From the Beam Notes sub-menu in the Notes menu, choose 
BEAM GROUP. 
	A beam appears over the selected group.  Beam Group should be used to 
create beams over rests or to 	 include a rest in a beamed group of 
notes.  Beam Group is also used to create bracket indications for quarter 
and half note tuplets.
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Changing Barlines
You have now entered all the notes and rests and measures necessary for the repeats.  Now you can 
define the section to be repeated.

1.	 Select Measure 1. 
	 Double-click in the treble staff of the first full measure (that is, not the pickup bar).

2.  From the Measures menu, choose BARLINE TYPES. 
	 The BARLINE TYPES dialog box appears.  At the top 

there a drop down menu lets you choose either 
“Apply to Range of Measures” or “Apply to Selected 
Measures”.  For this exercise, we will use “Apply 
to Range of Measures”.  Please type in the measure 
range, 1 to 16.  Make sure the “apply to Each 
Measure in Range” is unchecked.  Any changes 
you make to the left barline will only affect the left 
barline of measure 1. Changes made to the right 
barline will only affect Measure 16.

3.  Click the left and right repeat barline buttons.

4.  Make sure a check appears in the PLAY REPEATS 

checkbox. 
	 If you choose PLAY REPEATS and then play the score from the beginning via MIDI, it will play until it 

reaches the right repeat barline.  Playback then will jump to the left repeat barline, play through to the 
end of the score, and stop.

5.  Click OK.

Repeat Endings
Simple repeats like the one you just added are fine for some applications.  In this case, however, we 
want the main body of the song to play through 3 times and then jump to a different ending on the 
fourth repeat.

1.	 Select Measure 16. 
	 Double-click in the treble staff.

2.	 From the Measures menu, choose ENDINGS. 
	 The MEASURE ENDINGS dialog box appears.

3.	 Click the checkboxes labeled FIRST, SECOND, and THIRD. 
	 A check appears in each box.

4.	 Make sure a check appears in the PLAY THEM checkbox.

5.	 Click OK. 
	 The ending bracket appears over Measure 16, complete with text indicating this ending should be 

played through the first 3 times.

6.	 Select Measure 17.
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7.	 From the Measures menu, choose 
ENDINGS.

8.	 Click the checkbox labeled FOURTH.

9.	 Click OK.

If you play the score from the beginning, it 
will start with the pickup bar and then play 
Measures 1 through 16 three times.  On the 
fourth repeat, it will skip Measure 16, play 
17, then stop.

Like any other on-screen objects, the 
brackets and text associated with endings 
can be moved and adjusted.  Drag the 
upper-left corner to adjust the height.  Drag 
the lower-left end to adjust the length of the 
sides.  If the control points are showing, the 
control point on the right end looks like a 
small arrow head.  Click on it to “open and 
close” the bracket.  You can also drag the text.

You can adjust any of these parameters for two or more endings on a page simultaneously.  Simply 
hold the [control (win)/option(mac)] key and adjust one of the endings.  The other endings will be 
adjusted accordingly.  This comes In handy if you have adjusted the height of one bracket and are 
having trouble getting the other brackets lined up.  Hold the [control (win)/option(mac)] key and drag 
one of the brackets to the desired position.  The other brackets will automatically align with it.

Laying Out The Music
You have now entered and edited a complete (albeit one-page) piano score.  Everything that anyone 
would need to play this piece is there in the Score window.  All that remains to do is to make it 
presentable so that you can print it out.

The first thing that you need to do is determine the printable area of the page.  If the page margins are 
not already showing in the Score window, open the SHOW/HIDE dialog box (View menu) and click the 
PAGE MARGINS checkbox to display them.  The width of the margins is set in the Page Setup dialog (File 
menu).  The PRINTER DEFAULT setting should work for most printers, but you might want to specify an 
exact width.

The page margins appear in the Score window as a grey line around the score.  Anything within 
this line will print.  If you scroll to the end of the score, you’ll notice that the last two systems are 
apparently off the page.  Or, more accurately, they are on another page below the first one.  That’s 
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because Encore prints large scores in tiles. Say, for example, that you’re working on a large orchestral 
score. The size of a single page of a full orchestral score could easily exceed the standard paper sizes 
that will fit in your computer’s printer.  To get around this, Encore will print a large page in tiles, 
separate pieces of paper that can be assembled afterward.

But the piano score you’re working on should fit easily on a single page.  There are two things you 
can do to make this work: change the size of the music on the page, and arrange the measures and 
systems so that they make better use of the available space.

Changing Staff Size
One way to change the size of the music is to select a different point size for the Anastasia font.  
Anastasia is the font that Encore uses to display and print music.

1.	 Open the Staff Sheet window.

2.	 Click on the number 3 under the heading “Size.” 
	 The SET STAFF SIZE dialog box appears.  You can choose a staff size 

ranging from 1 to 4, where 1 is the smallest and 4 is the largest.

These numbers correspond to 4 different point sizes:

	 Staff Size 		  Point Size 
1			   16 						    
2			   20 						    
3			   24 						    
4			   36

3.	 Move the slider for staff size 2.

4.	 Click OK.

The on-screen display changes to reflect the newly chosen font size.  Before you proceed, set the staff 
size back to 3.  In the next section you’ll explore another option for getting more music on a page.

Reducing the Music
There is another way to make optimum use of the page:  you can print at a reduction. This has two 
distinct advantages.  It gives you more room to work with, and the size of the music does not change 
on the screen.

1.	 From the File menu, choose Page Setup. 
	 The Page Setup dialog box appears.

2.	 Enter the number “80” in the text box labeled Enlarge or Reduce Score By (Windows) or Scale 
(Mac) . 

	 In general, a reduction value of 75 to 80 percent works well with the staff size set to 3.

3.	 Click OK. 
	 The notes and other objects in the Score window remain the same size, but the apparent size of the 

page increases.
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Moving Staves
When you initially created the piano staff, you probably noticed that the spacing between staves was 
more than you might want.  In fact, there is much more space than there needs to be between most of 
the staves.  One of the great things about Encore is that it allows you to drag just about any object you 
can get your mouse on, including staves.

The spacing in the first system looks pretty good, so concentrate on the second system for now.

1.	 Using the arrow pointer, click and hold on the point where the left barline and the top staff line 
of the bass staff meet.

2.	 Drag the staff up.

3.	 Release the mouse button.

This method is fine for tweaking the spacing on individual systems, but it would be pretty tedious if 
you had to go through an entire score and change the spacing between the staves 
in each system.  Fortunately, you don’t have to do that.

1.	 Press and hold the [control (win)/option(mac)] key.

2.	 Repeat the previous procedure, but this time adjust the spacing between the 
staves in the first system.

3.	 Release the [control (win)/option(mac)] key.

Moving a staff while the [control (win)/option(mac)] key is down causes that 
staff to be moved to the same position in all subsequent systems.  In other words, 
if you adjusted the spacing in the second system while the [control (win)/option(mac)] key was held, 
the first system would not have been affected.

Use this technique to get a consistent and comfortable amount of space between the staves.

Moving Systems
Now that you’ve reduced the music and adjusted the spacing between staves, you should have 
more than enough room to fit all the music on one page.  In fact, you’ve probably got quite a bit of 
blank space at the bottom of the page.  Now you can space the systems to make the page a little less 
cluttered.  First, you’ll move everything on the page down a bit.

1.	 Using the arrow pointer, drag the left edge of the first system down a little. 
	 The spacing between the systems remains the same, but all the systems on the page move down.  

There are a number of reasons why you might want to do this. Chief among these is that you might 
want to add a title and other text elements later.

2.	 Release the mouse button.

Now you can adjust the spacing between the systems.  You can move systems individually, just like 
you did with staves.  But for now you want to adjust the space between all systems equally.

1.	 Press and hold the [control (win)/option(mac)] key.
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2.	 Drag the upper left corner of the second system. 
	 Adjust the spacing between the first and second systems.

3.	 Release the mouse button and the [control (win)/option(mac)] key. 
	 The spacing between all the systems is the same as the spacing between the first 

and second systems.

Check the bottom of the page to make sure that the last system still falls within 
the bottom margin.  You might have to work at it a bit to get everything properly 
spaced.

So far, you’ve only dealt with vertical space.  If, in the course of laying out the page, systems have 
moved away from the left margin you can apply the same techniques to horizontal movement.  
Remember, whenever you drag a system while holding the [control (win)/option(mac)] key, that 
system and all subsequent systems are affected. Therefore, if you want to realign the systems with the 
left margin without affecting the indent on the first system, just control (win)/option(mac)-drag the 
second system.

If you drag the left or right end of a system horizontally, the placement of objects within the system 
will be scaled proportionally.

1.	 Click and hold on the left edge of the first system.

2.	 Drag the staff to the right until its left end is over the center of Measure 3.

3.	 Release the mouse button.
	  The first system is compressed. All three of the measures in the system are scaled to occupy less 

horizontal space.

Dragging Barlines
You’re almost finished with the layout.  The systems are evenly spaced on the page, the spaces 
between staves are consistent, and you’ve indented the first system. The only thing left to do is adjust 
the width of the measures in the first system.

1.	 Click and hold on the barline between the pickup bar and Bar 1.

2.	 Drag the barline left 

3.	 Release the mouse button. 
	 The measure is resized.

Auto Align Spacing automatically adjusts the notes in the measures on either side of the barline.

At this point, your edited file should look pretty close to the file “jonnypno.enc.”  You might want to 
compare the two files to check your work so far.  You could even print them out if you’d like.

Adding a Staff
The next part of this tutorial will show you how to add a vocal staff.  Then you’ll enter the melody 
using MIDI step entry and real-time recording and, finally, add some lyrics.

1.	 Place the insertion cursor in the pickup bar of the treble staff. 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	 When you add a staff, Encore needs to know where to insert it.  Encore will insert a staff above or 
below the staff that contains the insertion cursor or, as an alternative, a staff that has been selected.

2.	 Choose ADD STAFF from the Score menu. 
	 The ADD STAFF dialog box appears.

3.	  Choose Add a staff to this Piano Staff.

4.	 Click OK. 
	 A new, blank treble staff appears above the piano 

staff.

5.	 Open the Staff Sheet and name the new Staff 1.
	  Enter “Vocal” in the STAFF NAME dialog.

You can also assign a separate MIDI channel and 
program for the new staff.  Maybe you’d like it to 
be played by a piccolo.

Breaking the Barline
The new staff is connected to the piano staff at each barline.  In a piano/vocal arrangement, the 
barlines are typically broken between the vocal and piano staves.

1.	 Select Staff 1.

2.	 From the Score menu, choose CONNECT STAVES. 
	 The Connect Staves dialog box appears.

3.	 Click the checkbox labeled BREAK BARLINES. 
	 A check appears in the box.

4.	 Click OK. The barlines are broken.

MIDI Step Entry
MIDI step entry is probably the fastest method of step-entering notes.  If you’re using a MIDI 
keyboard or other MIDI instrument, you can use it to enter pitches in step time.  The notes’ durations 
are determined by the current duration chosen in Encore. If you use the computer’s number keys to 
choose durations, you can enter notes with one hand and choose durations with the other.  With a little 
practice, it’s quite easy.

Note:  If you are using a MIDI master controller and a separate sound module, you will need to click 
on the Thru button in the Toolbar.  When Thru is on, MIDI data received at the computer’s MIDI in 
port is simultaneously transmitted from the computer’s MIDI Out port. See The Menus chapter for 
more information about MIDI Thru.

 1.	Place the insertion cursor in the pickup bar of the vocal staff. 
	 When you use MIDI step entry, place the cursor in the measure where the notes are to be inserted.

2.	 Choose the eighth note in the Notes palette. 
	 For MIDI step entry to work, the Notes palette must be the active palette and the pencil tool must be 

selected in the Toolbar.
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3.	 Play the first four notes of the melody. 
	 The notes appear in the vocal staff.  It is best to play fairly staccato.  Notes are not entered in the score 

until you release the key on your MIDI keyboard.  If you play a phrase and the notes overlap even 
slightly, those notes will be scored as a chord.  This comes in handy when you want to enter widely 
spaced chords.  Play the first note, then the second note, release the first and play a third, and so on.  
Even the smallest hands can enter huge chords this way.

4.	 Press [3] on your computer’s keyboard and enter the fifth note. 
	 You can continue to enter the vocal line in this fashion, using the MIDI instrument to enter pitches 

and the number keys to choose durations.  If you make a mistake,  use the [backspace] key to move 
back one event and reenter it.  To enter a rest, press [R] and play a note.  A rest with the current 
duration will be entered.  Press [R] again to toggle back to note entry.

Note: MIDI step entry determines not only the pitch of the entered notes, but also the MIDI velocity 
value assigned to each note or chord.

Real Time Entry
Real time note entry is the fastest (and most entertaining) method of getting notes into Encore.  Let’s 
set up Encore for recording.

1.	 From the Encore>Preferences menu, choose Record/TRANSCRIPTION SETUP. 
	 The Record/TRANSCRIPTION SETUP dialog box appears.

2.	 Click the eighth note choice. 
	 When Encore guesses the duration of notes, it subdivides each 

measure based upon the value you choose in the TRANSCRIP-

TION SETUP dialog.  Encore tries to make the notes you play fit 
within those subdivisions.  The shortest note duration in the 
melody line is an eighth note.  Choose the closest duration 
available in the TRANSCRIPTION SETUP dialog.  In this case, that 
would be the eighth note.

3.	 Click OK.

The next thing you’ll need to do is set up the metronome click 
and enable it.

1.	 From the Encore>Preferences menu, choose CLICK On/
Off. 
You may change the click set up by going to Encore>Preferences>Click Setup.

Before you attempt to record, it might be a good idea to slow down the tempo.
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1.	 Place the cursor in the first measure of the vocal staff. 

2.	 From the Measures menu, choose TEMPO. 
	 The CHANGE TEMPO dialog appears.

3.	 Indicate Measure range and Set all tempos to 200 
beats per minute.

4.	 Click OK.

Before you record, you should make sure that Encore’s 
Split Staff function is turned off.  Split Staff allows you 
to record into a piano staff in real time and split the notes 
onto the treble and bass staves as you record.  However, if you intend to record in only one staff while 
Split Staff is on, you may wipe out data that’s already been recorded in another staff.

1.	 From the Encore>Preferences menu, choose Record/TRANSCRIPTION SETUP. 
	 The Record/TRANSCRIPTION SETUP dialog box appears.

2.	 Make certain the checkbox labeled Split Notes Below... is disabled (not checked).

3.	 Click OK.

Now you can record the vocal melody.

1.	 Place the insertion cursor in the pickup bar of the vocal staff. 
	 Recording will begin in the measure that contains the cursor.

2.	 Click the Record button in the Toolbar or press the [enter]* key.
	  If everything is set up properly, you should hear a 1 bar count-in before recording begins. Since this 

piece has a pickup bar, recording will actually begin on beat 6 of the count-in.

	 Note:  [Enter] key must be enabled through Preferences>Record Transcription Set Up.

3.	 Play your MIDI instrument.

4. 	Stop recording before the end of measure 16. To stop recording, click the Record button again 
or press the [spacebar]. 

	 There is a brief pause while all the notes are guessed and beamed. 

If you made a mistake, use the Undo command to erase the recording.

Entering Lyrics
The next step is to add the lyrics to the vocal part.  Encore makes entering lyrics simple.  Lyrics are 
‘attached’ to notes and you can move through the score from note to note adding the desired words 
and syllables.  First, you’ll need to select the lyric tool which is found in the Graphics palette.

1.	 Click on the lyric tool (the “L” in the Graphics palette).

2.	 Click the arrow tool on the head of the first note in the vocal part. 
	 A blinking text cursor appears below the first note.  You should also see an arrow appear directly to 

the left of the cursor in the margin.
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3.	 Type the first word (“When”) and press the [spacebar]. 
	 The first word appears centered below the first note.  When you press the [spacebar], the cursor 

moves to the next note.

4.	 Type “John” and then press [ - ] (the hyphen key). 
	 For breaks between syllables, use the hyphen key.  This will move the cursor to the next note and 

place a hyphen between the two syllables.

5.	 Type in the second syllable.

If you look at the example you will also notice that there are some “melismas” in the vocal part. The 
first one occurs in Measure 3. To enter a melisma:

1.	 Type in the word or syllable.

2	 Hold the [shift] key and press the [spacebar]. 
	 The cursor moves to the tied notes.

3.	 Continue to hold [shift] and press [ - ] (the hyphen/underscore). 
	 A single underscore will appear there.  The melisma will not actually be drawn until you exit lyric 

mode.  If you click on the arrow tool, the melisma will be drawn.

Editing Lyrics
You can use the lyric tool to edit text and correct typos.  The [back space/delete] key will move the 
cursor back through the text, deleting letters as it goes.  The [tab] key will move forward through the 
lyric, selecting entire words.  Pressing [shift]+[tab] will select words in reverse order.

Selecting the lyric tool and pencil changes Encore’s Notes menu to the Text menu.  Use the Text 
menu to set the font, point size, and style for your lyrics.  If no lyrics are selected, these changes are 
global.  If lyrics are selected, the changes affect only the selected lyrics, allowing you to mix fonts 
and styles.

The arrow that you saw in the left margin when the lyric tool was selected is used to adjust the 
vertical alignment of the lyrics.  Drag it to move the lyrics up or down.  You can drag on individual 
lyrics with the arrow tool to adjust the horizontal placement.

Fitting It On The Page
You may have noticed that since you added the vocal staff your nicely formatted piano score no 
longer fits so neatly on one page.  Even if you follow the previously discussed steps for page layout, 
you won’t get all six systems to fit within the margins. The 
simplest solution is to put the last system onto another page.

1.  From the Score menu, choose SYSTEMS PER PAGE. 
	 The SYSTEMS PER PAGE dialog appears.

2.  Reduce the number of systems per page from 6 to 5.

3.  Click OK.

The last system will be put onto a new page, page 2.   A new page icon appears in the Toolbar.
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Now, if you want, you can adjust the systems and the spacing between the staves.

The Fun Part
This tutorial just scratches the surface of what you can do with Encore.  If you’ve followed it closely, 
you’ve already developed some excellent skills and habits to help you in your musical endeavors.  If 
you want to see what the complete piano vocal arrangement of the tutorial file looks like, open the 
file “When Johnny Comes Marching Home with Lyrics.”  A few other operations -- adding the slur in 
Measure 11, or the guitar chords -- you can try on your own. 

This manual is filled with examples and tips about things like voicing, transposable chord symbols, 
additional lyric lines, all kinds of marks, and much, much more.  Now stop working and get playing! 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When you make changes to your music in Encore, many of the edit operations require you to first 
select the notes and objects you  want to change.  Four different selection “objectives” exist 

within Encore: notes, graphics, measures, and staves.  Several methods can be used for selecting these 
items, and some methods are better suited for particular operations than others.  Using and combining 
the proper selection methods will require fewer individual edits..

One of the most basic operations on a computer, selecting an area with the arrow pointer, is often not 
the best method to select areas in Encore.   Yes, for a small group of notes within a measure, the arrow 
is ideal, and operations such as Sub-Group, Print Selection, and Beam Group require using the arrow.  
But, when selecting entire measures or systems, you should use easier more reliable methods.  This 
section outlines how each technique is applied within Encore and when each is most appropriate.

Drag Selection
Highlighting by dragging with the arrow pointer is a very common technique in all operating systems.  
For most readers, this need not be explained, but to provide a thorough overview we’ll describe the 
basic operation anyway.

Using the arrow, click at the upper left corner above the notes or 
graphic you want to select.  Click and hold the mouse button and 
drag diagonally from upper left to lower right.  While dragging, 
a highlighted version of your score appears in the growing 
rectangle.  As long as you hold down the mouse button, you are 
“drawing the selection.””

Adding to a Selection 
Encore allows you to add more selections without losing the last selection.  This speeds things up 
quite a bit when several different areas on a page all need the same change.

After selecting one area in Encore, hold down [shift] while making additional selections.  Make 
these selections either by clicking and dragging with the mouse or by using one of the other selection 
techniques discussed in this section..

Note:  Be careful when drag-selecting additional areas.  Avoid creating overlapping areas of 
selection.  When holding down the [shift] key, if a drag selection starts to overlap another selection, 
the overlapping area will appear as a normal score again (non-inverted).  Technically, the area is not 
selected.  Overlapping areas are difficult for Encore to account for and should be avoided.  Keep 
selections from overlapping and everything you select will be properly recognized.

Shift-Selecting Regions 
Encore lets you use the [shift] key for defining the first selection area without the need to drag.  If 
[shift] is held down before the first click, a small plus sign will indicate the location for the upper-left 
corner of a selection.  The second click determines the lower-right corner of the selected area and 
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draw the selection.  You can also select from lower-left to upper-right.

Using this technique to define a region works only when defining the first selection area.  Additional 
selections added using the [shift] key will require the standard click and drag technique.

Don’t confuse using the [shift] key to select a region with “shift-selecting” individual notes.  If the 
[shift] key is held down and you click on anything other than a note or rest, you will get a plus sign.  
That sign indicates that your next click will define a selection rectangle.  If you don’t want this, 
release the [shift] key, click once to clear the process, and start again.

The [shift] key can also be used to select additional areas on other pages, but we recommend that you 
keep all your edits on a single page unless you are selecting to the end of the score.  This keeps things 
simple for you and Encore and makes it easier to remember what you have selected.

Recognizing the Selection
When using the arrow pointer to select areas in your score there are a few “points” to consider:  
control points.  When selecting graphic item, control points are quite important.  In fact, control 
points are quite important when selecting graphic items.. 

Selecting Control Points
The left control points are the main control points recognized for selections.  When an item has four 
control points (like text boxes), selecting the left control point needs to either include both control 
points or more than a “quarter” of the left edge..

Items Without Control Points
Some items, most noticeably notes and rests, don’t have control points.  When selecting these items 
you should select the entire item.

Notes
It may be helpful to know that Encore recognizes a note as selected only when the left side is 
highlighted.  When notes have upward stems (if there is a stem at all), selecting just the first pixel at 
the tip of the note’s head counts as selecting the note.  Selecting the rest of the note without that tip 
doesn’t count.  If a note appears stem down, the far left side is the stem and the same rule applies; 
select just the stem and the note is still selected. Select anything but the stem and the selection will 
not be recognized.

Rests
The same concept concerning note selection remains true for rests.  If the left side of a rest is 
highlighted, the rest is selected..

Other Graphics
Dynamics, marks and chord symbols (both text chords and guitar indications) all have a control 
point in the approximate center.  As soon as a selection includes the center for one of these items, the 
graphic is selected.
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Clefs
Clefs cannot be selected.  Clefs that have been added after the beginning of a system can be erased 
with the eraser tool.

The one operation in Encore that will move a clef within the measure is the “stretch” function.  For 
more on this special function see the Advanced Topics appendix to this manual.

Shift-Selecting Notes
Encore provides a special method for selecting individual notes and rests, even when they are part of 
dense chords or passages.  This technique is called “shift-selecting.”

When a note is shift-selected, the note head is enclosed in a small selection rectangle to indicate 
the note has been added to the selection. Shift-selecting notes is very fast and efficient once you 
understand what to do.

Hold down [shift] and click directly on a note’s head.  A selection rectangle appears around the note’s 
head indicating it’s been selected.  If you continue to hold [shift] down 
you can click on additional note heads as well.  Far easier, however, 
is to hold the mouse button while you move the arrow pointer over 
additional notes and rests.   As the arrow passes over either notes or 
rests, each item becomes selected.

If you make a mistake and select an item unintentionally, you can deselect the item by holding down 
the [shift] key and clicking on the item.

If you release the [shift] key and click, all selections are cleared.

Be careful when first beginning the shift-selection process to click directly on a note head or rest.  If 
you miss and click anywhere else you will see a plus sign entered where you clicked.  This indicates 
the beginning of a shift-selection for a region and is not the same as shift-selecting notes.  See Shift-
Selecting Regions earlier in this chapter.

Shift-selecting notes is particularly useful for flipping the tie direction within a chord without 
changing the stem direction.  When Encore ties notes together in chords, it tries to arrive at logical 
solutions for the tie directions, but you may need to change some for your 
score.  By shift-selecting the two notes that are tied, you can use [control/
command] + [T] and the tie direction will change.

Shift-selecting notes becomes more natural the more you use the technique.  
Before long you’ll be gliding your mouse through your score and easily 
selecting entire regions for editing.  There are a few situations where shift-
selecting is not recommended, however, and other selection techniques are 
more appropriate.

Note: Copying and pasting partial note information from beamed groups or chords is not 
recommended for any copy operation, including standard drag selection.  If you need to copy 
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something from a group, you should either copy and paste the entire group and then erase what you 
don’t want, or separate the item from the group before copying..

Selecting Measures
Although you can draw a selection to include an entire measure, by far the most reliable and efficient 
method for selecting measures uses a double-click to select the measure.  For this selection process 
to work, you must double-click in some portion of the measure that doesn’t have a note, rest, or other 
graphic item.  This double-click creates an inverted selection for that measure and selects everything 
within the measure.

One advantage of double-clicking to select a measure over drag selecting is that you make sure you 
don’t accidentally select a measure in another system by mistake.  The areas between systems can be 
difficult to see and may even overlap in some cases.  Use the double-click method whenever possible 
and use the drag selection technique when selecting only some of the notes within a measure.

Selecting Additional Measures 
When using the double-click method to select measures, you can select additional measures by 
holding down [shift] before double-clicking each additional measure.

Selecting Staves
There are two special methods for selecting staves.  The selection techniques are similar, but the 
results are different.

Single-Click Selection
To select all the measures in a staff, a single click on the hot spot to the left of the staff will highlight 
the entire staff on that system.  This eliminates the need to select each individual measure..

Double-Click Selection
When a double-click is used to select a staff, the staff is selected to the end of the score.  This 
selection occurs from wherever the double-click is performed to the end of the entire score.

Selecting Additional Staves
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To select additional staves, hold down [shift] and click (or double-click) to the left of each additional 
staff you wish to add to the selection. 

Selecting an Entire Page
Double-click on a page icon in the Toolbar to select an entire page.  Page selections 
performed in this fashion are for single pages only.  Additional pages cannot be added 
to the selection using [shift].

Using the Computer’s Keyboard
You can also select notes and rests with your computer’s keyboard.  Use the command + the arrow 
keys on a Mac or the left and right angle bracket keys on Windows.  Since you don’t have to use 
[shift], it would be more accurate to refer to them as the [comma] and [period] keys.  But calling them 
the left and right angle bracket keys helps convey a sense of direction.

Open a score or enter some notes for several measures in a new score . Using the arrow tool, click in 
a measure to define the starting location of the selection. Press [>] on Windows or [command] + [] 
on a Mac.  The note or rest immediately to the right of the insertion cursor becomes selected. Do it 
again and the selection moves to the next note or rest to the right.  Using the [<]/[] key moves the 
selection through the score in the opposite direction.

If [shift] is held down while selecting in this fashion, each new note will be added to the selection.  
Releasing [shift] and selecting again will clear the selections made.

If [control] on Windows or [command] + [option] on a Mac is held down while using the angle 
bracket/arrow keys, entire measures will be selected. If [shift] is also held down, you can add 
measures to the selection.

Combining Techniques
Once you master the basic selection techniques, each technique can be combined with others.  For 
instance, to select from the second half of one measure that occurs in the middle of a system to 
the end of your score you could first use the arrow pointer to select the second half of the measure 
needed.  Next, hold down the [shift] key and double-click in the following measures in that system to 
select each additional measure.  Finally, while continuing to hold [shift] down, double-click to the left 
of the next system and you will have selected all the measures to the end of the score. 

That is only one example for combining these selection techniques.  Other possibilities will occur to 
you as different situations present themselves.

About MIDI Paste
Playing your MIDI master controller (keyboard, guitar, or whatever) while events (notes or rests) or 
regions are selected in Encore will result in a “MIDI Paste.”  If you select a note or rest and then play 
your instrument, the selected event will be replaced with the note or chord you play.  The duration 
stays the same as the original event.  If a region is selected, the first event in the region will be 
replaced.
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Moving objects in Encore is as easy as clicking and dragging.  A special hot spot location exists 
for everything moveable and, using the [option], [shift] and [control] keys, you can perform 

global changes to entire sections.  Understanding the location of the hot spots and the uses for the 
special keys is all you need to quickly customize your page layout and notation.

Moving Notes and Rests
The hot spot for notes is always the note head.  Use the arrow to click on the note head and drag to 
adjust either the note’s pitch or its horizontal placement.  Dragging up or down changes the note’s 
pitch.  Moving left or right changes the horizontal placement.  Right-clicking (Windows) or com-
mand-clicking (Mac) on a note will bring up a pop-up message displaying the note 
name.

When moving notes, the first direction applied to the note determines the result.  A 
first movement  up or down affects only the note’s pitch and the horizontal placement 
remains the same.  A left or right first movement changes only the horizontal location 
of the note or chord; the pitch will not change.  

You cannot change both the pitch and horizontal placement simultaneously.  That is, 
notes do not move diagonally.

When making pitch adjustments, each pitch adjustment up or down sends a MIDI note 
message on the channel and port used by the staff.

Auto spacing and beaming automatically adjusts when notes and measures are moved.

Note:  If you choose to work with Auto Space off when moving notes and rests, 
you need to use both Align Playback and Align Spacing after adding notes to the 
middle or beginning of a measure.   If an Align Spacing operation moves notes to the 
“wrong” locations, undo the operation and then check for missing rests.  Use Align 
Playback before using Align Spacing.

Encore does its best to align notes added to the middle of a measure or notes moved 
out of order within a measure.  Such operations are better avoided, since more consistent and reliable 
playback will occur when you enter everything from left to right in the proper order.  If a later portion 
of a measure requires extensive editing, it is better to erase the portion than to continually edit the 
existing material.

Moving Rests
Rests behave in the same fashion as notes and will move either horizontally or vertically depending 
on which movement is applied first.  When moving vertically, the rests are adjusted to the nearest staff 
line. 
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TIP: 
Encore also allows 
you to “audition” 
the pitches without 
entering notes. 
Hold the [right 
mouse/command] 
button down 
while the mouse 
pointer is over 
the score and the 
pointer turns into 
a pointing hand. 
Click the pointer on 
a staff location that 
doesn’t have a note 
or rest. This will 
send a MIDI note 
message on that 
staff’s channel.
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“Drag-Copying” notes and rests
If you hold down the [control/option] key while moving 
a note or rest, the note or rest will be copied to the new 
location.  When notes and rests are copied in this fashion 
the normal rules regarding the Auto Space and Auto Beam 
functions are ignored.

Note:  We strongly recommend that you use Align 
Playback after copying notes or rests using the [control/
option] key.  If you want Encore to automatically correct 
the measure spacing for the newly copied data use Align 
Spacing as well..

Stretching One Measure
Click on the barline and drag. Spacing within the measure is scaled when Auto Spacing is activated.

Stretching a System
Click on the barline and drag. Spacing within the measure is scaled when Auto Spacing is activated.

Note:  The stretch function will affect clef changes added to measures.  Other operations do not move 
clefs.

Moving Beams and Brackets
Beams have three hot spots.  Each end of the beam or bracket can be moved to change the angle. The 
center, or any part or the beam other than the ends of the beam or bracket, controls the height without 
changing the angle.

Note:  When beams are adjusted and the beam is dragged to the other side of the note heads, the stems 
automatically flip to connect to the beam.  Since brackets are not related to stem direction, moving a 
bracket above or below a group of notes will not affect the stem directions.
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Moving Marks
Marks, when attached to notes, are adjusted by clicking on the note head with the same mark selected 
and the [shift] key held down.  Each click raises the mark a little more.  For more information on how 
to move marks, refer to the section on the Marks palette.

Moving Text
Move text boxes in Encore by clicking anywhere within the text box and dragging.  To better see 
the text box we recommend that you show the control points.  The four control points (or “handles”) 
define the four corners of the text box.  Click anywhere within this area to move text boxes.  It is not 
necessary to click on actual text characters.

Because the entire area used for the text box is recognized with each mouse click, it is generally 
a good idea to size each text box to the same size (or a little larger) than the text entered.  This 
minimizes problems with text boxes that overlap other graphics.

Moving Lyrics
Lyrics can be adjusted horizontally by clicking and dragging on the lyric entry with the arrow pointer.  
The vertical height for lyrics in each system uses an adjustment arrow that appears while working in 
lyric mode.  For more information, refer to the section on the Lyric tool in the Graphics palette.

Moving Chord Symbols
Chords, both text and guitar indications, are adjusted horizontally in the same fashion as lyrics by 
clicking and dragging on the chord indication.  Adjust the vertical height for the chords by using the 
vertical alignment arrow that appears to the left of the system in chord mode.  This adjustment is 
identical to the way lyrics are adjusted vertically.

Sometimes, when an ending or text is in the way, chords will require different vertical heights for 
the same system.  By using different voices for entering each chord symbol, eight possible vertical 
positions exist for each system.  A different vertical position is used for each of the voices with each 
voice beyond voice one getting placed slightly higher.  

For more information about chords, refer to the chord section in the Graphics palette.

Note:  Text boxes, lyrics, and chords can all be copied while dragging by holding down the [control/
option] key before moving the item.  Lyrics copied in this way remain in the same lyric line but are 
not associated with any note.

Moving Slurs
Slurs differ from all other graphics and require the use of the [shift] key when moved.  You can use 
any of the three control points to move a slur.  Hold down [shift] and click on a control point with the 
arrow pointer.  Drag the slur to the new location.  For more information concerning slurs refer to the 
discussion of Slurs in the Tools Palette section..
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Moving Other Graphics
Move graphics in Encore by clicking on the graphic image and dragging.  To move symbols such as 
dynamics and marks (when not attached to the note head), click anywhere on the image and drag.  

Some of the graphics in the Tools palette, such as the hairpins and parenthesis indications, are similar 
to text boxes and have four control points.  These graphics are moved by clicking anywhere within 
the area defined by the four control points.

Moving Barlines
Barlines may be adjusted by clicking anywhere on the barline and dragging.  When barlines are 
adjusted, all data within the measures on either side is adjusted.  To bypass this adjustment, hold 
down the [Control] key while moving the barline. 

Moving Staves And Systems
Staves and systems use a hot spot that to move the vertical or horizontal position.  To change a staff’s 
position, click on the hot spot with the arrow tool and drag it to a new location. 

Finding the Staff Hot Spot
The hot spot for a staff is the beginning or ending barline.  When moving a staff, use the arrow tool 
and click on the staff at the beginning or ending barline.  Continue to hold the mouse button down and 
drag to move the staff. 

Note:  If you are selecting a staff on the left side and the entire staff becomes selected, you have 
clicked a little too far to the left.  To the left of each staff is a hot spot for selecting the staff.  If the 
staff becomes selected by mistake, click once in the staff to clear the selection and try again.

Both left and right sides can be used to change the vertical placement for a staff and system.  Set 
margin indents for the right or left side of a system by selecting the side you wish to change.  Encore 
automatically adjusts the measures in the system.

When a staff is moved, the distance between all staves and systems below the staff remains 
unchanged.

If the top staff is moved, only the distance between systems is affected.  When any staff other than the 
top staff is moved, only the spacing within the system is affected.
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Changing All Remaining Systems
Hold the [control/option] key while moving a staff, changes all remaining staves and systems in the 
score by the same amount.  For example, holding the [control/option] while moving down the bottom 
staff of a piano system gives the same spacing between staves to all the remaining systems in the 
score.

If you hold the [control/option] key while dragging the top staff of a system, all remaining systems 
will be spaced the same distance apart.  As an example, hold the [control/option] key down and drag 
the second system for a piano staff further away from the top system.  When you release, the distance 
you created between the first and second system will be used for all the remaining systems.  If the 
[control/option] key was not used, only the distance between the first and second system would have 
changed.

Horizontal changes made with the [control/option] key held down also get applied to all remaining 
systems.  If you wish to indent all the remaining systems in a score, hold down the [control/option] 
key while dragging a system to the right.  All the remaining systems will receive the same indent.  
This removes all indents by holding the [control/option] key down while dragging a system to the far 
left.

Changes made with the [control/option] key affect only the staves and systems after the one that is 
moved.  Any system before the edited one remains unchanged.

See also the section on Center Staves and Center Systems in the Score menu.  These two automatic 
functions are best used to obtain a basic page layout, which can then be further customized by moving 
individual staves and systems.

Advanced Technique
Parallel Systems

Sometimes two systems appear parallel in a score.  We see this most often for codas and endings.  By 
changing the left and right indents for two systems in your score, it is possible to duplicate this “side 
by side” layout.  However, because several automatic functions do not recognize this type of layout, 
we recommend that this procedure be applied only as the last step before printing.

Prior to arranging systems side by side, be sure to complete both systems and add any phrases or text 
that will be needed.
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This is an example of two systems that could be placed side by side.  

Drag the right side of the top system over to the left, creating enough room to accommodate the 
measures in the lower system.

Note:  The Coda Phrases were adjusted again for this example.  Some repositioning for graphics will 
be unavoidable when changing system size.
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Drag the lower system over to the right until it is small enough to fit in the space created above.

After changing the left and right indents for each system you can hold down the [control] key and 
drag the lower system up and align the two systems.  Always align the system on the right to match 
the system on the left. Changing the left system will change both systems at once.

Once you have created the parallel system arrangement it is best to print the score.  Using Center 
Staves, Center Systems, Align Spacing and many other operations can affect this layout, so it is best 
to use this step only in the final stages before printing.
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Score Window

Mac OS X
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In  Encore you’ll do most of your work in the Score window.  You can drag it, resize it, or scroll it 
to see more of your music.  Relative to the displayed page size, Encore shows your music just as it 

will be printed.  If you choose to reduce or enlarge your score, the music will appear to be the same 
size in the Score window, but the size of the displayed page will increase or decrease.  (For more 
information, see Page Setup in the section on the File menu.)  If the window or monitor is not large 
enough to display the entire width of the page, you can use the Fit Width option to scale the display.

The Window Header Toolbar
As its name suggests, the Toolbar contains the tools you’ll use in Encore.  Working in conjunction 
with the palettes, these tools enter, move, select, and erase the objects you enter into the score.  The 
Toolbar also contains the controls for real-time recording, MIDI playback, stopping MIDI playback, 
MIDI Thru, and a graphic Zoom tool.  Last but not least, the Toolbar provides feedback about your 
location in the score and which voice is currently active.

The Voice Selector 
Encore allows you to notate up to eight polyphonic voices per staff.  The Voice Selector 
displays the currently selected voice.  It also allows you to choose a voice to be displayed 
or edited.

 When you click and hold the Voice Selector, the Voice pop-up menu appears.  Drag the 
arrow pointer down to the desired voice and release the mouse button.

The voice number you chose will now be displayed in the Voice Selector.  Any notes or 
rests you enter will be assigned to that voice.  Any edits you make will affect only that 
voice.  Objects assigned to other voices appear “grayed out” on your screen.  If you choose “Voice -” 
all voices will be displayed normally, and any edits you make will affect all voices.  Notes and rests 
will be entered in the default voices.

For a complete discussion of voicing, see Chapter 7: Voices in Encore.

The Arrow Tool 
The arrow tool appears as the standard arrow pointer. The arrow tool is used in the Score window for 
most of the editing and layout functions that involve selecting or moving objects.  It is also used to 
change the size and shape of text boxes, slurs, hairpins, and other graphic objects.

The Eraser Tool 
The eraser tool erases objects that you enter in the Score window.  Be aware that there are certain 
things it will not erase.  Marks attached to notes will not be erased by the eraser tool.  To remove a 
mark attached to a note, simply click on the note head a second time with the same mark selected in 
the palette.

For more information about marks, see the section on the Marks palettes.

The Score Window Chapter Four
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The Pencil Tool 
The pencil tool must be selected to enter any palette object into the score, even if you intend to use 
MIDI step entry to enter notes.  The sole exception to this rule is when you are recording music in 
real time..

The Record Button 
Click this button to begin recording music in real time.  If the metronome click is turned on in the 
Setup menu (and it should be for real-time note entry), you will hear a one bar count-in before 
recording begins.  Click the button again to stop recording.

For more information about Click On/Off and Click Setup, see the section on the Setup menu.

The Play Button 
Click the Play button to hear your score played back via MIDI.  Playback always starts from the 
beginning of the measure that contains the blinking insertion cursor.  To set the start point, click 
with the arrow tool in the measure you’d like to start with.  If you don’t click on a note, rest, or other 
object, the insertion cursor will appear there. Playback starts at the beginning of that measure, not 
from the insertion point.

The Stop Button 
The Stop button stops MIDI playback and returns to the measure where playback was previously 
started.

The Thru Button 
The Thru button has two functions.  It allows you to turn on and off Encore’s MIDI Thru, and it 
shows you what the current MIDI Thru channel is.  When Thru is on, any MIDI data received by 
Encore is simultaneously transmitted via your computer’s MIDI output on the channel and port 
displayed on the button.  In the MIDI Setup dialog, you can assign a specific channel and port 
(Always Send Out) or set the Thru feature to automatically switch to the channel and port of the staff 
you’re working on (Follow Current Staff).

For a complete explanation of the MIDI Thru feature, see MIDI Setup in the section on the Setup 
menu.

The Zoom Button 
The Zoom tool is located between the Thru button and the Measure Indicator.

To use the Zoom tool:

Click on the Zoom tool and a zoom slider will appear.  Select the amount of magnification and the 
view will respond accordingly.

Setting the Zoom  
and Restore Levels

There is a pop-up menu immediately to the right of the Zoom tool’s magnifying glass icon.  This 
pop-up lets you select the Zoom level to which the tool is set and to select the normal viewing 
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level.  The menu is divided into two parts labeled Restore Level 
(the “normal” level) and Zoom Level.  A check mark denotes the 
current settings..

There are two Restore Level options:

Fit Page 
Fit Page proportionally scales the page so that the entire page fits within 
the Score window.  Use this setting for previewing your layout before 
printing.  It replaces the Print Preview command, which was formerly 
found in the File Menu.  Whereas the old Print Preview did not allow 
editing or adjustments, the Fit Page permits the same degree of manipula-
tion as any other zoom level.

Fit Width 
Fit Width scales the display horizontally so that the page’s full width can 
be displayed in the Score window. 

The Measure Indicator 

The Measure Indicator shows the number of the current, active measure. The current measure is 
either the measure that contains a selection or the blinking insertion cursor, or it is the measure that is 
currently being played.

The Measure Indicator also allows you to jump to 
another point in the score. Click on the Measure 
Indicator and the Jump to Measure dialog box appears. 
Enter the measure number you’d like to move to. If you 
want to jump to the end of your score, simply click the 
arrow to the right of the text box. Click OK.

Note: If your score includes a pickup bar, measure 
numbering begins with the first full measure. The pickup bar is represented by a dash ( - ) rather than 
a number 

The Page Icons 
The page icons represent the pages of your score. Click on the page you’d like to view. If you are 
working on a long piece and there are more pages than can easily be displayed in the Toolbar, use the 
arrows to the left and right of the page icons to scroll to the desired page number.

Tip: 
Double-click on a 
page icon to select 
an entire page.
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Using The Palettes Chapter Six

Tip: 
A mouse click on 
the right or left 
side of a palette’s 
name will switch 
the palette to the 
next or previous 
unopened palette 
in the palette list.

Encore contains eleven palettes from which you can enter notation, graphics, text, 
symbols and marks: Notes, Clefs, Graphics, Tools, Dynamics, Marks 1, Marks 2, 

Symbols, Guitar, Expressions, and Color palettes.

The default preferences for Encore opens the Notes palette to the left of an untitled Score 
window.  You can open additional palettes from the sub-menu called “Palette” under the 
Windows menu.  Also under the Windows menu is the option to display “All Palettes”.  By 
choosing this option, Encore will display all eleven palettes, cascading from the top left of 
the screen..

Encore always floats Palettes in front of Score window.

To move a palette, click in the area next to its ‘close box’ and drag it to a new location.

When preferences are saved, all open palettes and their positions are remembered.  Mac OS 
saves preferences automatically.

The Notes Palette
The Notes palette appears along with the Score window the very first time you run Encore.  As its 
name suggests, this palette lets you select various notes as well as rests and accidentals.

Notes and Rests
Using the pencil tool you can select notes or rests from the Notes palette and add them to any portion 
of your score.  As a shortcut for selecting more common durations, the number keys 0-8 select from 
a double whole note/rest to the 128th note/rest (see shortcuts).  The [R] key toggles between the note 
and rest for any selected duration.  Using any of the keyboard shortcuts for the Notes palette selects 
the pencil tool and opens the Notes palette. The Notes palette defaults to the quarter note.

In addition to inserting notes and rests with the pencil tool, the Notes palette is used to select a 
starting duration for keyboard step entry.  Please refer to the tutorial section on MIDI Keyboard step 
entry for further information.

Augmentation Dots and Tuplets
Three selections in the Notes palette can modify the standard note and rest indicators.  These are the 
two augmentation dots and the tuplet indicator.

Augmentation Dots
The single augmentation dot indicates a duration increased by one half of the note value.  A double 
dot indicates the duration is increased by three quarters.  The dot can be selected using the [D] key.  
Select the double dot by using [shift/option]+[D].  The dotted combinations are applied after selecting 
a note duration and are automatically cleared when a new note duration is selected.

Tip: 
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Tuplets
The last item in the Notes palette is the tuplet indication.  The tuplet selection defaults to the standard 
“triplet” (3:2).  The word “tuplet” refers to the various combinations of unequal rhythmic patterns, 
which can only be notated by subdividing a standard duration note.

If you are unfamiliar with the concept of tuplets, you may find it easier to understand how the 
numbers will apply to a selected note duration by converting the colon sign into the phrase “in the 
time that” and then forming a sentence using the selected duration.  For example, if you select an 
eighth note and the tuplet indicator is set for 3:2, you could think of the new duration for the eighth 
note as 3 eighth notes “in the time that” 2 eighth notes would normally occupy.

To enter a tuplet, select the desired note duration.  Then click on the tuplet item at the bottom of the 
Notes palette or press the [T] key.  Enter the tuplet in the score.

To change the tuplet value, double-click on the tuplet item in the Notes palette.  This opens the 
Choose Tuplet dialog where you can enter the new tuplet configuration.  
Common tuplet indications are:

Triplet = (3:2) 
Quintuplet = (5:4)
Sextuplet = (6:4) 
Septuplet = (7:4). 

Any combination can be created using numbers from 1 to 15. 

Changing Durations For Notes  
Already Entered

You can quickly change the duration for any note or group of notes in your score by first selecting the 
note with the arrow tool and then typing the number for the new duration.  Using the shortcut keys for 
dots, double dots and tuplets further modifies the selected notes.  Typing the [R] key turns all selected 
notes to rests.  Although you can undo this operation once, you cannot turn rests into notes.

Real-Time MIDI Note Durations
Recorded durations are displayed according to the quantize value set in the Transcription Setup dialog 
(Encore>Preferences menu).  Unless the MIDI durations are changed using Change Durations or the 
selection shortcut, Encore will keep the original, recorded durations.  Guess Durations will alter the 
MIDI data, however, and the transcription value selected will determine both the shortest duration to 
display and when to start rounding off playback durations.

Accidentals
Accidentals are selected separately from notes and applied to notes in the score by clicking directly 
on the note head or by selecting the note or notes to be altered and typing the keyboard shortcut for 
the accidental.  To remove an accidental from a note, click on the note again with the same accidental 
selected or type the shortcut letter again while the note is selected.
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Courtesy Accidentals
Enclosing the accidental in parentheses properly indicates a courtesy accidental.  The Notes palette 
includes parentheses for this purpose.  The parenthesis indication is combined with any selected 
accidental when applied to a note.  Encore adds a courtesy accidental when the parenthesis indicator 
and accidental indicator of choice are selected.

Encore normally ignores attempts to add an accidental to a note if the key signature or a previous note 
in the measure has the same accidental indication.  To override this behavior and add an additional 
accidental in the same measure, hold down the [control/option] key while applying an accidental.  
With the [control/option] key held down, Encore will always allow an accidental to be added with the 
pencil tool.  

Accidentals can be spaced either closer to or farther away from the note head by holding the [shift] 
key while clicking on the note.

Note: Using the [control/option] key to “force” an accidental onto a note requires using the pencil.

The Clefs Palette
The Clefs palette contains eight clef choices, Treble, Bass, Alto, Tenor,  Treble 8va, Treble 8vb, Bass 8vb. 
Each clef is a character in the Anastasia or handwritten fonts.  Clefs reference one staff line to a pitch, 
and this relationship determines the pitches for that staff.

Encore always uses clefs, but the choice can be changed at any time, and clefs can be inserted within 
the score at any location.  When importing MIDI or Pro files, Encore considers the pitch range for 
each track and chooses the initial clef for you.

To change the beginning clef for a staff, select the pencil tool and then click on the desired clef in the 
Clefs palette. The pointer will change to your clef selection. Position the new clef choice on top of the 
current clef in measure one and click to change the clef.

To remove a clef, use the eraser tool and click directly on the clef.

Please Note: Clefs can be “cut” but are not pasted when either copied or cut along with note data.

Clefs are special symbols in Encore and require some pre-planning and consideration when a change 
in clef is required in the middle or end of a measure.

Note: The current clef selection will always appear at the start of each new system. This clef 
reference cannot be removed.

Shorcut Key(s) Accidental

S sharp

F flat

N natural

shift+S double sharp

shift+F double flat

shift+N parentheses
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The Graphics Palette
The Graphics palette provides you with the tools to enter text, lyrics, chord names, and guitar chords. 
You can also enter circles, squares, rectangles, lines, as well as set the line style and width.

The Lyric Tool
The Tool item labeled “L” enters Lyrics.  Encore’s  special method for entering lyrics can add 
hyphens and melismas for you automatically.  Encore connects lyric words and syllables to a note or 
chord.  At first lyrics are centered under their “parent” note but can be freely dragged left or right after 
entering the lyric.  Dragging the parent note moves the attached lyric.  Lyric lines can be also adjusted 
vertically for each system.  

Additional lyric lines in Encore use the voice indicator for each new line.  The eight voices in Encore 
correspond to the eight possible lyric lines.

When you select the Lyric tool, a Text menu replaces the Notes mene.  This Text menu only appears 
when using the Lyrics, Text, or Chord tools in the Graphics palette. 

We recommend adding lyrics after you perform spacing and alignment for each system.  While not 
essential it can eliminate extra editing if you later change the number of measures in a system or 
the width of systems.  Align Spacing has an “Adjust for Lyrics” item, but lyric placement is often a 
subjective matter.  Using the Nudge commands is an excellent method for adjusting the spacing for 
individual lyrics horizontally while still retaining the vertical relationship between all the staves in the 
system.
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Using the Lyric Tool
To add a lyric to a staff line you should first select the staff with the notes to be used for lyrics or set 
the insert cursor (flashing line) using the arrow tool on the desired staff.  Set the voice indicator to 
either all voices or Voice 1.

After selecting the lyric tool, an arrow appears to the left of the selected system between the page 
margin and the Score window’s left edge.  This “vertical adjustment” indication is used to change the 
vertical location for the lyric lines in each system. 

When using the adjustment arrow to move lyrics in all voices mode (Voice -), all of the lyric lines 
associated with the active staff will move as one.  When a specific voice is selected, the adjustment 
arrow moves the lyric line associated with that voice.

When using the Lyric tool, the Notes menu will be replaced with a Text menu.

Select a font, size, and style (if desired) from the Text menu.  This becomes the font selection for the 
current line.  You can change the font information later for either the entire lyric line 
or individual syllables.

To go back to the Arrow tool while using the Lyrics Pencil tool, use the [Esc] key.

Adding a lyric line
To begin entering lyrics, select the lyric tool and click on the head of the note to 
receive the first lyric.  A flashing insert point appears under the selected note.  If the insert point 
needs to be adjusted vertically (to avoid colliding with that note or others in the same system), drag 
the vertical adjustment arrow on the left as needed.  While adjusting the vertical placement arrow, a 
horizontal reference line appears.  All lyric lines created for the current system are adjusted together.  
After adjusting the vertical placement for the line, you will need to reselect the starting note for your 
lyric.

Advancing to the next note
Once you have chosen the starting note, and the flashing insert point appears below the selected note, 
you can add your first lyric.  To advance to the next note in the measure, press the [space bar]. The 
insert cursor will advance to the next note event.

Tied Notes and lyrics
Tied Notes will be skipped.  If you wish to advance to a tied note, hold the [shift] key while typing a 
space.

Note: Encore treats chords as single events, but if two voices are used in a measure, the cursor 
advances to the next note in the second voice and may not appear to move forward.  This only 
happens when adding lyrics for measures containing multiple voices.  To skip a note, press the [space 
bar] again.

Adding the Space Character to a Lyric
Since the [space bar] normally advances to the next note, Encore provides an override method 
for when you need to add a space within the lyric line.  Hold down the [control/option] key while 
pressing the [space bar] and a space character will be added to the lyric.
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Creating Hyphens Between Words
Encore creates hyphens between syllables and automatically centers them for you.  Hyphens are 
adjustable but are not attached to a note or lyric.  To create a hyphen in Encore press the [-] key 
instead of the [space bar] at the end of the lyric.  The insert point advances to the next note, but a 
hyphen is added between the previous lyric and the next.  To override the hyphen mode in order to 
add a dash to a lyric, hold the [control/option] key while typing the dash or minus character.

Adding a Melisma
Melismas (underlines indicating a syllable is to be sung for several notes) can be added by typing 
an underscore ([shift]+[hyphen]) under the last note of the sung phrase.  Melismas are created when 
the lyric line is completed for a system and will not appear immediately; this is normal.  To force 
a melisma to appear, select the arrow tool in the Toolbar.  This will exit lyric mode and update the 
screen for any melismas entered.  As melismas are frequently added under tied notes, hold down 
the [shift] key while using the space bar to advance the lyric tool to a tied note and then type the 
underscore character to create the melisma line.  Encore automatically draws the melisma through all 
tied notes and connects with the previous lyric syllable.

Adding Additional Lyric Lines
You can add a maximum of eight lyric lines to Encore.  To add additional line, use the Lyrics position 
indicator and click on the lyric line number under the arrow. Select the lyric line. 

Editing Lyrics
The [back space/delete] key will erase lyric characters starting at the current lyric position and 
continue backwards to the beginning of the lyric. When the lyric has been completely deleted, the 
[back space/delete] key will back up to the previous lyric and continue the process. An alternate 
method is to select the lyric text and use the standard cut or clear commands.

Moving Through the Lyric Line
To advance to the next lyric and select that lyric for editing use the [tab] key. To back up to the 
previous lyric, use [shift]+[tab].

Changing Lyric Fonts
To change the font information for all lyrics on one line select the lyric tool and select the lyric line  
on the Lyric Positioning arrow  Go to the Text menu/Fonts and select the desired font.  The font 
selected for line 1 will be the assigned font for the other lines unless specfied otherwise

To change a single syllable or multiple syllables, select the word or syllables you wish to change.  
When lyrics have been selected, font changes will be applied only to the selected text.  

To define a new font for an entire line, select the lyric line you want to change using the voice 
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indicator.  Select the lyric tool and then use the Text menu to change the font information for that lyric 
line.  Changes intended to affect an entire lyric line can be done either before or after entering the 
line.  

Note:If you need to use different fonts throughout your score for either special words or entire lines, you may 
find it easiest to enter all the lyrics first and change the font information afterward.  Changing a font style in the 
middle of entering lyrics does not continue that font style for the rest of the lyric line but will affect only the 
lyric attached to the font-changed note.

Lyric Entry Overview
Use the [space bar] to go to the next note that can accept a lyric, whether there is a lyric there or not.  
Notes tied from the left are skipped.

Use [shift]+[space bar] to go to tied notes. 

[Control/option]+[space bar] results in a ‘hard’ space embedded in the lyric data.

[-]adds a hyphen between lyrics (dash or minus key).

[Control/option]+[-] embeds a ‘hard’ hyphen within the lyric data.

[Tab] gets you to the next lyric in the piece.

[Shift]+[tab] moves you to the previous lyric.

The [back space/delete] key deletes lyric characters and moves to the previous lyric if there are no 
characters left to delete in the current lyric.  

[Esc] takes you back to Arrow tool.

The Text Tool
Text boxes in Encore can hold up to 8,192 characters, and text can exist in different fonts, sizes, and 
styles within each text box.

Text boxes, like all graphic items in Encore, are ‘attached’ to a measure.  This attachment ensures that 
tempo and other musical instructions get copied and move along with the music during spacing and 
part extraction.

Creating a Text Box
Select the Text Tool from the Graphics palette.  Locate in your score the pointer where the top left 
corner of the text should be.  Click and drag the text pointer to define a text box.  A dotted reference 
line will be drawn showing where the text will be placed.  Text boxes resize after you exit text entry 
mode to eliminate extra space. 

If you resize the width of a text box, the text within reformats to word wrap each line to fit the new 
text box width.  Click and drag the lower right control point to change the size of the text box and 
reformat.  You can adjust the text box width without exiting text entry, or after existing text entry, 
using the arrow tool.
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Changing Fonts Within a Text Box
You can change Font selections at any time.  If text has not been 
selected or entered, changes to the font selection are applied to the 
text that is about to be entered.  You can also perform changes on 
previously entered text by selecting the text you wish to change and 
then selecting the new font, size, or style to be applied.

The Text Menu
The Text menu provides access to the Font dialog to select a font, size, and style for the text. The Text 
menu also contains three choices for text alignment: Left, Middle, and Right. A check mark appears 
next to the current choice.

 Moving a Text Box
You can drag Text boxes to new locations by clicking and dragging with the arrow tool on any area 
within a text box.  To avoid moving text boxes inadvertently, we recommend that the text box be no 
larger than the size needed.

Resizing Text Boxes
To resize a previously created text box, make sure that control points are showing.  Turn on 
control points from within the Show/Hide dialog (View menu).  Control points for text boxes 
exist at each of the four corners of the text box.  Drag any of the four control points with the 
arrow tool to adjust the height and/or width of the text box.  Text within the box automatically 
adjusts to fit the new box size.  Text that isn’t showing in a text box will not be printed.

Text Boxes and Measures
When measure widths are changed in Encore, text boxes also change in width and may need 
adjustment.  Text boxes might need to be adjusted if you apply a page reduction or enlargement to the 
score.

The Chord Tools
The letter “C” and the “Fretboard” graphic in the Graphics palette let you enter chord spellings using 
either text or both text and fretting indications for the guitar.

The letter “C” enters only a text spelling for a chord.  The “Fretboard” enters the guitar fretboard 
indications.  Once either indication has been added to the score, they can be selected and changed to 
be either type of display using the “Guitar Frets” item in the View menu.

In Encore chords are more than just text added to a score.  When transposing a section of music, 
chord indications will be transposed along with the note information by selecting “Transpose Chord 
Symbols” in the Notes>Change Pitch/Duration dialog.  When guitar chords have been added, the 
graphic changes to represent the new fingering for the transposed chord.

Note: The fingering indications supplied with the Frets fonts are standard for sheet music but cannot 
represent every possible guitar fingering combination.  A Custom option is available in the chord 
dialog that will enter a blank fret.  Custom chords are not transposed and the fingering indications 
must be added manually after printing the score.
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Adding a Chord Symbol
Use the pencil and select either the “C” or the “Fretboard” from the Graphics palette.  Place the 
crosshair in your score at the location where you wish to add a chord and click.  This opens the 
Choose Chord dialog box.

Note: If you click directly on a note head with the chord tool, the pitch for that note will be used for 
the root selection in the Choose Chord dialog.

The Choose Chord dialog is arranged with the root and alternate bass note selections at the bottom.  
Chord types are arranged in the following order within the dialog:   The first group contains Major 
chords and most common extensions; the second group contains Minor chords, and then come 
Augmented and Diminished.  You can also create a custom chord by clicking on the “Custom” button.

Once you’ve selected the desired chord symbol, click OK to enter the indication into the score.  For 
convenience, you can also double-click within any of the cells in the chord spelling display to both 
select the chord type and OK the dialog.

Chords placed on the lower staff of a Piano staff, will default to Voice 1.

Moving Chord Symbols
Similar to lyrics, chords use a vertical adjustment arrow in the left page margin to change the vertical 
position for all the chords entered in a system.  The horizontal position of each chord can be adjusted 
by clicking and dragging the text or graphic left or right.  If [control/option] is held down while 
dragging a chord, the item is copied to the new location.

Chord indications do not play back over MIDI.

The voice selector is used to relate each individual chord symbol’s vertical position to the vertical 
alignment arrow.  When the same voice is used for each chord, the vertical alignment for all the 
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chords will be the same.  

Sometimes a chord may need to be placed above a graphic or ending.  Each voice, from 2 through 8, 
uses a slightly higher vertical position in relationship to the vertical alignment arrow.  By selecting a 
higher voice number, a chord can be placed at a different vertical position than other chord symbols.  
For trickier situations the chord symbols can be entered as text.

Chord Parsing
A special method exists for entering chord symbols using the MIDI Keyboard.  Chord Parsing uses 
specific keyboard voicings to automatically select the chord types in the Choose Chord dialog without 
the need to open the dialog and use the mouse.  Chord Parsing should not be confused with analyzing 
what you have played and creating a chord “guess” for you.  As yet, Encore does not have such a 
function.  

Chord Parsing requires using the arrow tool to select notes or chords before playing the desired chord 
symbol spelling.  The actual notes to play for each chord possibility are included in an Encore file 
called “Chord Parsing”.  The examples are all in the same key but can be transposed to different keys 
for all possibilities.

Using Chord Parsing
The basic steps to enter the chord symbols requires first selecting either the “C” or “Fretboard” 
selection in the Graphics palette. This will determine whether text or both text and guitar frets are 
entered. After selecting the chord type, select the arrow tool and click once in the beginning of the 
measure where you would like to begin adding chords. The insertion cursor appears where you 
clicked. Press the [>] key (Windows) or [command]+[ (Mac). The note or rest immediately to the 
right of the insertion cursor will be selected. At this point, playing one of the Chord Parsing examples 
on a MIDI Keyboard connected to Encore will enter the chord spelling indicated in the parsing 
examples. For example playing a middle C along with the Bb above it would yield a C7 chord symbol 
as would playing the full C7 chord.

If the selected note is not at the horizontal position desired for the chord, continue to use the [>/] 
key until the correct note or rest is highlighted. After each chord is entered, the same technique can be 
used to continue selecting notes or rests for Chord Parsing entry.  Once you learn this technique, it is 
by far the fastest way to enter chord symbols into a score.

Chord Parsing should not be confused with MIDI Paste. When a selection is drawn around a note or 
rest or a chord (and the “C” or “Fretboard” from the Graphics palette is not selected), playing on the 
MIDI Keyboard will replace the selected item with the information coming from the keyboard.



Using the Palettes76



Using the Palettes77



Using the Palettes78

The Drawing Tools
The remaining tools on the Graphics palette can draw lines, rectangles, ellipses, and other graphic 
objects in the score.  Select the desired tool with the pencil tool, and then click and drag to draw the 
object in the score. Use the arrow tool to drag the object to another location.

You can also stretch or resize any of these objects by dragging on one of its control points with the 
arrow tool.

The box at the bottom of the Graphics palette allows you to select the line style and thickness for the 
drawn object. You choices include a thin dotted line and solid lines of varying thicknesses.  A small 
arrow head at each end of the selection indicates the current choice.

The Tools Palette
The Tools palette contains a variety of tools for adding everything from slurs to ottava indications.

You can add all of the items with the pencil tool.  An exception is slurs, which can be also be 
generated using a command in the Notes menu.  See Slur Notes under the Notes menu for more 
information.

Anything entered from the Tools palette can be deleted with the eraser.  Selecting the item with the 
arrow tool and using either the [back space/delete] key, or Cut or Clear from the Edit menu will also 
remove graphics.  When using the eraser, you should click on a control point if one exists for the item.

Some of the items in the Tools palette affect MIDI playback.  By “MIDI playback,” we simply mean 
the playback of the score within Encore or the MIDI export of the file.  Some of the tools, such as 
hairpins and tempo indications, allow you to choose whether or not they will affect playback.  Others, 
such as ottava, do not.

Slurs
A slur is a curved line over (or under) two or more notes of different pitches indicating the notes are 
to be played without articulation or smoothly.

If you are familiar with drawing programs and their terminology, the slur generated in Encore can be 
considered a “bezier curve,” meaning it’s slightly thicker in the middle and tapered on each end.

Slurs attach themselves to a beginning and end note and automatically recalculate as long as Auto 
Guess/Beam is selected in the Preferences menu.  To bypass Auto Guess/Beam, simply hold down the 
[Control] key while creating or adjusting the slur.  

MIDI will play the slurs that you create.  Adjustments to MIDI playback can be made by double 
clicking on the slur tool

Drawing a Slur
Select the slur tool.  Position the crosshair where the beginning of the slur should be drawn.  Then 
click and drag the mouse to draw the slur on the screen. The slur you draw should consist only of a 
single “arc” or curve.  Release the mouse when you have completed the drawing of your slur.  Encore 
automatically converts the drawing into a curve.
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For another method of drawing a slur, hold the [shift] key and make three spots for the shape of the 
slur, beginning, middle and end.

Automatic Slurs
For the most consistent slurs, Encore will draw the slur for you on a selected group of notes when 
[control/command]+[L] is typed.  Please refer to the reference section concerning the Notes menu for 
further information on the “Slur Notes” command.

Changing a Slur’s Shape
Once a slur has been entered into a score, it can be further moved or adjusted by dragging on any of 
the slur’s three control points.

With the arrow selected, click and drag on a control point to change the shape of a slur

Moving a Slur
If you hold the [shift] key while dragging a slur’s control point, the entire slur moves as a one object.

The nudge command also moves a slur if you select the left control point.  Slurs only nudge within 
the measure in which they are located.  If you need to move a slur to another measure, use the arrow 
tool and [shift] key as described above.

Copying a slur
If you hold the [control/option] key while dragging a slur’s control point, the slur is copied to a new 
location.  You can also copy and paste slurs, but note that pasted slurs  adjusted for the width of the 
measure into which they are paste.

Erasing a slur
To erase a slur, click on a slur’s control point with the eraser tool.  If you select the left control point 
of the slur, you can also use the [back space/delete] key, or the Cut and Clear commands. 

Two slur indications are included in the Notes palette. This first is for horizontal slurs and is the most 
commonly used.  The second is for incidents where the slur will need to occur at a more vertical 
angle.

Tempo Indications
The Tempo or Metronome Marking is a graphic indicating the score’s tempo or a change in tempo 
within the score.   When used to define a new tempo, the tool can also affect playback.  To place a 
tempo indication in the score, click on the icon in the Tools palette with the pencil tool.  When moved 
over the score, the pointer turns into a crosshair.  Click to enter the tempo indication and the Set 
Tempo Marking dialog box opens.

L’istesso
The term L’istesso (also referred to as “istesso tempo” or “lo stesso tempo”) comes from the Italian 
and means “in the same time.”  This direction indicates that the tempo remains the same even though 
the time signature has changed.  L’istesso indications do not affect MIDI Playback and are graphics 
only.
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Tempo Value
Tempo Indications designating a new tempo value can affect MIDI Playback if the checkbox 
labeled Change Playback is checked.  Tempo indications affecting MIDI remain in effect until the 
next measure where a tempo change occurs.  Inserting a tempo change will only change the MIDI 
Playback when the item is inserted.   Moving a tempo indication will not readjust the tempo for the 
new location.  If tempo changes were made using the Tempo dialog in the Measures menu, inserting 
a new tempo indication with the tempo tool will override the previous tempo settings when Change 
Playback is checked.

Hairpins or Wedges
Hairpins or Wedges are dynamics markings used to indicate a temporary increase or decrease in 
volume for a section.  Hairpins can affect MIDI playback by scaling the velocity values of the notes 
in the area where the hairpin is added.  To set the value used for scaling and enable their use in 
playback, double-click on the hairpin item in the Tools palette.  This opens the MIDI PLAYBACK 
SETTINGS dialog box.  Hold the [shift] key while drawing or dragging to flip the hairpin to the 
opposite direction.

Adding a hairpin
After selecting the hairpin tool, place the crosshair anywhere on the score.  Click, hold and drag the 
crosshair to the left to indicate diminishing volume.  Click, hold and drag the crosshair to the right to 
indicate increasing volume. 
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Hairpins can stand alone or be used in conjunction with other dynamic indications and marks.  The 
hairpin tool always enters the hairpins along the horizontal.  If you need to add a vertical hairpin 
or wedge, you should construct the graphic using the line tool in the Graphics palette.  Vertical 
graphically drawn hairpins do not affect playback.

Hairpins in Conductor Scores  
and Extracted Parts
It is not uncommon for a single hairpin to indicate a crescendo or decrescendo intended for an entire 
group of instruments.  In a conductor’s version of a score one hairpin at the top of the string section 
would most likely imply the entire string section should begin changing volume.

Like all graphics in Encore, hairpins are associated with a single measure and staff.  While one 
hairpin in a conductor’s score can be sufficient for the conductor, take care to copy the hairpin to each 
part before using the Extract Part command.  Copy the hairpin graphic by  holding [control/option] 
while dragging the hairpin to each staff.  Then save a new version of the file for use when extracting 
parts, and the original conductor’s score can be printed without the added graphics.

When using Hairpins to change MIDI playback, the same rule applies and only the staff the hairpin is 
attached to will receive the change in MIDI Velocities.  Again, you can either copy the hairpin to all 
other staves requiring the change, or you could use the Change Velocity dialog to select the data and 
manually change the note velocities without using the hairpin.  This requires a little more time but 
ultimately lets you to create a conductor’s version of the score that also sounds correct.

Trill and Arpeggio indications
Several tools are provided for entering trill and arpeggio indications, but these tools can also be used 
to construct a variety of other indications useful for many contemporary and classical notation needs.

The two trill indications can only be inserted horizontally but the two vertical wavy lines, while 
normally used to notate arpeggios, can be rotated to any angle and used to notate anything desired.

Trill and arpeggio indications do not affect MIDI Playback.

Adding a Trill, Arpeggio, or Wavy Line
Using the pencil tool, select the item you want to add from the Tools palette.  The pointer changes to 
a crosshair.  Move the crosshair to the point where you want to add the indication, and click and drag 
with the mouse. 

The two trill indications can be added only from left to right, and the indication always remains 
horizontal.  When adding one of the “wavy lines” used for arpeggios and other indications, you can 
enter the indication using whatever angle you like.

Adjusting Trills and Arpeggios lines
Both trills and arpeggio lines have a control point located at either end.  Trills can have their length 
adjusted after insertion inserted by clicking and dragging the right side control point.  You can change 
both the length and angle of Arpeggios after you add them to a score.  Click and drag either control 
point to adjust an arpeggio or wavy line indication.

To move a trill or arpeggio indication without adjusting the length or angle, click on the graphic at 
any location other than a control point and drag to the new location. 
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All graphic items can be copied while dragging if you hold the [control/option] key before dragging 
the object.

Parenthesis Tool 
The parenthesis tool has no specific function.  Use it to enclose text, a tempo indication, a musical 
phrase or for whatever you want.  Many musicians use parenthesis to indicate a section that has been 
made tacet for them.

Select the parenthesis and move the pointer to the left of the item you want to surround.  Click, hold 
and drag from upper left to lower right.

Vertical Bracket 
The vertical bracket is frequently used to indicate that notes in a chord spanning more than an octave 
are still played with the same hand.

Enter vertical brackets with a click and drag operation.  Adjust their length by dragging a control 
point.  Vertical brackets can be moved by dragging anywhere on the indication except a control point.  
Hold down the [shift] key to create a right facing bracket

Pedal

The  most commonly indicates that the damper or sustain pedal is to be used.  For a full 
discussion on the Pedal indication, we suggest that you refer to a notation manual or music dictionary.

Pedal indications can optionally affect MIDI playback. The pedal indication uses controller #64 
messages to control sustain. To turn MIDI playback of the pedal on or off, double-click on the 

- indication in the palette. When MIDI is used for the  indication, a value of 127 for 
controller #64 will be sent over MIDI at the location of the 

 sign and a sustain off message (a value of 0 for controller 
#64) will be sent every time a  is inserted. Please refer to 
your synthesizer manual to learn if your synthesizer responds to 
controller #64 messages.

Note: The  and indications can be moved only if you are working in all voices or voice one.  
The voice selection is important for MIDI Playback since the Pedal indicator only affects all voices 
when the voice indication is set to a dash.  Pedal indications do not affect voices separately.

Additional Pedal Indicators
Two additional graphics included in the tools palette indicate pedal usage.  
These are graphic items only and do not affect MIDI playback.

On both the slanting and horizontal line symbols, the initial and ending 
jogs denote the pedal down and release moments.

To apply either of these symbols, first select the symbol from the Tools 

Click crosshair on line

The new "notch" appears

You can drag the 
notch with the arrow pointer



Using the Palettes83

palette and then drag with the pencil tool to insert the symbol into your score.  In the case of the 
slanting symbol, the symbol height can be controlled as well as its length.

You can further modify the horizontal line symbol to have “notches” indicating that the pedal is to be 
briefly lifted at certain moments.  To add a “notch”, click with the mouse (still using the same graphic 
tool) at the desired location along the line.  A notch will be added at that location.  Add as many 
notches as you desire.  The notches can be dragged to new locations on the line by clicking directly 
on them with the arrow tool and then dragging.

Ottava (alto/basso)
The ottava indicates notes that are to be played an octave higher or lower than notated.

Adding an ottava indication to the score will add a broken line following the indication.  This broken 
line will continue to the end of the page and requires using the ending marker (or “notch”) to properly 
terminate both the broken line and the resulting effect on MIDI Playback.

Ottava indications always affect MIDI playbac.

Ottava end marker
Move the crosshair to the measure where you want the ottava line to stop and click directly on the 
broken line.  When the ending indication is placed on top of the broken line, the line will terminate 
at the ending mark and MIDI playback will resume the standard pitch reference following the ending 
mark.

Note:  It may sometimes be necessary to adjust the ending indication slightly for MIDI playback to 
resume the desired pitch at the correct location.

MIDI Tools
The MIDI tools feature allows you to enter both MIDI program changes and controller data into your 
score.  Inserted MIDI events will be shown by default in your score, but can be hidden using the 
Show/Hide dialog.

To add a MIDI Event, select the MIDI Item from the Tools palette with the pencil tool and click in the 
score at the location where you want to insert the event.  The MIDI Graphic Item dialog box opens 
and you can select either a program change or controller type and value to be inserted. 

When you add a MIDI item to the score, an arrow at the beginning of the item name will point either 
up or down to indicate the affected staff .  If the arrow indicates the wrong staff, drag the indication 
closer to the staff you wish to affect.

MIDI controller messages and program changes added to a score remain in effect until encountering 
another message of the same type.

Adding another message for the same controller or another program change after the previous change 
cancels the previous inserted MIDI event’s effect and replaces it with the new message.  You can 
remove MIDI events added with the MIDI Tool by clicking on them with the eraser.

Imported and recorded MIDI events, other than note events, are not automatically converted into text 
items in Encore. 
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MIDI messages which have been imported or recorded into Encore cannot be removed but can be 
filtered out when importing or recording the score by setting the Record Setup dialog to only record 
notes.  See Record Setup in the Setup menu for more information.

To edit any MIDI message, double click on the message.

A Word About Controllers
Special MIDI messages called Controllers continuously modify a series of notes as they are being 
played.  Pitch bend, modulation, reverb, and sustain are just a few of the standard controller types.  
Controller definitions are open for each manufacturer to decide, however, so controllers can be used 
for everything from controlling stage lighting to bending notes and changing volume.

Note:  Just to make things even more confusing, the word “controller” also describes anything that 
converts someone’s movements/performance into MIDI Data.  

The “controllers” added with the MIDI tool are basically two numbers sent from your computer to 
your synthesizer.  The first number represents the controller selected.  The second number is a value.

If you are unfamiliar with controllers, you should refer to your synthesizer documentation first.  MIDI 
Synthesizers usually have a MIDI Implementation chart indicating which controller numbers they 
support.  For more about MIDI and how controllers are used, refer to the chapter concerning MIDI.

Controller messages are voice specific.  When you enter a controller item, the MIDI Information 
will be sent on the same MIDI Channel as the voice currently selected. When Voice - is selected (all 
voices) the default voice and channel are used.
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Dynamics Palette
The Dynamics palette contains 13 symbols indicating the gradations of loudness and softness with 
which music is performed.  Dynamic symbols are frequently used in conjunction with hairpins.  Some 
of the dynamic symbols can optionally affect MIDI playback by scaling the velocity information for 
all notes following a dynamic indication. 

Double-click on any of the first eight dynamic symbols in the palette to open the MIDI Playback 
Settings dialog box.

The top eight dynamic symbols can scale MIDI velocity values for notes that occur after the 
indication.  The default values are listed below, but you can change those settings.  The optimum 
settings for your synthesizer and music may vary from score to score.  The settings in the MIDI 
Playback Settings dialog are therefore saved both in preferences and for each score.

When Send Volume Control and Change Note Velocities are selected in the MIDI Playback Settings 
dialog, all notes after the dynamic marking will be scaled to the velocity range for that mark until the 
next dynamic marking occurs in the score.

Note:  Only when playback starts from a point before a dynamic will the dynamic settings affect 
playback.  If playback begins in a measure after the dynamic, notes will not be affected until the next 
dynamic in the score.

To add a dynamic indication select the desired mark from the palette with the pencil tool and click at 
the location in the score where you want the dynamic to occur.

You can move dynamic symbols by clicking and holding on the dynamic symbol and then dragging it 
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to the new location using the arrow tool.

To delete a dynamic symbol use the eraser tool.  You can also select the mark with the arrow tool and 
use either Cut or Clear from the Edit menu, or press the [back space] key.

Copy dynamics by holding the [control] key while dragging the graphic to a new location.

Note:  Dynamics can be edited only while working in all voices (“Voice -”) or voice 1 view.  MIDI 
interpretation of dynamics affects all voices when the voice selection is set to “Voice -” but does not 
work selectively on separate voices.

The Marks Palettes
The Marks 1 and 2 palettes contain a variety of ornaments, symbols, and marks that can be attached 
to a note or freely placed anywhere within the score.  Optionally, the marks symbols in the Marks 2 
palette can affect MIDI playback for their attached notes by changing the velocity or duration.

When attached to notes, marks remain connected to the notes for all operations.  Remove marks by 
applying the same mark again to the note.  Additional types of marks can be placed above or below a 
note, but only one can be ‘attached’ to a note at a time.

To attach a mark to a note, use the pencil tool, choose a mark from the palette, and click directly on 
the note head.  When adding a mark in this fashion, Encore automatically places the mark above the 
note regardless of stem direction or the type of mark selected.

To place a mark below a note, hold the [control/option] key while applying the mark.

Adjusting Marks
To adjust the vertical position of the mark, hold the [shift] key after applying the mark and click again 
on the note’s head with the same mark.  

Each click raises the mark a little higher.  Eventually, a maximum vertical adjustment will be reached.  
If you continue to click, the mark will then drop to the lowest possible position.  Continued clicks will 
return you to the starting location.

Note:  If a mark is adjusted into the area of a staff either above or below, the mark may seem to 
disappear.  The mark is only covered by the other staff, and you can continue to make adjustments.  
The staff can be moved to reveal the mark.

If marks are added both below and above a note, hold down both the [shift] and [control/option] keys 
to adjust the vertical position for the mark below the note.

Removing Marks
To remove or replace a mark, apply the same mark or the new mark to the note.  Adding the same 
mark a second time removes the mark.  Adding a new mark to a note replaces the previous mark.

If more than one mark is called for, additional marks can be added by clicking at the desired location.  
Marks entered into the score in this manner (that is, without being attached to a note) become 
graphics and will not affect MIDI playback.  Marks as graphics also behave differently when measure 
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widths are adjusted and will move independently from notes.

The Marks 2 palette is used for accents and articulation and can optionally affect MIDI playback.

Double-clicking on any of the marks in the Marks 2 palette opens the MIDI Playback Settings dialog 
box.

Check the Play Marks checkbox and Encore interprets accents and articulations during playback.

Accents and MIDI
You can configure the accent marks to apply an additional fixed amount to each note’s recorded 
velocity.

The default velocity for mouse-entered notation is 64.  Step Entry uses the velocity sent from your 
MIDI instrument for each note, as does real-time recording.

The velocity ranges from 0 to 127.  Higher values will be interpreted by the synthesizer, increasing 
the volume for a note, but the actual response depends upon the synthesizer and the current sound or 
program selection.

Assuming velocity is affecting volume, entering a number close to the maximum will make almost all 
accented notes play as loud as possible.  A lower value will retain more of the original dynamics and 
add only a slight emphasis when applied.

Note:  To really control the effect of Marks, you should also learn how to use the Change Velocity 
option under the Notes menu or hold down [Shift] and [Command] and click on the note head to 
change the velocity of that note. A better understanding of how the various levels of velocity are 
going to be interpreted by your synthesizer will give you greater control over your score’s MIDI 
playback.

Articulations and MIDI
The staccato and legato articulations use a percentage value to change a note’s duration.  This 
percentage is applied to the note’s duration as it appears in your score and not to the duration with 
which it is currently being played.  The duration of the underlying MIDI data could be slightly 
different than what is displayed if you recorded in real time and guessed the durations, or even 
drastically different if you used the Change Durations command.  The previous duration is preserved 
but superseded by the addition of the articulation.  If you remove the articulation or uncheck Play 
Marks in the MIDI Playback Settings dialog, the note will return to the original duration of the MIDI 
note.
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The Symbols Palette
The Symbols palette contains both additional marks, which can be attached to notes or used by 
themselves, and some common score indications.

All of the symbols above the double line in the Symbols palette can be thought of as marks and 
attached to notes.  Adding them and adjusting the vertical position for these marks uses the same 
technique described for the two Marks palettes in the previous section.  The symbols below the line, 
starting with the Dal Segno, are always added to the score without attaching them to a note.  

All of the symbols in the palette can be added as graphics and located wherever needed.  The Symbols 
Palette items do not affect MIDI playback.

Note:  Encore includes graphic symbols for Dal Segno and Coda in the Symbols palette, but these 
symbols by themselves will not affect MIDI playback.  For Dal Segno, Coda and other similar in-
structions to affect playback, use the Coda Phrases item in the Measures menu.

Symbols (for Cymbals...)
The Symbols palette contains several symbols designed specifically for drum and percussion notation. 
These symbols can be attached to notes or they can be “free-floating” on the page, just like any of the 
other symbols. 

The Guitar Palette
The Guitar palette provides a number of graphic items commonly used when notating for fretted 
instruments.  Along with the Tab Staff (see Make Tab in the Notes Menu), these symbols can 
indicate special instructions unique for fretted instruments.  Use these drawing tools to further 
augment the selection of graphic tools available in Encore and apply them in whatever fashion you 
desire.

Fingering and Articulation Marks
The top eight items are used to indicate fingering and special types of articulation.  The fingering 
marks are explained in the following table.

P, H, and T denote pull-offs, hammer-ons, and tapped notes, respectively.

String Numbers
The string numbers (for instruments with up to 8 strings) can be used in a variety of ways.  One of the 
most common shows the open string tuning for each string when an alternate tuning is used.

Encircled numbers are sometimes used to show the fret at which a harmonic is to be played.

Mark Spanish Latin Finger

p pulgar polex thumb
i indice index index

m medio medius middle
a añular anularis ring
c meñique inkypay ingerfay little
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Barre tool
The barre tool indicates that a section of music notated for a fretted instrument is to be played at 
a higher fret or fingering position.  Both fret references and the number of strings affected can be 
entered as well as an indication for how long the change is to occur.

Select the Barre tool and then click on the score and drag to the right.  As you drag further to the 
right, Roman Numerals I through XXII appear, representing fret positions.  While defining the 
fret position, you can also define the number of strings involved by continuing to hold the mouse 
button and dragging downward.  The number of strings to be fretted is represented by fractions 
(1/6,1/3,1/2,2/3,5/6) that appear before the barre indication.  1/6 means the first one of the six strings, 
1/3 means the first two, 1/2 the first 3 of six, etc.  The barre tool supports a total of 6 strings and 22 
frets.

Release the mouse button when the desired fret and string indications have been selected.  With the 
arrow, you can adjust the length of the indication by dragging the notch at the end.  The graphic can 
be positioned by clicking anywhere else on the indication and dragging to the new location.

Bend Tools
The pre-bend (up arrow) and bend up or bend down (curved up arrow) indications can be drawn 
directionally.  Select either tool with the pencil and move the crosshair to where you want the bend to 
begin.  Click and drag to enter the symbol.

The three remaining graphic tools in the Guitar palette, also used for 
indicating bends, are similar to the slur tool in the Tools palette and 
require three mouse clicks to define the beginning, middle and end 
points for the graphic.  The V-shaped bend tool is generally used for 
indicating bends in standard notation.

Note:  With the exception of the Bend Up or Down arrow, all of the 
drawing tools are designed to be used from left to right.  The up or 
down arrow is entered either up or down. 

Wavy Line Tools
There are two line tools included at the bottom of the Guitar Palette used for indicating tremolos, 
vibratos, whammy bar effects or whatever you deem appropriate.  These tools behave identically to 
similar tools in the Tools palette and require a click and drag operation to enter them into your score.

The Expressions Palette
An expression is a custom text item that you can create and store for repeated use.  Enter or change 
expressions in the Expressions palette by double-clicking on any box in the palette and entering a new 
expression or redefining the previous expression for that palette location. 

Expressions are text strings of up to 64 characters.  Each expression uses one font, size and style for 
the expression.  Once entered into a score, expressions become text boxes and can be further modified 
without restrictions.  Refer to the section on the Text tool for more information about editing text.  

You can define up to 255 expression boxes in the Expressions palette.  Encore provides some 
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common expressions.  A blank expression box always appears at the end of the list.  

The data for the expressions is contained in the file EXPRESSI.ini (Windows) in the Encore directory 
or com.gvox.encore.plist (Mac) in the user>library>preferences.

Editing an Expression
Locate either an empty box on the palette or an item you would like to replace.  If necessary, use the 
up and down arrows to scroll through the palette.

Double-click on the box.  The Edit User Expression dialog appears.

Type your expression and click the Font button to customize the look of your expression.

When you are done, click OK.  The first several characters of your expression appear in the 
expression box in the chosen font.

Entering an Expression
Select the expression you want. Move the crosshair to where you want the expression to appear and 
click. The expression is added as a text item to your score.

Color
The Color palette adds color to objects in Encore.  Open the palette from the Palettes sub-menu 
(Windows menu) or click on the name of any open palette until the Color palette appears.  Color 
changes made with the Color palette affect objects entered into the score such as notes, rests, marks, 
chords, and text. The Pencil tool indicates the current color selection 

Adding Color
To use the Color palette, choose an object (note, rest, etc.) from one of Encore’s palettes and then 
click on a color in the Color palette.  Enter the object in the score.  You can choose another color at 
any time.
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Changing the Color  
of Selected Objects

You can also edit the color of objects  already entered into the score.  Select the objects using any of 
Encore’s selection methods, then click one of the 16 available colors in the palette.  The color will be 
applied to the selected objects.

Customizing the Palette
Encore does not limit you to the 16 default colors in the palette.  Double-click on any of the colors 
but black or white and a Color Picker appears.  Mac OS X makes five alternate views of the Color 
Picker available.  Choose a new color and click OK.  Black and white cannot be changed.

Note:  Custom color palettes are saved when you save the score and do not affect the default color 
palette for new scores unless you save preferences.  If you save preferences while a score with a 
custom palette is open, the default color palette will be changed to the custom palette.

The Score Colors Dialog
The Score Colors (Windows) or Change Score Colors (Mac) item in the View menu gives you a way 
to make global color changes and to change the color of other score elements like staff and bar lines. 
You can also set the color defaults for new scores by using the Change Color dialog and then saving 
preferences. For more on the Score Colors dialog, see the View Menu in Chapter 7.

Show/Hide Color
Encore provides the option to not print the colors that appear on the screen. Go to the View>Show/
Hide dialog and deselect Color When Printing to print the score in black and white. 
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The Menus - Mac Chapter Seven

Encore contains eight menus.  The first three, the Encore, File and Edit menus, contain all the 
usual commands plus a few unique to Encore.  The remaining five, Notes, Measures, Score, View and 
Windows,  contain operations for defining the contents and behavior of the music.  The Score and 
View menus are used for general aspects of score layout.  The Windows menu contains a list of your 
open scores and lets you open the Staff Sheet and various palettes. 

Encore Menu
About

This is where the version, copyright and registration information is. 

When you first install Encore, the program will run in Demo mode.  To unlock and fully install the 
program, simply enter your serial number when asked.  The program is fully installed when you can 
see the version information window.

Preferences
The preferences menu contains choices to determine how Encore commu-
nicates with your MIDI equipment, what parameters are used for transcrib-
ing MIDI data, some global score settings for notational spacing and menu 
items that toggle settings on and off in Encore.

The toggle settings are:

Click On/Off
To hear a metronome click, you can toggle the state on or off from the menu or use the shortcut 		
combination of [control/command] + [F].

For more about the click function refer to the previous section.

Follow Playback
When Follow Playback is selected, an arrow head appears above the measure currently playing 		
back.  The score scrolls as it plays. 

In page view, the playback arrow centers the page while scrolling, keeping the current staff 
andmeasure in view.  Before starting playback, place the arrow pointer in the measure and staff 
where you want playback to begin.

You can use the Fit Width item in the Zoom Tool menu to avoid horizontal scrolling during 
playback.

The Follow Playback status is saved in preferences.

The Auto Space function will beep if you attempt to add a note or rest to a measure that is full.



The Menus93

Auto Space defaults to “on.”  If you don’t want Encore to automatically space the 
notation, choose Auto Space again to remove the check mark.

Auto Guess/Beam
If on, this function automatically applies the Guess Durations and Beam on Beat 
operations for all recorded data, imported MIDI or Master Tracks Pro files, and 
step-entered notes.

Auto Guess/Beam automatically beams notes together when adding or erasing 
notes with the pencil and eraser tools.

Auto Guess/Beam automatically readjusts beams and stem when dragging notes.  
It will also attempt to move any slur that appears “attached” to the dragged note.

Holding down the [control] key during the drag bypasses these adjustments.

Please Note: Operations that require selections or measure ranges will not use Auto 
Guess/Beam.

The Auto Guess/Beam status is saved in preferences.  Choose Auto Guess/Beam 
from the menu to toggle the check mark on or off.

Auto Space
This function applies engraver’s spacing automatically after several different 
operations in Encore.

When adding or erasing notes or rests with the pencil and eraser tools, Auto Space 
will apply the engraver’s spacing operation to the notes in the measure being 
edited.  In addition, erasing or adding an accidental will also apply the engraver’s 
spacing. 

When pasting data, the Auto Space function applies an Align Spacing operation on 
the measures affected by the paste.

Auto Space automatically applies the engraver’s spacing when dragging notes, 
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barlines, and staves.  Holding down the control key during the drag bypasses these adjustments.

Please Note: Operations that require selections or measure ranges will not use Auto Space.

Setup Toolbar Mode
Encore features a floating, customizable Toolbar.  This Toolbar contains icons that represent 
commonly used Encore commands.  The Toolbar contains a few icons by default, but remains 
fully configurable.  You can choose the icons and the order in which they appear.  Make your 
choices with the Setup Toolbar Mode item in the Preferences menu.

Choose Setup Toolbar Mode to open the Toolbar Setup dialog.  There are 90 possible items that 
you can place in the Toolbar.  Most of these items correspond to menu commands.  The Toolbar 
will expand to accommodate and can be resized by dragging the bottom right corner.

To add icons to the Toolbar:

•	 Enter Setup Toolbar Mode in the preferences menu.

•	 Click on the icons on the bottom of the window to add them to the toolbar in whichever 		
	 order you prefer.

To remove icons from the Toolbar:

•	 Enter Setup Toolbar Mode in the preferences menu.

•	 Drag the icon from the upper part of the window to the lower part or hold down the shift 		
	 key and click on the tool to be removed.

The Toolbar is a floating window that can be activated or deactivated through the Windows menu.

You can rearrange the order of the enabled tools by clicking and dragging them to the desired 
position Make sure you select “Setup Toolbar Mode” from the Preferences menu again after 
editing the toolbar.  The toolbar will not function while “Setup Toolbar Mode” is on.

Record/Transcription Setup

Record items
Record Items is used for determining both a “split point” when recording in real time and 
for selecting what types of MIDI data are to be either recorded or imported into Encore.  
Selecting Record/Transcription Setup opens a window to the recording options.

The Split function lets you split incoming notes at a specific pitch location when recording 
in real time.  For Split to work properly, you should have two staves or a piano staff showing 
in your score.  Set the starting point for the record process by clicking in the top staff of the 
two staves to be used when recording the split.  The split point can be anything from C2 to 
G8, but is usually somewhere near middle C (C3).  Encore defaults to C3. The split point 
responds to MIDI input, so you can experiment with your keyboard or controller if you are 
unsure what might be appropriate.  Notes below the selected pitch will be placed in the lower 
staff.  Unless you are recording into a specific voice, notes in the bass clef of a standard Piano 
staff will be set to voice 5.

The Record Items choice is used for both real-time input and also when opening (importing) 
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a MIDI or Master Tracks Pro file.  Each checkbox acts as a filter, allowing the selected MIDI 
Data type to be recorded or imported with a file.

Note: The record settings do not affect the Thru function. This means that turning off “pitch 
bend” will not prevent pitch bend messages from being sent over the Thru channel and 
device.

Warning!  If you uncheck the item Notes you will only see rests when recording or importing 
files.

To prevent accidentally recording over your previous work, Encore has an option to Enable 
Enter Key to Start/Stop Recording. 

Transcription Settings
The Transcription Settings item is used to select the shortest duration value to be used when 
“guessing” recorded or imported MIDI note data.  Note durations shorter than the selected 
duration will be “rounded up” to the selected duration.  Essentially, this means that if you 
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select sixteenth notes in the Transcription Settings, a guess operation will never convert a 
note into any duration shorter than a sixteenth.

Encore’s “guessing” routine is designed to recognize multiple voices and to accurately 
transcribe triplets.  This may, however, result in unwanted triplets in some situations.  For 
this reason, a checkbox in the Transcription Settings dialog forces Encore to ignore triplets 
completely when checked.

You can choose to ignore triplets when guessing (or re-guessing) the entire score, or you can 
select the measure(s) that contains the offending triplets and re-guess that section.

The Ignore Triplets checkbox defaults to the unchecked (disabled) state.  The setting of the 
Ignore Triplets checkbox is saved with preferences.  For more information on how Tran-
scription Settings will affect the Guess Durations operation, refer to the section on Guess 
Durations (Notes Menu). 

Encore includes an Auto-Align Playback After Transcribing check box.  If checked, Encore 
will align MIDI playback information to the transcribed “guessed” notes notated in the score.   
If you want to keep the original MIDI data intact, do not select Auto-Align Playback After 
Transcribing. Refer to the Align Playback section for more information.

Click Setup
Click Setup configures the choices and methods used to generate a metronome click.  The actual 
number of clicks to be played for each measure is determined by the time signature for each 
measure and the Click value set for those measures.

Encore allows you to specify the device to playback the click.

The settings for pitch are determined by the MIDI note number in the field.

Count-In (Pre roll)
When recording in real time, the Bar Click plays for the number of beats indicated by the 
time signature in the measure in which recording is to start. 

MIDI Click
Use MIDI to generate the metronome click with your synthesizer or drum machine.  Drum 
machines are a common choice for a MIDI click, but you can choose any sound or patch you 
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like.

The Pitch field in the Click Setup dialog responds to MIDI Input.  If your synthesizer can 
send note data to Encore, you can set the choice for the Bar and Beat clicks by playing the 
note.  You can use any keyboard or controller to send notes Thru to your click choice.  First, 
before you open the Click Setup dialog, be sure Thru is turned on and set to the same channel 
and device as your choice for click.  In the Click Setup dialog, highlight the Pitch field ([tab] 
will advance through each field) and then play notes into Encore.  The Pitch field will display 
the pitch of notes as they are entered, and the sound will be sent thru on the channel and 
device selected for Thru.

When using MIDI, the velocity and duration settings may have different effects for each 
sound.

The Bar Click is used at the beginning of every measure.  The Beat Click will sound for the 
number of clicks assigned to the measure in the Time Signature dialog.  This number will 
frequently be the same as the top portion of the time signature.

MIDI Setup
The MIDI Setup dialog box is used to ‘manage’ Encore’s MIDI communications.  In order to use 
Encore, you need to configure the software so that it works properly with your hardware.  Refer 
to the manual that came with your MIDI Interface or sound card if you are unsure about your 
interface connections.  For more info on this, see Chapter 1.

The MIDI Setup dialog box contains several drop-down list boxes. These list boxes allow you to 
route the flow of MIDI data to and from Encore. 

MIDI In/Record Device
The drop down list labeled Record  is Encore’s ‘MIDI in’ device.  Encore uses this device to 
receive MIDI data from your master keyboard or other MIDI master controller.
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MIDI Thru
MIDI Thru lets you send the MIDI data coming in on the “record” device back out over either 
device and on any channel.

About Thru
Most MIDI controllers are also sound-generating instruments like synthesizers or samplers.  
If you are using only one synthesizer, you may not need to use Thru.  If you have more than 
one synthesizer, however, Thru can let you play one synthesizer with another.  Unless you 
want to hear both synthesizers playing together, you should either turn the master control-
ler’s Local Control off or mute the synthesizer being used to send the note messages.  Turning 
Local Control off essentially splits an instrument into a master controller and a sound module. 
For example, if you turn off Local Control  on your keyboard synthesizer, performance data 
(note-ons, note-offs, modulation, et cetera) will be transmitted via the instrument’s MIDI out 
device as usual.  But the instrument’s internal, sound-generating hardware will not respond to 
your playing unless that data is somehow routed to the instrument’s MIDI in device.

MIDI Thru is turned on or off by clicking on the “Thru” button in any Score window.  The 
Thru button is located in the Toolbar between the Zoom tool and the measure indicator. 

MIDI Thru can be configured to always use the same device and channel, or you can have the 
Thru channel and device choices “follow” the device and channel of the current selected staff 
in your score.

File Menu
New

When you create a new score, you have three basic Staff Formats from 
which to choose:

• Piano (default)  • Piano-vocal  • Single staves 

Piano Staff
A Piano staff in Encore is a special combined staff that appears as 
only one item in the Staff Sheet.  A piano staff is the only staff type 
that allows cross-staff beaming.

Piano-Vocal Staff
A Piano-Vocal score uses the Piano staff described above and adds a 
single staff with a treble clef above the piano staff.

Single Staves
The Single staves format is used for any arrangement greater than the above.  A maximum of 128 
staves can be created.

Measures Per System  Systems Per Page
A system is a group of instruments.  In Encore, the number of instruments that appear in the Staff 
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Sheet is one system.  The number of systems per page times the number of staves per system 
cannot be greater than 128.

Note: It may seem obvious, but the staves will either have to be very small or the page extremely 
large to fit 128 staves on “one page”.  Encore can accommodate any size page as defined by your 
page set up.  If you decide to only use standard paper sizes, a single page in Encore can consist of 
several “tiles.”  Refer to the section on Tiles under Printing for more information.

Starting Template
Encore comes with over 30 templates from which you can choose.  Encore also lets you create 
your own personalized templates to put in the Starting Template window.  To add your personal 
templates, simply create a score with the information you know want in it, (composer name, 
copyright, MIDI settings, etc.) and Export it as a Score Template.  Alternately, you may save the 
file to user>library>applicationsupport>GVOX>Templates and they will appear in the Starting 
Template window.  Conversely, if you would like to remove any templates from the Starting 
Template window, remove those templates from the same location as stated above.

Make a “C” Score
Encore saves the templates as transposed scores with all key transpositions and playback 
adjustments ready to go.  However, if you would rather work with a “C” score, check this box and 
all playback transpositions will be removed so that every instrument will sound as written.

Use Handwritten Style
Encore offers two font styles, Anastasia, a real classic classical font, and Encore NorMusic for 
a handwritten, jazz style font.  By checking Use Handwritten Style, all of the template’s font 
settings will be replaced with the Encore NorMusic font library.  In addition, all symbols will be 
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drawn in the handwritten style.

Create, then open using Wizard Windows
Encore will take you through all the windows needed to completely set up a score. These 
windows include:

		  Key Signature

		  Time Signature

		  Text Elements

		  Staff Sheet

Create
Create will skip the Wizard and let you get right to your score to start writing.

New Default Score
The item will create a new default score.  The default score is a piano score in C and in 4/4.  You may 
set the default score to whatever set up you would like to use.  Please refer to the Export menu item 
for information on saving a default score.

Open
The standard File Open dialog is used for the Open command and all four file types usable in En-
coreóEncore® and MusicTime® files, Master Tracks Pro®, MusicXML and MIDI files can be 
opened.

After opening, MIDI, Music XML, or Master Tracks Pro files will be guessed and beamed unless the 
Auto Guess/Beam item in the Setup menu is disabled (a check mark next to the Auto Guess/Beam 
selection in the Setup menu indicates the choice is enabled).

Until a score is saved as an Encore file you are making changes only to the raw MIDI data, and any 
graphic information you change is temporary.

Starting with version 3.0, Encore for Windows can open files created with Encore for the 
Macintosh®.  Save the files with the appropriate name and extension (*.enc) on the Macintosh. 

To open Windows files in Encore for the Macintosh, simply move them onto your Mac and select 
Open from the File menu. 

Open Recent
The drop down menu displays the most recent scores you have saved, opened or created.

Close 
Choosing Close closes the active Score window.  If you make changes to a score you will be asked 
if you’d like to save those changes before closing the file.  With MIDI and Pro files not yet saved in 
Encore, you will be asked if you wish to save the file as an Encore file before closing, even if you 
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have saved changes.  This avoids any confusion since graphic information is saved only in an Encore 
file.

Save 
Choose Save to keep any changes made in Encore to the active file.  If the file has not been saved, 
the Save As dialog will appear and you can enter a new file name.  See the Save As section for more 
information.

If you have opened a MIDI or Master Tracks Pro file, you will always be prompted with the Save As 
dialog when Save is selected.  This reminds you that all of the graphic information you are working 
with in Encore is saved only if you create an Encore version of the file.

As with all computer files, in addition to using Save to update your score for any changes you make, 
we recommend that you also save backup copies onto different volumes (hard drives or diskettes).  
How often you choose to do this is up to you, but consider how much time it would take to recreate 
a lost score if and use that as a guide.  One or two backups before you start or stop working is a good 
habit to get into, but if you work for several hours on a score, you should use Save As in addition 
to using the Save function and create alternate versions as you go along.  Since Encore scores are 
relatively small, a diskette is both an efficient and cost effective way to make backups.  Use Save As 
to make backups.  See the Save As section for more information.

Save As 
Save As is used to save Encore scores that are new untitled scores or MIDI, MusicXML and Master-
Tracks Pro files that were opened with Encore.  Save As will save in the Encore format.

The Save As dialog you’ll see is the standard Save As dialog for your platform. 
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Revert to Saved
The Revert to Saved function allows you to disregard all the edits made to a score since the last Save 
operation.  Revert to Saved is frequently used as the ultimate “undo”.  Most edits in Encore can be 
undone using Undo in the Edit menu, but only the last edit operation can be undone.  If you decide 
against a series of edits, you can use Revert to Saved to discard all of your edits and start again 
without closing and reopening the file.

Of course, if you choose Close before saving changes, you are always asked if you want to save 
changes at that time.  If you tell Encore not to save those changes, you will be duplicating the Revert 
to Saved function.  The only difference is the file will remain open if you choose Revert to Saved.

Export
Since Encore can also open MIDI, Music XML and Master Tracks Pro files, any file that can be 
opened in Encore can be exported as any other file type available to Encore.  This means that Encore 
files can be exported as MIDI, Music 
XML and Master Tracks Pro files. 

If you would like a score to serve as 
the default “template”, the blank score 
that opens when Encore is launched, 
you may export the desired file as 
Current Score Settings to Default 
Score Template.  A template file is 
useful for saving information such as 
MIDI Channel choices and program 
assignments for each voice and for 
several staves.  You can also customize 
the layout, have the copyright 
information already entered or even go 
so far as to include some music or initial notation.  Basically, anything that you can save as an Encore 
file can be saved as the default Template.  To add additional templates to the new score window, 
export to Score Template and follow the prompts to name it.

Extract Part
The part extraction function allows you to quickly create a new score containing one or more staves 
of a multi-staff score.  Most often this function will be 
used to create individual parts for each player from a larger 
composition.

Select the staff or staves you want extracted.  All the staves 
between your top and bottom selections will be specified as 
the staff range for the new score.  You can specify the staff 
range within the Extract Part dialog as well.  If you want 
to extract several instruments to the same score, but they 
appear at different vertical positions in your system, you 
can rearrange their order in the Staff Sheet window before 
using Extract Part.  For more about the Staff Sheet, see the 
section on the Windows menu.
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Auto-Compress Rests
When Auto-compress Rests is checked, all empty measures in the score that do not include 
special barlines, coda phrases, text boxes or graphics will be compressed automatically for you.  
The font selection for compressed rests will be the same as that specified in the Compressed 
Rests dialog. (See Compressed Rests in the Measures Menu section for more information about 
compressed rests within Encore).

The extracted part is given a default name using the score name the part was extracted from and 
the name of the top staff selected when extracting the part.  Combined staves used for piano and 
organ notation are always extracted fully and include both or all staves for the instrument.

Extracting Text and Lyrics
If you choose All Text Boxes in the Extract Part dialog, every text box on every page will be 
added to the new score.  You may select where you would like the text boxes to appear, above or 
below the staff of the extracted part. 

When creating a full score or scoring parts for 
a section, it is not unusual for various text in-
structions to be placed above the top staff only.  
If you enable the Text from Top Staff (Windows) 
or Text from Staff 1 (Mac) checkbox, text from 
the Top Staff will be copied to the extracted 
part.

Print and Print Selection
The File Menu will normally display the standard 
Print option, but Encore will change the wording 
if a selection has been made (use the arrow tool 
to highlight an area on a page).  When an area 
has been selected, the File menu will say Print 
Selection.

For more on Printing and information on saving a 
selection as an a PDF or other format, please see 
Chapter 11 Printing With Encore  Edit Menu.

Page Setup
After selecting Page Setup from the File menu, you 
will see a screen like this:

Select your printer from the Format for pop-up 
menu. Then select the Paper Size and Orientation 
that you would like to use.  To enlarge or reduce 
your score, enter a number in the Scale box and 
click OK.  The staves will remain the same size on 
your screen, but the size of the displayed page will 
change.

To create a score with specific margin settings you 
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will need to create a custom page, set the page size and select options to access the margin settings.  
Be sure to save the settings with a specific name.  This way you may use this setting again with other 
scores.

Edit
Undo

Undo is available for most editing operations within Encore.  For operations 
which are not undoable, you will either see a warning within the dialog or you will 
be given an alert before the operation continues with an option to cancel.

Cut 
Cut deletes any selected area and places it in the Encore clipboard.  Using the 
Paste command lets you paste the cut material elsewhere in the score. The Encore 
clipboard retains the information until another Cut or copy operation is performed 
and replaces it.

Copy 
Copy places a duplicate of whatever you select onto the Encore clipboard.  You can then paste the 
copied notation to another area in either the same score or another score using the Paste command.

Paste 
Paste places the contents of the Encore clipboard into the score.  Paste will not work when an area 
is selected.  To paste copied or cut data, choose the starting location for the paste operation with the 
arrow tool.  You should have a flashing insert cursor in a measure before using Paste.

Auto Space On While Pasting
If Auto Space (Preferences) is on, pasted notation is automatically aligned following each paste.  
If the paste operation does not replace all of the notes in a measure, non-pasted notes in the same 
measure will also be aligned.

Auto Space Off While Pasting
If Auto Space is off, Encore will not use Align Spacing for the pasted area and the original 
spacing will be maintained.  If the measure width of copied data is different than the measure(s) 
into which the data is pasted, the data is scaled to fit the new area.  This works best when 
complete measures are copied but will also affect paste operations for notes that do not fill the 
measure.

Note: Paste operations will paste notes, text, lyrics and all graphic indications with the exception 
of Clefs.

Paste does not paste tempo, time signature and key signature changes.

Encore copies data within each measure but not the measure itself.  Time signatures, tempos and 
key signatures are all attributes saved for each measure.  Clefs are “anchors” giving Encore a 
reference point for relating all the entered note data.
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Tempo indications added from the Tool palette will be pasted but only as a graphic item.  If you 
are copying a section that includes clef changes, time signature changes or key signature changes, 
we recommend that you first create the measures needed and define at least the time signature for 
each section before pasting.  Key signatures can be added before or after pasting, and clefs should 
always be added after the paste.

If the time signature of copied data is different than the measure into which it is being pasted, 
Encore will paste copied data into the new measures as best as it can.  If notes were copied from 
radically different time signatures, the notes will be pasted over a different number of measures 
but the values will remain the same.  Generally speaking, every note and rest in every voice is 
first counted as an item.  Encore will keep adding notes and rests to each measure until no space 
remains.  If the last item exceeds the number of beats for that measure, Encore leaves it up to you 
to decide what to do.  Changing the time signature for a measure after pasting will not move notes 
to other measures.  See the section on Time Signatures for more information.

Measure widths and number of measures per system will need to be defined for each new area 
either before or after pasting.  New measures and pages created in Encore when pasting will 
use the last existing system before the paste and create new systems with the same number of 
measures.  If a paste creates new pages, the page layout of the last page before the paste will be 
copied for all the new pages created.

Clear
Clear is similar to Cut with one very important difference:  the cleared data is not copied to the 
Encore clipboard.  A Clear command can be undone but the cleared area is not stored for further use 
in the clipboard, and the current clipboard contents remain.

Clear does not have a command key equivalent but instead uses the [back space/delete] key.

Select All
The Select All command will select all of the available data in the current score.  Select All is limited 
by the current voice indication for the score and will only affect notes and rests for the current voice.  
Graphics and text boxes are not assigned to voices but are placed by default into voice one.  An 
exception to this rule is lyrics and chords which use voices for determining vertical position.  The 
voice selector will affect lyrics and chords when altering selected data.

Nudge
Although the Nudge commands exist as menu items, the keyboard shortcuts are the preferred method 
to nudge objects.  The four nudge commands are:

Nudge Left		 [control/command]+ [ (open bracket) 

Nudge Right	 [control/command]+ ] (close bracket) 

Nudge Up		  [shift]+[control/command]+ [  

Nudge Down	 [shift]+[control/command]+ ]

The basic nudge operations move data left or right and up or down.  A single nudge unit left or right is 
one pixel.
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Nudge requires a selection.  Use the arrow tool to select one or more areas using the standard 
selection technique.  Additional areas can be defined if you hold the [shift] key down before selecting 
again.  Isolated notes and rests selected using the shift-select method will also respond to the nudge 
command but will only move to the right or left.  See the section on selecting for more information.

Nudge Left and Right
The Nudge Left and Right commands provide a powerful method for moving selections as a 
group.  Nudge can be particularly useful for adjusting the horizontal alignment of several staves 
without sacrificing their vertical alignment.  Use Align Spacing to apply engraver’s rules to your 
music, and then nudge to make subtle adjustments to horizontal spacing while still retaining the 
essential vertical alignment between staves. This lets you create room for articulations, composer 
notes, graphics and lyrics.

Since nudge operations are frequently needed to move data in greater increments than a single 
nudge, the nudge command will respond to key repeat messages.  The delay before repeats occur 
can be set in the Keyboard Control Panel. 

Nudge Up and Down
Encore allows you to use Nudge Up and Nudge Down commands on objects.  To change the pitch 
of a note up or down, use Move Notes in the Notes menu. 

Notes Menu
Attributes

The Attributes menu is a hierarchical menu with a sub-menu for Notes, Beams and Rests.  Each of 
these sub-menu items opens a dialog for that item and allows you to change how Encore displays and 
prints the related information.

The Attributes menu requires that you first select the notes or 
rests to be altered.

Notes

Set Stem Height
The stem height can be any number from 1 through 
63.  Each number represents half the distance 
between two staff lines.  The default length is 7.  As 
in common notation practice, Encore adjusts stems 
to touch the middle staff line when the notes are 
in the ledger lines.  Enter the desired length in the 
highlighted box.

When changing the stem height of beamed notes, 
please check the Apply Height to Beamed Notes 
check box
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Note: If you flip stem direction, transpose or change pitch, the stem length will revert to 
Encore’s defaults. To change these defaults see View>Spacing Defaults.

Shift Accidental Left
Encore automatically offsets accidentals for chords, but can also be manually adjusted if you 
desire.  The higher the number, the more the accidental shifts to the left.

Note: If you flip stem direction or use Change Pitch or Transpose, accidental offsets will 
revert to Encore’s default placement.

Set Play State
Set Play State allows you to turn on or off selected notation or measures of notation in your 
score.  The default for standard notes is Play.  To turn 
selected notation off, click the Mute radio button.  To 
turn the selected notation back on, click the Play radio 
button.

Note: Cue notes are set to the Mute state by default 
and must be “play enabled” before you can hear them.

Set Note Head Type
Different note head types can be freely mixed within 
the score for any staff or measure without limitation.  
Note head types remain set until altered again with 
the Change Note Attributes dialog.

The ten available head types are: standard, diamond, 
triangle, square, X, circle-X, plus, slash, hollow 
diamond and stem only.   

Beams 
The Change Beam Attributes dialog box allows tuplet numerals and/or brackets to be hidden and 
also allows control over the length of half beams and the beam height.  Select the music you want 
to alter and then choose Beams.

Hide Bracket
Hide bracket removes the bracket indication on either side of a 
tuplet group or any other bracketed selection. Beamed tuplets do 
not have a bracket.

Note: Altering any of the notes for a group where the bracket 
has been hidden will show the bracket again.

Hide Tuplet
Hide tuplet removes the numeric indication for a tuplet.  Once 
hidden, a tuplet indication can be shown again by selecting the 
tuplet group and deselecting the hide option in the Change Beam 
Attributes dialog.
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Hidden tuplet numbers will remain hidden for almost all operations.  Only changing the 
duration will return the tuplet indication to the “show tuplet” state, and only then if the beam 
or bracket is removed when the duration is changed.

Set Half Beam Length
The half beam length affects beamed groups containing mixed durations which include 
a sixteenth note or shorter note duration.  When a sixteenth is beamed to an eighth note, 
the sixteenth note will show a “half beam” between the two notes to indicate the note is a 
sixteenth and not an eighth.  Encore sets the default length for this beam when the beam is 
first created but that default can be altered using the Beam dialog to any length between 0 and 
63.  Each number represents 1/72 of an inch.

Note:  Adjusting a beam in any manner after the half beam length has been altered will revert 
the half beams to their default length.

Grow Beam Height by...
Encore calculates beam heights at the time they are created and can be adjusted with the 
mouse (see the section on Moving Items in Encore).  To adjust the beam height for several 
beams at once, use the Grow Beam Height option.  Beam heights can be adjusted from 0 to 
63.  The number entered will be added to the current height of the selected beam(s).  Enter a 
negative number to decrease the beam height.

Note: Beam heights will revert to their default when the stem direction for any of the notes is 
changed.

Rests
Encore lets you change the look of your rests from standard rest notation 
(default) to slashes or vice versa.

Select the rests you want to change and then choose Rests to open the 
Change Rest Attribute dialog (Windows) or Set Rest Attribute (Mac).  Take 
your pick.

Note: See Moving Objects in Encore for more information.

Set to Voice
A complete discussion of voices and voicing in Encore is provided in Chapter 8, Voices in Encore.

The voice sub-menu shows Encore’s eight voices.  Changing the voice assignment for a selection 
can be done using this menu.  You may find it easier to use the [control/command] key and number 
shortcuts provided.

To view by voice: 

Press [V]+[ - ] (dash) for all voices, [V]+[1] for voice one, [V]+[2] for voice two, etc.

To change the voice of a selection: 

[control/command]+[1] for voice one, [control/command]+[2] for voice two, etc.
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Changing voice for a beamed group of notes will unbeam the notes in the process.

Accidentals
This feature permits you to change the accidentals that occur in a selection.  Although Encore 
attempts to use the correct accidentals for the current key signature, there are instances where your 
music may require changing the accidentals.  In the key of C, for instance, the “correct” accidental 
depends on several factors which Encore cannot know about.

Notes which do not have an accidental attached will not be affected when changing to flats or sharps.

Enharmonics
The term “enharmonic” describes two pitches that are notated differently but are still played 
and sounded the same.  In practice, this is not always true since some instruments can generate 
slightly different tunings for a pitch depending upon how the pitch is created, but in general (and 
always for MIDI) the “enharmonic spelling” for a pitch is just another way to describe the same 
pitch.  An example would be F flat and E.

Every note has an enharmonic equivalent.  The actual spelling for the enharmonic depends on the 
key signature.

Most commonly, the enharmonic function helps avoid crowded chord clusters with excessive or 
confusing accidental indications.

To change a single note in a chord we recommend that you select the note using the shift-click 
select method (see Selecting in Encore).

Simplify Accidentals
Simplifying accidentals changes the accidentals to best fit the key while removing double sharps 
and double flats.  

Stems (direction)
Although a menu item has been provided for changing stem direction, we recommend that you learn 
the shortcut equivalents [control/command]+[U] for stems up and [control/command]+[D] for stems 
down.  Select the notes you want to change and apply either the shortcut keys or menu item.

Changing stem direction for chords will also change the tie direction.  See the section on Tie Notes 
for more information about tie directions and flipping ties.   [control/command]+[T] toggles the ties 
up and down.

Voice 1 Stem Directions
Stem directions for notes in voice 1 will follow standard notation practice and be placed up or 
down depending on their pitch location in reference to the clef.

Voice 2-8 Stem Directions
Voices other than voice one default to stems down except when using a combined staff such 
as the piano staff.  In a piano staff the notes in the bass clef will default to voice 5.  These 
notes will also follow standard notation practice and set the stem direction according to the 
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clef in use.

When two or more voices are used in the same measure, you may need to flip the stems 
for one voice.  Most commonly, some or all of the notes in voice one will have stem down 
directions and will need to be changed to stems up.  Set the voice selector to the voice you 
wish to affect and it will be easier to select only those notes and change their stem direction 
without affecting the other voices.

Normalize
Normalize sets stems back to the default directions.

Marks 
Add

To add marks to a group of notes:

1	 Select the notes. 2	 On the Notes menu, point to Marks, then click Add.  3	 Under 
Apply Marks, select an option to determine the position of the marks. 4	 Under Mark to apply, 
click the mark you want.

Remove
To remove marks from a group of notes:

1	 Select the notes. 2	 On the Notes menu, point to Marks, then click Remove. 3	Under 
Remove Marks From, select an option to determine which marks to remove. 4	 Under Mark to 
apply, click the mark you want. 5	Do one of the following: 		  To remove all types of 
marks: click Remove All Marks.

		  To remove one particular mark: click that mark button under Mark Types to 
Remove.

Tie Notes
Tie Notes allows you to tie two or more notes of the same pitch 
together for the purpose of indicating the note is played only once 
but held for the full value of all the combined notes.

Tie Notes requires that you first select the notes to be tied.

All notes to be tied must be within the same selection.

If notes to be tied exist across system breaks or page breaks you can 
either change the number of measures in the system or select the 
notes you wish to tie using the shift-select method of clicking on 
the note head.  See Selecting in Encore for more information.

Notes to be tied must be the same pitch.  If a tie occurs over 
a barline, accidentals will be removed from the note in the 
following measure after the tie has been performed, but 
both notes must be notated the same before the tie will be 
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allowed.  If you wish to apply a courtesy accidental to a tied note you must do so before the tie is 
performed.  Use the [control/option] key while applying the accidental to force Encore to retain 
the accidental.  To apply an accidental after notes have been tied, apply the accidental to the first 
note in the tied group.  We do not recommend that you change the accidental for a tied group if 
you placed a courtesy accidental within the group. 

The keyboard shortcut for ties is [control/command]+[T]. [control/command]+[shift]+[T] toggles 
the ties up and down.

Tie Directions
Stem direction and the number of notes being tied determines the tie directions for notes.  When 
chords are tied together the tie directions will be created for the chords according to Encore’s best 
judgment.  If you flip stem directions for a tied group, the tie direction will also change.  To alter 
the tie directions without changing the stem direction, shift-select the tied notes that need the tie 
flipped and use [control/command]+[T].

Adjusting Ties Using the Mouse
Ties can be adjusted manually by dragging the tie’s control point.  Control points for ties occur in 
the middle of the tie and can be adjusted either up or down provided the tie is not indicating a tie 
from or to a note in another system or page.  If a tie occurs over a system or page you will need to 
change (“flow”) the number of measures to bring both notes being tied onto the same system.

Note: The Tie Notes function ties only notes that are in the same voice.

Tie Defaults
The Spacing Defaults dialog from the View menu contains the default settings for tie offsets.  The 
default horizontal offset is 0, placing the tie’s ends at the edge of the notes being tied.  Using a 
higher number moves the ties farther away from the note heads.

The default vertical offset is 3, and places the tie ends slightly above or below the note heads 
being tied.  Using 0 will start the tie ends from the middle of the note’s head.  Entering higher 
values moves the ties higher or lower than the notes.

A maximum of 8 can be used to define the tie offsets. Each number represents a quarter of the 
distance between two staff lines.

Slur Notes
A slur is a curved line over (or under) two or more notes of different 
pitches indicating the notes are to be played as a group.

Slurs can be entered in Encore using a variety of methods.  For more 
information about entering slurs using the pencil tool, refer to the 
reference section for the Tools palette.

Using the Slur Notes command
The menu item for Slur Notes will create a slur for you based on a 
selection.  The default slur is created over a group of notes. Holding 
down [shift] while using the slur command will place the slur under 
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the selected notes.

Slurs are drawn from either the note head or the stem depending upon the stem direction and the 
slur placement.  The default placement of the slur is at the note heads if all stems of the end notes 
face the same direction.  If the stems face the opposite direction, the slur will be placed on the top.  
Holding down [shift] will place the slur on the other side as the default.  The end points of slurs 
attempt to stay “attached” to the original notes and readjust when the notes are moved (except 
when [control] key is down or Auto Guess/Beam is OFF).  The selection for creating a slur should 
be made by highlighting the entire group of notes the slur appears over or under.  Make sure the 
first and last notes, which define the slur, are fully selected within the same rectangle.

Additional note groups can be selected using the [shift] key before defining the selections.

Shift-selection of individual notes can also be used for creating slurs, but take care:   A slur will 
be generated between every pair of shift-selected notes.  Shift-clicking on the beginning and 
ending note head of a phrase will “slur” that phrase.

Beam Notes 
The Beam Notes item has a sub-menu containing the four beaming operations used within Encore.   
For more information on changing Beams see also Attributes>Beams, Moving Objects in Encore, 
Selecting in Encore and Spacing Defaults.

Beam Group creates brackets or beams over all selected notes and rests and also creates beams across 
barlines.

Beam On Beat uses the time signature and beat location for the selected notes to determine a default 
beaming combination.  The Auto Guess/Beam function uses Beam On Beat.

Sub-Group will “break” the secondary beams under the primary beam of a beamed group into smaller 
groups without changing the duration information.  This leaves only the primary beam connecting the 
entire group. 

Flatten Beams changes angled beams so that they run in a straight, horizontal line.

All notes must be in the same voice for Beam Group and Beam On Beat to work.  Notes in different 
voices will be beamed according to the logic or selection applied to each separate voice.

Beam Group and Beam On Beat require an unbeamed selection to function properly.  If any of the 
selected areas were previously beamed, these two beaming operations will undo the beaming instead 
of creating additional beams.  If this happens, you can just do it again and Encore will reapply the 
beam operation to the same selection.

Sub-Group is applied after a group has been beamed together.  Sub-Group will frequently require a 
Beam Group operation before it can be used.

Beam Group
Beam Group is a manual operation used when you require different beaming combinations than 
are provided with Auto Guess/Beam or Beat On Beat.  This can occur when using time signatures 
other than a simple 4/4 or when using complex groups of shorter durations.  Beam Group is also 
used when brackets are needed above tuplet groups (such as half note or quarter note triplets) and 
when beams are desired across barlines.
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Beam Group will work only if the selected area does not contain any notes previously beamed 
together.

Beam Group only affects notes in the same voice.

Beam Group creates additional brackets along with beams if the selected group includes quarter, 
half or whole notes.

Beam Group can include rests either within or at the end of a beamed group.

Using Beam Group
Select the group of notes you want to beam together.  Previously beamed notes require you to 
use the Beam Group command twice.  The first time will unbeam anything already beamed, 
and the second operation will beam all of the selected items together.

Beaming Notes Over a Barline
If you make a selection that includes notes in two measures, the beam created will be drawn 
across the barline.

Note:  Encore will create beams over one barline only. Beaming operations with selections 
greater than two measures will stop at the end of the second measure.  Beams across 
measures should not be “flowed” to a new system.

Beam on Beat
Beat On Beat uses the time signature to apply some basic rules to the way notes are beamed 
together.  If Auto Guess/Beam has been enabled, the Beat On Beat operation is applied every time 
a note is entered or erased from a measure.

Beat On Beat rules are fairly straight-forward for time signatures based on quarter notes (2/4, 3/4, 
4/4, etc.). Each quarter note in the measure is a beat and beams will not cross the beat boundaries. 

When the time signature is based on eighth notes, it is not possible to arrive at a universal 
beaming solution appropriate for every situation. 

Encore uses a beat value of three eighth notes for 6/8 12/8 and 9/8.  For odd time signatures such 
as 5/8 and 7/8 the beat value is one eighth note. 

For complex rhythms, the beaming must be performed manually using Beam Group.

See Default Spacing, Auto Beam/Guess and Selecting Objects in Encore and Moving in Encore 
for more information related to beams.

Sub-Group
Sub-Group clarifies a measure’s rhythm.  Used after Beam Group, the Sub-Group command can 
remove secondary beams between groups of notes and/or change the secondary beam direction.

You can also use Sub-Group to change the direction of a secondary beam.

The following examples illustrate how Sub-Group works.
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Flatten Beams
The Flatten Beams command changes angled beams so that they run in a straight, horizontal line.  
To see this command in action, do the following:

1	 Place four eighth notes in a measure, keeping the notes within the lines of the staff. 

2	 Select the beam.  You must drag the pointer over the center point of the beam to select it.

3	 Click the Notes menu, point to Beams, then click Flatten Beams.

Change Pitch/Transpose
Change Pitch/Transpose alters both the position of notes 
and their playback.

For Change Pitch/Transpose to function, you need to 
make a selection.

The Change Pitch/Transpose dialog can raise or lower 
pitches three octaves in either direction.  If you need a 
transposition greater than this, use the Change Pitch/
Transpose function a second time.  The transpose amount 
is indicated with the transpose direction, the interval name 
and quality ( the number of half steps is calculated for you).  Use the pop up menus to the desired 
interval and select the choice by highlighting the name.  Click OK.

Change Pitch/Transpose changes the key signature if desired.  If you would also like to change key 
signatures to the transposed amount, check the Transpose Key Signature box.

Change Pitch/Transpose removes courtesy accidentals and enharmonics, and can apply standard 
defaults or Simplified Accidentals (see Simplified Enharmonics) for the new pitches. 

Change Pitch/Transpose also transposes any chord symbols when Transpose Chord Symbols is 
checked. 

To change the playback of notes without changing their display, use the Key function in the Staff 
Sheet.  See the section on the Staff Sheet (Windows menu) for more information.

Change Duration 
The Change Durations dialog can alter the display and playback of notation in your score.

Change Durations requires a selection.
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Set Note Durations
This portion of the dialog requires the checkbox 
to be enabled if you wish the note types to change.  
Use your mouse to place a check mark in the box 
next to the words Set Note Duration and select the 
duration, including dots and the tuplet indication if 
needed.

Changing the duration will change both the 
duration and the start time for the notes.  If the new 
duration is greater than the number of beats in the 
measure, notes in each measure that exceed the time 
signature will not be heard.

Note: All of the choices in the Set Note Duration section can also be applied quickly to selections 
using shortcut keys.  See the section on the Notes palette for details.

Set Play Duration
The second option in the Change Durations dialog concerns the MIDI duration to be played for 
each note.

Changing Play Duration  for Step Entered Notes
The default playback for notes entered with the mouse or step entered with a MIDI Keyboard is 
90% of the displayed value. 

Changing Play Duration for  Real Time and Imported Notes
Notes recorded in real time or imported MIDI Files initially have unique durations for each note 
depending on the recording.  Even after Guess Durations and Transcription Options have assigned 
a display duration value, the original recording or MIDI file is maintained as much as possible.  
When changing the duration for real time and imported scores, the new play duration is the 
percentage of the transcribed value and not the recorded value.

For passages intended to be played legato, you can increase the percentage to 100%.  An overlap 
can be achieved depending on articulation settings and MIDI OFF velocities of the particular 
synthesizer used.  (See MIDI Playback Settings)

Decreasing the percentage will result in a more staccato interpretation.

Note:  Even at full duration, what is actually heard will depend on the synthesizer and the sound 
selection.  Reducing the playback percentage for sounds with slow “attack” times can result in 
some notes not being heard at all.  See the appendix on MIDI for more information.

The Set Play Duration settings will be lost if a note’s duration is changed again.

See also the Notes palette, Changing Displayed Notation without Affecting MIDI Playback.

Change Velocity
Change Velocity combined with dynamics, marks, hairpins and your synthesizer settings can give 
you complete control over the interpretation of your score’s dynamics by your MIDI synthesizer.  
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MIDI Playback Settings and Staff Sheet settings can change the 
velocity or perceived volume.

Velocity is a MIDI parameter in every note.  The value for 
velocity ranges between 0 and 127 but the value of 0 is special 
and not used in Encore (a zero velocity essentially means “don’t 
play this note”).

What actually happens when different velocity “values” are 
used depends entirely upon the synthesizer responding to the 
MIDI messages.  Common practice, however, uses velocity to 
control volume.  For more information about velocity see the appendix on MIDI.

Change Velocity requires a selection.

The dialog for changing velocity contains both ON and OFF selections.  These settings can be 
enabled independently.

Note:  Consult the documentation for your synthesizer to determine if it responds to OF or OFF 
Velocity, or both. Most synthesizers will respond to OF Velocity but very few respond to OFF 
Velocity.

There are four choices in the Change Velocity dialog.

Setting all velocities to the same value will ensure that all volumes are the same.

Changing by percentage maintains any changes made within the selection and scales the velocity 
levels.  The values range from 1% to 999%.  Percentage changes close to maximum or minimum will 
compress the dynamic range to one extreme or the other.

Change smoothly will replace the velocity values for the selected notes with new values obtained 
from the value range entered.  The first value will be applied to the first note and the second value 
applied to the last note in your selection.  Notes between the beginning and end selections will be 
altered according to their placement in time.  This means the changes in velocity level for short 
durations will be more gradual than changes between notes with longer durations.

The fixed value range will accept values between -127 and 127.

If any operation would result in a value less than 0 or greater than 127, the value assigned is 
either 0 or 127 depending on which limit was encountered.

To change just the ON velocity, click on the note while holding the [Shift]+[Command] keys.  A 
pop up menu with velocities will open.

Make Chord 
Make Chord combines two or more notes of the same duration into a chord.  Both MIDI Playback and 
screen display are changed.

Make Chord can be used to change imported or real-time recorded data containing arpeggiated chords 
into an actual chord to which an arpeggio symbol can be added.

To use Make Chord, select the notes that you wish to use in the chord and then use Make Chord.
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Make Chord will work only when notes are of the same duration.  If notes have been guessed to be 
different durations, first change all of the notes to the same duration.

Unless the notes combined into a chord were hand entered with Auto Space off, the number of beats 
in the measure will change as well.  You may need to add rests or additional notes to complete the 
measure.  It is also a good idea to Align Playback. 

Make Grace/Cue
This function lets you change notes to grace notes or cue 
notes and to clear the grace or cue attributes.

Encore does not count grace notes when calculating the 
number of beats in each measure, and their playback can be 
set to play in advance of the next note if the grace note can 
borrow time from a preceding note or rest.  Cue notes have 
their full beat value counted in the measure and are muted 
by default.  If cue notes are to be used to indicate alternate 
or secondary lines, add all of the cue notes in a separate 
voice.

Grace
Before Encore can create grace notes, you must first 
enter the duration used for the grace as a regular note.

Note:  When a phrase of two or more beamed notes are converted to grace notes, the original 
duration of the note is retained in the beamed configuration.  Single grace notes, however, are 
always converted to the standard eighth note grace character.

When notes added to a measure are intended to be grace notes, you will need to turn OFF Auto 
Space and Auto Guess/Beam.  With Auto Space ON you will be prevented from entering more 
than the full beat count for the measure.  Since grace notes are standard notes before you convert 
them to grace notes, you have to be able to add them to the measure.

The percentage amount entered for Scale duration by determines how long the grace note will be 
played.  This value is applied to the current duration of the note before it is changed to a grace 
note.  That is, changing a half note to a grace note will indicate the grace as an eighth note, but if 
the duration is scaled to play at 50%, the note will be played for the duration of a quarter note.

When Play before the beat has been selected, the original note duration combined with the scaled 
amount will also determine at what time in the measure the note is to be played.  As an example, 
place two eighth notes into the beginning of a measure.  Select the second eighth note, convert it 
to a grace note with a duration of 25% and set it to play before the beat.  When this combination 
is played the grace note’s duration will be played as a thirty-second (25% of an eighth note) and 
the note will start playing starting a thirty-second sooner than where it occurs in the measure.  
If the play duration was set to 50% for this example, the note would play for the duration of a 
sixteenth (half of the original duration) and also start playing a sixteenth before its beat location.

Note: Grace notes cannot borrow time from notes or rests that don’t exist and cannot be set to a 
play duration greater than the value of the note or rest before the grace note.  Remember that the 
duration amount is for the original duration of the note you are converting to a grace note.
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If you need to start a section or piece with a grace note, you will need to uncheck Play before the 
beat as there will not be a note to borrow time from.

No Slash (appoggiatura)
When No slash (appoggiatura) is selected, the option to Play before the beat is automatically 
deselected.   The appoggiatura option automatically plays the notes on the beat location at which 
they are located.  A full discussion of the term “appoggiatura” cannot be covered in this manual, 
and there are disagreements concerning the exact interpretation and use of the appoggiatura 
anyway.  In Encore, the selection will create a grace note that is played on the beat and the note’s 
type will be preserved (that is, a half note will look like a small half note, a quarter will look like 
a small quarter note, etc.).  Appoggiaturas differ from cue notes in that they are played on the beat 
but will not affect the beat locations of other notes in the measure. 

Cue
This option shrinks all notes, beams, and marks to 70% of normal size.  Cue notes are muted 
by default.  If you would prefer to hear the cue notes, you can select them and use the Note 
Attributes dialog to unmute them.

Standard Note
This removes any grace or cue changes made to the selected notes and restores full performance 
and duration values.

Make Tab
Make Tab to create tablature staff for fretted instruments and converts notation from a regular staff 
to the tablature staff.  The tablature numbers indicate the corresponding fret locations selected for the 
tablature staff’s tuning.

Make Tab requires that a Tab staff be created by using the Add Staff dialog > Tablature Staff.

To convert standard notation into tablature, select the staff or notes to be converted and then use 
“Make Tablaute”.  The converted notes will then appear on the new tab staff.  Encore does its best to 
give you a logical fingering for the notated music.  It does not, however, know the neck position in 
which you want it played.  Make Tab lets you transcribe a selected section into tablature and set the 
lowest fret to be used.

To set the fret position:

•	 Add a new blank tablature staff with the Add Staff command or convert a standard notation staff 
into tablature with the Tablature Staff command.

•	 In the standard notation staff, select the notes you’d like to transcribe as tablature.  If you’ve 
already converted the staff, select only those notes that you want to re-transcribe at a different neck 
position.

•	 Choose Make Tab from the Notes menu.  The Make Tablature dialog appears. 

•	 Enter a value into the parameter box labeled “Start tablature at fret {n}.”

•	 Click OK.  The selected notes are re-transcribed.
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Note:  All selected items are used for creating the tablature numbers.  Don’t select more than one staff 
unless you want the tablature part to include fingerings for notes on more than one staff.

Updates to the tab staff can be made for one note or an entire score.  Whatever is selected will be 
converted to numbers on the tab staff.  Previous fretting indications will be replaced.

Note:  If you edit the pitch of a note or notes in a regular staff and then select and reconvert just 
those notes to an existing tab staff, the fingering numbers in the affected measures will revert to the 
default fingerings.  Therefore, you should be satisfied with the pitches before you nudge the fingering 
numbers around to different strings. 

If two or more tab staves exist in a score, the order in which they appear will determine which staff 
receives the numbering indications.  If both staves are intended to be references for the same notation, 
you will need to update each staff separately.  Use the Staff Sheet to swap staff positions and use 
Make Tab for each staff.  By rearranging the staff order, it is possible to convert the same piece of 
notation for several different fretted instruments.  

Create Tab Staff
The Tab Staff created by default is in a standard 6 string guitar tuning.  Use the OK-Open Setup 
button to change these defaults.

Tablature staves are created below the selected staff but can 
be moved to any staff position after they are created (see 
Staff Sheet for more information).

Setup
The OK-Open Setup button takes you to the dialog 
used to select the number of strings and their respective 
tuning.  Encore can create a tablature staff containing 
from one to eight string indications.  Each string will 
correspond to a line in the tablature staff.  Encore uses 
the tuning information when creating the fret position 
numbers and when nudge is used to change the string 
reference.  You may use one of our presets or create you 
own set up.

Note:  Tablature and notation for fretted instruments is 
frequently written an octave higher than played.  The 
standard guitar tuning, for example, uses E2 as the pitch 
for Low E but most guitarists tune to E1.  The Key 
function in the Staff Sheet can be used to transpose the 
playback for a guitar part on the standard staff for the 
proper register of the intended instrument. 

Font menus provided in Setup determine how the 
number indications in the tablature staff are to be 
displayed and printed.  The font choice affects all 
tablature staves in the score.

Selecting a tablature staff alone and then choosing Make 
Tab will open the Setup dialog independently of the 
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Make Tab dialog.  This permits you to change just the font and tuning information.

Changing the String Indications
Numbers on a Tablature staff are not like notes and graphics and you cannot drag them to 
new locations with the arrow tool.  Instead, numbers must be selected and adjusted using the 
Nudge command.  Nudge Left and Nudge Right change the horizontal positions of numbers.  
Nudge Up and Down adjust the string indication.

Changing Fret and String Indication
Guitars and most fretted instruments have several different string and fret possibilities 
capable of generating the same pitch.  The Make Tab function will select one possibility for 
you.  To change the fret and string reference for a pitch, select the number indicating the fret 
on the current string.  Nudge Up to change the fret indication for the next string up and its 
tuning.  Nudge Down to change the indication to the next string below and the tuning used 
for that string.

Note:  Nudge will not move numbers onto strings tuned beyond the range for the pitch being 
indicated.  Although standard tunings and even most alternate tunings can be used without 
trouble, tunings using non-ascending or descending pitches are not fully supported. 

Tablature staves do not play over MIDI.  The Staff Sheet options for tablature staves are 
limited to changing their size and location.

Revert to Raw
“Raw” data in Encore appears as note heads with accidental and tie information only.  Revert to Raw 
removes all stems, flags, beams and marks from notes and leaves only this information and the MIDI 
data associated with each note.  Graphic information such as slurs and dynamics are unaffected by 
Revert to Raw and will remain in the score.

Use Revert to Raw when you want to undo all the changes to a section of music and apply new tran-
scription parameters.  Select a transcription value after reverting to raw data and use Guess Durations 
to convert the raw data into notation. 

Guess Durations
Guess Durations applies the duration value selected in Transcription 
Setup to the MIDI data and converts the MIDI duration and timing 
information into notation.  The accuracy of Guess Durations depends 
on both the recorded data and the transcription value selected.

Guess Durations requires a selection and uses the settings in Transcrip-
tion Setup. 

Encore biases the Guess Durations function to avoid creating 
unnecessary rests and notes of awkward duration values.  Ordinary 
playing usually consists of varying durations and pauses between 
notes.  A literal transcription of such playing would consist of an 
unreadable profusion of rests, double-dots and needlessly complex tied 
note combinations.  To avoid such a transcription, the Guess Durations 
function rounds off the interpreted note and rest values to within the 
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duration amount specified in Transcription Setup.  The default transcription value is sixteenth notes.  
The transcription value set in the Transcription Setup dialog can be saved in preferences. 

If Auto Guess/Beam is enabled in the Setup menu, the Guess Durations operation and the current 
transcription option will be applied to all recorded data and imported MIDI or Master Tracks Pro® 
files. 

If an imported or real-time recording is guessed incorrectly, you can change the transcription value 
and use Guess Durations again on all or part of the score.

Transcribing Triplets
When using Guess Durations on triplets, the result will depend on how accurately the triplets 
were entered.  Step entered triplets can be accurately “guessed” by Encore down to a sixteenth 
note triplet, but only if the duration is repeatedly used.  When triplet values are combined with 
other durations or alternate with rests, the guess function will be less able to account for them and 
the result will vary according to the note’s position.

When recording data into Encore in real time, it is important to play with great emphasis on 
maintaining the timing if you want the transcription to be as accurate as possible.  If a sequencing 
program such as Master Tracks Pro is available, you can often improve the transcription within 
Encore even further by first opening the file in the sequencer program and quantizing it before 
you open it in Encore.

Move Notes
	 Move Notes section of the menu lets you easily change the pitch of the selected notes up or down 
by a half step, or by an octave.  Simply select the note(s) before using the operation.  Chords in the 
selected area will be transposed also.

Measures Menu
Add Measure

Add Measure creates new measures anywhere within the 
score for either one or all staves in the system.

The default setting for Add Measure  adds one measure after 
the measure in which the insert point was placed.  The range 
of measures can be changed and new measures can be added 
either before or after the specified measure. 

The lower portion of the Add Measure dialog allows the new measures to be added to all staves or on 
a single staff only.  If you select Only on staff, the initial entry will be obtained from the measure in 
which the insert point was placed.  Enter a new staff number if you wish.

Note:  Staff numbers are the same as instruments in the Staff Sheet.  Combined staves, such as a piano 
staff, get counted as one staff even though they technically contain two or more staves. 

Add Measure does not have an “undo” option but the added measures can be easily removed with the 
Delete Measure function if later you decide you don’t need them.
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Delete Measure
Delete Measure removes measures and all data and information related to 
those measures from either one or all staves in a score.

Delete Measure is NOT UNDOABLE!  If you delete measures you meant 
to keep, you can only regain those measures if you saved the score while the 
deleted measures were complete and you discard all recent edits.  Revert to 
Saved will retrieve the last-saved version of your file.

If you select the measures you wish to delete before opening the Delete Measure dialog, the range of 
measures selected will automatically appear in the dialog.  The range to be deleted can be redefined 
by changing any of the numbers within the dialog.  If no selection was in effect the dialog will default 
to one measure.

Caution:  Encore does not allow you to delete discontinuous measures. That is, if you select only 
measures 1 and 5, the measure range will be 1 through 5 and Delete Measure will also delete 
measures 2, 3, and 4. 

Note: If you want to delete all the measures from the “From” measure to the last measure of your 
piece, click on the arrow (located to the right of the “To” box).  The last measure in the score appears 
in the “To” box. 

Indicate whether you want to delete measures from all staves or just the currently displayed staff by 
clicking the applicable radio button.

If you want to change the currently displayed staff number to another staff number, click twice in the 
box to highlight it and then type the desired staff number.

Remember:  Delete Measure is not undoable.  Once deleted, measures are gone unless you can use the 
Revert to Saved function explained above.

Tempo
The tempo can be adjusted for the entire score or just a section within the score.

If you select the area you wish to change before opening the Tempo dialog, your selection will be 
entered into the dialog’s measure range. 

If no selection has been made, the measure range will default to the current location or measure 1. 

Note:  All measures between the first and last measure indicated will 
be included in the operation. 

The Tempo dialog defaults to changing by a percentage.  After using 
the dialog once, however, your selections are “sticky” and your last 
operation choice will remain selected. 

Finding the Current Tempo  for a Measure
When the Tempo dialog is first opened, the tempo indicated in 
the Set all Tempos to... field is for the “From” measure in the 
selection range.  Tempo changes after this may exist but are not 
indicated.  If the measure range is altered within the dialog, the 
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tempo for the new range is not indicated.

Set all Tempos to...
This option changes all tempos in the selected area to the one tempo entered here.  If the selected 
measures contain different time signatures (i.e. 4/4 and 6/8) each time signature will apply the 
new value to the beat value used.

Note:  The beat is the lower portion of the Time Signature.  When the tempo amount is applied to 
the beat, you should think of the tempo as applying to one note of the indicated value.  In 4/4 the 
tempo describes how long quarter notes are to be played.  In 6/8 the tempo describes how long 
eighth notes are to be played.  If a measure of 4/4 and 6/8 are both set to play at “100” an eighth 
note in the 4/4 measure will play twice as fast as the eighth note in the 6/8 measure. 

Changing by Percentage
Entering a percentage value for the defined measure range will scale the tempo and any changes 
already defined for the range.

Change Smoothly From...
This dialog will apply two tempo values to a range of measures.  The two numbers are scaled 
to fit the number of measures within the selection.  Changes within each measure will occur on 
each beat for the time signature of the measure.  If there are different time signatures the tempo is 
applied to the beat value of each measure.

Add _ to all values
This option will increase or decrease the tempos for the selected region by a fixed amount.  
Negative values can be entered.  This operation will maintain the relative differences between 
tempos unless tempo limits are encountered.

Tempo changes are saved with the measure and not the measure number.  If a tempo change is 
made for measure 5 and then 5 measures are inserted before measure 5 on all staves, the tempo 
change will occur at measure 10.  When measures are inserted for only one staff, tempo changes 
are unaffected.

Encore allows a maximum tempo value of 400 beats per minute.  The minimum is 1 .

Time Signature
Time signatures are used to indicate how many beats are in each measure and what note value is used 
for each beat.

Encore can define one time signature per measure as often as needed.  
Measures and pages added to the score use the last time signature defined.  
The time signature determines how many notes Encore will play for each 
measure, but it is possible to both hide the time signature and enter more 
notes than can be played (if Auto Space is off).

If you select the area you wish to change before opening the Time 
Signature dialog, your selection will be entered into the dialog’s measure 
range.
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If no selection has been made, the measure range will default to the current location or Measure 1.

Note:  All measures between the first and last measure indicated will be included in the operation.

When the Time Signature dialog is first opened the time signature indicated is for the measure number 
that appears in the “From” box of the measure range.  If the measure range is altered within the 
dialog, the time signature for the new range is not indicated. 

Click the arrow to the right of the measure range to enter the last measure in your score in the “to” 
box.  You can use this to select to the end without knowing how many measures currently exist.

Encore includes two standard time signatures.  C is used for 4/4 and  ¢  is the same as 2/4.  Since the 
click value can be altered, the metronome could effectively give the impression of 8/8 or 4/4 time as 
well.  However, the tempo applied to the meter will be based always upon a quarter note.  See the 
section on Tempo for more information.

Note:  The click amount must always divide evenly into the number of beats (upper or left portion of 
time signature).

Other
When the standard selections do not include the time signature desired you can define one 
yourself using Other.  Encore allows up to sixteen beats per measure (upper or left portion of time 
signature) and units of 1 (whole note), 2 (half note), 4 (quarter note), 8 (eighth note), 16 (sixteenth 
note) and 32 (thirty-second note).

When defining the choice for Other, the number of clicks to be used will be updated to a common 
selection.  If you wish to base the click on another value you can enter the number after you have 
finished defining the time signature.  The click, however, must divide evenly into the number of 
beats.

Hide Meter
Hide Meter will simply hide the time signature defined.  The time signature is still used, however, 
when calculating the correct tempo and number of beats to be applied.  Hide Meter can be used to 
create a pickup within the score.  If a measure of 4/4 is instead defined as two measures, one 7/8 
and the other only 1/8, the time signatures in both measures can be hidden and the result can be 
an eighth note pickup into the next section.

Note:  Measure numbers are unaffected by Hide Meter operations.

Time Signature Reminders
When the next system begins with a new time signature, the previous measure will have a 
“reminder” added by default.  This optional reminder can be hidden from within the Show/Hide 
dialog.  If the next measure’s time signature is hidden, a reminder is never used.

Pickup Bar
The Pickup Bar checkbox performs several functions at once.  A pickup bar displays the time 
signature of the following measure instead of the selected time signature.  In addition, the time 
signature in the next measure is automatically hidden and measure numbers are adjusted for the 
pickup indication. 
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Note:  First Bar is Pickup in the Measure Numbers dialog and the Pickup Bar option in the Set 
Time Signature dialog are connected.  Changing the selection in one dialog will change the option 
in both dialogs.

Special Note:  If the first measure is configured as a pickup bar, the measure range in dialogs will 
be affected as well.  Be sure to take the pickup measure into account when calculating measure 
numbers.  A pickup measure is represented by a zero in the From field of a measure range and can 
be entered into the range by typing the zero key. 

For the pickup selection to work correctly you must select only the one measure to become the 
pickup bar. 

Creating A Pickup Bar
Here is an example for creating a pickup measure of a one 
eighth note pickup leading into a score in 4/4 time.  Before 
you open the time signature dialog, make sure the first 
measure contains the pickup note or notes that you want 
and is not the measure after the pickup bar.  If the pickup 
measure needs to be created, use Add Measure and add one 
measure before measure one.

Select the first measure and change the time signature to 
be the number of beats needed for the pickup.  Since our 
example is going to use one eighth note, the time signature 
will require entering 1/8 in the “other” portion of the 
dialog. 

Put a check mark in the box next to Pickup Bar and click OK.

If you check both Hide Meter and Pickup Bar, the time signature in both the first and second 
measures selected will be hidden.  Measure numbers are only changed for the first measure in 
the score.

If the pickup bar option is removed from a measure, the Hide Meter setting for the following 
measure will also be removed.

Key Signature
Key signatures can be defined for either a portion of the score or for the whole score.  When key 
signatures are changed, accidentals for notes within the section are changed but the pitches can either 
be transposed or left alone.

Selecting a measure range before opening the Set Key Signature dialog will enter the selected area 
into the measure range portion of the Set Key Signature dialog.  The key signature change will be 
applied to all measures between the first and last measure indicated.  Enter a new measure range if 
desired. 

Use the Circle of 5ths buttons to select a key.  To easily understand the circle, the sharp keys move 
clockwise and the flat keys move counter-clockwise, each progression adding another sharp or flat.  
C, at top center, has neither sharps or flats.  
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No Double Barline
Place a check mark in this 
box if you do not wish to have 
double barlines inserted into 
the score at the place of the 
key signature change. 

Just Delete the  Current 
Key Signature

When a key signature needs 
to be removed, the option 
to Just delete the current 
Key Signature should be 
selected.  This removes all 
key signatures for the measure 
range specified.  The new key signature will be a continuation of any key signature used before 
the first measure of the affected measure range, or the key signature will default to the key of C.

Note:  When Just Delete The Current Key Signature is used, the selected key signature is ignored.

Just this staff
By default the Transpose/Key Signature dialog will change the key signature for all staves.  If you 
wish to change the key signature for only one staff, select that staff before opening the Transpose/
Key Signature dialog.  If more than one staff is selected, a check mark placed in the Just this staff 
box will only change the key signature for the lowest staff in the selection. 

Ignore Instrument Transposition Keys
Encore will insert the appropriate key signature depending on the staff’s playback transposition 
(set via the Staff Sheet Window).   For example, if one staff’s playback transposition is set for 
a Bb instrument and one in C, then inserting a key signature of G Major will result in the first 
staff having an A Major signature, while the second will have a G Major signature (“Transposed 
Score”).  

If you select “Ignore Instrument Transposition Keys, all staves to have the same key signature 
(“C” Score). . 

Move Notes
If you want to transpose the pitch for notes as well as change the key signature, place a check 
mark in the Move Notes checkbox and choose the direction the transpose operation should move 
the notes.  Move Notes will also transpose Chord symbols and Guitar Fret symbols. 

Move Endings and Symbols
Normally when you Move Notes, symbols and endings are unaffected and will remain at the same 
vertical location in your score.  Checking Move Endings and Symbols adjusts these items up or 
down along with the notes.

Changing the Key Signature  for Playback
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If you wish to change the key used for an instrument when playing the score, use the Key 
function in the Staff Sheet.  This transposes the notes on the staff to a new key for playback only 
and does not affect the display.

Reminder Key Signatures
When the next system in a score changes to a new key signature, the change is indicated at the 
end of the previous measure by default.  This reminder can be removed by using the Show/Hide 
dialog.

Encore always indicates key signature cancellations and changes within a system.

Barline Types 
Each measure in your score has both a left and a right barline type.  The default barline type is a 
single line drawn between each measure.  The default ending barline is a 
standard double-bar.

The barline type used to indicate repeats can optionally affect playback.

Left and right barline selections affect the first and last measures of 
the selection range only.  Adding repeats to the beginning and ending 
measures of a section can be performed in one operation. 

If measures are selected before opening the Barline Types dialog, the 
measure range and barline types indicated are the current settings for the 
selection.  

	 The left barline type will be applied to the left side of the first measure in the measure range.  The 
right barline type will be applied to the right side of last measure in the measure range. 

Play Repeats
If Play Repeats is checked, the repeat barline type will affect playback.  Repeat barlines combined 
with measure endings will determine how repeat bars are interpreted during playback.

Used without an ending or coda phrase (see Endings and Coda Phrases), the next measure played 
after a right repeat bar will be the previous measure which has a left repeat bar.  If no left repeat 
bar can be found, playback will begin at measure one again.  After a repeat bar has been played 
once in a song without stopping, the repeat will be ignored the next time that bar is played. 

When repeats are used with the Endings and Coda Phrases settings, the next measure played will 
depend on the settings selected from within those dialogs. 

Barline Types will also affect the automatic Compress Rests function when extracting parts.  See 
Compress Rests and Extract Parts for more information.

Endings
The Endings dialog enters measure endings within the score.  Measure endings can be interpreted 
during playback and Encore will support up to six endings for playback.  Additional endings can 
be defined using text boxes but will not be used during playback.

Endings are easiest to define if the measures are pre-selected before opening the Measure Endings 
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dialog, but the measure range can also be entered from 
within the dialog.

When measures are selected that have endings already 
defined, the ending type for the first measure selected will 
be indicated in the dialog.

For endings to be interpreted during playback, the Play 
Repeats checkbox must be enabled.

The font button at the top of the Measure Endings dialog 
determines the font, size and style for the numbers in the 
ending indications.  If Custom text box is selected the 
font selection will also be used for the text box.  Text 
boxes created within the Measure Endings dialog are 
standard text boxes and can be edited further after exiting 
the dialog.  Font selections for measure numbers apply 
to all endings but can be changed at any time.  Open the 
Measure Endings dialog and select a new font without selecting an ending to change the current 
font.  Click OK when you’re through.

The ending indication selected determines both what number or numbers are used for the ending 
and how playback will interpret the ending.  As each ending selection is checked, the field next to 
Custom text box updates to show you what characters are to be entered by default for the ending.

Custom Text Box
When Custom text box is enabled the measure ending will display only the entered text.  
Playback of measures with custom text boxes will still use the endings selected above the custom 
text box to determine how many times to play each ending and what measure is played next.

Lock Ending, Open, Closed 
Near the bottom of the dialog are three choices which affect how the ending is displayed in the 
last measure.  Open refers to a measure ending without a line drawn on the right side of the 
ending.  Closed will draw a vertical line in the last measure enclosing the measure ending.  If 
there is an ending in the selected area already, the current setting is displayed.  If a new ending 
is being defined, the choice will be based upon the barline type. Measures with a repeat or thick 
double bar on the right will be closed.  If the right barline is not a repeat or double bar, the ending 
will be open.  Although Encore will initially select either open or closed for you, the selection 
can be changed.  The Lock Ending option prevents the selection of open or closed from being 
changed later if the barline type is changed.

Changing the Vertical Position  of Endings
The default position for endings can be changed after the ending is created.  A control point in the 
upper left corner of each ending adjusts the height of the ending.  The control point at the lower 
left sets the distance between the top staff line and where the vertical line for the ending begins.  
Click and drag at either of these locations to adjust either part of the ending.

A special control point on the right side of the ending will change the measure ending to either 
open or closed, depending on the current condition.  The status of the Lock Ending checkbox will 
not prevent this adjustment.
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If the [control/option] key is held down while changing an ending using any of the control points, 
all other endings in that system will be adjusted at the same time.  This remains true for control 
points on both the left and right sides.

Coda Phrases
The Coda Phrases dialog contains various musical phrases used to direct the player to another section 
in the score.  When Play Them is selected, phrases entered with 
this dialog will also control playback.

Note:  Coda and segno signs also exist in the Symbols palette.  If 
you enter a coda or segno indication using the Symbols palette, 
the section will not be interpreted during playback.  Only codas 
and segnos entered with the Coda Phrases dialog can affect 
playback.

Also included are the words Coda, Segno and Fine which can 
be selected and placed at the appropriate measure.

You can select only one phrase at a time.

The Style, Font and Size menus determine the appearance of the 
phrase selected.  Font choices apply to all phrases added with 
the Coda Phrases dialog within the score.

Encore places Coda phrases within the selected measure at a default location and can be adjusted.  
Each phrase, however, can be adjusted only within the measure it was added to and will not move 
beyond that measure.

To move the phrase, click and hold on the phrase and move it to the desired location.

Measure Numbers
Measure numbers can be added or removed at any time.  Measure numbers showing in the score will 
also appear on printouts.

Font attributes for measure numbers are selected by clicking 
the Font button. 

Click the Add Numbers checkbox to activate the measure 
numbers function. 

Measure numbers can be shown for every measure, every nth 
measure or at the beginning of each system.  If you select Each 
system, the numbers will automatically update when the layout 
is changed to show the new measure number beginning each 
system. 

The first measure number is optional and hidden by default.  
Enable Start with First Bar if you want a number over the first 
measure.

When the first measure of your score is a pickup measure, 
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click the First Bar is a Pickup checkbox.  The first measure will not have a number and the second 
measure in the score will be called measure one.

Note:  The First Bar is a Pickup selection will affect the time signature settings for the first measure as 
well.  Refer to the section on Time Signature for more information.

If the first measure is already configured as a “pickup bar”, the measure range in dialogs will be 
affected. A pickup measure will be represented with a dash (“-”) in the From field of a measure range.

If you would like the measure numbers to appear in a box, click Enclose Numbers in a Box.

The starting number can be offset by either a positive or negative number of measures using the 
Number Offset box.  An example on how to use this would be in the case of a 4 measure introduc-
tion where you would like measure 1 to be after the introduction.  Place -4 in the box and measure 5 
becomes measure 1.

Encore allows you to indicate whether you want your measure numbers to appear above or below the 
measures.  The default is zero spaces above the measure. Any number from 1-15 can be used.

Compressed Rests
The Compressed Rests dialog is used to indicate multiple measures of rest with the standard graphic 
consisting of a thick horizontal bar and a number for the measures included.

You must select the measure or measures you want to 
“compress.”  To “expand” the multiple rest indication for a 
measure back into standard measures, select only the measure 
with the indication.

Note:  Both options in the Compressed Rests dialog (compress 
and expand) will be grayed out if your selection contains 
either notes or more than one measure with a compressed rest.  
The section being compressed is for ALL staves.  If there are 
notes on any staves (even hidden staves) the compressed rest 
function cannot be used.

When measures that can be compressed or expanded are 
properly selected, the Compressed Rests dialog will automatically select the appropriate option and 
tell you how many measures the operation affects. 

The Horizontal line drawn within the measure defaults to filling 80% of the measure.  Enter any 
percentage between 1 and 100 to change the appearance.  100% will draw the line from the left 
barline to the right barline and completely fill the measure.

Font choices affect all compressed rests within the score. 

Measure numbers always update for compressed rests.

If Play Them is checked the full number of measures represented by each compressed rest will be 
played.  Think carefully about using this option as you may not care to “hear” several measures of 
nothing unless you are rehearsing.

Note:  When compressed rests are created with the Compressed Rests dialog, barline types, text 



The Menus131

boxes and other symbols within the selection are ignored and lost should you choose to expand 
the compressed rests back into standard measures later.  However, when Extract Part is used, the 
compress rests option will consider barline types, text boxes and other graphics and break consecutive 
measures of rests into groups when it encounters these items within the score.

Align Playback
Align Playback changes the MIDI start times for notes within the selected area to exactly match the 
screen representation.  Align Playback can be used to change a real-time or imported MIDI file to 
perform closer to the transcription obtained.  Align Playback can also be used if extensive editing for 
a section requires re-establishing the correct note order and timing.

Align Playback does not affect durations.

A selection is required for Align Playback.

Only notes within the selection are affected by the Align Playback operation.  Multiple areas on a 
page can be changed together using [shift] to select additional areas after making the first selection.  
See Selecting in Encore for more information. 

Swing Playback
The Swing Playback function imparts a swing feeling to a staff by changing the start time for notes 
that fall within the beat or on the “off” beat, and by changing the durations of all notes within the 
measure. 

Swing Playback requires a selection.  Selections made to a portion of a 
measure will affect the entire measure, but each system can be changed 
independently.  All staves of combined instrument staves such as piano 
staves are affected by Swing Playback equally. 

A percentage amount defines how far forward the notes are to be moved.  
50% is equivalent to saying “half the distance between beats,” which 
translates into “no swing.”  The default is 66.7 but any value between 
50.0 and 75.0 can be used.

The Longest duration to swing determines how far the notes are to be moved and how much the 
duration is to be changed.

We recommend experimenting with the settings on a variety of music samples containing different 
note durations and tempos.  The default selection for eighth notes at 66.7 is also a good starting place.  
Rather than try and explain the mathematics for this operation, we’re going to let your ears explain it 
for you.

To remove the effects of Swing Playback you can use either Align Playback or set the swing 
percentage to 50%.  Either option effectively removes the swing effect. 

Align Spacing
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Align Spacing establishes the horizontal and vertical spacing 
relationships between notes, both within each measure and for all 
measures in the system. 

Align Spacing affects all measures on all staves for a range of 
measures.  If the measure range is selected before opening the Align 
Spacing dialog, the measure range will be entered into the upper 
portion of the dialog for you.  The measure range can be changed 
by entering new measure numbers.  The arrow button to the right of 
the last measure selection is a shortcut for selecting to the end of the 
score.

Encore provides two different methods to calculate the spacing for notes, and can also 
alter the layout.

Engraver’s Spacing
Engraver’s spacing follows more of the rules traditional in engraving practices and 
tries to provide a compromise between strict placement within the measure according 
to each note’s duration and the need to more clearly show the contents of the measure 
without overlapping notes or accidentals.

Mathematically Perfect
When Mathematically Perfect is selected, notes are placed in the measure according to their 
indicated duration.  Accidentals are not considered and may overlap as a result of mathematical 
spacing.

Adjust Measure Widths
If the measure range is defined for entire systems (either one or several), the option to change 
measure widths will be available.  This selection tells Encore to change measure widths within 
the selected area according to whatever will best accommodate the notation within each measure. 

Adjust Measures Per System
When the measure range is only for entire systems, you can optionally let Encore adjust how 
many measures are used in each system.  This adjustment will be performed on a system by 
system basis and will use the note density for each system to decide if the number of measures 
can be increased or decreased.

Adjust for Lyrics
This option (checked by default) will consider lyrics connected to notes within the measure when 
making spacing changes and try to avoid overlapping lyrics when altering note locations.

All Staves
This selection is checked by default.  In normal practice the notes on all staves are considered 
when using Align Spacing.  In some instances you may wish to change only the selected staves 
without changing other staves in the system.  Uncheck the All Staves option if you do not want 
Encore to align the entire system.

Tip: 
Hold the [Shift] 
key to bypass the 
Align Spacing 
dialog and use the 
previous settings
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General Spacing Guidelines
Although several options exist within the Align Spacing dialog, the correct choice will depend on 
how much prior spacing has been applied to the score.  Generally speaking, the options to alter 
the number or width of measures should be performed only before graphics and lyrics have been 
added.  This ensures that any prior spacing for these items will not be altered in the process.

After a general arrangement for your score has been decided, Adjust Measure Widths and Adjust 
Measures Per System should not be used again or you may lose spacing considerations that Align 
Spacing does not calculate.

Finally, after adding lyrics and symbols to each measure, you may need to make some final 
“tweaks” to the spacing.  We recommend using Nudge and not Align Spacing.  See the section on 
Nudge under the Edit menu for more information.  

Save often, save well, and save copies of your work as you progress.

Score Menu
Add Page

The Add Page item allows you to enter any number of blank pages either before 
or after the currently displayed page.

All new pages created will use the page layout of the current page.  If you add 
pages after the current page, the last measure of the current page will be used to 
set the time signature and key signature for all measures in the new pages.  When 
adding pages before the current page, the first measure of the current page will be used to determine 
the time signature and key signature for all measures in the new pages. 

Note:  Be careful when adding pages before the first page in your score.  If you have created a pickup 
measure, the time signature of that pickup measure will be used for all measures in the inserted 
section.

Add Page does not have an undo option for the operation.  If you wish to remove the pages added, use 
the Delete Page function.

Delete Page
Delete Page removes pages from your score.  Data in those pages 
gets removed with the pages.

Warning: Delete Page is NOT UNDOABLE!  If you delete pages 
with notation, the notation is lost.  You can use Revert to Saved to 
return to a previously saved version but all edits after the file was 
last saved will be discarded.

Delete Page will be available only when two or more pages exist.  The current page will be entered 
for the delete range but the Delete Page dialog allows a new range for either a different page or more 
than just one page, or both.

The arrow button to the right of the page range fields will enter the page number for the last page.  
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Use this when you want to delete pages to the end of the score.

Caution:  Encore does not allow you to delete discontinuous pages.  The page range includes all pages 
between the first and last page specified.

Add Staff
The Add Staff dialog creates additional Note, Rhythm, Tab or 
Percussion blank staves in Encore.

Add Staff is NOT UNDOABLE.  To remove an added staff, use the 
Delete Staff item.

Add Staff does not require a selection but the current staff (where the 
cursor is located) is used to determine both where the staff is added 
and what operations are available within the Add Staff dialog.

Note:  Add Staff is only available in Page View.

Add _ Regular Staves
As many as 128 staves can be used in Encore, but the total number of staves you can add within 
this dialog may depend on the number of systems each page currently displays.  The total number 
of staves appearing on any one page (including tiles) can be no more than 128.  If the Add Staff 
dialog does not allow you to add the needed number of staves, exit (cancel) from the dialog and 
change the number of systems per page to a number that will not exceed the 128 per page limit. 

Add a Piano Staff
A Piano Staff is a combined staff that defaults to a treble and bass clef, but each staff is linked 
to the other staff to allow for cross-staff beaming.  The Staff Sheet displays one instrument for a 
piano staff and a staff name will be centered between the two staves when using the name field in 
the Staff Sheet.

Voices on Piano Staves
The default voicing assignments for piano staves is as follows:

The top staff (treble by default) uses voices 1-4.  Voice 1 is used by default when inserting 
notes in “all voices” (Voice -) view.

The bottom staff (bass clef by default) uses voices 5-8.  Voice 5 is used by default when 
inserting notes in “all voices” (Voice -) view.

A piano staff can be from two to four staves.  See Add a Staff to this Piano Staff for more 
information. 

Change this to a Piano Staff
If a regular staff is selected before selecting Add Staff, the option to change the staff will be 
enabled.  This option creates only an additional staff and does not move notes onto the staff or 
change any of the notation for the selected staff.  If the staff is added above the new staff, the new 
staff is given a treble clef.  Changing to a Piano Staff and choosing add below will create a new 
staff with a Bass clef.
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Note:  If you wish to create a piano part from a single staff you should consider using the Split 
Staff operation.  Split Staff lets you move notes onto the new staff at the same time the staff is 
created.

Add a Staff to this Piano Staff
If an existing piano staff with (fewer than four staves) is selected before opening the Add 
Staff dialog, the option for Add a staff to this Piano Staff will be enabled. Organ arrangements 
sometimes need more than two staves.  Piano parts for two players can also use the four stave 
system.

The voicing defaults when adding a third or fourth stave will use voices normally intended for the 
bass clef of a piano staff.

The third staff will use voice 7 by default and the fourth staff will use voice 8.  These are the 
default assignments for notes entered in all voices or “Voice -” view. 

Cross-staff beaming requires piano staves.  To create a beam between two staves in a Piano Staff, 
you must use the same voice for notes in both staves.  For instance, to beam an eighth note on the 
treble staff to another eighth on the bass clef, you must enter or change both notes to the same 
voice.  Entering the notes in all voices view will use different voices by default for each, so when 
creating a cross-staff beam, you must select a specific voice before entering the notes.  

You can find a section on cross-staff beaming in Chapter 8, Voices in Encore.

Placement
Add Above and Add Below determine where, in relationship to the current staff, the new staves 
will appear.  If you need to change the order of staves after they are added, you can do so using 
the Staff Sheet. See the section on the Staff Sheet (Windows menu) for more information.

Type:  Note, Rhythm, Tab, Percussion
The drop down menu for the type selection will be available only when you are adding regular 
staves. 

Piano staves are standard note staves only.

Rhythm Staff
A rhythm staff is a single line staff without key signature, clef or barline indications.  Notes 
added to the rhythm staff use slashed note heads and are always placed directly on the single line 
indication.

Although a rhythm staff will play over MIDI, the intended purpose for the staff is to indicate 
the rhythm, so we recommend that you mute the staff within the Staff Sheet to avoid confusion.  
Notes copied and pasted to a rhythm staff will still use their original pitch but will appear at the 
same vertical position on the rhythm staff.

A common use for a rhythm staff will require the staff only for the beginning of the score or 
for new sections.  You can hide the rhythm staff when it is not needed by using the hide staff 
function.  See the section on Hide Staff for more information.
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Tab Staff
The Tab Staff indicates the fingering for fretted instruments.  Each line of the Tab staff refers to 
a string on the instrument, and numbers placed along the string indicate the fingering position 
relative to the instrument’s frets and tuning.  Click on OK-Open Setup to set up the Tab staff.

Tab staves are usually combined with standard notation staves since the durations for each note 
cannot be easily indicated along with the fingering numbers.  A complete discussion of the Tab 
Staff can be found in the section concerning the Make Tab item.  See the Notes menu and Make 
Tab or Tablature Staff for more information. 

Percussion Staff
Percussion staves are used for notating drum and percussion parts.  See Chapter 12 “Percussion 
Staff” for more information about adding and editing a percussion staff.

Delete Staff
When a staff is no longer needed for the entire score, you can use Delete Staff to completely remove 
the staff.

Delete Staff requires a selection.  All selected staves will be removed.

Caution:  Delete Staff is NOT UNDOABLE.  All notation on the staves is deleted along with the staff 
or staves themselves.

If you are working on a score with several instruments and you wish to hide instruments for a section 
when they are not playing, use Hide Staves and not Delete Staff.  The Hide Staves command does not 
remove the staff from the score but simply hides it for the selected system.  Delete Staff completely 
removes the staff from the entire score.

Split This Staff
Split This Staff takes an existing staff and “splits” both the staff and notes, giving you two staves.  
MIDI files with piano parts on a single track can be changed to a Piano Staff within Encore for further 
editing with this feature.  Another use would be to separate two instruments notated on one staff into 
two separate staves for each instrument.

Split This Staff requires you to select the staff you wish to split.  The staff must be a single staff.  
Piano staves cannot be split.

Move these notes to a new staff
Two methods exist for determining what notes are moved to the new staff.  
If the pitch selection is specified, then anything below the entered pitch will 
be placed onto the new staff.  The second method uses the voicing capabili-
ties within Encore to separate notes.  For this to work correctly, the voice 
selected should fill each measure with the correct number of beats.

Note:  If you revoice a section just so you can split a few notes to a new 
staff, remember that changing the voice may require adding rests for all 
affected voices.  It is best to fully align playback after revoicing and adding 
any needed rests.
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Set the Clef to
Four checkboxes are available for selecting the clef to be used on the new staff.  Hybrid clefs or 
additional clefs can be added after the staff has been created.

Keep Notes in a Piano Staff
This option changes a regular staff into a Piano Staff.  If Keep Notes in a Piano Staff is not 
checked, the new staff will be a regular staff.

Connect Staves
Connect Staves creates and removes both Brackets and Braces and breaks the barlines between staves 
in a system.

Connect Staves requires selecting the staves to be changed before opening the Connect Staves 
dialog.  Selection of the staves should be made using the single-click method for selecting a system 
with additional staves selected by holding the [shift] key down.  You can also use “select all” if the 
operation is for connecting an entire system.

Break Barlines
Barlines, sometimes called measure lines, are drawn by default 
between each staff in the system.  When lyrics are added to a 
system it is not uncommon to break the barlines below the staff 
with the lyrics.

Break Barlines removes the barlines between the selected staff and 
the staff below.  If more than one staff is selected, the barlines will 
continue to be broken in the same manner for all selected staves. 

Brace
The Brace or curved bracket, looks like an archer’s bow and is 
placed to the left of a system.  The brace indicates two or more 
staves that are to be read and played together.  The standard use 
for the brace is for instruments such as the piano, celeste, harp and organ.  Piano Staves in Encore 
have braces added by default but these can be removed if you desire.

Bracket
The Bracket or Accolade is commonly used to connect chamber or choral music or to connect 
instruments in the same family for orchestral arrangements.

To add either brace or bracket or to break barlines for selected staves, check the appropriate box.

To remove one of these indications, click in the box again to clear the check mark.  The Connect 
Staves dialog will display any existing braces, brackets or a broken barline state for your selection 
by checking the appropriate box.

Center Staves
Center Staves moves all the staves, regardless of the vertical spacing within each system, to 
equidistant positions on the page.  If the number of staves does not fit, all extra staves are moved to 
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additional tiles.

Caution:  Center Staves is NOT UNDOABLE!

Center Staves is a quick and easy method to redefine the page layout.  After adding or deleting staves 
in your score, or when changing the page reduction amount, you can use Center Staves to establish a 
basic layout that can be further edited as needed.  See Moving Objects in Encore for more information 
about adjusting the page layout for staves and systems.

Center Systems
Center Systems is similar to Center Staves but adjusts only the distance between each system.  Within 
each system, the spacing between staves is maintained.

Caution: Center Systems is NOT UNDOABLE!

Center Systems optimizes the page layout after establishing the system layout.  For final page layout 
of systems and staves see Moving Objects in Encore.

Measures Per System
Measures Per System can change the number of measures for a single system or 
for all the remaining systems, including the current system. 

If you reduce the number of measures for a system, the extra measures will be 
placed in the next system or the next several systems.  When changing the number 
of measures to be greater than the current amount, measures in the following 
systems will be moved onto the current system.

Changing the number of measures per system can also change the number of pages depending on 
your selections and the number of measures and systems on each page.  Encore will attempt to keep 
the number of systems on each page the same.  As measures are needed to fulfill the measures per 
system request, however, unneeded systems will be removed from the end of the score.

You can also change the number of measures in any system without using a dialog by placing the 
insertion cursor in that system and then using the bracket keys “[“ and “]”  to move measures to and 
from the following system.  The left bracket key will move measures onto the next system. The right 
bracket key will move measures onto the current system.

When moving measures in this fashion, only the last system in the score is affected.  Rather than 
continuing to add them to last system, however, Encore will create new systems and pages when 
needed.

New systems are created when the number of measures in the last system equals the number of 
measures in the previous system.  That is, if the last system in your score has only one measure and 
the system before that has three measures, you can “flow” two measures forward before Encore will 
generate a new system.

New pages are created when creating a new system would create more systems than the previous 
page.  This prevents a situation where the last page has numerous systems because you were moving 
measures around somewhere earlier in the score.
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Systems per Page
Systems Per Page changes how many systems appear on either the current page 
or the current page and all remaining pages.

Changing the number of systems per page will frequently change the number of 
pages but will not affect the number of measures in each system.

If the number of systems for a page will not fit on a printed page, the extra systems are moved 
onto “tiles” below the bottom margin of the ‘normal size’ page.  See Printing in Encore for more 
information.

Text Elements
Text Elements defines score titles, headers, footers, page numbers, dates, times and copyright notices 
in your score.  Each item can use a different font, and items that contain several lines (such as the 
Title) can have different fonts defined for each line.

Score Titles 
Three lines are provided for score titles.  Text is automatically centered and appears only on the 
first page.

The title section can use a different font selection for each of the three available lines, but the first 
line is special.  Font changes applied to the first line automatically apply the same font selection 
to the second and third lines whenever the first line is changed.  This provides a shortcut to 
change the title section quickly.
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Instructions
Instructions appear on the left side and are left justified for the longest line, but center justified in re-
lationship to each other.  Three lines are provided and each line can have its own font selection.  Font 
selections act independently of other lines.

Instructions appear on the first page only.

The instructions section can be used for indicating a tempo or style, additional composer information 
or anything desired.

Composer’s Name
Four lines are available for the right side of the first score page.  Traditionally this location is used 
for the composer’s name, but can be used for any text desired.  Each line can use a different font 
selection and selections are independent of the other lines.

Headers and Footers
Headers appear along the top of a page.  Footers appear at the bottom of a page.  You can create 
two different header items and footer items for each score. 
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Header and footer contents can combine text with automatic options for adding page numbers and 
time indications.

Justify options can place each header and footer on either side or centered.

Flip on even/odd pages takes the page number into account when placing header and footer items 
on the page.  This is especially useful if you will ultimately be printing two-sided pages and 
binding your score.  For example, if you use a right-justified header to print a page number on 
your score and check Flip on even/odd pages, the first page number will appear on page 1 in the 
upper-right corner.  Page 2’s number will appear in the upper-left corner.  This placement will 
hold true for all subsequent odd- and even-numbered pages.

Page, Date and Time
#P is used to indicate the current page number.

#D is used to display the current date in the format mm/dd/yy.

#T is used to display the time.

Date and time indications will update as you work on the score.  These indications are saved as 
special instructions and not as the actual date or time when the score is saved.  Every time you 
open the score, these settings will reflect the currently displayed time and date for your computer 
as defined in Windows’ Date/Time Control Panel or Mac’s System Preferences.

Start on Page
Start on Page indicates which page begins showing numbering options using the #P option.  For 
example, if you type a 3 in this box, you won’t see page numbers for pages 1 and 2 and page 
numbers will start on page 3.

Note:  This feature only hides page numbers.  It does not re-paginate.  Use Page Offset to re-
paginate.

Page Offset
Using an offset allows two different scores intended to be first and second sections for the same 
score, to be printed with a consistent page reference.  For example, if your first section ended on 
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page 33, you can continue the page numbering for the second file by entering the number 33 into 
the page offset.  Now the second section can be numbered starting with page 34. 

Copyright Notice 
Copyright information is centered at the bottom of the score.  Six lines are provided for copyright.  
Each line can use a different font selection.  Font changes are made independently from other 
lines.

MIDI Device/Instrument Settings

The Staff MIDI Device and Instrument Settings dialog provides access to all instrument settings.  You 
may assign instruments/ MIDI channels to any staff, to any voice, from any device or bank as well as 
adjusting the Gain, Pan and Reverb Level.  Encore has the capabilities to use two copies of the built 
in synthesizer, thereby doubling the number in individual MIDI channels.  This enables you to hear a 
score with full instrumentation without using multiple MIDI devices.
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Use the staff selection to indicate which staff you would like to assign the device/instrument with the 
staff name drop down menu.

Select the Playback Device.  This can be the Built-in Synths, a MIDI device plugged into your 
computer, another MIDI enabled application or one of the IAC busses  

Set the Playback Device’s Bank.  If you are using the built-in synth, the default bank is Apple’s 
General MIDI DLS, but you can use any DLS or SoundFont file you wish.  To do so, simply place 
the DLS or SoundFont file into your /Library/Audio/Sounds/Banks folder.  The next time you launch 
Encore, the DLS/SoundFont files will appear as an option in the “Bank” menu.

If you are using an external MIDI Device, a popup menu allows you to choose a common mapping 
of instrument names to MIDI instrument number.  The default mapping uses General MIDI standard, 
to which most newer synths adhere.  For more advanced synths, text fields are displayed for Bank 
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settings on the device.  The MSB setting corresponds to MIDI Controller #0 and the LSB setting 
corresponds to MIDI Controller #32.  Refer to your synth’s documentation for more information 
about Bank control messages.  Select which voice in this staff will use this set up.  Encore defaults to 
All Voices.

Click on the grid to select the instrument patch on the playback device you want to use for the 
selected staff/voice.  A test note will be played.  Hitting a key on the computer keyboard will play 
another test note.

Select the MIDI channel.  It is best to assign each staff to its own MIDI channel.  If staves or voices 
share MIDI channels, then you must be careful to ensure that they use the same settings, otherwise 
unpredictable conflicts may occur.

Adjust the Gain (volume) by moving the slider.  If the slider is all the way to the left, then the gain is 
at maximum.

Adjust the Pan to determine speaker balance left, right or somewhere in between.

Adjust the Reverb Level as desired.

Repeat the process for each staff and voice.

Click OK.

You may make all of your instrument assignments in one use of the dialog and then hit OK.  There is 
no need to have to reopen the window for each staff or voice.

MIDI Playback Settings
Music is just a bunch of notes if there is no life to it.  With MIDI Playback Settings, you can bring 
music to life or close to it (nothing can replace a “live” musician) by adjusting the velocities of 
dynamics and markings.

The MIDI Playback Settings window allows you to control dynamics velocities, Send Volume 
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Control, Change Note Velocities, Humanize, Play 
Pedal Markings, Slurs, and Hairpins, Ramp to 
Ending Dynamic, Always Change Dynamic By n, 
Play Marks  including Accents and Articulations.

The Dynamics settings allow you to customize the 
velocity range for each dynamic marking.  The Send 
Volume Control check box sends the dynamics data 
within the ranges selected to MIDI controller #7 
(volume).  If you are using the Garritan Studio to use 
Garritan’s instrument samples, Encore will recognize 
the Garritan Studio and send the volume message 
to the Mod wheel as per Garritan’s specifications.  
Change Note Velocities replaces the recorded 
velocities with the velocities specified in the 
dynamics ranges.  The Humanize feature uses more 
random attack velocities and volume velocities.

Play Pedal Markings activates the sustain pedal controller #64 when indicated and releases when 
indicated in the score.

Play Slurs sends MIDI legato to controller #68.  This adjusts the attack and decay of the notes in the 
slur to make them more legato or smooth.

Play Hairpins contains two options.  The first, Ramp to Ending Dynamic, enables Encore to scan 
ahead to the next dynamic marking and smoothly crescendo or decresceno.  The second option, 
Always Change Dynamic By, makes all hairpins perform in the same way, increasing or decreasing 
by n  velocity from the last dynamic marking before the hairpin. 

Play Marks allows you to change velocity and duration for specific accent and articulation markings.

View Menu
The View menu contains several methods to select both how the score is viewed and what items are to 
be shown within the score.

Show/Hide
Show/Hide contains checkboxes to either show or 
hide notational elements and page layout options 
such as a rulers and page margins.

To show any of the selections in the Show/Hide 
dialog, enable the checkbox next to the item (that is, 
click in the box so a  appears).  With the exception 
of rulers, all selections in the Show/Hide dialog 
affect only the current score and are saved for each 
score independently. 

Rulers
Rulers are useful in page view when aligning 
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several objects at different locations.  You can select either inches or centimeters.  Ruler status 
(on or off) is saved with a score only, but the selection of inches or centimeters is saved in 
preferences.  The inches or centimeter selection applies to all open scores. Rulers are not 
available on Mac.

Staff Name
Staff names can be displayed on the first page or on every page in the score.  When displaying 
the staff name on each page, the names are displayed for the top system only.  Staff names are 
designated in the Staff Sheet.

Control Points
Control points are the small squares at the end or corners of many graphic objects that are used to 
define the shape and/or length of the graphic.

Cancellation Keys
Key signature changes that occur at the beginning of a system can be displayed at the end of the 
previous system.  This indication is called a “reminder” key signature. When cancellation keys 
are hidden, this reminder is removed from the end of systems. 

Encore will always display the cancellation of accidentals for key signatures that occur within a 
system. 

Initial Clef & Time
Hiding the initial clef and time signature can come in handy when you want to print blank 
manuscript paper.

Background
There may be times when you have resized the score window, allowing a portion of the 
background to become visible.  When the Background option is selected, the program background 
will be a graphic pattern.  When Background is not selected, the background is solid gray.

Page Margin
The Page Margin indicates the area of graphic information that will be printed.  Staves and 
systems cannot be placed outside this area and graphics and text should remain inside the page 
margin.

When Page Margins have been enabled a broken line will indicate the page margin within your 
Score window.

Print Rhythm Staff Line
A rhythm staff is a single line staff without key signature, clef or barline indications.  Notes 
added to the rhythm staff use slashed note heads and are always placed directly on the single line 
indication.

When “Print Rhythm Staff Line” is selected, the rhythm staff and any notes or rests it contains 
prints just as it appears onscreen.  When this option is not selected, the notes and rests print, but 
the line itself does not.
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Left Barline/Single Staves
This option has an effect only when your systems consist of a single staff.  When selected, the left 
edge of each staff has a bar line; it is “closed.”  When not selected, there is no bar line; the left 
edge of each staff is “open.”

MIDI Items
MIDI Items refers specifically to the text indication added to the score when controller or 
program changes are added using the Tools palette.  Even when MIDI items are hidden they 
continue to affect the MIDI playback of the staff they are attached to. 

By hiding MIDI items you can enter more appropriate text strings for the event.  For example, 
you may use a different program on your synthesizer when a change in tonality is needed, but the 
basic instrument could remain the same.  By hiding the MIDI item and adding a text box instead, 
you can indicate the performance change using more suitable terminology.

Encore also has the option to print the MIDI items on the score by checking the Print MIDI Items 
box.

Time Signature
Time signature changes that occur at the beginning of a system can be indicated at the end of the 
previous system.  This is called a “reminder” time signature.  When time signature reminders are 
hidden, the time signature will only be indicated in the measure where it begins.

Key Signature
Key signature changes that occur at the beginning of a system can be indicated at the end of the 
previous system.  This is called a “reminder” key signature.  When key signature reminders are 
hidden, the key signature will be indicated only in the measure where it begins.

Color
Encore gives you the ability to display and print your music in color.  This can be useful for 
showing different parts or for differentiating between voices on a single staff. Situations may 
arise, however, where it is necessary to “hide”. 

If your printer is capable of printing color or grayscale images, and you want a color score to print 
in black and white, deselect the In Printout checkbox and the score will print in black and white.

Rests
Rests for each voice in Encore can be hidden.  The default has the rests showing for voice 1 and 5 
as these two voices are used for the treble and bass clef of the piano staff.

Hiding rests in Encore is provided because different uses for each “voice” may arise.  If a 
second voice is needed for only part of a measure, it may not be appropriate to use a rest in the 
first portion of that measure.  At other times, perhaps for the same instrument, rests may well 
be needed for more than one voice indication.  In many cases, the “voice” being indicated may 
technically be considered the same (in regards to the actual music indicated) but the need to 
sometimes hide or show the rests will require using two different voices to achieve that result.  
With eight voices provided, Encore gives you plenty of choices to cover even the most complex 
voicing situations.  See Chapter 8: Voices in Encore for some examples using hidden rests.
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Show Control Points
This shortcut toggles between showing and not showing the control points.

Use Handwritten Music Symbols
Encore has two music 
writing fonts, Anastasia 
and our NorMusic Font.  
By  choos ing  th i s  i t em, all 
notes  and symbols  wi l l be 
notated with a handwritten 
look.  After turning this option on, 
you may manually change 
any of the text fonts to one of 
Encore’s handwritten style “NorScript” fonts.

Spacing Defaults 
This function sets global defaults for beam stem lengths, beam 
thicknesses, horizontal/vertical tie offsets, and measure spacing 
(distance between barline, clef, time signature, and key signature).

Each score can store its own set of spacing defaults but an initial 
setting is determined by the preferences or template file settings.

Change Score Colors 
The Change Colors dialog gives you a way to make global color changes 
and to change the color of other score elements like staff and bar 
lines.  In order to save the color selections as a default, make your color 
selections and then Export the score as a Template or as the default score 
setting.   

The drop down menu enables you to change the colors of specific score 
elements:  Notes and rests in voices one through eight, inactive voices, 
other symbols, and the background.  Inactive voices are the voices 
that normally “gray out” when you’re using the Voice Selector to view 
individual voices.  “Other Symbols” are the non-note/rest objects you 
have entered into your score like text and chord symbols.

Near the top of the Change Color dialog is the Color pop-up.  Click on 
the color box and the pop-up menu will appear to gain access to the 16 
available colors.

The graphic below the drop down menu provides a visual representation 
of each of these items.  Choosing a color for any of the items will cause 
its color to change in the graphic. 

The Staff Lines list box displays each of the staves in the score.  To 
change a staff’s color, select a staff in the list box and choose a color 
from the pop-up.  Press and hold the [shift] key to select multiple staves.
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Guitar Frets
Chord indications in Encore are either text only or text and guitar fret indications.  With the Guitar 
Frets dialog you can change between either display for any selected section in your score.  

Guitar Frets requires you to select the chords you want to change.  Select the chords and open the 
Change Guitar Frets dialog.

Show Staves
Show Staves shows hidden staves within a system or systems.  The menu item requires a selection, 
and all selected systems will be affected.  To better understand the process of showing staves, refer to 
the following section regarding the hiding of staves.

Hide Staves
Hide Staves hides one or several staves on a system-by-system basis.  You can hide a staff for as 
many systems as you desire, and different staves can be hidden in different systems.

The uses for Hide Staves are many, but a standard use is to hide staves within the arrangement for 
instruments that are not performing.  Another use may be to hide the entire drum track of an imported 
MIDI file.  

Hide Staves requires a selection.  The selection can be one or more staves and can cover one or more 
systems.  All selected staves will be hidden.

Hiding staves in Linear View mode is temporary.  Hidden staves are all shown when switching from 
Page View to Linear View.

The Hide Staves and Show Staves menu options do not use dialogs and are not undoable.  

Linear View
Linear View changes the normal system-by-system view arranged vertically on each page into a con-
tinuously scrolling view with only one system arranged horizontally.

If staves have been hidden in page view they will be showing in Linear View, but staves can also 
be hidden while in Linear View.  However, when hiding staves in Linear View, the change is only 
temporary and will neither affect hidden staves in page view nor be remembered for the Linear View 
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selection.  

Linear View does not affect the printing of your score.

Hide Floating Windows
Encore has several floating windows.  Floating windows  always appear “in front” of other windows 
in a program; they can be hidden only behind other floating windows.  In Encore, the palettes, the 
Tempo and Keyboard windows, and the Toolbar are all floating windows.  They will always appear in 
front of the Score window and the Staff Sheet.

The Hide Floating Windows command gives you an easy way to remove these windows from the screen 
without actually closing them.  This is especially helpful with smaller monitors or at low resolutions.

Choose Hide Floating Windows from the View menu and any of the floating windows on the screen 
disappear. Choose Show Floating Windows and they reappear.

Note:  Floating windows must be opened from the Windows menu before you can use the hide/show 
command.

Windows Menu 
The Windows menu contains the Palette sub-menu, the Staff Sheet, Keyboard, Tempo Window, Cus-
tomizable Toolbar, and all open scores.

Minimize Window
This sends your window to the OSX dock and may be resized by clicking on the icon in the dock.

Zoom
This expands Encore’s window to the full screen.

Open All Palettes
To open all 11 palettes, use this command.  The palettes will be displayed on the left side and may be 
relocated by dragging. 

Close All Palettes
To close all 11 palettes, use this command. 

Palette
To open any or all of the 11 palettes, select Palettes in the Windows menu and select from the palettes 
sub-menu that appears.  Palettes that are already open will have a check mark next to them.  Palettes 
are closed by clicking the palette’s Close box.  

Open palettes and their locations are saved with preferences and recalled the next time you run 
Encore.

In addition to opening each palette, you can also switch any open palette to one of the unopened 
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palettes.  Click to the left or right side of the palette’s name to change the palette to the next unopened 
palette in the list.  The right side selects the next palette below the current palette name in the list, and 
the left side selects from above. You can continue using this method to access unopened palettes until 
you reach the desired palette.  

Staff Sheet

The Staff Sheet configures each staff for playback and for the name displayed for the staff.

Play
To the right of the staff number is a field in the Staff Sheet that represents the play status for each 
track.  By default, each track will be “play enabled” and represented with a solid triangle.  To 
“mute” a track, click directly on the triangle.  This turns the center of the triangle white and all 
MIDI playback for that track will cease.

Staves can be muted at any time and as many staves as desired can be muted.  The mute status is 
saved with the file.

Solo
The solo field provides an easy method for temporarily disabling other staves to allow a single 
instrument or instruments to be heard.  Click in the solo field for the staff you wish to solo.  A 
solid diamond indicates a soloed staff.

Staves which are not soloed will reflect their temporary mute status by changing the play 
indication (the solid triangle) to gray.

As many staves as desired can be soloed, and the solo function can be enabled and disabled while 
playing.

Name
The Name field is used within the score when Show Names is enabled in the Show/Hide dialog.  
The name is always placed to the left of the staff and will be centered between the staves of a 
piano staff.

Click in the Name field to open the Staff Name dialog and enter a name for the staff.  You can 
also use this dialog to set the font and style for the name as it appears on the score.

Staff names are always right justified against the staff.  If you want to change this, enter spaces 
after the name to offset the staff name.  Line returns can be used as well.

Size
Encore provides four sizes for staves.  Click the Size field to open the Set Staff Size dialog.  Staff 
sizes can be set independently for each staff.  Use the provided checkbox for changing all staves 
at the same time.   Move the slider from 1 to 4 to set the staff size.
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Key
The Key field in the Staff Sheet transposes only the playback of the staff.  Clicking in the Key 
field opens a dropdown menu with a list of all known instrument transpositions.

The Key function transposes individual instruments (staves) within a score to their proper key 
when playing back.  For instance, you could write a band arrangement with each instrument in its 
notated key, and by setting the playback transposition of each instrument be able to playback the 
score at sounding pitch.  Another example concerns writing guitar transcriptions.  Since the guitar 
sounds an octave lower than written, you need to set the playback key to “Octave Lower (C)” to 
hear your transcription playback in the right octave.

MIDI Channel (Chnl)
When a cell in the ‘Channel’ column is clicked, the MIDI Device/Instrument dialog will appear.  

See MIDI Device/Instrument Settings for more information earlier in this chapter.

Program Name
The Program Name field selects a “patch” setting for your synthesizer.  The selected program 
(or patch) is one of the 128 numbers used in the MIDI protocol and the selection is sent to the 
synthesizer whenever playback begins from the start of the score.

The Program Name field has two display settings.  Change these settings by clicking on the 
Program Name (or Prg) at the top of the Staff Sheet.  The width of the column used for the 
program name will expand and collapse when toggling between the two display settings.

When expanded, the Program Name column uses a text description for the currently selected 
program number and MIDI device.  The collapsed view uses only the MIDI number reference.  In 
either view the indication will be for the first voice only.

When a cell in the ‘Program Name’ column is clicked, a popup menu appears allowing you to 
select the program for the staff’s current device. 

This setting will affect the voice currently displayed in the score’s voice menu.  If a single voice 
is being viewed, text will appear at the top of the Staff Sheet Window to remind of which voice 
you are viewing/editing.  Alternatively, you can click on a Channel or Gain cell to open the Staff 
MIDI Device and Instrument Settings dialog.

Staff MIDI Device and Instrument Settings
The Staff MIDI Device and Instrument Settings dialog appears when you click in the Channel column 
to choose an instrument sound (MIDI program change number) for that staff.

Device Names
The default device selected in the Staff MIDI Device and Instrument Settings dialog is “Built-In 
Synth.”  To choose from one of the other included devices, use the Device menu in the dialog.  A 
more complete description of the Device menu appears later in this section.

128 Program names are available for each device but not every synthesizer will use all 128.  
Some synthesizers may have more than 128 programs stored, but the MIDI Program definition 
only uses 128.  To use other programs on your synthesizer you will need to change the location of 
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the program to one of the locations that can be recalled using the standard program numbers.

To select from any of the available program names, click on a program name in the matrix of 
names.  When the ‘focus’ is set to the program name matrix, you can use the arrow keys to select 
different programs. 

Assigning Different Programs  for Each Voice
The Voice text box in the upper right corner of the Staff MIDI Device and Instrument Settings dialog 
lets you choose which voice the current program selection will affect. When Voice - is selected, 
changing the program selection changes all other voices to the same selection.

To make individual selections for each of the eight voices, select the voice from the voice menu and 
then make your selection.

Encore allows you to use a different MIDI Channel and program for each of the eight voices.  Normal 
use of the voices will not require unique sounds for each voice.  When writing for two instruments on 
a single staff, you can assign a different program name for each voice used.

Note:  To use different program names you must also use different MIDI channels for each voice 
assigned a different sound.  For example, if you used voice 1 for a trumpet and voice 2 for a trombone 
you would need to assign voice 1 to one MIDI channel and voice 2 to a different MIDI channel.  
If the other voices were unused they should be assigned to “none” to avoid interfering with other 
selections on different staves.

Staff Selection
The Staff MIDI Device and Instrument Settings dialog allows you to make your device choice 
for one, multiple or all.  When All Staves is enabled, changing the device type for one staff will 
change the device referenced for all other staves as well. 

The Choose Program Dialog
In collapsed view the Program Name field will display only the number reference for voice one 
in the Staff Sheet.  Clicking on the Prg field will open a drop down menu of the instruments 
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available to the device as set in the Staff MIDI Device and Instrument Settings dialog.

Voices Settings
The voice selection drop down menu provides options for program assignment for all voices or 
for individual voices in a staff. 

Gain (Volume)
Gain is controlled through the Staff MIDI Device and Instrument Settings dialog with the fader at 
the bottom.

Changing the Staff Sheet Order
The order in which the staves appear within the system can be changed from within the Staff 
Sheet.  Changes made to the staff order affects all systems. 

Note:  Changing the staff order will change the status of hidden staves.

To change the location of a staff, click on the number for the staff in the Staff Sheet and drag the 
staff up or down to the new position.  Release the mouse button and the staff will be moved to the 
new location. 

Note:  We strongly recommend that you remove any braces or brackets before rearranging the 
staff order.

Keyboard Window
The Keyboard window is a graphic, on-screen keyboard that can be “played” with your mouse or 
from your computer’s QWERTY keyboard.  This enables you to input music from a keyboard in step 
time or real time without the need for a MIDI keyboard.

Playing the Keyboard
To play the keyboard with your mouse, simply click on the keys.  If you’ve got a soundcard or 
a MIDI sound module connected to your computer, you will hear the notes sound as you click 
on the keys.  The instrument sound you hear is determined by the channel and program settings 
for the active staff (the staff that contains the blinking insertion cursor).  The MIDI program and 
channel settings are made in the Staff Sheet.

A
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To play the graphic keyboard from your computer’s keyboard you must first enable QWERTY 
note entry mode.  Click the checkbox labeled QWERTY Keyboard Note Entry in the lower 
left corner of the Keyboard window.  The “lights” on the little keyboard icon turn green and 
QWERTY note entry mode is enabled.  The illustration shows the QWERTY keys you can “play” 
and their corresponding notes.

Input notes in step time or real time just as you would with a MIDI keyboard.  You can even use 
the QWERTY keyboard to parse chords.  (See Chord Parsing in the chapter “Using the Palettes.”)

Note:  When recording in real time from the QWERTY keyboard, turn Follow Playback off in the 
Setup menu for the best results. 

Chords
As you may already have noticed, you can’t enter chords with your mouse.  You can play chords 
on your QWERTY keyboard, but the number of notes may be limited with certain key combina-
tions.  There is, however, a simple method for step-entering chords.  Hold the [shift] key and click 
on the notes that make up the chord.  When you release the [shift] key, the notes will be scored as 
a chord.

You can also use the [shift] key to enter chords from your QWERTY keyboard.

Changing the Octave
You can click any of the keys in the Keyboard window with your mouse, but if you’re using the 
QWERTY keyboard your range is limited to an octave and a fourth (from C to the F in the next 
highest octave).

To shift the range up or down by octaves, drag the little QWERTY keyboard icon in the Keyboard 
window.  You can drag the keyboard icon left or right in one octave increments.

Watch Staves/Setup
When you play back a score in Encore, the Keyboard window will indicate which notes are being 
played.  The Watch Staves (Windows) or Setup (Mac) button opens a dialog that allows you to 
choose which of the score’s staves will be displayed in the Keyboard window during playback.

If the notes in the score have been set to a particular color, the appropriate keys in the Keyboard 
window will “light up” with that color when the notes play.  This comes in handy while viewing 
different staves or voices simultaneously on the keyboard.

Displaying Notes on the Keyboard
Encore’s ability to display the score’s notes on the keyboard can be a useful educational tool, 
but if you’re playing the piece back at tempo, it may be difficult to see the individual notes and 
chords.  If you use the arrow key selection technique while the Keyboard window is open, the 
selected notes will be highlighted on the graphic keyboard. 

Using the arrow pointer, place the insertion cursor next to the note or chord you’d like to view.  
Hold [control/command] and press the left or right arrow keys to select the event.  The note or 
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chord is displayed in the Keyboard window.  The notes appear in the Keyboard window with the 
color assigned to them in the Score window.  Only single events (one note or chord) in a single 
staff can be displayed at one time.  You can hold [control/command] and press the left or right 
arrow repeatedly to step through the score. 

Tempo Window
The Tempo window provides a quick and easy way to globally alter the tempo of a score.  Changes 
made with the Tempo window will scale the tempo for the whole score, even when tempo changes 
within the score.

Changing the Tempo
The Tempo window displays the current tempo in beats per minute (bpm).  The displayed tempo 
is for the measure that contains the insertion cursor.

There are two ways to change the tempo:

	 Drag the tempo control up or down to choose a new tempo.  You can even do this during 
playback to continuously vary the tempo.

	 Use the “+” and “-” buttons to slowly and accurately increment and decrement the tempo.

Resetting to the Saved Tempo
The Reset button causes the score to revert to the saved tempo.  This can be very helpful if you 
simply want to make temporary changes (for example, to record a particularly difficult passage in 
real time).  If, however, you save the score after changing the tempo with the Tempo window, the 
tempo will be permanently altered.

The Tempo Window and Tempo Changes
If you use the Tempo window to alter a piece that contains tempo changes, all of the tempos will 
be scaled accordingly.  Let’s say a piece starts out at 100 bpm.  Then, after four bars, the tempo 
changes to 200 bpm.  If the insertion cursor is in the first four bars, the Tempo window displays 
100 bpm.  If you change the tempo to 50 bpm, the tempo will now change to 100 bpm at measure 
5. Both tempos are reduced by 50%.

Customizable Toolbar
Encore features a floating, customizable Toolbar.  This Toolbar contains icons that represent 
commonly used Encore commands.  (All of the icons and their related functions are shown at the end 
of this manual on the pages entitled Toolbar Icons.)  Rules about selection and cursor placement still 
apply; the toolbar simply provides a convenient shortcut.

The Toolbar is a floating window so it is affected by the Hide/Show Floating Windows command in 
the View menu.

Customizing the Toolbar
The Toolbar contains a few icons by default, but it is fully configurable.  You can choose the 
icons and the order in which they appear.  This is accomplished with the Toolbar Setup item in the 
preferences menu.  For more info see Toolbar Setup.
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Open Scores
At the bottom of the Windows menu is a list of all new and currently open songs in Encore.  A check 
mark will appear next to the active song.  MIDI and Master Tracks Pro files, before they are saved as 
Encore files, have the words “MIDI File” or “MTPro File” added to the end of their file name.  This 
indicates that the notation information has not been saved in an Encore file.
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The Menus for Windows Chapter Seven

Encore contains nine menus.  The first two, the File and Edit menus, contain all the usual 
commands plus a few unique to Encore.  The next six, Notes, Measures, Score, View, Windows and 
Setup,  contain operations for defining the contents and behavior of the music.  The Score and View 
menus are used for general aspects of score layout.  The Windows menu contains a list of your open 
scores and lets you open the Staff Sheet and various palettes.  The last menu is the Help menu.

File Menu
New

When you create a new score, you have three basic Staff Formats from which to choose:

• Piano (default)  • Piano-vocal  • Single staves 

Piano Staff
A Piano staff in Encore is a special combined staff 
that appears as only one item in the Staff Sheet.  
A piano staff is the only staff type that allows 
cross-staff beaming.

Piano-Vocal Staff
A Piano-Vocal score uses the Piano staff described 
above and adds a single staff with a treble clef 
above the piano staff.

Single Staves
The Single staves format is used for any arrangement greater than the above.  A maximum of 64 
staves can be created.

Measures Per System  Systems Per Page
A system is a group of instruments.  In Encore, the number of instruments that appear in the Staff 
Sheet is one system.  The number of systems per page times the number of staves per system 
cannot be greater than 64.

Note: It may seem obvious, but the staves will either have to be very small or the page extremely 
large to fit 64 staves on “one page”.  Encore can accommodate any size page as defined by your 
page set up.  If you decide to only use standard paper sizes, a single page in Encore can consist of 
several “tiles.”  Refer to the section on Tiles under Printing for more information.

Starting Template
Encore comes with over 30 templates from which you can choose.  Encore also lets you create 
your own personalized templates to put in the Starting Template window.  To add your personal 



The Menus- Windows159

templates, simply create a score with the information you know want in it, (composer name, 
copyright, MIDI settings, etc.) and Export it as a Score Template.  

Make a “C” Score
Encore saves the templates as transposed scores with all key transpositions and playback 
adjustments ready to go.  However, if you would rather work with a “C” score, check this box and 
all playback transpositions will be removed so that every instrument will sound as written.

Use Handwritten Style
Encore offers two font styles, Anastasia, a real classic classical font, and Encore NorMusic for 
a handwritten, jazz style font.  By checking Use Handwritten Style, all of the template’s font 
settings will be replaced with the Encore NorMusic font library.  In addition, all symbols will be 
drawn in the handwritten style.

Create, then open using Wizard Windows
Encore will take you through all the windows needed to completely set up a score. These 
windows include:

		  Key Signature

		  Time Signature

		  Text Elements

		  Staff Sheet

Create
Create will skip the Wizard and let you get right to your score to start writing.

New Default Score
The item will create a new default score.  The default score is a piano score in C and in 4/4.  You may 
set the default score to whatever set up you would like to use.  Please refer to the Export menu item 
for information on saving a default score.
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Open
The standard File Open dialog is used for the Open command and all four file types usable in 
Encore® and MusicTime® files, Master Tracks Pro®, MusicXML and MIDI files can be opened.

After opening, MIDI, Music XML, or Master Tracks Pro files will be guessed and beamed unless the 
Auto Guess/Beam item in the Setup menu is disabled (a check mark next to the Auto Guess/Beam 
selection in the Setup menu indicates the choice is enabled).

Until a score is saved as an Encore file you are making changes only to the raw MIDI data, and any 
graphic information you change is temporary.

Starting with version 3.0, Encore for Windows can open files created with Encore for the 
Macintosh®.  Save the files with the appropriate name and extension (*.enc) on the Macintosh. 

To open Windows files in Encore for the Macintosh, simply move them onto your Mac and select 
Open from the File menu. 

Close 
Choosing Close closes the active Score window.  If you make changes to a score you will be asked 
if you’d like to save those changes before closing the file.  With MIDI and Pro files not yet saved in 
Encore, you will be asked if you wish to save the file as an Encore file before closing, even if you 
have saved changes.  This avoids any confusion since graphic information is saved only in an Encore 
file.

Save 
Choose Save to keep any changes made in Encore to the active file.  If the file has not been saved, 
the Save As dialog will appear and you can enter a new file name.  See the Save As section for more 
information.

If you have opened a MIDI or Master Tracks Pro file, you will always be prompted with the Save As 
dialog when Save is selected.  This reminds you that all of the graphic information you are working 
with in Encore is saved only if you create an Encore version of the file.

As with all computer files, in addition to using Save to update your score for any changes you make, 
we recommend that you also save backup copies onto different volumes (hard drives or diskettes).  
How often you choose to do this is up to you, but consider how much time it would take to recreate 
a lost score if and use that as a guide.  One or two backups before you start or stop working is a good 
habit to get into, but if you work for several hours on a score, you should use Save As in addition 
to using the Save function and create alternate versions as you go along.  Since Encore scores are 
relatively small, a diskette is both an efficient and cost effective way to make backups.  Use Save As 
to make backups.  See the Save As section for more information.

Save As 
Save As is used to save Encore scores that are new untitled scores or MIDI, MusicXML and Master-
Tracks Pro files that were opened with Encore.  Save As will save in the Encore format.

The Save As dialog you’ll see is the standard Save As dialog for your platform. 
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Revert to Saved
The Revert to Saved function allows you to disregard all the edits made to a score since the last Save 
operation.  Revert to Saved is frequently used as the ultimate “undo”.  Most edits in Encore can be 
undone using Undo in the Edit menu, but only the last edit operation can be undone.  If you decide 
against a series of edits, you can use Revert to Saved to discard all of your edits and start again 
without closing and reopening the file.

Of course, if you choose Close before saving changes, you are always asked if you want to save 
changes at that time.  If you tell Encore not to save those changes, you will be duplicating the Revert 
to Saved function.  The only difference is the file will remain open if you choose Revert to Saved.

Export
Since Encore can also open MIDI, Music XML and Master Tracks Pro files, any file that can be 
opened in Encore can be exported as any other file type available to Encore.  This means that Encore 
files can be exported as MIDI, Music XML and Master Tracks Pro files. 

If you would like a score to serve as the default “template”, the blank score that opens when Encore 
is launched, you may export the desired file as Current Score Settings to Default Score Template.  A 
template file is useful for saving information such as MIDI Channel choices and program assignments 
for each voice and for several staves.  You can also customize the layout, have the copyright 
information already entered or even go so far as to include some music or initial notation.  Basically, 
anything that you can save as an Encore file can be saved as the default Template.  To add additional 
templates to the new score window, export to Score Template and follow the prompts to name it.

Extract Part
The part extraction function allows you to quickly create a new score containing one or more staves 
of a multi-staff score.  Most often this function will be used to create individual parts for each player 
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from a larger composition.

Select the staff or staves you want extracted.  All the staves between your top and bottom selections 
will be specified as the staff range for the new score.  You can specify the staff range within the 
Extract Part dialog as well.  If you want to extract several instruments to the same score, but they 
appear at different vertical positions in your system, 
you can rearrange their order in the Staff Sheet 
window before using Extract Part.  For more about 
the Staff Sheet, see the section on the Windows 
menu.

Auto-Compress Rests
When Auto-compress Rests is checked, all 
empty measures in the score that do not include 
special barlines, coda phrases, text boxes or 
graphics will be compressed automatically 
for you.  The font selection for compressed 
rests will be the same as that specified in the 
Compressed Rests dialog. (See Compressed 
Rests in the Measures Menu section for more information about compressed rests within Encore).

The extracted part is given a default name using the score name the part was extracted from and 
the name of the top staff selected when extracting the part.  Combined staves used for piano and 
organ notation are always extracted fully and include both or all staves for the instrument.

Extracting Text and Lyrics
If you choose All Text Boxes in the Extract Part dialog, every text box on every page will be 
added to the new score.  You may select where you would like the text boxes to appear, above or 
below the staff of the extracted part. 

When creating a full score or scoring parts for a section, it is not unusual for various text instruc-
tions to be placed above the top staff only.  If you enable the Text from Top Staff (Windows) or Text 
from Staff 1 (Mac) checkbox, text from the Top Staff will be copied to the extracted part.

Print and Print Selection
The File Menu will normally display the standard Print option, but Encore will change the wording if 
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a selection has been made (use the arrow tool to highlight an area on a page).  When an area has been 
selected, the File menu will say Print Selection.

For more on Printing and information on saving a selection as an a PDF or other format, please see 
Chapter 11 Printing With Encore  Edit Menu.

Page Setup
After selecting Page Setup from the File 
menu, you will see a screen like this:

Select your printer from the Format for 
pop-up menu. Then select the Paper Size 
and Orientation that you would like to use.  
To enlarge or reduce your score, enter a 
number in the Scale box and click OK.  The 
staves will remain the same size on your 
screen, but the size of the displayed page 
will change.

To create a score with specific margin 
settings you will need to create a custom 
page, set the page size and select options to 
access the margin settings.  Be sure to save 
the settings with a specific name.  This way 
you may use this setting again with other 
scores.

Recent Scores
The menu displays the most recent scores 
you have saved, opened or created.

Edit
Undo

Undo is available for most editing operations within Encore.  For operations which are not undoable, 
you will either see a warning within the dialog or you will be given an alert before the operation 
continues with an option to cancel.

Cut 
Cut deletes any selected area and places it in the Encore clipboard.  Using the Paste command lets 
you paste the cut material elsewhere in the score. The Encore clipboard retains the information until 
another Cut or copy operation is performed and replaces it.

Copy 
Copy places a duplicate of whatever you select onto the Encore clipboard.  You can then paste the 
copied notation to another area in either the same score or another score using the Paste command.
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Paste 
Paste places the contents of the Encore clipboard into the score.  
Paste will not work when an area is selected.  To paste copied 
or cut data, choose the starting location for the paste operation 
with the arrow tool.  You should have a flashing insert cursor in 
a measure before using Paste.

Auto Space On While Pasting
If Auto Space (Setup) is on, pasted notation is automatically 
aligned following each paste.  If the paste operation does 
not replace all of the notes in a measure, non-pasted notes in 
the same measure will also be aligned.

Auto Space Off While Pasting
If Auto Space is off, Encore will not use Align Spacing for 
the pasted area and the original spacing will be maintained.  If the measure width of copied data 
is different than the measure(s) into which the data is pasted, the data is scaled to fit the new area.  
This works best when complete measures are copied but will also affect paste operations for notes 
that do not fill the measure.

Note: Paste operations will paste notes, text, lyrics and all graphic indications with the exception 
of Clefs.

Paste does not paste tempo, time signature and key signature changes.

Encore copies data within each measure but not the measure itself.  Time signatures, tempos and 
key signatures are all attributes saved for each measure.  Clefs are “anchors” giving Encore a 
reference point for relating all the entered note data.

Tempo indications added from the Tool palette will be pasted but only as a graphic item.  If you 
are copying a section that includes clef changes, time signature changes or key signature changes, 
we recommend that you first create the measures needed and define at least the time signature for 
each section before pasting.  Key signatures can be added before or after pasting, and clefs should 
always be added after the paste.

If the time signature of copied data is different than the measure into which it is being pasted, 
Encore will paste copied data into the new measures as best as it can.  If notes were copied from 
radically different time signatures, the notes will be pasted over a different number of measures 
but the values will remain the same.  Generally speaking, every note and rest in every voice is 
first counted as an item.  Encore will keep adding notes and rests to each measure until no space 
remains.  If the last item exceeds the number of beats for that measure, Encore leaves it up to you 
to decide what to do.  Changing the time signature for a measure after pasting will not move notes 
to other measures.  See the section on Time Signatures for more information.

Measure widths and number of measures per system will need to be defined for each new area 
either before or after pasting.  New measures and pages created in Encore when pasting will 
use the last existing system before the paste and create new systems with the same number of 
measures.  If a paste creates new pages, the page layout of the last page before the paste will be 
copied for all the new pages created.
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Clear
Clear is similar to Cut with one very important difference:  the cleared data is not copied to the 
Encore clipboard.  A Clear command can be undone but the cleared area is not stored for further use 
in the clipboard, and the current clipboard contents remain.

Clear does not have a command key equivalent but instead uses the [back space/delete] key.

Select All
The Select All command will select all of the available data in the current score.  Select All is limited 
by the current voice indication for the score and will only affect notes and rests for the current voice.  
Graphics and text boxes are not assigned to voices but are placed by default into voice one.  An 
exception to this rule is lyrics and chords which use voices for determining vertical position.  The 
voice selector will affect lyrics and chords when altering selected data.

Nudge
Although the Nudge commands exist as menu items, the keyboard shortcuts are the preferred method 
to nudge objects.  The four nudge commands are:

Nudge Left		 [control/command]+ [ (open bracket) 

Nudge Right	 [control/command]+ ] (close bracket) 

Nudge Up		  [shift]+[control/command]+ [  

Nudge Down	 [shift]+[control/command]+ ]

The basic nudge operations move data left or right and up or down.  A single nudge unit left or right is 
one pixel.

Nudge requires a selection.  Use the arrow tool to select one or more areas using the standard 
selection technique.  Additional areas can be defined if you hold the [shift] key down before selecting 
again.  Isolated notes and rests selected using the shift-select method will also respond to the nudge 
command but will only move to the right or left.  See the section on selecting for more information.

Nudge Left and Right
The Nudge Left and Right commands provide a powerful method for moving selections as a 
group.  Nudge can be particularly useful for adjusting the horizontal alignment of several staves 
without sacrificing their vertical alignment.  Use Align Spacing to apply engraver’s rules to your 
music, and then nudge to make subtle adjustments to horizontal spacing while still retaining the 
essential vertical alignment between staves. This lets you create room for articulations, composer 
notes, graphics and lyrics.

Since nudge operations are frequently needed to move data in greater increments than a single 
nudge, the nudge command will respond to key repeat messages.  The delay before repeats occur 
can be set in the Keyboard Control Panel. 

Nudge Up and Down
Encore allows you to use Nudge Up and Nudge Down commands on objects.  To change the pitch 
of a note up or down, use Move Notes in the Notes menu. 
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Notes Menu
Attributes

The Attributes menu is a hierar-
chical menu with a sub-menu for 
Notes, Beams and Rests.  Each 
of these sub-menu items opens a 
dialog for that item and allows you 
to change how Encore displays 
and prints the related information.

The Attributes menu requires that 
you first select the notes or rests to 
be altered.

Notes

Set Stem Height
The stem height can be any number from 1 through 63.  Each number represents half the 
distance between two staff lines.  The default length is 7.  As in common notation practice, 
Encore adjusts stems to touch the middle staff line when the notes are in the ledger lines.  
Enter the desired length in the highlighted box.

When changing the stem height of beamed notes, please check the Apply Height to Beamed 
Notes check box

Note: If you flip stem direction, transpose or change pitch, the stem length will revert to 
Encore’s defaults. To change these defaults see View>Spacing Defaults.

Shift Accidental Left
Encore automatically offsets accidentals for chords, but can also be manually adjusted if you 
desire.  The higher the number, the more the accidental shifts to the left.

Note: If you flip stem direction or use Change Pitch or Transpose, accidental offsets will 
revert to Encore’s default placement.

Set Play State
Set Play State allows you to turn on or off selected notation or measures of notation in your 
score.  The default for standard notes is Play.  To turn selected notation off, click the Mute 
radio button.  To turn the selected notation back on, click the Play radio button.

Note: Cue notes are set to the Mute state by default and must be “play enabled” before you 
can hear them.

Set Note Head Type
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Different note head types can be freely mixed within the score for any staff or measure 
without limitation.  Note head types remain set until altered again with the Change Note 
Attributes dialog.

The ten available head types are: standard, diamond, triangle, square, X, circle-X, plus, slash, 
hollow diamond and stem only.   

Beams 
The Change Beam Attributes dialog box allows tuplet 
numerals and/or brackets to be hidden and also allows 
control over the length of half beams and the beam 
height.  Select the music you want to alter and then 
choose Beams.

Hide Bracket
Hide bracket removes the bracket indication on 
either side of a tuplet group or any other bracketed 
selection. Beamed tuplets do not have a bracket.

Note: Altering any of the notes for a group where the bracket has been hidden will show the 
bracket again.

Hide Tuplet
Hide tuplet removes the numeric indication for a tuplet.  Once hidden, a tuplet indication can 
be shown again by selecting the tuplet group and deselecting the hide option in the Change 
Beam Attributes dialog.

Hidden tuplet numbers will remain hidden for almost all operations.  Only changing the 
duration will return the tuplet indication to the “show tuplet” state, and only then if the beam 
or bracket is removed when the duration is changed.

Set Half Beam Length
The half beam length affects beamed groups containing mixed durations which include 
a sixteenth note or shorter note duration.  When a sixteenth is beamed to an eighth note, 
the sixteenth note will show a “half beam” between the two notes to indicate the note is a 
sixteenth and not an eighth.  Encore sets the default length for this beam when the beam is 
first created but that default can be altered using the Beam dialog to any length between 0 and 
63.  Each number represents 1/72 of an inch.

Note:  Adjusting a beam in any manner after the half beam length has been altered will revert 
the half beams to their default length.

Grow Beam Height by...
Encore calculates beam heights at the time they are created and can be adjusted with the 
mouse (see the section on Moving Items in Encore).  To adjust the beam height for several 
beams at once, use the Grow Beam Height option.  Beam heights can be adjusted from 0 to 
63.  The number entered will be added to the current height of the selected beam(s).  Enter a 
negative number to decrease the beam height.
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Note: Beam heights will revert to their default when the stem direction for any of the notes is 
changed.

Rests
Encore lets you change the look of your rests from standard rest 
notation (default) to slashes or vice versa.

Select the rests you want to change and then choose Rests to open 
the Change Rest Attribute dialog (Windows) or Set Rest Attribute 
(Mac).  Take your pick.

Note: See Moving Objects in Encore for more information.

Set to Voice
A complete discussion of voices and voicing in Encore is provided in Chapter 8, Voices in Encore.

The voice sub-menu shows Encore’s eight voices.  Changing the voice assignment for a selection 
can be done using this menu.  You may find it easier to use the [control/command] key and number 
shortcuts provided.

To view by voice: 

Press [V]+[ - ] (dash) for all voices, [V]+[1] for voice one, [V]+[2] for voice two, etc.

To change the voice of a selection: 

[control/command]+[1] for voice one, [control/command]+[2] for voice two, etc.

Changing voice for a beamed group of notes will unbeam the notes in the process.

Accidentals
This feature permits you to change the accidentals that occur in a selection.  Although Encore 
attempts to use the correct accidentals for the current key signature, there are instances where your 
music may require changing the accidentals.  In the key of C, for instance, the “correct” accidental 
depends on several factors which Encore cannot know about.

Notes which do not have an accidental attached will not be affected when changing to flats or sharps.

Enharmonics
The term “enharmonic” describes two pitches that are notated differently but are still played 
and sounded the same.  In practice, this is not always true since some instruments can generate 
slightly different tunings for a pitch depending upon how the pitch is created, but in general (and 
always for MIDI) the “enharmonic spelling” for a pitch is just another way to describe the same 
pitch.  An example would be F flat and E.

Every note has an enharmonic equivalent.  The actual spelling for the enharmonic depends on the 
key signature.

Most commonly, the enharmonic function helps avoid crowded chord clusters with excessive or 
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confusing accidental indications.

To change a single note in a chord we recommend that you select the note using the shift-click 
select method (see Selecting in Encore).

Simplify Accidentals
Simplifying accidentals changes the accidentals to best fit the key while removing double sharps 
and double flats.  

Stems (direction)
Although a menu item has been provided for changing stem direction, we recommend that you learn 
the shortcut equivalents [control/command]+[U] for stems up and [control/command]+[D] for stems 
down.  Select the notes you want to change and apply either the shortcut keys or menu item.

Changing stem direction for chords will also change the tie direction.  See the section on Tie Notes 
for more information about tie directions and flipping ties.   [control/command]+[T] toggles the ties 
up and down.

Voice 1 Stem Directions
Stem directions for notes in voice 1 will follow standard notation practice and be placed up or 
down depending on their pitch location in reference to the clef.

Voice 2-8 Stem Directions
Voices other than voice one default to stems down except when using a combined staff such 
as the piano staff.  In a piano staff the notes in the bass clef will default to voice 5.  These 
notes will also follow standard notation practice and set the stem direction according to the 
clef in use.

When two or more voices are used in the same measure, you may need to flip the stems 
for one voice.  Most commonly, some or all of the notes in voice one will have stem down 
directions and will need to be changed to stems up.  Set the voice selector to the voice you 
wish to affect and it will be easier to select only those notes and change their stem direction 
without affecting the other voices.

Normalize
Normalize sets stems back to the default directions.

Marks 
Add

To add marks to a group of notes:

1	 Select the notes. 

2	 On the Notes menu, point to Marks, then click Add

. 3	 Under Apply Marks, select an option to determine the position of the marks. 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4	 Under Mark to apply, click the mark you want.

Remove
To remove marks from a group of notes:

1	 Select the notes

. 2	 On the Notes menu, point to Marks, then click Remove. 

3	 Under Remove Marks From, select an option to determine which marks to remove.

 4	 Under Mark to apply, click the mark you want. 

5	 Do one of the following: 		

		  To remove all types of marks: click Remove All Marks.

		  To remove one particular mark: click that mark button under Mark Types to 		
		  Remove.

Tie Notes
Tie Notes allows you to tie two or more notes of the same pitch together for the purpose of indicating 
the note is played only once but held for the full value of all the combined notes.

Tie Notes requires that you first select the notes to be tied.

All notes to be tied must be within the same selection.

If notes to be tied exist across system breaks or page breaks you can 
either change the number of measures in the system or select the 
notes you wish to tie using the shift-select method of clicking on the 
note head.  See Selecting in Encore for more information.

Notes to be tied must be the same pitch.  If a tie occurs over 
a barline, accidentals will be removed from the note in the 
following measure after the tie has been performed, but both 
notes must be notated the same before the tie will be allowed.  
If you wish to apply a courtesy accidental to a tied note you 
must do so before the tie is performed.  Use the [control/option] 
key while applying the accidental to force Encore to retain the 
accidental.  To apply an accidental after notes have been tied, 
apply the accidental to the first note in the tied group.  We do 
not recommend that you change the accidental for a tied group 
if you placed a courtesy accidental within the group. 

The keyboard shortcut for ties is [control/command]+[T]. 
[control/command]+[shift]+[T] toggles the ties up and down.

Tie Directions
Stem direction and the number of notes being tied determines the tie directions for notes.  When 
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chords are tied together the tie directions will be created for the chords according to Encore’s best 
judgment.  If you flip stem directions for a tied group, the tie direction will also change.  To alter 
the tie directions without changing the stem direction, shift-select the tied notes that need the tie 
flipped and use [control/command]+[T].

Adjusting Ties Using the Mouse
Ties can be adjusted manually by dragging the tie’s control point.  Control points for ties occur in 
the middle of the tie and can be adjusted either up or down provided the tie is not indicating a tie 
from or to a note in another system or page.  If a tie occurs over a system or page you will need to 
change (“flow”) the number of measures to bring both notes being tied onto the same system.

Note: The Tie Notes function ties only notes that are in the same voice.

Tie Defaults
The Spacing Defaults dialog from the View menu contains the default settings for tie offsets.  The 
default horizontal offset is 0, placing the tie’s ends at the edge of the notes being tied.  Using a 
higher number moves the ties farther away from the note heads.

The default vertical offset is 3, and places the tie ends slightly above or below the note heads 
being tied.  Using 0 will start the tie ends from the middle of the note’s head.  Entering higher 
values moves the ties higher or lower than the notes.

A maximum of 8 can be used to define the tie offsets. Each number represents a quarter of the 
distance between two staff lines.

Slur Notes
A slur is a curved line over (or under) two or more notes of different pitches indicating the notes are 
to be played as a group.

Slurs can be entered in Encore using a variety of methods.  For more information about entering slurs 
using the pencil tool, refer to the reference section for the Tools palette.

Using the Slur Notes command
The menu item for Slur Notes will create a slur for you based on a selection.  The default slur is 
created over a group of notes. Holding down [shift] while using the slur command will place the 
slur under the selected notes.

Slurs are drawn from either the note head or the stem depending upon 
the stem direction and the slur placement.  The default placement 
of the slur is at the note heads if all stems of the end notes face the 
same direction.  If the stems face the opposite direction, the slur 
will be placed on the top.  Holding down [shift] will place the slur 
on the other side as the default.  The end points of slurs attempt to 
stay “attached” to the original notes and readjust when the notes are 
moved (except when [control] key is down or Auto Guess/Beam is 
OFF).  The selection for creating a slur should be made by highlight-
ing the entire group of notes the slur appears over or under.  Make 
sure the first and last notes, which define the slur, are fully selected 
within the same rectangle.
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Additional note groups can be selected using the [shift] key before defining the selections.

Shift-selection of individual notes can also be used for creating slurs, but take care:   A slur will 
be generated between every pair of shift-selected notes.  Shift-clicking on the beginning and 
ending note head of a phrase will “slur” that phrase.

Beam Notes 
The Beam Notes item has a sub-menu containing the four beaming operations used within Encore.   
For more information on changing Beams see also Attributes>Beams, Moving Objects in Encore, 
Selecting in Encore and Spacing Defaults.

Beam Group creates brackets or beams over all selected notes and rests and also creates beams across 
barlines.

Beam On Beat uses the time signature and beat location for the selected notes to determine a default 
beaming combination.  The Auto Guess/Beam function uses Beam On Beat.

Sub-Group will “break” the secondary beams under the primary beam of a beamed group into smaller 
groups without changing the duration information.  This leaves only the primary beam connecting the 
entire group. 

Flatten Beams changes angled beams so that they run in a straight, horizontal line.

All notes must be in the same voice for Beam Group and Beam On Beat to work.  Notes in different 
voices will be beamed according to the logic or selection applied to each separate voice.

Beam Group and Beam On Beat require an unbeamed selection to function properly.  If any of the 
selected areas were previously beamed, these two beaming operations will undo the beaming instead 
of creating additional beams.  If this happens, you can just do it again and Encore will reapply the 
beam operation to the same selection.

Sub-Group is applied after a group has been beamed together.  Sub-Group will frequently require a 
Beam Group operation before it can be used.

Beam Group
Beam Group is a manual operation used when you require different beaming combinations than 
are provided with Auto Guess/Beam or Beat On Beat.  This can occur when using time signatures 
other than a simple 4/4 or when using complex groups of shorter durations.  Beam Group is also 
used when brackets are needed above tuplet groups (such as half note or quarter note triplets) and 
when beams are desired across barlines.

Beam Group will work only if the selected area does not contain any notes previously beamed 
together.

Beam Group only affects notes in the same voice.

Beam Group creates additional brackets along with beams if the selected group includes quarter, 
half or whole notes.

Beam Group can include rests either within or at the end of a beamed group.
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Using Beam Group
Select the group of notes you want to beam together.  Previously beamed notes require you to 
use the Beam Group command twice.  The first time will unbeam anything already beamed, 
and the second operation will beam all of the selected items together.

Beaming Notes Over a Barline
If you make a selection that includes notes in two measures, the beam created will be drawn 
across the barline.

Note:  Encore will create beams over one barline only. Beaming operations with selections 
greater than two measures will stop at the end of the second measure.  Beams across 
measures should not be “flowed” to a new system.

Beam on Beat
Beat On Beat uses the time signature to apply some basic rules to the way notes are beamed 
together.  If Auto Guess/Beam has been enabled, the Beat On Beat operation is applied every time 
a note is entered or erased from a measure.

Beat On Beat rules are fairly straight-forward for time signatures based on quarter notes (2/4, 3/4, 
4/4, etc.). Each quarter note in the measure is a beat and beams will not cross the beat boundaries. 

When the time signature is based on eighth notes, it is not possible to arrive at a universal 
beaming solution appropriate for every situation. 

Encore uses a beat value of three eighth notes for 6/8 12/8 and 9/8.  For odd time signatures such 
as 5/8 and 7/8 the beat value is one eighth note. 

For complex rhythms, the beaming must be performed manually using Beam Group.

See Default Spacing, Auto Beam/Guess and Selecting Objects in Encore and Moving in Encore 
for more information related to beams.

Sub-Group
Sub-Group clarifies a measure’s rhythm.  Used after Beam Group, the Sub-Group command can 
remove secondary beams between groups of notes and/or change the secondary beam direction.

You can also use Sub-Group to change the direction of a secondary beam.

The following examples illustrate how Sub-Group works.

Flatten Beams
The Flatten Beams command changes angled beams so that they run in a straight, horizontal line.  
To see this command in action, do the following:

1	 Place four eighth notes in a measure, keeping the notes within the lines of the staff. 

2	 Select the beam.  You must drag the pointer over the center point of the beam to select it.

3	 Click the Notes menu, point to Beams, then click Flatten Beams.
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Change Pitch/Transpose

Change Pitch/Transpose alters both the position of notes and their playback.

For Change Pitch/Transpose to function, you need to make a selection.

The Change Pitch/Transpose dialog can raise or lower pitches three octaves in either direction.  If you 
need a transposition greater than this, use the Change Pitch/Transpose function a second time.  The 
transpose amount is indicated with the transpose direction, the interval name and quality ( the number 
of half steps is calculated for you).  Use the pop up menus to the desired interval and select the choice 
by highlighting the name.  Click OK.

Change Pitch/Transpose changes the key signature if desired.  If you would also like to change key 
signatures to the transposed amount, check the Transpose Key Signature box.

Change Pitch/Transpose removes courtesy accidentals and enharmonics, and can apply standard 
defaults or Simplified Accidentals (see Simplified Enharmonics) for the new pitches. 

Change Pitch/Transpose also transposes any chord symbols when Transpose Chord Symbols is 

checked. 

To change the playback of notes without changing their display, use the Key function in the Staff 
Sheet.  See the section on the Staff Sheet (Windows menu) for more information.
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Change Duration 
The Change Durations dialog can alter the display and 
playback of notation in your score.

Change Durations requires a selection.

Set Note Durations
This portion of the dialog requires the checkbox to 
be enabled if you wish the note types to change.  Use 
your mouse to place a check mark in the box next to 
the words Set Note Duration and select the duration, 
including dots and the tuplet indication if needed.

Changing the duration will change both the duration 
and the start time for the notes.  If the new duration is 
greater than the number of beats in the measure, notes 
in each measure that exceed the time signature will 
not be heard.

Note: All of the choices in the Set Note Duration section can also be applied quickly to selections 
using shortcut keys.  See the section on the Notes palette for details.

Set Play Duration
The second option in the Change Durations dialog concerns the MIDI duration to be played for 
each note.

Changing Play Duration  for Step Entered Notes
The default playback for notes entered with the mouse or step entered with a MIDI Keyboard is 
90% of the displayed value. 

Changing Play Duration for  Real Time and Imported Notes
Notes recorded in real time or imported MIDI Files initially have unique durations for each note 
depending on the recording.  Even after Guess Durations and Transcription Options have assigned 
a display duration value, the original recording or MIDI file is maintained as much as possible.  
When changing the duration for real time and imported scores, the new play duration is the 
percentage of the transcribed value and not the recorded value.

For passages intended to be played legato, you can increase the percentage to 100%.  An overlap 
can be achieved depending on articulation settings and MIDI OFF velocities of the particular 
synthesizer used.  (See MIDI Playback Settings)

Decreasing the percentage will result in a more staccato interpretation.

Note:  Even at full duration, what is actually heard will depend on the synthesizer and the sound 
selection.  Reducing the playback percentage for sounds with slow “attack” times can result in 
some notes not being heard at all.  See the appendix on MIDI for more information.

The Set Play Duration settings will be lost if a note’s duration is changed again.
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See also the Notes palette, Changing Displayed Notation without Affecting MIDI Playback.

Change Velocity
Change Velocity combined with dynamics, marks, hairpins and your 
synthesizer settings can give you complete control over the interpre-
tation of your score’s dynamics by your MIDI synthesizer.  MIDI 
Playback Settings and Staff Sheet settings can change the velocity or 
perceived volume.

Velocity is a MIDI parameter in every note.  The value for velocity 
ranges between 0 and 127 but the value of 0 is special and not used in 
Encore (a zero velocity essentially means “don’t play this note”).

What actually happens when different velocity “values” are used 
depends entirely upon the synthesizer responding to the MIDI 
messages.  Common practice, however, uses velocity to control 
volume.  For more information about velocity see the appendix on 
MIDI.

Change Velocity requires a selection.

The dialog for changing velocity contains both ON and OFF selections.  These settings can be 
enabled independently.

Note:  Consult the documentation for your synthesizer to determine if it responds to OF or OFF 
Velocity, or both. Most synthesizers will respond to OF Velocity but very few respond to OFF 
Velocity.

There are four choices in the Change Velocity dialog.

Setting all velocities to the same value will ensure that all volumes are the same.

Changing by percentage maintains any changes made within the selection and scales the velocity 
levels.  The values range from 1% to 999%.  Percentage changes close to maximum or minimum will 
compress the dynamic range to one extreme or the other.

Change smoothly will replace the velocity values for the selected notes with new values obtained 
from the value range entered.  The first value will be applied to the first note and the second value 
applied to the last note in your selection.  Notes between the beginning and end selections will be 
altered according to their placement in time.  This means the changes in velocity level for short 
durations will be more gradual than changes between notes with longer durations.

The fixed value range will accept values between -127 and 127.

If any operation would result in a value less than 0 or greater than 127, the value assigned is 
either 0 or 127 depending on which limit was encountered.

To change just the ON velocity, click on the note while holding the [Shift]+[Command] keys.  A 
pop up menu with velocities will open.

Make Chord 
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Make Chord combines two or more notes of the same duration into a chord.  Both MIDI Playback and 
screen display are changed.

Make Chord can be used to change imported or real-time recorded data containing arpeggiated chords 
into an actual chord to which an arpeggio symbol can be added.

To use Make Chord, select the notes that you wish to use in the chord and then use Make Chord.

Make Chord will work only when notes are of the same duration.  If notes have been guessed to be 
different durations, first change all of the notes to the same duration.

Unless the notes combined into a chord were hand entered with Auto Space off, the number of beats 
in the measure will change as well.  You may need to add rests or additional notes to complete the 
measure.  It is also a good idea to Align Playback. 

Make Grace/Cue
This function lets you change notes to grace notes or cue notes and to clear the grace or cue attributes.

Encore does not count grace notes when calculating the number of beats in each measure, and their 
playback can be set to play in advance of the next note if the grace note can borrow time from a 
preceding note or rest.  Cue notes have their full beat value counted in the measure and are muted by 
default.  If cue notes are to be used to indicate alternate or secondary lines, add all of the cue notes in 
a separate voice.

Grace
Before Encore can create grace notes, you must first 
enter the duration used for the grace as a regular note.

Note:  When a phrase of two or more beamed notes are 
converted to grace notes, the original duration of the 
note is retained in the beamed configuration.  Single 
grace notes, however, are always converted to the 
standard eighth note grace character.

When notes added to a measure are intended to be 
grace notes, you will need to turn OFF Auto Space and Auto Guess/Beam.  With Auto Space ON 
you will be prevented from entering more than the full beat count for the measure.  Since grace 
notes are standard notes before you convert them to grace notes, you have to be able to add them 
to the measure.

The percentage amount entered for Scale duration by determines how long the grace note will be 
played.  This value is applied to the current duration of the note before it is changed to a grace 
note.  That is, changing a half note to a grace note will indicate the grace as an eighth note, but if 
the duration is scaled to play at 50%, the note will be played for the duration of a quarter note.

When Play before the beat has been selected, the original note duration combined with the scaled 
amount will also determine at what time in the measure the note is to be played.  As an example, 
place two eighth notes into the beginning of a measure.  Select the second eighth note, convert it 
to a grace note with a duration of 25% and set it to play before the beat.  When this combination 
is played the grace note’s duration will be played as a thirty-second (25% of an eighth note) and 
the note will start playing starting a thirty-second sooner than where it occurs in the measure.  
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If the play duration was set to 50% for this example, the note would play for the duration of a 
sixteenth (half of the original duration) and also start playing a sixteenth before its beat location.

Note: Grace notes cannot borrow time from notes or rests that don’t exist and cannot be set to a 
play duration greater than the value of the note or rest before the grace note.  Remember that the 
duration amount is for the original duration of the note you are converting to a grace note.

If you need to start a section or piece with a grace note, you will need to uncheck Play before the 
beat as there will not be a note to borrow time from.

No Slash (appoggiatura)
When No slash (appoggiatura) is selected, the option to Play before the beat is automatically 
deselected.   The appoggiatura option automatically plays the notes on the beat location at which 
they are located.  A full discussion of the term “appoggiatura” cannot be covered in this manual, 
and there are disagreements concerning the exact interpretation and use of the appoggiatura 
anyway.  In Encore, the selection will create a grace note that is played on the beat and the note’s 
type will be preserved (that is, a half note will look like a small half note, a quarter will look like 
a small quarter note, etc.).  Appoggiaturas differ from cue notes in that they are played on the beat 
but will not affect the beat locations of other notes in the measure. 

Cue
This option shrinks all notes, beams, and marks to 70% of normal size.  Cue notes are muted 
by default.  If you would prefer to hear the cue notes, you can select them and use the Note 
Attributes dialog to unmute them.

Standard Note
This removes any grace or cue changes made to the selected notes and restores full performance 
and duration values.

Make Tab
Make Tab creates tablature staff for fretted instruments and converts notation from a regular staff to 
the tablature staff.  The tablature numbers indicate the corresponding fret locations selected for the 
tablature staff’s tuning.

Make Tab requires that a Tab staff be created by using the Add Staff dialog or Tablature Staff.

To convert standard notation into tablature, select the staff or notes to be converted and then use 
“Make Tablaute”.  The converted notes will then appear on the new tab staff.  Encore does its best to 
give you a logical fingering for the notated music.  It does not, however, know the neck position in 
which you want it played.  Make Tab lets you transcribe a selected section into tablature and set the 
lowest fret to be used.

To set the fret position:

•	 Add a new blank tablature staff with the Add Staff command or convert a standard notation staff 
into tablature with the Tablature Staff command.

•	 In the standard notation staff, select the notes you’d like to transcribe as tablature.  If you’ve 
already converted the staff, select only those notes that you want to re-transcribe at a different neck 
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position.

•	 Choose Make Tab from the Notes menu.  The Make Tablature dialog appears. 

•	 Enter a value into the parameter box labeled “Start tablature at fret {n}.”

•	 Click OK.  The selected notes are re-transcribed.

Note:  All selected items are used for creating the tablature numbers.  Don’t select more than one staff 
unless you want the tablature part to include fingerings for notes on more than one staff.

Updates to the tab staff can be made for one note or an entire score.  Whatever is selected will be 
converted to numbers on the tab staff.  Previous fretting indications will be replaced.

Note:  If you edit the pitch of a note or notes in a regular staff and then select and reconvert just 
those notes to an existing tab staff, the fingering numbers in the affected measures will revert to the 
default fingerings.  Therefore, you should be satisfied with the pitches before you nudge the fingering 
numbers around to different strings. 

If two or more tab staves exist in a score, the order in which they appear will determine which staff 
receives the numbering indications.  If both staves are intended to be references for the same notation, 
you will need to update each staff separately.  Use the Staff Sheet to swap staff positions and use 
Make Tab for each staff.  By rearranging the staff order, it is possible to convert the same piece of 
notation for several different fretted instruments.  

Create Tab Staff
The Tab Staff created by default is in a standard 6 string guitar tuning.  Use the OK-Open Setup 
button to change these defaults.

Tablature staves are created below the selected staff but can be moved to any staff position after 
they are created (see Staff Sheet for more information).

Setup
The OK-Open Setup button takes you to the dialog used to select the number of strings and 
their respective tuning.  Encore can create a tablature staff containing from one to eight 
string indications.  Each string will 
correspond to a line in the tablature 
staff.  Encore uses the tuning 
information when creating the fret 
position numbers and when nudge is 
used to change the string reference.  
You may use one of our presets or 
create you own set up.

Note:  Tablature and notation for 
fretted instruments is frequently 
written an octave higher than 
played.  The standard guitar tuning, 
for example, uses E2 as the pitch 
for Low E but most guitarists tune 
to E1.  The Key function in the 
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Staff Sheet can be used to transpose the playback for a guitar part on the standard staff for the 
proper register of the intended instrument. 

Font menus provided in Setup determine how the number indications in the tablature staff are 
to be displayed and printed.  The font choice affects all tablature staves in the score.

Selecting a tablature staff alone and then choosing Make Tab will open the Setup dialog 
independently of the Make Tab dialog.  This permits you to change just the font and tuning 
information.

Changing the String Indications
Numbers on a Tablature staff are not like notes and graphics and you cannot drag them to 
new locations with the arrow tool.  Instead, numbers must be selected and adjusted using the 
Nudge command.  Nudge Left and Nudge Right change the horizontal positions of numbers.  
Nudge Up and Down adjust the string reference.

Changing Fret and String Indication
Guitars and most fretted instruments have several different string and fret possibilities 
capable of generating the same pitch.  The Make Tab function will select one possibility for 
you.  To change the fret and string reference for a pitch, select the number indicating the fret 
on the current string.  Nudge Up to change the fret indication for the next string up and its 
tuning.  Nudge Down to change the indication to the next string below and the tuning used 
for that string.

Note:  Nudge will not move numbers onto strings tuned beyond the range for the pitch being 
indicated.  Although standard tunings and even most alternate tunings can be used without 
trouble, tunings using non-ascending or descending pitches are not fully supported. 

Tablature staves do not play over MIDI.  The Staff Sheet options for tablature staves are 
limited to changing their size and location.

Revert to Raw
“Raw” data in Encore appears as note heads with accidental and tie information only.  Revert to Raw 
removes all stems, flags, beams and marks from notes and leaves only this information and the MIDI 
data associated with each note.  Graphic information such as slurs and dynamics are unaffected by 
Revert to Raw and will remain in the score.

Use Revert to Raw when you want to undo all the changes to a section of music and start over.  Select 
a transcription value after reverting to raw data and use Guess Durations to convert the raw data into 
notation. 

Guess Durations
Guess Durations applies the duration value selected in Transcription Setup to the MIDI data and 
converts the MIDI duration and timing information into notation.  The accuracy of Guess Durations 
depends on both the recorded data and the transcription value selected.

Guess Durations requires a selection and uses the settings in Transcription Setup. 

Encore biases the Guess Durations function to avoid creating unnecessary rests and notes of awkward 
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duration values.  Ordinary playing usually consists of varying 
durations and pauses between notes.  A literal transcription of 
such playing would consist of an unreadable profusion of rests, 
double-dots and needlessly complex tied note combinations.  To 
avoid such a transcription, the Guess Durations function rounds 
off the interpreted note and rest values to within the duration 
amount specified in Transcription Setup.  The default transcrip-
tion value is sixteenth notes.  The transcription value set in the 
Transcription Setup dialog can be saved in preferences. 

If Auto Guess/Beam is enabled in the Setup menu, the Guess 
Durations operation and the current transcription option will be 
applied to all recorded data and imported MIDI or Master Tracks 
Pro® files. 

If an imported or real-time recording is guessed incorrectly, you can change the transcription value 
and use Guess Durations again on all or part of the score.

Transcribing Triplets
When using Guess Durations on triplets, the result will depend on how accurately the triplets 
were entered.  Step entered triplets can be accurately “guessed” by Encore down to a sixteenth 
note triplet, but only if the duration is repeatedly used.  When triplet values are combined with 
other durations or alternate with rests, the guess function will be less able to account for them and 
the result will vary according to the note’s position.

When recording data into Encore in real time, it is important to play with great emphasis on 
maintaining the timing if you want the transcription to be as accurate as possible.  If a sequencing 
program such as Master Tracks Pro is available, you can often improve the transcription within 
Encore even further by first opening the file in the sequencer program and quantizing it before 
you open it in Encore.

Move Notes
	 Move Notes section of the menu lets you easily change the pitch of the selected notes up or down 
by a half step, or by an octave.  Simply select the note(s) before using the operation.  Chords in the 
selected area will be transposed also.

Measures Menu
Add Measure

Add Measure creates new measures anywhere 
within the score for either one or all staves in the 
system.

The default setting for Add Measure  adds one 
measure after the measure in which the insert point 
was placed.  The range of measures can be changed 
and new measures can be added either before or 
after the specified measure. 
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The lower portion of the Add Measure dialog allows the new measures to be added to all staves or on 
a single staff only.  If you select Only on staff, the initial entry will be obtained from the measure in 
which the insert point was placed.  Enter a new staff number if you wish.

Note:  Staff numbers are the same as instruments in the Staff Sheet.  Combined staves, such as a piano 
staff, get counted as one staff even though they technically contain two or more staves. 

Add Measure does not have an “undo” option but the added measures can be easily removed with the 
Delete Measure function if later you decide you don’t need them.

Delete Measure
Delete Measure removes measures and all data and 
information related to those measures from either 
one or all staves in a score.

Delete Measure is NOT UNDOABLE!  If you delete 
measures you meant to keep, you can only regain 
those measures if you saved the score while the 
deleted measures were complete and you discard 
all recent edits.  Revert to Saved will retrieve the 
last-saved version of your file.

If you select the measures you wish to delete before 
opening the Delete Measure dialog, the range of measures selected will automatically appear in the 
dialog.  The range to be deleted can be redefined by changing any of the numbers within the dialog.  
If no selection was in effect the dialog will default to one measure.

Caution:  Encore does not allow you to delete discontinuous measures. That is, if you select only 
measures 1 and 5, the measure range will be 1 through 5 and Delete Measure will also delete 
measures 2, 3, and 4. 

Note: If you want to delete all the measures from the “From” measure to the last measure of your 
piece, click on the arrow (located to the right of the “To” box).  The last measure in the score appears 
in the “To” box. 

Indicate whether you want to delete measures from all staves or just the currently displayed staff by 
clicking the applicable radio button.

If you want to change the currently displayed staff number to another staff number, click twice in the 
box to highlight it and then type the desired staff number.

Remember:  Delete Measure is not undoable.  Once deleted, measures are gone unless you can use the 
Revert to Saved function explained above.

Tempo
The tempo can be adjusted for the entire score or just a section within the score.

If you select the area you wish to change before opening the Tempo dialog, your selection will be 
entered into the dialog’s measure range. 

If no selection has been made, the measure range will default to the current location or measure 1. 



The Menus- Windows183

Note:  All measures between the first and last measure indicated 
will be included in the operation. 

The Tempo dialog defaults to changing by a percentage.  After 
using the dialog once, however, your selections are “sticky” and 
your last operation choice will remain selected. 

Finding the Current Tempo  for a Measure
When the Tempo dialog is first opened, the tempo indicated 
in the Set all Tempos to... field is for the “From” measure in 
the selection range.  Tempo changes after this may exist but 
are not indicated.  If the measure range is altered within the 
dialog, the tempo for the new range is not indicated.

Set all Tempos to...
This option changes all tempos in the selected area to the one tempo entered here.  If the selected 
measures contain different time signatures (i.e. 4/4 and 6/8) each time signature will apply the 
new value to the beat value used.

Note:  The beat is the lower portion of the Time Signature.  When the tempo amount is applied to 
the beat, you should think of the tempo as applying to one note of the indicated value.  In 4/4 the 
tempo describes how long quarter notes are to be played.  In 6/8 the tempo describes how long 
eighth notes are to be played.  If a measure of 4/4 and 6/8 are both set to play at “100” an eighth 
note in the 4/4 measure will play twice as fast as the eighth note in the 6/8 measure. 

Changing by Percentage
Entering a percentage value for the defined measure range will scale the tempo and any changes 
already defined for the range.

Change Smoothly From...
This dialog will apply two tempo values to a range of measures.  The two numbers are scaled 
to fit the number of measures within the selection.  Changes within each measure will occur on 
each beat for the time signature of the measure.  If there are different time signatures the tempo is 
applied to the beat value of each measure.

Add _ to all values
This option will increase or decrease the tempos for the selected region by a fixed amount.  
Negative values can be entered.  This operation will maintain the relative differences between 
tempos unless tempo limits are encountered.

Tempo changes are saved with the measure and not the measure number.  If a tempo change is 
made for measure 5 and then 5 measures are inserted before measure 5 on all staves, the tempo 
change will occur at measure 10.  When measures are inserted for only one staff, tempo changes 
are unaffected.

Encore allows a maximum tempo value of 400 beats per minute.  The minimum is 1 .



The Menus- Windows184

Time Signature
Time signatures are used to indicate how many beats are in 
each measure and what note value is used for each beat.

Encore can define one time signature per measure as often 
as needed.  Measures and pages added to the score use the 
last time signature defined.  The time signature determines 
how many notes Encore will play for each measure, but it 
is possible to both hide the time signature and enter more 
notes than can be played (if Auto Space is off).

If you select the area you wish to change before opening the 
Time Signature dialog, your selection will be entered into 
the dialog’s measure range.

If no selection has been made, the measure range will default to the current location or Measure 1.

Note:  All measures between the first and last measure indicated will be included in the operation.

When the Time Signature dialog is first opened the time signature indicated is for the measure number 
that appears in the “From” box of the measure range.  If the measure range is altered within the 
dialog, the time signature for the new range is not indicated. 

Click the arrow to the right of the measure range to enter the last measure in your score in the “to” 
box.  You can use this to select to the end without knowing how many measures currently exist.

Encore includes two standard time signatures.  C is used for 4/4 and  ¢  is the same as 2/4.  Since the 
click value can be altered, the metronome could effectively give the impression of 8/8 or 4/4 time as 
well.  However, the tempo applied to the meter will be based always upon a quarter note.  See the 
section on Tempo for more information.

Note:  The click amount must always divide evenly into the number of beats (upper or left portion of 
time signature).

Other
When the standard selections do not include the time signature desired you can define one 
yourself using Other.  Encore allows up to sixteen beats per measure (upper or left portion of time 
signature) and units of 1 (whole note), 2 (half note), 4 (quarter note), 8 (eighth note), 16 (sixteenth 
note) and 32 (thirty-second note).

When defining the choice for Other, the number of clicks to be used will be updated to a common 
selection.  If you wish to base the click on another value you can enter the number after you have 
finished defining the time signature.  The click, however, must divide evenly into the number of 
beats.

Hide Meter
Hide Meter will simply hide the time signature defined.  The time signature is still used, however, 
when calculating the correct tempo and number of beats to be applied.  Hide Meter can be used to 
create a pickup within the score.  If a measure of 4/4 is instead defined as two measures, one 7/8 
and the other only 1/8, the time signatures in both measures can be hidden and the result can be 
an eighth note pickup into the next section.
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Note:  Measure numbers are unaffected by Hide Meter operations.

Time Signature Reminders
When the next system begins with a new time signature, the previous measure will have a 
“reminder” added by default.  This optional reminder can be hidden from within the Show/Hide 
dialog.  If the next measure’s time signature is hidden, a reminder is never used.

Pickup Bar
The Pickup Bar checkbox performs several functions at once.  A pickup bar displays the time 
signature of the following measure instead of the selected time signature.  In addition, the time 
signature in the next measure is automatically hidden and measure numbers are adjusted for the 
pickup indication. 

Note:  First Bar is Pickup in the Measure Numbers dialog and the Pickup Bar option in the Set 
Time Signature dialog are connected.  Changing the selection in one dialog will change the option 
in both dialogs.

Special Note:  If the first measure is configured as a pickup bar, the measure range in dialogs will 
be affected as well.  Be sure to take the pickup measure into account when calculating measure 
numbers.  A pickup measure is represented by a zero in the From field of a measure range and can 
be entered into the range by typing the zero key. 

For the pickup selection to work correctly you must select only the one measure to become the 
pickup bar. 

Creating A Pickup Bar
Here is an example for creating a pickup 
measure of a one eighth note pickup leading 
into a score in 4/4 time.  Before you open 
the time signature dialog, make sure the first 
measure contains the pickup note or notes 
that you want and is not the measure after 
the pickup bar.  If the pickup measure needs 
to be created, use Add Measure and add one 
measure before measure one.

Select the first measure and change the time 
signature to be the number of beats needed 
for the pickup.  Since our example is going to use one eighth note, the time signature will 
require entering 1/8 in the “other” portion of the dialog. 

Put a check mark in the box next to Pickup Bar and click OK.

If you check both Hide Meter and Pickup Bar, the time signature in both the first and second 
measures selected will be hidden.  Measure numbers are only changed for the first measure in 
the score.

If the pickup bar option is removed from a measure, the Hide Meter setting for the following 
measure will also be removed.
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Key Signature
Key signatures can be defined for either a portion of the 
score or for the whole score.  When key signatures are 
changed, accidentals for notes within the section are 
changed but the pitches can either be transposed or left 
alone.

Selecting a measure range before opening the Set Key 
Signature dialog will enter the selected area into the 
measure range portion of the Set Key Signature dialog.  
The key signature change will be applied to all measures 
between the first and last measure indicated.  Enter a new 
measure range if desired. 

Use the scroll to select a key.  

No Double Barline
Place a check mark in this box if you do not wish to 
have double barlines inserted into the score at the place 
of the key signature change. 

Just Delete the  Current Key Signature
When a key signature needs to be removed, the option to Just delete the current Key Signature 
should be selected.  This removes all key signatures for the measure range specified.  The new 
key signature will be a continuation of any key signature used before the first measure of the 
affected measure range, or the key signature will default to the key of C.

Note:  When Just Delete The Current Key Signature is used, the selected key signature is ignored.

Just this staff
By default the Transpose/Key Signature dialog will change the key signature for all staves.  If you 
wish to change the key signature for only one staff, select that staff before opening the Transpose/
Key Signature dialog.  If more than one staff is selected, a check mark placed in the Just this staff 
box will only change the key signature for the lowest staff in the selection. 

Ignore Instrument Transposition Keys
Encore will insert the appropriate key signature depending on the staff’s playback transposition 
(set via the Staff Sheet Window). For example, if one staff’s playback transposition is set for 
a Bb instrument and one in C, then inserting a key signature of G Major will result in the first 
staff having an A Major signature, while the second will have a G Major signature (“Transposed 
Score”).

If you select “Ignore Instrument Transposition Keys, all staves to have the same key signature 
(“C” Score).

Move Notes
If you want to transpose the pitch for notes as well as change the key signature, place a check 
mark in the Move Notes checkbox and choose the direction the transpose operation should move 
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the notes.  Move Notes will also transpose Chord symbols and Guitar Fret symbols. 

Move Endings and Symbols
Normally when you Move Notes, symbols and endings are unaffected and will remain at the same 
vertical location in your score.  Checking Move Endings and Symbols adjusts these items up or 
down along with the notes.

Changing the Key Signature  for Playback
If you wish to change the key used for an instrument when playing the score, use the Key 
function in the Staff Sheet.  This transposes the notes on the staff to a new key for playback only 
and does not affect the display.

Reminder Key Signatures
When the next system in a score changes to a new key signature, the change is indicated at the 
end of the previous measure by default.  This reminder can be removed by using the Show/Hide 
dialog.

Encore always indicates key signature cancellations 
and changes within a system.

Barline Types 
Each measure in your score has both a left and a right 
barline type.  The default barline type is a single line drawn 
between each measure.  The default ending barline is a 
standard double-bar.

The barline type used to indicate repeats can optionally 
affect playback.

Left and right barline selections affect the first and last 
measures of the selection range only.  Adding repeats to 
the beginning and ending measures of a section can be 
performed in one operation. 

If measures are selected before opening the Barline Types 
dialog, the measure range and barline types indicated are 
the current settings for the selection.  

	 The left barline type will be applied to the left side of the first measure in the measure range.  The 
right barline type will be applied to the right side of last measure in the measure range. 

Play Repeats
If Play Repeats is checked, the repeat barline type will affect playback.  Repeat barlines combined 
with measure endings will determine how repeat bars are interpreted during playback.

Used without an ending or coda phrase (see Endings and Coda Phrases), the next measure played 
after a right repeat bar will be the previous measure which has a left repeat bar.  If no left repeat 
bar can be found, playback will begin at measure one again.  After a repeat bar has been played 
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once in a song without stopping, the repeat will be ignored the next time that bar is played. 

When repeats are used with the Endings and Coda Phrases settings, the next measure played will 
depend on the settings selected from within those dialogs. 

Barline Types will also affect the automatic Compress Rests function when extracting parts.  See 
Compress Rests and Extract Parts for more information.

Endings
The Endings dialog enters measure endings within 
the score.  Measure endings can be interpreted 
during playback and Encore will support up to six 
endings for playback.  Additional endings can be 
defined using text boxes but will not be used during 
playback.

Endings are easiest to define if the measures are 
pre-selected before opening the Measure Endings 
dialog, but the measure range can also be entered 
from within the dialog.

When measures are selected that have endings 
already defined, the ending type for the first measure 
selected will be indicated in the dialog.

For endings to be interpreted during playback, the Play Repeats checkbox must be enabled.

The font button at the top of the Measure Endings dialog determines the font, size and style for 
the numbers in the ending indications.  If Custom text box is selected the font selection will also 
be used for the text box.  Text boxes created within the Measure Endings dialog are standard text 
boxes and can be edited further after exiting the dialog.  Font selections for measure numbers 
apply to all endings but can be changed at any time.  Open the Measure Endings dialog and 
select a new font without selecting an ending to change the current font.  Click OK when you’re 
through.

The ending indication selected determines both what number or numbers are used for the ending 
and how playback will interpret the ending.  As each ending selection is checked, the field next to 
Custom text box updates to show you what characters are to be entered by default for the ending.

Custom Text Box
When Custom text box is enabled the measure ending will display only the entered text.  
Playback of measures with custom text boxes will still use the endings selected above the custom 
text box to determine how many times to play each ending and what measure is played next.

Lock Ending, Open, Closed 
Near the bottom of the dialog are three choices which affect how the ending is displayed in the 
last measure.  Open refers to a measure ending without a line drawn on the right side of the 
ending.  Closed will draw a vertical line in the last measure enclosing the measure ending.  If 
there is an ending in the selected area already, the current setting is displayed.  If a new ending 
is being defined, the choice will be based upon the barline type. Measures with a repeat or thick 
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double bar on the right will be closed.  If the right barline is not a repeat or double bar, the ending 
will be open.  Although Encore will initially select either open or closed for you, the selection 
can be changed.  The Lock Ending option prevents the selection of open or closed from being 
changed later if the barline type is changed.

Changing the Vertical Position  of Endings
The default position for endings can be changed after the ending is created.  A control point in the 
upper left corner of each ending adjusts the height of the ending.  The control point at the lower 
left sets the distance between the top staff line and where the vertical line for the ending begins.  
Click and drag at either of these locations to adjust either part of the ending.

A special control point on the right side of the ending will change the measure ending to either 
open or closed, depending on the current condition.  The status of the Lock Ending checkbox will 
not prevent this adjustment.

If the [control/option] key is held down while changing an ending using any of the control points, 
all other endings in that system will be adjusted at the same time.  This remains true for control 
points on both the left and right sides.

Coda Phrases
The Coda Phrases dialog contains various 
musical phrases used to direct the player to 
another section in the score.  When Play Them 
is selected, phrases entered with this dialog 
will also control playback.

Note:  Coda and segno signs also exist in 
the Symbols palette.  If you enter a coda or 
segno indication using the Symbols palette, 
the section will not be interpreted during 
playback.  Only codas and segnos entered with 
the Coda Phrases dialog can affect playback.

Also included are the words Coda, Segno and Fine which can be selected and placed at the 
appropriate measure.

You can select only one phrase at a time.

The Style, Font and Size menus determine the appearance of the phrase selected.  Font choices apply 
to all phrases added with the Coda Phrases dialog within the score.

Encore places Coda phrases within the selected measure at a default location and can be adjusted.  
Each phrase, however, can be adjusted only within the measure it was added to and will not move 
beyond that measure.

To move the phrase, click and hold on the phrase and move it to the desired location.

Measure Numbers
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Measure numbers can be added or removed at any 
time.  Measure numbers showing in the score will also 
appear on printouts.

Font attributes for measure numbers are selected by 
clicking the Font button. 

Click the Add Numbers checkbox to activate the 
measure numbers function. 

Measure numbers can be shown for every measure, 
every nth measure or at the beginning of each system.  
If you select Each system, the numbers will automati-
cally update when the layout is changed to show the 
new measure number beginning each system. 

The first measure number is optional and hidden by 
default.  Enable Start with First Bar if you want a 
number over the first measure.

When the first measure of your score is a pickup measure, click the First Bar is a Pickup checkbox.  
The first measure will not have a number and the second measure in the score will be called measure 
one.

Note:  The First Bar is a Pickup selection will affect the time signature settings for the first measure as 
well.  Refer to the section on Time Signature for more information.

If the first measure is already configured as a “pickup bar”, the measure range in dialogs will be 
affected. A pickup measure will be represented with a dash (“-”) in the From field of a measure range.

If you would like the measure numbers to appear in a box, click Enclose Numbers in a Box.

The starting number can be offset by either a positive or negative number of measures using the 
Number Offset box.  An example on how to use this would be in the case of a 4 measure introduc-
tion where you would like measure 1 to be after the introduction.  Place -4 in the box and measure 5 
becomes measure 1.

Encore allows you to indicate whether you want your measure numbers to appear above or below the 
measures.  The default is zero spaces above the measure. Any number from 1-15 can be used.

Compressed Rests
The Compressed Rests dialog is used to indicate multiple measures of rest with the standard graphic 
consisting of a thick horizontal bar and a number for the measures included.

You must select the measure or measures you want to “compress.”  To “expand” the multiple rest 
indication for a measure back into standard measures, select only the measure with the indication.

Note:  Both options in the Compressed Rests dialog (compress and expand) will be grayed out if your 
selection contains either notes or more than one measure with a compressed rest.  The section being 
compressed is for ALL staves.  If there are notes on any staves (even hidden staves) the compressed 
rest function cannot be used.
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When measures that can be compressed 
or expanded are properly selected, the 
Compressed Rests dialog will automati-
cally select the appropriate option and tell 
you how many measures the operation 
affects. 

The Horizontal line drawn within the 
measure defaults to filling 80% of the 
measure.  Enter any percentage between 
1 and 100 to change the appearance.  
100% will draw the line from the 
left barline to the right barline and 
completely fill the measure.

Font choices affect all compressed rests within the score. 

Measure numbers always update for compressed rests.

If Play Them is checked the full number of measures represented by each compressed rest will be 
played.  Think carefully about using this option as you may not care to “hear” several measures of 
nothing unless you are rehearsing.

Note:  When compressed rests are created with the Compressed Rests dialog, barline types, text 
boxes and other symbols within the selection are ignored and lost should you choose to expand 
the compressed rests back into standard measures later.  However, when Extract Part is used, the 
compress rests option will consider barline types, text boxes and other graphics and break consecutive 
measures of rests into groups when it encounters these items within the score.

Align Playback
Align Playback changes the MIDI start times for notes within the selected area to exactly match the 
screen representation.  Align Playback can be used to change a real-time or imported MIDI file to 
perform closer to the transcription obtained.  Align Playback can also be used if extensive editing for 
a section requires re-establishing the correct note order and timing.

Align Playback does not affect durations.

A selection is required for Align Playback.

Only notes within the selection are affected by the Align Playback operation.  Multiple areas on a 
page can be changed together using [shift] to select additional areas after making the first selection.  
See Selecting in Encore for more information. 

Swing Playback
The Swing Playback function imparts a swing 
feeling to a staff by changing the start time for 
notes that fall within the beat or on the “off” beat, 
and by changing the durations of all notes within 
the measure. 

Swing Playback requires a selection.  Selections 
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made to a portion of a measure will affect the entire measure, but each system can be changed in-
dependently.  All staves of combined instrument staves such as piano staves are affected by Swing 
Playback equally. 

A percentage amount defines how far forward the notes are to be moved.  50% is equivalent to saying 
“half the distance between beats,” which translates into “no swing.”  The default is 66.7 but any value 
between 50.0 and 75.0 can be used.

The Longest duration to swing determines how far the notes are to be moved and how much the 
duration is to be changed.

We recommend experimenting with the settings on a variety of music samples containing different 
note durations and tempos.  The default selection for eighth notes at 66.7 is also a good starting place.  
Rather than try and explain the mathematics for this operation, we’re going to let your ears explain it 
for you.

To remove the effects of Swing Playback you can use either Align Playback or set the swing 
percentage to 50%.  Either option effectively removes the swing effect. 

Align Spacing
Align Spacing establishes the horizontal and vertical spacing relation-
ships between notes, both within each measure and for all measures in the 
system. 

Align Spacing affects all measures on all staves for a range of measures.  
If the measure range is selected before opening the Align Spacing dialog, 
the measure range will be entered into the upper portion of the dialog 
for you.  The measure range can be changed by entering new measure 
numbers.  The arrow button to the right of the last measure selection is a 
shortcut for selecting to the end of the score.

Encore provides two different methods to calculate the spacing for notes, 
and can also alter the layout.

Engraver’s Spacing
Engraver’s spacing follows more of the rules traditional in engraving practices and tries to 
provide a compromise between strict placement within the measure according to each note’s 
duration and the need to more clearly show the contents of the measure without overlapping notes 
or accidentals.

Mathematically Perfect
When Mathematically Perfect is selected, notes are placed in the measure according to their 
indicated duration.  Accidentals are not considered and may overlap as a result of mathematical 
spacing.

Adjust Measure Widths
If the measure range is defined for entire systems (either one or several), the option to change 
measure widths will be available.  This selection tells Encore to change measure widths within 
the selected area according to whatever will best accommodate the notation within each measure. 
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Adjust Measures Per System
When the measure range is only for entire systems, you can optionally let Encore adjust how 
many measures are used in each system.  This adjustment will be performed on a system by 
system basis and will use the note density for each system to decide if the number of measures 
can be increased or decreased.

Adjust for Lyrics
This option (checked by default) will consider lyrics connected to notes within the measure when 
making spacing changes and try to avoid overlapping lyrics when altering note locations.

All Staves
This selection is checked by default.  In normal practice the notes on all staves are considered 
when using Align Spacing.  In some instances you may wish to change only the selected staves 
without changing other staves in the system.  Uncheck the All Staves option if you do not want 
Encore to align the entire system.

General Spacing Guidelines
Although several options exist within the Align Spacing dialog, the correct choice will depend on 
how much prior spacing has been applied to the score.  Generally speaking, the options to alter 
the number or width of measures should be performed only before graphics and lyrics have been 
added.  This ensures that any prior spacing for these items will not be altered in the process.

After a general arrangement for your score has been decided, Adjust Measure Widths and Adjust 
Measures Per System should not be used again or you may lose spacing considerations that Align 
Spacing does not calculate.

Finally, after adding lyrics and symbols to each measure, you may need to make some final 
“tweaks” to the spacing.  We recommend using Nudge and not Align Spacing.  See the section on 
Nudge under the Edit menu for more information.  

Save often, save well, and save copies of your work as you progress.

Score Menu
Add Page

The Add Page item allows you to enter any number of blank 
pages either before or after the currently displayed page.

All new pages created will use the page layout of the current 
page.  If you add pages after the current page, the last measure 
of the current page will be used to set the time signature and 
key signature for all measures in the new pages.  When adding 
pages before the current page, the first measure of the current 
page will be used to determine the time signature and key signature for all measures in the new pages. 

Note:  Be careful when adding pages before the first page in your score.  If you have created a pickup 
measure, the time signature of that pickup measure will be used for all measures in the inserted 
section.
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Add Page does not have an undo option for the operation.  If you wish to remove the pages added, use 
the Delete Page function.

Delete Page
Delete Page removes pages from your score.  Data in those 
pages gets removed with the pages.

Warning: Delete Page is NOT UNDOABLE!  If you delete 
pages with notation, the notation is lost.  You can use Revert 
to Saved to return to a previously saved version but all edits 
after the file was last saved will be discarded.

Delete Page will be available only when two or more pages 
exist.  The current page will be entered for the delete range but the Delete Page dialog allows a new 
range for either a different page or more than just one page, or both.

The arrow button to the right of the page range fields will enter the page number for the last page.  
Use this when you want to delete pages to the end of the score.

Caution:  Encore does not allow you to delete discontinuous pages.  The page range includes all pages 
between the first and last page specified.

Add Staff
The Add Staff dialog creates additional Note, Rhythm, Tab or 
Percussion blank staves in Encore.

Add Staff is NOT UNDOABLE.  To remove an added staff, 
use the Delete Staff item.

Add Staff does not require a selection but the current staff 
(where the cursor is located) is used to determine both where 
the staff is added and what operations are available within the 
Add Staff dialog.

Note:  Add Staff is only available in Page View.

Add _ Regular Staves
As many as 128 staves can be used in Encore, but the 
total number of staves you can add within this dialog may 
depend on the number of systems each page currently 
displays.  The total number of staves appearing on any 
one page (including tiles) can be no more than 128.  If the 
Add Staff dialog does not allow you to add the needed 
number of staves, exit (cancel) from the dialog and change 
the number of systems per page to a number that will not 
exceed the 128 per page limit. 

Add a Piano Staff
A Piano Staff is a combined staff that defaults to a treble and bass clef, but each staff is linked 
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to the other staff to allow for cross-staff beaming.  The Staff Sheet displays one instrument for a 
piano staff and a staff name will be centered between the two staves when using the name field in 
the Staff Sheet.

Voices on Piano Staves
The default voicing assignments for piano staves is as follows:

The top staff (treble by default) uses voices 1-4.  Voice 1 is used by default when inserting 
notes in “all voices” (Voice -) view.

The bottom staff (bass clef by default) uses voices 5-8.  Voice 5 is used by default when 
inserting notes in “all voices” (Voice -) view.

A piano staff can be from two to four staves.  See Add a Staff to this Piano Staff for more 
information. 

Change this to a Piano Staff
If a regular staff is selected before selecting Add Staff, the option to change the staff will be 
enabled.  This option creates only an additional staff and does not move notes onto the staff or 
change any of the notation for the selected staff.  If the staff is added above the new staff, the new 
staff is given a treble clef.  Changing to a Piano Staff and choosing add below will create a new 
staff with a Bass clef.

Note:  If you wish to create a piano part from a single staff you should consider using the Split 
Staff operation.  Split Staff lets you move notes onto the new staff at the same time the staff is 
created.

Add a Staff to this Piano Staff
If an existing piano staff with (fewer than four staves) is selected before opening the Add 
Staff dialog, the option for Add a staff to this Piano Staff will be enabled. Organ arrangements 
sometimes need more than two staves.  Piano parts for two players can also use the four stave 
system.

The voicing defaults when adding a third or fourth stave will use voices normally intended for the 
bass clef of a piano staff.

The third staff will use voice 7 by default and the fourth staff will use voice 8.  These are the 
default assignments for notes entered in all voices or “Voice -” view. 

Cross-staff beaming requires piano staves.  To create a beam between two staves in a Piano Staff, 
you must use the same voice for notes in both staves.  For instance, to beam an eighth note on the 
treble staff to another eighth on the bass clef, you must enter or change both notes to the same 
voice.  Entering the notes in all voices view will use different voices by default for each, so when 
creating a cross-staff beam, you must select a specific voice before entering the notes.  

You can find a section on cross-staff beaming in Chapter 8, Voices in Encore.

Placement
Add Above and Add Below determine where, in relationship to the current staff, the new staves 
will appear.  If you need to change the order of staves after they are added, you can do so using 
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the Staff Sheet. See the section on the Staff Sheet (Windows menu) for more information.

Type:  Note, Rhythm, Tab, Percussion
The drop down menu for the type selection will be available only when you are adding regular 
staves. 

Piano staves are standard note staves only.

Rhythm Staff
A rhythm staff is a single line staff without key signature, clef or barline indications.  Notes 
added to the rhythm staff use slashed note heads and are always placed directly on the single line 
indication.

Although a rhythm staff will play over MIDI, the intended purpose for the staff is to indicate 
the rhythm, so we recommend that you mute the staff within the Staff Sheet to avoid confusion.  
Notes copied and pasted to a rhythm staff will still use their original pitch but will appear at the 
same vertical position on the rhythm staff.

A common use for a rhythm staff will require the staff only for the beginning of the score or 
for new sections.  You can hide the rhythm staff when it is not needed by using the hide staff 
function.  See the section on Hide Staff for more information.

Tab Staff
The Tab Staff indicates the fingering for fretted instruments.  Each line of the Tab staff refers to 
a string on the instrument, and numbers placed along the string indicate the fingering position 
relative to the instrument’s frets and tuning.  Click on OK-Open Setup to set up the Tab staff.

Tab staves are usually combined with standard notation staves.  A complete discussion of the Tab 
Staff can be found in the section concerning the Make Tab item.  See the Notes menu and Make 
Tab or Tablature Staff for more information. 

Percussion Staff
Percussion staves are used for notating drum and percussion parts.  See Chapter 12 “Percussion 
Staff” for more information about adding and editing a percussion staff.

Delete Staff
When a staff is no longer needed for the entire score, you can use Delete Staff to completely remove 
the staff.

Delete Staff requires a selection.  All selected staves will be removed.

Caution:  Delete Staff is NOT UNDOABLE.  All notation on the staves is deleted along with the staff 
or staves themselves.

If you are working on a score with several instruments and you wish to hide instruments for a section 
when they are not playing, use Hide Staves and not Delete Staff.  The Hide Staves command does not 
remove the staff from the score but simply hides it for the selected system.  Delete Staff completely 
removes the staff from the entire score.
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Split This Staff
Split This Staff takes an existing staff and “splits” 
both the staff and notes, giving you two staves.  
MIDI files with piano parts on a single track can be 
changed to a Piano Staff within Encore for further 
editing with this feature.  Another use would be to 
separate two instruments notated on one staff into 
two separate staves for each instrument.

Split This Staff requires you to select the staff you 
wish to split.  The staff must be a single staff.  Piano 
staves cannot be split.

Move these notes to a new staff
Two methods exist for determining what notes 
are moved to the new staff.  If the pitch selection is specified, then anything below the entered 
pitch will be placed onto the new staff.  The second method uses the voicing capabilities within 
Encore to separate notes.  For this to work correctly, the voice selected should fill each measure 
with the correct number of beats.

Note:  If you revoice a section just so you can split a few notes to a new staff, remember that 
changing the voice may require adding rests for all affected voices.  It is best to fully align 
playback after revoicing and adding any needed rests.

Set the Clef to
Four checkboxes are available for selecting the clef to be used on the new staff.  Hybrid clefs or 
additional clefs can be added after the staff has been created.

Keep Notes in a Piano Staff
This option changes a regular staff into a Piano Staff.  If Keep Notes in a Piano Staff is not 
checked, the new staff will be a regular staff.

Connect Staves
Connect Staves creates and removes both Brackets and Braces and breaks the barlines between staves 
in a system.

Connect Staves requires selecting the staves to be changed before opening the Connect Staves 
dialog.  Selection of the staves should be made using the single-click method for selecting a system 
with additional staves selected by holding the [shift] key down.  You can also use “select all” if the 
operation is for connecting an entire system.

Break Barlines
Barlines, sometimes called measure lines, are drawn by default between each staff in the system.  
When lyrics are added to a system it is not uncommon to break the barlines below the staff with 
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the lyrics.

Break Barlines removes the barlines between the 
selected staff and the staff below.  If more than one staff 
is selected, the barlines will continue to be broken in the 
same manner for all selected staves. 

Brace
The Brace or curved bracket, looks like an archer’s bow 
and is placed to the left of a system.  The brace indicates two or more staves that are to be read 
and played together.  The standard use for the brace is for instruments such as the piano, celeste, 
harp and organ.  Piano Staves in Encore have braces added by default but these can be removed if 
you desire.

Bracket
The Bracket or Accolade is commonly used to connect chamber or choral music or to connect 
instruments in the same family for orchestral arrangements.

To add either brace or bracket or to break barlines for selected staves, check the appropriate box.

To remove one of these indications, click in the box again to clear the check mark.  The Connect 
Staves dialog will display any existing braces, brackets or a broken barline state for your selection 
by checking the appropriate box.

Center Staves
Center Staves moves all the staves, regardless of the vertical spacing within each system, to 
equidistant positions on the page.  If the number of staves does not fit, all extra staves are moved to 
additional tiles.

Caution:  Center Staves is NOT UNDOABLE!

Center Staves is a quick and easy method to redefine the page layout.  After adding or deleting staves 
in your score, or when changing the page reduction amount, you can use Center Staves to establish a 
basic layout that can be further edited as needed.  See Moving Objects in Encore for more information 
about adjusting the page layout for staves and systems.

Center Systems
Center Systems is similar to Center Staves but adjusts only the distance between each system.  Within 
each system, the spacing between staves is maintained.

Caution: Center Systems is NOT UNDOABLE!

Center Systems optimizes the page layout after establishing the system layout.  For final page layout 
of systems and staves see Moving Objects in Encore.
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Systems per Page
Systems Per Page changes how many systems appear on 
either the current page or the current page and all remaining 
pages.

Changing the number of systems per page will frequently 
change the number of pages but will not affect the number 
of measures in each system.

If the number of systems for a page will not fit on a printed page, the extra systems are moved 
onto “tiles” below the bottom margin of the ‘normal size’ page.  See Printing in Encore for more 
information.

Measures Per System
Measures Per System can change the number of 
measures for a single system or for all the remaining 
systems, including the current system. 

If you reduce the number of measures for a system, 
the extra measures will be placed in the next system or 
the next several systems.  When changing the number 
of measures to be greater than the current amount, 
measures in the following systems will be moved onto 
the current system.

Changing the number of measures per system can also change the number of pages depending on 
your selections and the number of measures and systems on each page.  Encore will attempt to keep 
the number of systems on each page the same.  As measures are needed to fulfill the measures per 
system request, however, unneeded systems will be removed from the end of the score.

You can also change the number of measures in any system without using a dialog by placing the 
insertion cursor in that system and then using the bracket keys “[“ and “]”  to move measures to and 
from the following system.  The left bracket key will move measures onto the next system. The right 
bracket key will move measures onto the current system.

When moving measures in this fashion, only the last system in the score is affected.  Rather than 
continuing to add them to last system, however, Encore will create new systems and pages when 
needed.

New systems are created when the number of measures in the last system equals the number of 
measures in the previous system.  That is, if the last system in your score has only one measure and 
the system before that has three measures, you can “flow” two measures forward before Encore will 
generate a new system.

New pages are created when creating a new system would create more systems than the previous 
page.  This prevents a situation where the last page has numerous systems because you were moving 
measures around somewhere earlier in the score.
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Text Elements
Text Elements defines score titles, 
headers, footers, page numbers, 
dates, times and copyright notices 
in your score.  Each item can use a 
different font, and items that contain 
several lines (such as the Title) can 
have different fonts defined for each 
line.

Score Titles 
Three lines are provided for 
score titles.  Text is automatically 
centered and appears only on the 
first page.

The title section can use a 
different font selection for each 
of the three available lines, but 
the first line is special.  Font changes applied to the first line automatically apply the same font 
selection to the second and third lines whenever the first line is changed.  This provides a shortcut 
to change the title section quickly.

Instructions
Instructions appear on the left side and are left justified for the longest line, but center justified in 
relationship to each other.  Three lines are provided and each line can have its own font selection.  
Font selections act independently of other lines.

Instructions appear on the first page only.

The instructions section can be used for indicating a tempo or style, additional composer 
information or anything desired.

Composer’s Name
Four lines are available for the right side of the first score page.  Traditionally this location is used 
for the composer’s name, but can be used for any text desired.  Each line can use a different font 
selection and selections are independent of the other lines.

Headers and Footers
Headers appear along the top of a page.  Footers appear at the bottom of a page.  You can create 
two different header items and footer items for each score. 

Header and footer contents can combine text with automatic options for adding page numbers and 
time indications.

Justify options can place each header and footer on either side or centered.

Flip on even/odd pages takes the page number into account when placing header and footer items 
on the page.  This is especially useful if you will ultimately be printing two-sided pages and 
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binding your score.  For example, if you use a right-justified header to print a page number on 
your score and check Flip on even/odd pages, the first page number will appear on page 1 in the 
upper-right corner.  Page 2’s number will appear in the upper-left corner.  This placement will 
hold true for all subsequent odd- and even-numbered pages.

Page, Date and Time
#P is used to indicate the current page number.

#D is used to display the current date in the format mm/dd/yy.

#T is used to display the time.

Date and time indications will update as you work on the score.  These indications are saved as 
special instructions and not as the actual date or time when the score is saved.  Every time you 
open the score, these settings will reflect the currently displayed time and date for your computer 
as defined in Windows’ Date/Time Control Panel or Mac’s System Preferences.

Start on Page
Start on Page indicates which page begins showing numbering options using the #P option.  For 
example, if you type a 3 in this box, you won’t see page numbers for pages 1 and 2 and page 
numbers will start on page 3.

Note:  This feature only hides page numbers.  It does not re-paginate.  Use Page Offset to re-
paginate.

Page Offset
Using an offset allows two different scores intended to be first and second sections for the same 
score, to be printed with a consistent page reference.  For example, if your first section ended on 
page 33, you can continue the page numbering for the second file by entering the number 33 into 
the page offset.  Now the second section can be numbered starting with page 34. 

Copyright Notice 
Copyright information is centered at the bottom of the score.  Six lines are provided for copyright.  
Each line can use a different font selection.  Font changes are made independently from other 
lines.

MIDI Device/Instrument Settings
The Staff MIDI Device and Instrument Settings dialog provides access to all instrument settings.  You 
may assign instruments/ MIDI channels to any staff, to any voice, from any device or bank as well as 
adjusting the Gain, Pan and Reverb Level.  Encore has the capabilities to use two copies of the built 
in synthesizer, thereby doubling the number in individual MIDI channels.  This enables you to hear a 
score with full instrumentation without using multiple MIDI devices.

Use the staff selection to indicate which staff you would like to assign the device/instrument with the 
staff name drop down menu.

Select the Playback Device.  This can be the Built-in Synths, a MIDI device plugged into your 
computer, another MIDI enabled application or a VST Instrument  
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Set the Playback Device’s Bank.  If you are using the built-in synth, the default bank is already set

If you are using an external MIDI Device, a popup menu allows you to choose a common mapping 
of instrument names to MIDI instrument number.  The default mapping uses General MIDI standard, 
to which most newer synths adhere.  For more advanced synths, text fields are displayed for Bank 
settings on the device.  The MSB setting corresponds to MIDI Controller #0 and the LSB setting 
corresponds to MIDI Controller #32.  Refer to your synth’s documentation for more information 
about Bank control messages.  Select which voice in this staff will use this set up.  Encore defaults to 
All Voices.

Click on the grid to select the instrument patch on the playback device you want to use for the 
selected staff/voice.  A test note will be played.  Hitting a key on the computer keyboard will play 
another test note.

Select the MIDI channel.  It is best to assign each staff to its own MIDI channel.  If staves or voices 
share MIDI channels, then you must be careful to ensure that they use the same settings, otherwise 
unpredictable conflicts may occur.

Adjust the Gain (volume) by moving the slider.  If the slider is all the way to the left, then the gain is 
at maximum.

Adjust the Pan to determine speaker balance left, right or somewhere in between.

Adjust the Reverb Level as desired.

Repeat the process for each staff and voice.

Click OK.

You may make all of your instrument assignments in one use of the dialog and then hit OK.  There is 
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no need to have to reopen the window for each staff or voice.

MIDI Playback Settings
Music is just a bunch of notes if there is no life to it.  With MIDI Playback Settings, you can bring 
music to life or close to it (nothing can replace a “live” musician) by adjusting the velocities of 
dynamics and markings.

The MIDI Playback Settings window allows you to control dynamics velocities, Send Volume 
Control, Change Note Velocities, Humanize, Play Pedal Markings, Slurs, and Hairpins, Ramp to 

Ending Dynamic, Always Change Dynamic By n, Play Marks  including Accents and Articulations.

The Dynamics settings allow you to customize the velocity range for each dynamic marking.  The 
Send Volume Control check box sends the dynamics data within the ranges selected to MIDI 
controller #7 (volume).  If you are using the Garritan Studio to use Garritan’s instrument samples, 
Encore will recognize the Garritan Studio and send the volume message to the Mod wheel as per 
Garritan’s specifications.  Change Note Velocities replaces the recorded velocities with the velocities 
specified in the dynamics ranges.  The Humanize feature uses more random attack velocities and 
volume velocities.

Play Pedal Markings activates the sustain pedal controller #64 when indicated and releases when 
indicated in the score.

Play Slurs sends MIDI legato to controller #68.  This adjusts the attack and decay of the notes in the 
slur to make them more legato or smooth.

Play Hairpins contains two options.  The first, Ramp to Ending Dynamic, enables Encore to scan 
ahead to the next dynamic marking and smoothly crescendo or decresceno.  The second option, 
Always Change Dynamic By, makes all hairpins perform in the same way, increasing or decreasing 
by n  velocity from the last dynamic marking before the hairpin. 
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Play Marks allows you to change velocity and duration for specific accent and articulation markings.

View Menu
The View menu contains several methods to select both how the score is viewed and what items are to 
be shown within the score.

Show/Hide
Show/Hide contains checkboxes to either 
show or hide notational elements and page 
layout options such as a rulers and page 
margins.

To show any of the selections in the Show/
Hide dialog, enable the checkbox next to the 
item (that is, click in the box so a  appears).  
With the exception of rulers, all selections in 
the Show/Hide dialog affect only the current 
score and are saved for each score indepen-
dently. 

Rulers
Rulers are useful in page view when 
aligning several objects at different 
locations.  You can select either inches 
or centimeters.  Ruler status (on or off) 
is saved with a score only, but the selection of inches or centimeters is saved in preferences.  The 
inches or centimeter selection applies to all open scores. Rulers are not available on Mac.

Staff Name
Staff names can be displayed on the first page or on every page in the score.  When displaying 
the staff name on each page, the names are displayed for the top system only.  Staff names are 
designated in the Staff Sheet.

Control Points
Control points are the small squares at the end or corners of many graphic objects that are used to 
define the shape and/or length of the graphic.

Cancellation Keys
Key signature changes that occur at the beginning of a system can be displayed at the end of the 
previous system.  This indication is called a “reminder” key signature. When cancellation keys 
are hidden, this reminder is removed from the end of systems. 

Encore will always display the cancellation of accidentals for key signatures that occur within a 
system. 



The Menus- Windows205

Initial Clef & Time
Hiding the initial clef and time signature can come in handy when you want to print blank 
manuscript paper.

Background
There may be times when you have resized the score window, allowing a portion of the 
background to become visible.  When the Background option is selected, the program background 
will be a graphic pattern.  When Background is not selected, the background is solid gray.

Page Margin
The Page Margin indicates the area of graphic information that will be printed.  Staves and 
systems cannot be placed outside this area and graphics and text should remain inside the page 
margin.

When Page Margins have been enabled a broken line will indicate the page margin within your 
Score window.

Print Rhythm Staff Line
A rhythm staff is a single line staff without key signature, clef or barline indications.  Notes 
added to the rhythm staff use slashed note heads and are always placed directly on the single line 
indication.

When “Print Rhythm Staff Line” is selected, the rhythm staff and any notes or rests it contains 
prints just as it appears onscreen.  When this option is not selected, the notes and rests print, but 
the line itself does not.

Left Barline/Single Staves
This option has an effect only when your systems consist of a single staff.  When selected, the left 
edge of each staff has a bar line; it is “closed.”  When not selected, there is no bar line; the left 
edge of each staff is “open.”

MIDI Items
MIDI Items refers specifically to the text indication added to the score when controller or 
program changes are added using the Tools palette.  Even when MIDI items are hidden they 
continue to affect the MIDI playback of the staff they are attached to. 

By hiding MIDI items you can enter more appropriate text strings for the event.  For example, 
you may use a different program on your synthesizer when a change in tonality is needed, but the 
basic instrument could remain the same.  By hiding the MIDI item and adding a text box instead, 
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you can indicate the performance change using more suitable terminology.

Encore also has the option to print the MIDI items on the score by checking the Print MIDI Items 
box.

Time Signature
Time signature changes that occur at the beginning of a system can be indicated at the end of the 
previous system.  This is called a “reminder” time signature.  When time signature reminders are 
hidden, the time signature will only be indicated in the measure where it begins.

Key Signature
Key signature changes that occur at the beginning of a system can be indicated at the end of the 
previous system.  This is called a “reminder” key signature.  When key signature reminders are 
hidden, the key signature will be indicated only in the measure where it begins.

Color
Encore gives you the ability to display and print your music in color.  This can be useful for 
showing different parts or for differentiating between voices on a single staff. Situations may 
arise, however, where it is necessary to “hide”. 

If your printer is capable of printing color or grayscale images, and you want a color score to print 
in black and white, deselect the In Printout checkbox and the score will print in black and white.

Rests
Rests for each voice in Encore can be hidden.  The default has the rests showing for voice 1 and 5 
as these two voices are used for the treble and bass clef of the piano staff.

Hiding rests in Encore is provided because different uses for each “voice” may arise.  If a 
second voice is needed for only part of a measure, it may not be appropriate to use a rest in the 
first portion of that measure.  At other times, perhaps for the same instrument, rests may well 
be needed for more than one voice indication.  In many cases, the “voice” being indicated may 
technically be considered the same (in regards to the actual music indicated) but the need to 
sometimes hide or show the rests will require using two different voices to achieve that result.  
With eight voices provided, Encore gives you plenty of choices to cover even the most complex 
voicing situations.  See Chapter 8: Voices in Encore for some examples using hidden rests.

Show Control Points
This shortcut toggles between showing and not showing the control points.
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Use Handwritten Music Symbols
Encore has two music writing fonts, Anastasia and our NorMusic Font.  By choosing this item, all 
notes and symbols will be notated with a handwritten look.  After turning this option on, you may 
manually change any of the text fonts to one of Encore’s handwritten style “NorScript” fonts.

Spacing Defaults 
This function sets global defaults for 
beam stem lengths, beam thicknesses, 
horizontal/vertical tie offsets, and 
measure spacing (distance between 
barline, clef, time signature, and key 
signature).

Each score can store its own set of 
spacing defaults but an initial setting 
is determined by the preferences or 
template file settings.

Change Score Colors 
The Change Colors dialog gives you 
a way to make global color changes 
and to change the color of other score elements like staff and bar lines.  In order to save the color 
selections as a default, make your color selections and then Export the score as a Template or as the 
default score setting.   

The drop down menu enables you to change 
the colors of specific score elements:  Notes 
and rests in voices one through eight, inactive 
voices, other symbols, and the background.  
Inactive voices are the voices that normally 
“gray out” when you’re using the Voice Selector 
to view individual voices.  “Other Symbols” are 
the non-note/rest objects you have entered into 
your score like text and chord symbols.

Near the top of the Change Color dialog is the 
Color pop-up.  Click on the color box and the 
pop-up menu will appear to gain access to the 
16 available colors.

The graphic below the drop down menu 
provides a visual representation of each of these 
items.  Choosing a color for any of the items 
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will cause its color to change in the graphic. 

The Staff Lines list box displays each of the staves in the score.  To change a staff’s color, select 
a staff in the list box and choose a color from the pop-up.  Press and hold the [shift] key to select 
multiple staves.

Guitar Frets
Chord indications in Encore are either text only or text and guitar fret indications.  With the Guitar 
Frets dialog you can change between either display for any selected section in your score.  

Guitar Frets requires you to select the chords you want to change.  Select the chords and open the 
Change Guitar Frets dialog.

Show Staves
Show Staves shows hidden staves within a system or systems.  The menu item requires a selection, 
and all selected systems will be affected.  To better understand the process of showing staves, refer to 
the following section regarding the hiding of staves.

Hide Staves
Hide Staves hides one or several staves on a system-by-system basis.  You can hide a staff for as 
many systems as you desire, and different staves can be hidden in different systems.

The uses for Hide Staves are many, but a standard use is to hide staves within the arrangement for 
instruments that are not performing.  Another use may be to hide the entire drum track of an imported 
MIDI file.  

Hide Staves requires a selection.  The selection can be one or more staves and can cover one or more 
systems.  All selected staves will be hidden.

Hiding staves in Linear View mode is temporary.  Hidden staves are all shown when switching from 
Page View to Linear View.

The Hide Staves and Show Staves menu options do not use dialogs and are not undoable.  

Linear View
Linear View changes the normal system-by-system view arranged vertically on each page into a con-
tinuously scrolling view with only one system arranged horizontally.

If staves have been hidden in page view they will be showing in Linear View, but staves can also 
be hidden while in Linear View.  However, when hiding staves in Linear View, the change is only 
temporary and will neither affect hidden staves in page view nor be remembered for the Linear View 
selection.  

Linear View does not affect the printing of your score.

Hide Floating Windows
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Encore has several floating windows.  Floating windows  always appear “in front” of other windows 
in a program; they can be hidden only behind other floating windows.  In Encore, the palettes, the 
Tempo and Keyboard windows, and the Toolbar are all floating windows.  They will always appear in 
front of the Score window and the Staff Sheet.

The Hide Floating Windows command gives you an easy way to remove these windows from the screen 
without actually closing them.  This is especially helpful with smaller monitors or at low resolutions.

Choose Hide Floating Windows from the View menu and any of the floating windows on the screen 
disappear. Choose Show Floating Windows and they reappear.

Note:  Floating windows must be opened from the Windows menu before you can use the hide/show 
command.

Windows Menu 
The Windows menu contains the Palette sub-menu, the Staff Sheet, Keyboard, Tempo Window, Cus-
tomizable Toolbar, and all open scores.

Palette
To open any or all of the 11 palettes, select Palettes in the Windows menu and select from the palettes 
sub-menu that appears.  Palettes that are already open will have a check mark next to them.  Palettes 
are closed by clicking the palette’s Close box.  

Open palettes and their locations are saved with preferences and recalled the next time you run 
Encore.

In addition to opening each palette, you can also switch any open palette to one of the unopened 
palettes.  Click to the left or right side of the palette’s name to change the palette to the next unopened 
palette in the list.  The right side selects the next palette below the current palette name in the list, and 
the left side selects from above. You can continue using this method to access unopened palettes until 
you reach the desired palette.  

Open All Palettes
To open all 11 palettes, use this command.  The palettes will be displayed on the left side and may be 
relocated by dragging. 

Close All Palettes
To close all 11 palettes, use this command. 

Staff Sheet
The Staff Sheet configures each staff for playback and for the name displayed for the staff.

Play
To the right of the staff number is a field in the Staff Sheet that represents the play status for each 
track.  By default, each track will be “play enabled” and represented with a solid triangle.  To 
“mute” a track, click directly on the triangle.  This turns the center of the triangle white and all 
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MIDI playback for that track will cease.

Staves can be muted at any time and as many 
staves as desired can be muted.  The mute 
status is saved with the file.

Solo
The solo field provides an easy method for 
temporarily disabling other staves to allow a 
single instrument or instruments to be heard.  
Click in the solo field for the staff you wish to 
solo.  A solid diamond indicates a soloed staff.

Staves which are not soloed will reflect their temporary mute status by changing the play 
indication (the solid triangle) to gray.

As many staves as desired can be soloed, and the solo function can be enabled and disabled while 
playing.

Name
The Name field is used within the score when Show Names is enabled in the Show/Hide dialog.  
The name is always placed to the left of the staff and will be centered between the staves of a 
piano staff.

Click in the Name field to open the Staff Name dialog and enter a name for the staff.  You can 
also use this dialog to set the font and style for the name as it appears on the score.

Staff names are always right justified against the staff.  If you want to change this, enter spaces 
after the name to offset the staff name.  Line returns can be used as well.

Size
Encore provides four sizes for staves.  Click the Size field to open the Set Staff Size dialog.  Staff 
sizes can be set independently for each staff.  Use the provided checkbox for changing all staves 
at the same time.   Move the slider from 1 to 4 to set the staff size.

Key
The Key field in the Staff Sheet transposes only the playback of the staff.  Clicking in the Key 
field opens a dropdown menu with a list of all known instrument transpositions.

The Key function transposes individual instruments (staves) within a score to their proper key 
when playing back.  For instance, you could write a band arrangement with each instrument in its 
notated key, and by setting the playback transposition of each instrument be able to playback the 
score at sounding pitch.  Another example concerns writing guitar transcriptions.  Since the guitar 
sounds an octave lower than written, you need to set the playback key to “Octave Lower (C)” to 
hear your transcription playback in the right octave.

MIDI Channel (Chnl)
When a cell in the ‘Channel’ column is clicked, the MIDI Device/Instrument dialog will appear.  



The Menus- Windows211

See MIDI Device/Instrument Settings for more information.

Program Name
The Program Name field selects a “patch” setting for your synthesizer.  The selected program 
(or patch) is one of the 128 numbers used in the MIDI protocol and the selection is sent to the 
synthesizer whenever playback begins from the start of the score.

The Program Name field has two display settings.  Change these settings by clicking on the 
Program Name (or Prg) at the top of the Staff Sheet.  The width of the column used for the 
program name will expand and collapse when toggling between the two display settings.

When expanded, the Program Name column uses a text description for the currently selected 
program number and MIDI device.  The collapsed view uses only the MIDI number reference.  In 
either view the indication will be for the first voice only.

When a cell in the ‘Program Name’ column is clicked, a popup menu appears allowing you to 
select the program for the staff’s current device. 

This setting will affect the voice currently displayed in the score’s voice menu.  If a single voice 
is being viewed, text will appear at the top of the Staff Sheet Window to remind of which voice 
you are viewing/editing.  Alternatively, you can click on a Channel or Gain cell to open the Staff 
MIDI Device and Instrument Settings dialog.

Staff MIDI Device and Instrument Settings
The Staff MIDI Device and Instrument Settings dialog appears when you click in the Channel column 
to choose an instrument sound (MIDI program change number) for that staff.

Device Names
The default device selected in the Staff MIDI Device and Instrument Settings dialog is General 
MIDI  To choose from one of the other included devices, use the Device menu in the dialog.  A 
more complete description of the Device menu appears later in this section.

128 Program names are available for each device but not every synthesizer will use all 128.  
Some synthesizers may have more than 128 programs stored, but the MIDI Program definition 
only uses 128.  To use other programs on your synthesizer you will need to change the location of 
the program to one of the locations that can be recalled using the standard program numbers.

To select from any of the available program names, click on a program name in the matrix of 
names.  When the ‘focus’ is set to the program name matrix, you can use the arrow keys to select 
different programs. 

Assigning Different Programs  for Each Voice
The Voice text box in the upper right corner of the Staff MIDI Device and Instrument Settings 
dialog lets you choose which voice the current program selection will affect. When Voice - is 
selected, changing the program selection changes all other voices to the same selection.

To make individual selections for each of the eight voices, select the voice from the voice menu 
and then make your selection.
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Encore allows you to use a different MIDI Channel and program for each of the eight voices.  
Normal use of the voices will not require unique sounds for each voice.  When writing for two 
instruments on a single staff, you can assign a different program name for each voice used.

Note:  To use different program names you must also use different MIDI channels for each voice 
assigned a different sound.  For example, if you used voice 1 for a trumpet and voice 2 for a 
trombone you would need to assign voice 1 to one MIDI channel and voice 2 to a different MIDI 
channel.  If the other voices were unused they should be assigned to “none” to avoid interfering 
with other selections on different staves.

Staff Selection
The Staff MIDI Device and Instrument Settings dialog allows you to make your device choice 
for one, multiple or all.  When All Staves is enabled, changing the device type for one staff will 
change the device referenced for all other staves as well. 

The Choose Program Dialog
In collapsed view the Program Name field will display only the number reference for voice one 
in the Staff Sheet.  Clicking on the Prg field will open a drop down menu of the instruments 
available to the device as set in the Staff MIDI Device and Instrument Settings dialog.

Voices Settings
The voice selection drop down menu provides options for program assignment for all voices or 
for individual voices in a staff. 

Gain (Volume)
Gain is controlled through the Staff MIDI Device and Instrument Settings dialog with the fader at 
the bottom.

Changing the Staff Sheet Order
The order in which the staves appear within the system can be changed from within the Staff 
Sheet.  Changes made to the staff order affects all systems. 
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Note:  Changing the staff order will change the status of hidden staves.

To change the location of a staff, click on the number for the staff in the Staff Sheet and drag the 
staff up or down to the new position.  Release the mouse button and the staff will be moved to the 
new location. 

Note:  We strongly recommend that you remove any braces or brackets before rearranging the 
staff order.

Keyboard Window
The Keyboard window is a graphic, on-screen keyboard that can be “played” with your mouse or 
from your computer’s QWERTY keyboard.  This enables you to input music from a keyboard in step 
time or real time without the need for a MIDI keyboard.

Playing the Keyboard

To play the keyboard with your mouse, simply click on the keys.  If you’ve got a soundcard or 
a MIDI sound module connected to your computer, you will hear the notes sound as you click 
on the keys.  The instrument sound you hear is determined by the channel and program settings 
for the active staff (the staff that contains the blinking insertion cursor).  The MIDI program and 
channel settings are made in the Staff Sheet.

To play the graphic keyboard from your computer’s keyboard you must first enable QWERTY 
note entry mode.  Click the checkbox labeled QWERTY Keyboard Note Entry in the lower 
left corner of the Keyboard window.  The “lights” on the little keyboard icon turn green and 
QWERTY note entry mode is enabled.  The illustration shows the QWERTY keys you can “play” 
and their corresponding notes.

Input notes in step time or real time just as you would with a MIDI keyboard.  You can even use 
the QWERTY keyboard to parse chords.  (See Chord Parsing in the chapter “Using the Palettes.”)

Note:  When recording in real time from the QWERTY keyboard, turn Follow Playback off in the 
Setup menu for the best results. 

Chords
As you may already have noticed, you can’t enter chords with your mouse.  You can play chords 
on your QWERTY keyboard, but the number of notes may be limited with certain key combina-
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tions.  There is, however, a simple method for step-entering chords.  Hold the [shift] key and click 
on the notes that make up the chord.  When you release the [shift] key, the notes will be scored as 
a chord.

You can also use the [shift] key to enter chords from your QWERTY keyboard.

Changing the Octave
You can click any of the keys in the Keyboard window with your mouse, but if you’re using the 
QWERTY keyboard your range is limited to an octave and a fourth (from C to the F in the next 
highest octave).

To shift the range up or down by octaves, drag the little QWERTY keyboard icon in the Keyboard 
window.  You can drag the keyboard icon left or right in one octave increments.

Watch Staves/Setup
When you play back a score in Encore, the Keyboard window will indicate which notes are being 
played.  The Watch Staves (Windows) or Setup (Mac) button opens a dialog that allows you to 
choose which of the score’s staves will be displayed in the Keyboard window during playback.

If the notes in the score have been set to a particular color, the appropriate keys in the Keyboard 
window will “light up” with that color when the notes play.  This comes in handy while viewing 
different staves or voices simultaneously on the keyboard.

Displaying Notes on the Keyboard
Encore’s ability to display the score’s notes on the keyboard can be a useful educational tool, 
but if you’re playing the piece back at tempo, it may be difficult to see the individual notes and 
chords.  If you use the arrow key selection technique while the Keyboard window is open, the 
selected notes will be highlighted on the graphic keyboard. 

Using the arrow pointer, place the insertion cursor next to the note or chord you’d like to view.  
Hold [control/command] and press the left or right arrow keys to select the event.  The note or 
chord is displayed in the Keyboard window.  The notes appear in the Keyboard window with the 
color assigned to them in the Score window.  Only single events (one note or chord) in a single 
staff can be displayed at one time.  You can hold [control/command] and press the left or right 
arrow repeatedly to step through the score. 

Tempo Window
The Tempo window provides a quick and easy way to globally alter the tempo of a score.  Changes 
made with the Tempo window will scale the tempo for the whole score, even when tempo changes 
within the score.

Changing the Tempo
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The Tempo window displays the current tempo in beats per minute (bpm).  The 
displayed tempo is for the measure that contains the insertion cursor.

There are two ways to change the tempo:

	 Drag the tempo control up or down to choose a new tempo.  You can even do 
this during playback to continuously vary the tempo.

	 Use the “+” and “-” buttons to slowly and accurately increment and 
decrement the tempo.

Resetting to the Saved Tempo
The Reset button causes the score to revert to the saved tempo.  This can be very 
helpful if you simply want to make temporary changes (for example, to record a 
particularly difficult passage in real time).  If, however, you save the score after 
changing the tempo with the Tempo window, the tempo will be permanently altered.

The Tempo Window and Tempo Changes
If you use the Tempo window to alter a piece that contains tempo changes, all of the tempos will 
be scaled accordingly.  Let’s say a piece starts out at 100 bpm.  Then, after four bars, the tempo 
changes to 200 bpm.  If the insertion cursor is in the first four bars, the Tempo window displays 
100 bpm.  If you change the tempo to 50 bpm, the tempo will now change to 100 bpm at measure 
5. Both tempos are reduced by 50%.

Customizable Toolbar
Encore features a floating, customizable Toolbar.  This Toolbar contains icons that represent 
commonly used Encore commands.  (All of the icons and their related functions are shown at the end 
of this manual on the pages entitled Toolbar Icons.)  Rules about selection and cursor placement still 
apply; the toolbar simply provides a convenient shortcut.

The Toolbar is a floating window so it is affected by the Hide/Show Floating Windows command in 
the View menu.

Customizing the Toolbar
The Toolbar contains a few icons by default, but it is fully configurable.  You can choose the 
icons and the order in which they appear.  This is accomplished with the Toolbar Setup item in the 
preferences menu.  For more info see Toolbar Setup.

Open Scores
At the bottom of the Windows menu is a list of all new and currently open songs in Encore.  A check 
mark will appear next to the active song.  MIDI and Master Tracks Pro files, before they are saved as 
Encore files, have the words “MIDI File” or “MTPro File” added to the end of their file name.  This 
indicates that the notation information has not been saved in an Encore file.
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Setup Menu 
Click On/Off

To hear a metronome click, you can toggle the state on or off from the menu or use the shortcut 		
combination of [control/command] + [F].

For more about the click function refer to the previous section.

Follow Playback
When Follow Playback is selected, an arrow head appears above the measure currently playing 		
back.  The score scrolls as it plays. 

In page view, the playback arrow centers the page while scrolling, keeping the current staff 
andmeasure in view.  Before starting playback, place the arrow pointer in the measure and staff where 
you want playback to begin.

You can use the Fit Width item in the Zoom Tool menu to avoid horizontal scrolling during playback.

The Follow Playback status is saved in preferences.

The Auto Space function will beep if you attempt to add a note or rest to a measure that is full.

Auto Space defaults to “on.”  If you don’t want Encore to automatically space the notation, choose 
Auto Space again to remove the check mark.

Auto Guess/Beam
If on, this function automatically applies the Guess Durations and Beam on Beat operations for all 
recorded data, imported MIDI or Master Tracks Pro files, and step-entered notes.

Auto Guess/Beam automatically beams notes together when adding or erasing notes with the pencil 
and eraser tools.

Auto Guess/Beam automatically readjusts beams and stem when dragging notes.  It will also attempt 
to move any slur that appears “attached” to the dragged note.

Holding down the [control] key during the drag bypasses these adjustments.

Please Note: Operations that require selections or measure ranges will not use Auto Guess/Beam.

The Auto Guess/Beam status is saved in preferences.  Choose Auto Guess/Beam from the menu to 
toggle the check mark on or off.

Auto Space
This function applies engraver’s spacing automatically after several different operations in Encore.

When adding or erasing notes or rests with the pencil and eraser tools, Auto Space will apply the 
engraver’s spacing operation to the notes in the measure being edited.  In addition, erasing or adding 
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an accidental will also apply the engraver’s spacing. 

When pasting data, the Auto Space function applies an Align Spacing operation on the measures 
affected by the paste.

Auto Space automatically applies the engraver’s spacing when dragging notes, barlines, and staves.  
Holding down the control key during the drag bypasses these adjustments.

Please Note: Operations that require selections or measure ranges will not use Auto Space.

Record Setup
Record items

Record Items is used for determining both a “split 
point” when recording in real time and for selecting 
what types of MIDI data are to be either recorded or 
imported into Encore.  Selecting Record/Transcription 
Setup opens a window to the recording options.

The Split function lets you split incoming notes at a 
specific pitch location when recording in real time.  
For Split to work properly, you should have two staves 
or a piano staff showing in your score.  Set the starting 
point for the record process by clicking in the top 
staff of the two staves to be used when recording the 
split.  The split point can be anything from C2 to G8, 
but is usually somewhere near middle C (C3).  Encore defaults to C3. The split point responds to 
MIDI input, so you can experiment with your keyboard or controller if you are unsure what might 
be appropriate.  Notes below the selected pitch will be placed in the lower staff.  Unless you are 
recording into a specific voice, notes in the bass clef of a standard Piano staff will be set to voice 
5.

The Record Items choice is used for both real-time input and also when opening (importing) a 
MIDI or Master Tracks Pro file.  Each checkbox acts as a filter, allowing the selected MIDI Data 
type to be recorded or imported with a file.

Note: The record settings do not affect the Thru function. This means that turning off “pitch 
bend” will not prevent pitch bend messages from being sent over the Thru channel and device.

Warning!  If you uncheck the item Notes you will only see rests when recording or importing 
files.

To prevent accidentally recording over your previous work, Encore has an option to Enable Enter 
Key to Start/Stop Recording. 

Transcription Setup
The Transcription Settings item is used to select the shortest duration value to be used when 
“guessing” recorded or imported MIDI note data.  Note durations shorter than the selected 
duration will be “rounded up” to the selected duration.  Essentially, this means that if you select 
sixteenth notes in the Transcription Settings, a guess operation will never convert a note into any 
duration shorter than a sixteenth.



The Menus- Windows218

Encore’s “guessing” routine is designed to recognize multiple 
voices and to accurately transcribe triplets.  This may, however, 
result in unwanted triplets in some situations.  For this reason, a 
checkbox in the Transcription Settings dialog forces Encore to 
ignore triplets completely when checked.

You can choose to ignore triplets when guessing (or re-guessing) 
the entire score, or you can select the measure(s) that contains the 
offending triplets and re-guess that section.

The Ignore Triplets checkbox defaults to the unchecked (disabled) 
state.  The setting of the Ignore Triplets checkbox is saved with 
preferences.  For more information on how Transcription Settings 
will affect the Guess Durations operation, refer to the section on Guess Durations (Notes Menu). 

Encore includes an Auto-Align Playback After Transcribing check box.  If checked, Encore will 
align MIDI playback information to the transcribed “guessed” notes notated in the score.   If you 
want to keep the original MIDI data intact, do not select Auto-Align Playback After Transcribing. 
Refer to the Align Playback section for more information.

Click Setup
Click Setup configures the choices and 
methods used to generate a metronome click.  
The actual number of clicks to be played 
for each measure is determined by the time 
signature for each measure and the Click 
value set for those measures.

Encore allows you to specify the device to 
playback the click.

The settings for pitch are determined by the 
MIDI note number in the field.

Count-In (Pre roll)
When recording in real time, the Bar Click plays for the number of beats indicated by the time 
signature in the measure in which recording is to start. 

MIDI Click
Use MIDI to generate the metronome click with your synthesizer or drum machine.  Drum 
machines are a common choice for a MIDI click, but you can choose any sound or patch you like.

The Pitch field in the Click Setup dialog responds to MIDI Input.  If your synthesizer can send 
note data to Encore, you can set the choice for the Bar and Beat clicks by playing the note.  You 
can use any keyboard or controller to send notes Thru to your click choice.  First, before you open 
the Click Setup dialog, be sure Thru is turned on and set to the same channel and device as your 
choice for click.  In the Click Setup dialog, highlight the Pitch field ([tab] will advance through 
each field) and then play notes into Encore.  The Pitch field will display the pitch of notes as they 
are entered, and the sound will be sent thru on the channel and device selected for Thru.
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When using MIDI, the velocity and duration settings may have different effects for each sound.

The Bar Click is used at the beginning of every measure.  The Beat Click will sound for the 
number of clicks assigned to the measure in the Time Signature dialog.  This number will 
frequently be the same as the top portion of the time signature.

MIDI Setup
The MIDI Setup dialog box is used 
to ‘manage’ Encore’s MIDI commu-
nications.  In order to use Encore, 
you need to configure the software 
so that it works properly with your 
hardware.  Refer to the manual that 
came with your MIDI Interface or 
sound card if you are unsure about 
your interface connections.  For 
more info on this, see Chapter 1.

The MIDI Setup dialog box 
contains several drop-down list 
boxes. These list boxes allow you to 
route the flow of MIDI data to and 
from Encore. 

MIDI In/Record Device
The drop down list labeled 
Record  is Encore’s ‘MIDI in’ 
device.  Encore uses this device 
to receive MIDI data from your 
master keyboard or other MIDI 
master controller.

MIDI Thru
MIDI Thru lets you send the MIDI data coming in on the “record” device back out over either 
device and on any channel.

About Thru
Most MIDI controllers are also sound-generating instruments like synthesizers or samplers.  If 
you are using only one synthesizer, you may not need to use Thru.  If you have more than one 
synthesizer, however, Thru can let you play one synthesizer with another.  Unless you want to 
hear both synthesizers playing together, you should either turn the master controller’s Local 
Control off or mute the synthesizer being used to send the note messages.  Turning Local Control 
off essentially splits an instrument into a master controller and a sound module. For example, if 
you turn off Local Control  on your keyboard synthesizer, performance data (note-ons, note-offs, 
modulation, et cetera) will be transmitted via the instrument’s MIDI out device as usual.  But the 
instrument’s internal, sound-generating hardware will not respond to your playing unless that data 
is somehow routed to the instrument’s MIDI in device.

MIDI Thru is turned on or off by clicking on the “Thru” button in any Score window.  The Thru 
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button is located in the Toolbar between the Zoom tool and the measure indicator. 

MIDI Thru can be configured to always use the same device and channel, or you can have the 
Thru channel and device choices “follow” the device and channel of the current selected staff in 
your score.

Toolbar Setup
Encore features a floating, 
customizable Toolbar.  This 
Toolbar contains icons that 
represent commonly used 
Encore commands.  The 
Toolbar contains a few icons 
by default, but remains 
fully configurable.  You can 
choose the icons and the 
order in which they appear.  

Choose Toolbar Setup 
to open the Toolbar Setup 
dialog.  There are 90 possible 
items that you can place in 
the Toolbar.  Most of these 
items correspond to menu 
commands.  The Toolbar will 
expand to accommodate and 
can be resized by dragging 
the bottom right corner.

To add icons to the Toolbar 
add or remove the item in 
the order you wish them to 
appear.:

The Toolbar is a floating 
window that can be activated or deactivated through the Windows menu.

Help Menu
Topics

This will display the HTML Help files as a list of topics.

Current Topic
This will display the Help file for  what ever dialog or menu item that was last used.

Gvox Home Page
This will open a browser and direct it to the Gvox Customer Support Center
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About Encore
This is where the version, copyright and registration information is. 

When you first install Encore, the program will run in Demo mode.  To unlock and fully install the 
program, simply enter your serial number when asked. 
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Encore uses Voices to notate two or more melodic or rhythmic concepts on the same staff or for 
several staves.  Voices can be two instruments playing different parts, such as two flute parts on 

one staff, or one instrument, such as a piano, for which hands and even fingers can generate different 
rhythms simultaneously.  Whenever the instrumentation or performance requires two or more musical 
ideas to coexist on the same staff or staves, Encore uses voices to keep the concepts distinct for both 
playback and beaming operations.

Encore makes eight voices available.  When using a Piano Staff, which Encore considers one staff, 
the combined staves share all eight voices.  Each note and rest belongs to only one of the eight voices.  
When different voices are used to notate a measure, each voice becomes equivalent to an individual 
instrument with its own part.  It is important, therefore, to make sure that each voice’s musical line 
is completed within the measure (that is, all the metric time accounted for with rests entered, even if 
they are hidden) for all the parts to play correctly.

To specify and check the voicing used in your score, you need to use the Voice Selector menu.  You’ll 
find this menu within the Score window in the upper-left corner.  

Keyboard Shortcut for Changing Voices
Voicing and viewing separate voices are common operations, so a shortcut is provided for changing 
the voice menu using the computer keyboard.  When the Score window is active, type the letter [V] 
followed by the number of the voice desired.  For example, typing [V] followed by [5] would select 
voice 5.  

To select all voices, type [V] followed by either [A] or the dash [-].

Note:  The two keystrokes cannot occur too far apart or the shortcut will not work.

The Voice Selector
When the voice selector is set to one of the eight voice selections, only notes and rests in the selected 
voice will be displayed in solid black.  All other voices appear in light gray.  In addition, only the 
current voice will respond to selections, mouse actions or edit operations. 

The voice selector also affects playback.  When any of the eight voices are selected in the voice 
selector, only notes belonging to the selected voice will be sent over MIDI.

Rests In Different Voices and Hidden Rests

Voices In Encore Chapter Eight
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The voice selector also affects rests, and selecting a specific voice in the voice selector will display 
rests for the selected voice as solid black.  Rests in other voices appear in light gray.  

You can hide rests, but remember that the voice selector will not show hidden rests.  Use the Show/
Hide dialog to show the rests for a voice when editing.

Voice -
When the voice selector shows all voices (Voice -), both selections and edit operations affect all 
voices.  Notes entered while the voice selector is set to [-] are assigned to a default voice.  The default 
is voice one, except when entering notes into the lower staves of a piano staff.  Piano staves use voice 
one for the treble (or upper) staff and voice 5 for the bass (or lower) staff.  If a third and fourth staff 
are added to the piano staff, the default voice for the third staff (below the default bass clef) is voice 
7.   The fourth staff is voice 8.  

When the voice selector shows Voice -, paste operations will ignore the voice assignments of the 
copied data and use the default voice for each staff.  When pasting data, existing notes and rests are 
replaced for all voice when the voice selector shows Voice -.

Voices 1-8
When the voice selector is set to a voice from one to eight, notes recorded in real time, step entered or 
added with the mouse are entered using that voice number. Paste operations respect the voice selector 
settings as well, and all pasted material replaces and makes changes to the voice number specified.

Stem Direction and Voices
When notes are entered in either the default mode or voice 1, Encore applies several rules concerning 
stem direction.   Notes above the middle staff line are stems up and notes below the middle staff line 
are stems down.  This defaults when the note is entered or moved to a new pitch with the mouse.

Notes in voices other than the default voice or voice 1, defaults to stems down.  When using two or 
more voices for a single instrument, the stem directions will need the least adjustment if voice one is 
used for the voice group with the greatest number of pitches above the middle staff line.

Note:  If Auto Space is off, enter each voice by clicking in the notes from left to right.  If Auto Space 
is on, notes are best added from the far right side of the measure, letting the auto spacing routine 
perform the spacing for you.

Voices and Beaming
Two important rules concerning beams and voices should be remembered:  

1. Beams can be created only between notes that are in the same voice.  

2. Beams will not extend to another staff (cross-beam) unless both staves belong to a piano staff.

If notes are selected and changed to a new voice, all beams drawn for the selected notes will be 
removed.  For this reason, voicing operations should be performed prior to beaming operations 
whenever possible. 

Piano staves share all eight voices and are designed specifically to address the need for cross-staff 
beaming.  Cross-staff beaming is discussed later in this section.
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When To Use Another Voice
To better understand how to use Encore’s voicing capabilities, it is important to know when a musical 
idea will require two or more voices.  The example below uses two voices.

The total number of beats used in the first measure is greater than the time signature.

The quarter notes were entered in voice one, the default voice.  For this example, the quarter notes 
were also changed so that all were stems up.  The voice selector was then set to voice two.  The whole 
notes were entered and the tie added.

In general, when entering two voices it is easiest to first enter all the notes needed for voice one.  
Next, select the measure and use [control/command]+[U] (or select Stems Up from the Notes Menu) 
to flip all of the voice one notes to stems up.  Then, set the voice selector to voice 2 and proceed with 
entering the next voice.  

Changing the Voice Selector to  
View Separate Voices 

Using the voice selector to select first voice one and then voice two allows the notes assigned to each 
voice to be clearly seen.

This is how our example appears when the voice selector is set for voice one only. 

When the voice selector is set to voice 2, the display changes to indicate the whole notes in voice two.

What Happens If I Don’t  
Use Different Voices?

The previous example cannot be properly created in Encore without using two voices.  An attempt 
to add a whole note in voice one after adding the quarter notes and rest would not achieve the same 
result.  If you try to add a whole note with Auto Space on, it would either be ignored or added to 
the closest note, forming a chord.  When a note joins another note, the duration will change to the 
duration used for the note previously entered.  Even if Auto Space is disabled, you might succeed in 
adding a whole note in voice one after adding the quarter notes and rest in voice one, but the playback 
would be incorrect.

For Encore to perform and align a measure with more than one voice, each voice must be properly 
entered. Each voice should completely fill the number of beats for the measure based on the current 
time signature.  When voices are required to begin on beats after the initial downbeat, the proper 
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amount of rest indications should be entered before the first notes.

If a measure is edited or entered out of order (that is, from back to front or inside out), Align 
Playback and Align Spacing may be needed to correct MIDI playback.  

Using Additional Voices
What if you need additional sixteenth notes?  That would require using a third voice.  In the following 
example, a sixteenth note phrase was added for the last beat.

Here are the new notes and rests as viewed when the voice selector is set to voice 3.

The choice of voice 3 for the added notes was made only to provide a clear example of the additional 
voice as if it was added as an afterthought to our previous example (or being played by a third 
instrument). In general practice, it is recommended that voices be entered using voice one for the 
highest pitched notes in the score.  This is only a recommendation, however, and, as long as care is 
taken to complete the voices used in each measure, any voice number can be used.

 
Using Two Voices

Sometimes two or more voices will be needed even when the same durations are used.

In the previous example, two voices have been used to create the beamed groups.  The stems-up 
notes are all in voice one.  The stems-down notes are all in voice 2.  This example could be for two 
instruments notated on the same staff or to indicate that both left and right hands are used to play the 
phrase.
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Showing/Hiding Rests
When more than one voice is used within a measure, a need may arise to hide rests that would 
otherwise confuse or complicate the way the measure is read.  The following example shows a 
measure with a hidden rest.

Here is the same example showing just the notes in voice 3.

And here is the example with the rest showing.

Unless the stem directions were changed, these two examples would not mean the same thing to a 
musician seeing the notation.  When the use of a rest detracts from the notation, consider using a 
different voice and hiding the rest.

Here is a different example requiring a hidden rest.

In this case, an alternate line is indicated using cue notes.  Because the alternate line begins on the 
second beat, a rest was added but later hidden using the Show/Hide dialog.

Here is the same example with the rest showing.
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Here is the example again with only voice 3 showing.

Entering Additional Voices
When creating a measure requiring a hidden rest, show the rests while creating the measure and create 
the measure by adding notes and rests from left to right.  If Auto Space is on, it is best to enter the 
pitches from the right side of the measure.  This way the notes will be positioned evenly as they are 
added and the proper number of beats will be correctly incremented.  If Auto Space is off, the notes 
should be added with regard to proper spacing.

Cross-Staff Beaming
As explained earlier, piano staves are unique and share all eight voices between two combined staves.  
When notes on two different staves require a beam to be drawn between the staves, a piano staff must 
be used.

When a piano staff is used, beaming operations can ignore the normal rules and extend a beam from 
one staff to another.  Notes on both staves must be in the same voice since beams are only created 
between notes in the same voice.

Here is an example of cross-staff beaming viewed for all voices.  The beamed notes in the treble clef 
of the piano staff use voices 1 and 2, and the bass clef uses the default voice 5.
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Here is the same example viewed only for voice one.

Voice two was used for only one measure (remember, the bass clef is voice 5).  It is not unusual for a 
voice to be required for just one or two measures.

In this particular example, a trick was also used to make the second voice appear to be tied to the 
first voice.  In the first measure, the second portion of the tied chord is actually two quarter notes.  
However, when viewed and played, these notes are considered eighth notes.  By flipping the stem 
direction to match the existing eighth notes, the appearance suggests the chord is of the same duration 
as the eighth notes in voice one.  To change the quarter notes so that they play back as eighth notes, 
the two notes were selected and then changed to eighth notes.  Next (with the notes still selected), 
[shift] was held down and the number [3] entered.  This changed the displayed duration back to 
quarter notes, but because the [shift] key was held down, only the screen representation changed.  The 
notes will continue to play back as eighths.
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Finally, here is the example showing notes in voice 5.

Please Note!  There are no hidden rests in these cross-staff beaming examples.  When a piano staff is 
used, notes can move from staff to staff without the need to use rests to specify the proper beat.  Notes 
are spaced and played in the order each new note is added to a voice.

Auto Space will align notes when step entering from a MIDI keyboard or using the mouse.  For 
Auto Space to work effectively, the pitches should be entered by clicking into the right side of the 
measure.  Auto Space will continue to compensate as each note and rest is added until the measure is 
completed.

When using a MIDI keyboard to enter a part, the up and down arrow keys can be used to change 
staves in a piano system without losing track of the measure location. This allows cross-staff beaming 
during keyboard step entry.

During both mouse and MIDI keyboard entry, Auto Beam and Auto Space will create cross-staff 
beams only if the voice selector is set to a specific voice.  When the voice selector is set to Voice -î, 
each piano staff will use a unique voice by default and cross-staff beaming will not occur.

Voicing MIDI Files and Live Recording
When sequenced material or real time recording requires voicing, Align Playback should be used to 
update the MIDI information after changing notes and rests to their new voice assignments. 

When changing voice assignments, use the voice selector to isolate each voice.  Then count the 
number of beats used. 

Another method to quickly check for timing changes is to use Align Spacing and check the alignment 
for each voice.  Sometimes a missing rest or miscalculated duration will become apparent after Align 
Spacing attempts to correct the spacing based on the existing information.

If this is the case, undo the operation and turn off Auto Space.  Correct the problem by either inserting 
new notes or rests with the pencil tool or changing the duration of existing material.  After correcting 
the problem, select the measure and use Align Playback.  Align Spacing should also be used to 
correct timing problems.  When a measure is edited extensively, it may become necessary to erase 
portions and re-enter the information in the correct order.

Note:  Whenever multiple voices are being edited, check the rest status in the Show/Hide dialog.  
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Spacing and voicing is extremely difficult and confusing if rests are hidden for voices being edited.

Voicing a Real-Time Recording

The example above shows what our earlier example looks like when recorded in real time.  To change 
this into two voices, a second voice needs to be created for the appropriate notes, the missing rest 
added to fill the timing gap that results from the new voicing, and the playback aligned.

First the tied notes are selected and changed to voice 2.

Next, the quarter note is selected and changed to a whole note.

At this point, both measures are selected and Align Playback is used.  Actually, only the first measure 
would require alignment in this example, but it is a good idea to align all of the measures involved in 
the edit.  When there are notes tied between measures, both measures can be affected by the voicing 
operation.

Next, the rest is added in front of the quarter notes in voice one.

Finally, the last two quarter notes are selected and stems are changed to point up.
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As you can see, voicing even simple recordings involves clearly identifying 
the voices within each measure and then isolating the voices.  After 
identifying the voices and selecting and changing notes that should use a 
different voice, care must be taken to replace notes that were removed with 
rests, and to change note durations in each voice to correct timing.  This can 
require several steps.  Whenever possible, consider recording or importing 
only a single voice and then adding the second voice afterward.  This usually 
requires fewer steps than separating voices.
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Advanced Topics Chapter Eight

MIDI Paste 

MIDI Paste allows you to replace a selected note, rest or chord using your MIDI instrument.  
Select the note, rest or chord that you want to replace in your score and play the replacement 

note or notes on your MIDI instrument.  The duration will be the same as the existing notes or rest.  If 
you select more than one event, only the first item found in the selection will be replaced.  MIDI Paste 
automatically clears the selection after making the replacement.

Save Preferences
Encore automatically saves preferences. However, we do understand that sometimes you may want a 
different preferences set up for different scores. To acheive this, you will need to make templates with 
the preference set ups you desire, Encore allows an unlimited number of user created templates.

Spacing and Clef Changes
Since clefs cannot be dragged to new locations with the mouse, and Align Spacing does not keep notes 
from overlapping clefs past the start of a measure, you’ll have to take a few extra steps to correctly 
space measures in which a clef change is needed and where room for the clef change was not allowed 
for in the first place.

If the clef change occurs at the end of a measure, first complete the measure before adding the clef.  
Select and justify the measure (optional).  Unless the measure contents do not require extra space for 
the clef, you will probably need to create the needed space yourself.  With Auto Space off, select the 
arrow tool and hold down both the [control] and [shift] keys.  Then [right-click/command-click] on 
the last note in the measure and drag the note to the left until there is enough room to accommodate 
the new clef.  You may want to widen the measure first by dragging its right barline further to the 
right.  Using the [control] and [shift] keys while dragging a note ‘stretches’ the measure contents for 
all staves.  Using the [control] key without the [shift] key will stretch only the contents of the measure 
containing the selected note.  When you have created enough space to accommodate the new clef, add 
the clef and continue.

To add a clef in the middle of a measure you can use the same stretch function (dragging notes with 
the [control] and [shift] keys depressed) from any point within the measure.  First enter all the data 
before the place where the clef change is to occur.  Auto Space should be off before adding notes 
after an inserted clef or the auto spacing operation may move notes on top of the clef.  With Auto 
Space off, complete the remainder of the measure.  You do not need to hand align the remainder of the 
measure unless it suits you.  To use the spacing operation in Encore, erase the clef within the measure.  
This avoids the spacing operation moving notes on top of the clef.   

We had you enter the clef to more easily reference the notes entered after the clef.  If you wish, you 
can also enter the pitches without the clef change and insert the clef later.  Keep in mind when adding 
the pitches without the clef that the pitch locations should be referenced to the current clef.  Select 
and use the spacing function for the measure.  Next use the stretch function to drag notes in the 
middle of the measure either left or right until you have enough room to accommodate the new clef.
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When stretching within the measure, the stretch function will both expand and compress the data on 
either side, compressing the data in the direction you are dragging and expanding the data in the other.  
Because the relationship between notes will be scaled from the beginning and end of the measure, a 
gradual opening can be created without losing the vertical spacing relationship established with the 
spacing function.  

Fermatas
A fermata indicates a note or rest is to be held longer than notated.  Encore will not automatically 
change tempo or duration when fermatas are attached to a note or rest.  It can be very effective, 
however, to manually change the tempo to create the effect of a fermata during playback.

Select the measure in which the fermata occurs.  Open the Tempo dialog.  The current tempo used for 
the measure will be indicated in the Set all tempos to field.  Unless the fermata applies to the entire 
measure, consider using the Change smoothly option in the Tempo dialog.  The first tempo should be 
the current tempo and the second tempo should be the tempo change needed for the fermata.  Finding 
the correct tempo values may require several attempts.  In addition, the measures following the 
change will probably need to be selected and the correct tempo entered.  

If you want to create an isolated and dramatic change in tempo for a single note within or at the end 
of a measure, consider isolating the note within its own measure.  To create the illusion that the note 
belongs to the same measure as other notes, the barlines can be hidden. Time signatures must also be 
defined to account for the measure changes, but these can also be hidden.  The only drawback to such 
a solution is that the measure numbers will be incorrect.  

Here is the same example shown two different ways.  The one on the left has the time signatures and 
barline hidden.  The example on the right shows you how the measures look when the time signatures 
and barline are shown.

With the half note isolated within its own measure, changing the duration for the fermata becomes a 
simple matter of changing the tempo for only that measure.

Hiding barlines also can be used for difficult notation examples such as the one below. 

Here is the same example with barlines and time signatures showing.

Examples such as this require patience to create and are not always possible.  Fortunately, the same 
example can also be created without all of the hidden barlines and time signatures if you are willing 
to hand space the notation and sacrifice MIDI Playback.  In any event, these examples are provided 

only to show you that some pretty amazing things are possible in Encore.
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MIDI Tricks
Using the MIDI tool in the Tools palette, you can control many of the parameters of your synthesiz-
ers to tailor the sounds to a score’s specific needs.  As an example, a guitar part may consist of mostly 
strummed chords up to the solo.  When the solo is played, however, the same sound used when 
strumming may sound too thin.  Using a program change to select a better program for the solo just 
before the solo begins and then another program to return to the original guitar sound after the solo 
takes just a few steps.  For the final printing stage the text indicating the MIDI program change can be 
hidden using the Show/Hide dialog and either replaced with a text box or omitted completely.

Controllers can add everything from subtle changes in volume to reverb effects and modulation.  
There are options for display and printing of MIDI objects in the Show/Hide dialog.  

Hiding Staves
Some symbols such as trills, turns, rolls and bend indications are notated in one fashion but played 
quite differently.  These symbols are not interpreted for MIDI playback because there are many 
different methods to interpret such markings.  If it is important for you to hear the indication using 
MIDI, consider adding another staff just for use in MIDI playback.  This added staff can be used to 
record only the measures needed and hidden for the entire score to avoid conflicting with the desired 
notation.

As an example, let’s suppose you want to add the sound of a trilled note to your playback.  The note 
in question appears in the middle of your score as a single half note with a trill indication.  If you 
haven’t done so already, complete the measure as the printed score should appear using a single note 
and the trill mark.  Next, select the staff and use the Add Staff dialog to add a single staff either above 
or below the staff with the trill.  This staff will be used only for the MIDI interpretation of the trill 
symbol.  The new staff should use the same MIDI channels as the notes and voices in the measure and 
staff with the trill symbol.  Check the Staff Sheet to be sure the correct MIDI Channels are selected.

Since the new staff will be used to replace the MIDI playback for the trill indication, select the 
measure with the trill indication and select Attributes > Notes from the Notes menu (or use [control/
command]+[I]).  In the Note Attributes dialog use the checkbox for Set Play State and set the play 
state to Mute.  This prevents the selected measure from playing.  Since you are going to replace the 
MIDI playback in this measure with MIDI in your newly added staff, you should mute the measures 
you are replacing.  Otherwise, you would hear both measures playing together and the result would 
not be as effective. 

In the new staff, enter notes which will correctly play the trill indication you notated.  You can either 
record the trill in real time or use step or mouse entry.  After creating the correct sound for the trill 
using MIDI playback, the next step is to hide the staff.  Return to page one and double-click to the 
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left of the staff with the MIDI playback of the trill.  This selects the staff throughout the score.  Use 
the Hide Staves item in the View menu to hide the staff.  Make any adjustments to layout that are 
needed, and you’re done.

Once you become familiar with this concept, it can be used throughout your score whenever needed.  
To add additional MIDI playback effects to other locations, use Show Staves for the section you are 
working on and the hide the staff again when you are through.  Remember to check both the MIDI 
channels used and to mute the play state for anything you replace.  In some cases you may need to 
mute only one or two notes instead of replacing the entire measure.

Broken Beams
Beam Group can also be used to create a beaming situation that is essentially a broken primary beam.  
This may be needed when space considerations affect the note ranges to be indicated.  This unusual 
situation can be handled within Encore if care is taken when making adjustments to beams connected 
to a common object.

In some cases it may not be possible to notate exactly what you want using either Beam Group or Sub 
Group.  Where you want to employ more avant garde beams, use the graphic tools for drawing lines.

Example of a broken primary beam Select and use Beam Group Adjust beam angles

Select and use
Beam Group again Adjust beam angles

The order in which you adjust shared 
beams

is important
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MIDI Setup Chapter Nine

Encore will work immediately after installation without any special MIDI set up.  Both Windows 
and Mac contain built in software synthesizers that Encore finds and connects to as a playback 

default.  However, for MIDI input and more advanced uses of MIDI and MIDI devices, you will need 
to make sure your hardware drivers are installed and operating as per the hardware’s documentation.  

MIDI Drivers and Encore
Encore requires a MIDI ‘driver’ in order to communicate with MIDI hardware such as a MIDI 
interface or sound card.  The driver enables Encore to use a MIDI interface’s In and Out devices or to 
play a sound card’s on-board synthesizer. 

There are many different MIDI interfaces on the market, and each one requires a specific driver.  
These drivers should be included with your interface or sound card. (They do not come with the 
Encore software.)  The instructions included with your MIDI hardware should cover installation of 
the drivers. 

MIDI drivers on Macintosh
MIDI Setup on Mac OS X 
If you are using Mac OS X and want to connect an external MIDI interface, follow these steps:

1.	 Connect your external MIDI interface to your Mac. Most devices will work right away.  If your 
device does not, please continue to step two.

2.	 Launch Audio MIDI Setup (in Applications/Utilities).

3.	 Click on the MIDI Devices tab. 
Follow the instructions for setting up and configuring your MIDI studio.  
Note:  If you have connected your MIDI interface to your Mac but it’s still not being recognized, click 
on the Rescan MIDI button at the top of Audio MIDI Setup.  You should then see an icon representing 
the interface appear in Audio MIDI Setup. 

4. 	 Quit Audio MIDI Setup.

5.	 Launch Encore.

Using Apple’s General MIDI DLS Synthesizer (Built-In Synth)
You can play back your Encore scores through the Mac’s sound system using Apple’s General MIDI 
DLS Synthesizer’s built-in synth, thereby eliminating the need for any additional hardware.  You’ll 
probably still want to use your MIDI instrument for recording purposes, but you can get surprisingly 
good playback quality just by using Encore and the built-in Apple Synthesizer.  For more information 
on using Apple’s General MIDI DLS Synthesizer, see Chapter 7 “The Menus.”
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Configuring MIDI
Encore needs to know how your system is configured so that the software can communicate with the 
hardware. 

Setting Output Devices/Channels on Macintosh
On Mac OS X, MIDI output devices are set in the Staff MIDI Device and Instrument Settings dialog.  
The MIDI Setup dialog is used for Record and Thru settings.   

Staff MIDI Device and Instrument Settings
To set the output devices and channels on Macintosh, do the following:

1.	 Select MIDI Device/Instrument Settings from the Score menu in Encore.

2.	 Set your MIDI output devices and channels.  (See MIDI Device/Instrument Settings in the Score 
section of the manual for more information.)

Note:  An unlimited number of devices are available on Macintosh.  Thus, if you are using a 
six-device interface, all six devices would be available.

The MIDI Setup Dialog
You will choose your Record, Sync, and Thru settings in the MIDI 
Setup dialog.  To open the MIDI Setup dialog box, choose MIDI 
Setup from Encore’s Setup menu.

The ‘Record from’ menu specifies what devices Encore will listen 
to for MIDI input.  In general, keep this setting to “All”.  Also note 
that if ‘Enable Virtual Ports’ is enabled, other applications will be 
able to connect to Encore to send MIDI data.

When you have finished choosing your record, sync, and thru 
settings, click OK to exit the MIDI Setup dialog. Configuring 
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MIDI

Encore needs to know how your system is configured so that the software can communicate with the 
hardware. 

Setting Output Ports/Channels  
on Windows

To set the output ports on Windows, choose MIDI Setup from Encore’s Setup menu. The MIDI Setup 
dialog box will appear. 

The MIDI Setup Dialog
The MIDI Setup dialog box 
contains 4 drop-down list boxes. 
These list boxes allow you to 
route the flow of MIDI data to 
and from Encore. The devices that 
appear in the list boxes will vary 
depending upon the MIDI drivers 
installed in your system. All you 
need to concern yourself with for 
now are the output ports and the 
Record port.

Encore has two output ports, Port 
A and Port B. Use the drop-down 
box next to each port to select the 
proper output device. 

Note: If you are using a multi-port 
interface, you may choose any two 
of the available ports., however 
you are limited to just two. (On 
Mac, an unlimited number of ports 
are available)

Any time you see a staff’s channel 
number displayed in Encore it 
will be preceded by the port designation. For example, “A12” would be MIDI channel 12 on Port 
A. The great thing about having two output ports is that each one can transmit up to 16 channels of 
MIDI data, effectively giving you 32 channels. If the drivers are installed properly, the driver names 
for your output devices should appear in the drop-down list boxes. You can have any combination of 
MIDI interfaces and sound cards assigned to the output ports as long as the proper driver is available. 
Some MIDI interfaces are ‘dual port’ or ‘multi-port’ interfaces, meaning that you can assign both 
ports in Encore to different outputs on the same interface. 

You don’t have to assign both of the ports to an output device. Encore works fine with just one output 
port.

The Record port is Encore’s ‘MIDI in’ port. This is the port that Encore will use to receive MIDI data 
from your master keyboard or other MIDI master controller.
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When you have assigned your output port(s) 
and your record port, click OK to exit the MIDI 
Setup dialog. Then use the Save Preferences item 
in the Setup menu to save your choices.

The Choose Channel/Port Dialog
To choose between output ports and channels on 
Windows, do the following:

1.	 Select Staff Sheet from the Windows menu 
in Encore.

2.	 Click on the “Channel” column in the Staff 
Sheet to bring up the Choose Channel/Port 
dialog.

3.	 Use this dialog to choose between the two 
output ports that you selected earlier in MIDI Setup.

Using MIDI
It would be impossible to describe each possible combination of MIDI instruments and interfaces 
here, but a few general assumptions can be made.  Three very basic MIDI systems are described in 
this section.

System One
The most common set up involves a single MIDI instrument with its own sound generating capa-
bilities, a MIDI interface, and your computer running Encore.  The MIDI Out of the instrument is 
connected to the MIDI In of the interface; the MIDI Out of the interface is connected to the MIDI In 
of the instrument.

There is also a slight variation of this setup.  If you are using a multitimbral instrument with the 
ability to receive MIDI data on several channels simultaneously, you may want to turn off the instru-
ment’s local control.  Normally, an instrument’s local control is on.  This means the keyboard controls 
its internal (“local”) sound-generating hardware.  When local control is off, the performance data 
from the instrument (notes, pitch bend, sustain pedal, etc.) is transmitted via the MIDI Out device, but 
it does not control the local synthesizer hardware.  In other words, you play the keyboard and the only 
thing that comes out is MIDI data, no sound.  If you connected the instrument’s MIDI Out to its own 
MIDI In, you would generate sound.  Turning local control off essentially splits an instrument into a 
master controller and a separate sound module.

Synthesizer MIDI Interface

MIDI Interface

Computer
Running
Encore

Computer
Running
Encore

(MIDI Thru On)

MIDI Master Keyboard

Sound Module Sound Module

MIDI Data From Master Keyboard Only

MIDI Data From Encore And Master Keyboard

Computer
Running
Encore

Sound Card
or ModuleMIDI Master Keyboard



MIDI Setup240

So, why would this be useful?  If you are working on a score with multiple staves on multiple MIDI 
channels, you can turn on Encore’s MIDI Thru option and use Encore to determine which channel 
(and thereby which of your synth sounds) is currently being played by the keyboard.  That’s generally 
much easier than changing the channel on your synth every time you want to work on a different staff. 

For more about MIDI Thru, see the MIDI Setup item in the Setup menu section of the Reference 
manual.

System Two
A slightly more sophisticated setup uses a MIDI master controller (a keyboard or some alternate 
controller) and one or more sound modules or sound cards.  This requires you to use Encore’s MIDI 
Thru feature.  (For more about MIDI Thru, see the MIDI Setup item in the Setup menu section of the 
manual.)

System Three 
There are several sound cards and modules being marketed that can be either installed or connected 
directly to your computer.  Many of these devices can also act as a MIDI interface for additional 
MIDI modules.  Assign one of Encore’s output devices to the sound card or module.  Then connect 
your keyboard or other controller to the card/module’s MIDI In.  You can connect additional MIDI 
instruments to the module’s MIDI Out.

Other Options
You may want to connect a MIDI interface to each of Encore’s output devices, or you could connect 
a sound card or module directly to one and a MIDI interface to the other.  Whatever the case, this 
should at least help you to get up and running with Encore.  

Synthesizer MIDI Interface

MIDI Interface

Computer
Running
Encore

Computer
Running
Encore

(MIDI Thru On)

MIDI Master Keyboard

Sound Module Sound Module

MIDI Data From Master Keyboard Only

MIDI Data From Encore And Master Keyboard

Computer
Running
Encore

Sound Card
or ModuleMIDI Master Keyboard

Synthesizer MIDI Interface

MIDI Interface

Computer
Running
Encore

Computer
Running
Encore

(MIDI Thru On)

MIDI Master Keyboard

Sound Module Sound Module

MIDI Data From Master Keyboard Only

MIDI Data From Encore And Master Keyboard

Computer
Running
Encore

Sound Card
or ModuleMIDI Master Keyboard
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MIDI And Encore Chapter Ten

The use of MIDI and notation requires both patience and understanding when problems arise.  The 
flexibility that gives MIDI its strength can also cause confusion.  One notation symbol can mean 

something very different for two different instruments, composers or musicians.

When MIDI interpretation of a score is your goal, a MIDI file exported from Encore can be further 
edited in a program devoted to editing MIDI data.  Such programs are called “MIDI Sequencers.”  
Unlike notation, such programs use all kinds of symbols to display notes and other MIDI messages, 
such as pitch bend, which have no consistent representation in the notation world.

GVOX offers MasterTracks Pro™, available for both Windows and Macintosh, a professional 
sequencer with several different editing views.  Master Tracks Pro offers an Event List for viewing 
the MIDI information, a graphic display of controller data, and extensive processing operations for 
creating both subtle and dramatic changes.  

The MIDI capabilities of Encore may not be as extensive as a dedicated MIDI sequencer, but you’ll 
have more than enough power to create an impressive MIDI performance.  This section discusses the 
basic types of messages used in Encore and how to enter and edit those messages.

We cannot begin to discuss all the definitions for everything in the MIDI spec.  If you are interested 
in learning more about MIDI, check your local music or computer store for what’s available.  All that 
concerns Encore and our discussion are MIDI note messages and controller messages.

When a “note” is sent over MIDI, two messages are actually sent at two different times.  The first 
message says, basically, “start playing note such and such.”  The second tells when that note should 
stop playing.  These two messages get sent when notes are played in Encore. The note’s duration and 
the current tempo determine the time between the messages.

MIDI notes do not have sound associated with them.  When a note is “played,” the message sent 
contains information about the pitch played, but nothing saying “what” was played.  The message 
uses a number called “velocity” to describe “how” the note was played.  Velocity can be used to send 
information about how loud a note was played, but how that numerical message is interpreted is up to 
the responding synthesizer.  Even the common pitch names are only reference points, and a pitch may 
sound quite different from one synthesizer to another.  For instance, Middle C might trigger either a 
piano or a snare drum.  The result ultimately depends on the sound capabilities of whatever is at the 
receiving end.

This free interpretation of MIDI data is MIDI’s greatest strength and greatest source of confusion.  The 
MIDI performance you achieve with your synthesizers is entirely your own.  But, for shared MIDI files, 
this is not always a good thing.  The General MIDI description allows MIDI users to refer to an instru-
mentation standard when selecting sounds.  General MIDI synthesizers abound in the marketplace, 
and even if you do not own one, if you can program your synthesizer, you can configure your own 
General MIDI arrangement.  At a basic level, the General MIDI standard is simply an agreement about 
the arrangement of patches and their names within the 128 possible program message choices for each 
channel.  An agreement also exists for a standard drum arrangement, and this determines the pitches 
used for the array percussion instruments.



MIDI and Encore242

Of course, the sound of a General MIDI synth causes great debate among both manufactures and 
owners.  Some ask, “When do we stop defining how a piano should sound?”  This deserves con-
sideration, but we suggest that you simply include documentation when sharing your files with 
others, even if you use the General MIDI patch assignments.  And if the MIDI performance is really 
important, put it on tape and send it along.  Even a poor fidelity recording can give the listener more 
information about how the MIDI file should sound than trying to explain how “SoloSynthVX” decays 
with a velocity of 12.

General MIDI Patch Map

 97. Ice rain
 98. Soundtrack
 99. Crystal
 100. Atmosphere
 101. Brightness
 102. Goblin
 103. Echo drops
 104. Star theme
 105. Sitar
 106. Banjo
 107. Shamisen
 108. Koto
 109. Kalimba
 110. Bag pipe
 111. Fiddle
 112. Shanai
 113. Tinkle bell
 114. Agogo
 115. Steel drums
 116. Woodblock
 117. Taiko drum
 118. Melodic tom
 119. Synth drum
 120. Reverse cymbal
 121. Guitar fret noise
 122. Breath noise
 123. Sea shore
 124. Bird tweet
 125. Telephone ring
 126. Helicopter
 127. Applause
 128. Gun shot

 65. Soprano sax
 66. Alto sax
 67. Tenor sax
 68. Baritone sax
 69. Oboe
 70. English horn
 71. Bassoon
 72. Clarinet
 73. Piccolo
 74. Flute
 75. Recorder
 76. Pan flute
 77. Bottle blow
 78. Shakuhachi
 79. Whistle
 80. Ocarina
 81. Square wave lead
 82. Sawtooth wave lead
 83. Caliope lead
 84. Chiff lead
 85. Charang
 86. Solo synth voice
 87. Bright saw wave lead
 88. Brass and lead
 89. Fantasia pad
 90. Warm pad
 91. Poly synth pad
 92. Space voices pad
 93. Bowed glass pad
 94. Metal pad
 95. Halo pad
 96. Sweep pad

 33. Acoustic bass
 34. Electric bass fingered
 35. Electric bass picked
 36. Fretless bass
 37. Slap bass 1
 38. Slap bass 2
 39. Synth bass 1
 40. Synth bass 2
 41. Violin
 42. Viola
 43. Cello
 44. Contrabass
 45. Tremolo strings
 46. Pizzicatto strings
 47. Orchestral harp
 48. Timpani
 49. String ensemble 1
 50. String ensemble 2
 51. Synth strings 1
 52. Synth strings 2
 53. Choir aahs
 54. Voice oohs
 55. Synth voice
 56. Orchestra hit
 57. Trumpet
 58. Trombone
 59. Tuba
 60. Muted trumpet
 61. French horn
 62. Brass section
 63. Synth brass 1
 64. Synth brass 2

 1. Acoustic grand piano
 2. Bright acoustic piano
 3. Electric grand piano
 4. Honky-tonk piano
 5. Rhodes piano
 6. Chorused piano
 7. Harpsichord
 8. Clavinet
 9. Celesta
 10. Glockenspiel
 11. Music box
 12. Vibraphone
 13. Marimba
 14. Xylophone
 15. Tubular bells
 16. Dulcimer
 17. Hammond organ
 18. Percussive organ
 19. Rock organ
 20. Church organ
 21. Reed organ
 22. Accordion
 23. Harmonica
 24. Tango accordion
 25. Acoustic nylon guitar
 26. Acoustic steel guitar
 27. Electric jazz guitar
 28. Electric clean guitar
 29. Electric muted guitar 
 30. Overdriven guitar
 31. Distortion guitar
 32. Guitar harmonics
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35 B0 Acoustic Bass

36  C1 Bass Drum 1

37 C#1 Rim Shot

38 D1 Acou Snare

39 D#1 Hand Clap

40 E1 Elec Snare

41 F1 Lo Tom

42 F#1 Closed Hi Hat

43 G1 Hi Tom

44 G#1 Pedal Hi Hat

45 A1 Lo Tom

46 A#1 Open Hi Hat 1

47 B1 Lo-Mid Tom

48 C2 Hi-Mid Tom

49 C#2 Crash Cymbal 1

50 D2 Acoustic Hi Tom

51 D#2 Ride Cymbal

52 E2 Chinese Cymbal

53 F2 Ride Bell

54 F#2 Tambourine

55 G2 Splash Cymbal

56 G#2 Cow Bell

57 A2 Crash Cymbal 2

58 A#2 Vibra-slap

59 B2 Ride Cymbal 2

60 C3 Hi Bongo

61 C#3 Lo Bongo

62 D3 Mute Hi Conga

63 D#3 Open Hi Conga

64 E3 Lo Conga

65 F3 Hi Timbale

66 F#3 Lo Timbale

67 G3 Hi Agogo

68 G#3 Lo Agogo

69 A3 Cabasa

70 A#3 Maracas

71 B3 Whistle Short

72 C4 WhistleLong

73 C#4 Short Guiro

74 D4 Long Guiro

75 D#4 Claves

76 E4 Hi Wood Block

77 F4 Low Wood Block

78 F#4 Mute Cuica

79 G4 Open Cuica

80 G#4 Mute Triangle

81 A4 Open Triangle

General MIDI Drum Map

Volume, Velocity,  
And Graphics

Controlling volume becomes one of the biggest problems when creating and sharing scores.  Both 
Encore and MIDI offer several ways to control MIDI volume.  This can lead to the sending of two 
different volume messages which can either complement or contradict one another.

The basic methods for changing volume use controller 7 “volume” messages and/or note velocity 
information.  The gain faders in the Staff MIDI Device and Instrument Settings use controller 7 
messages.  The dynamic markings and hairpins can use controller 7 and/or note velocity to adjust 
volume.  Accent marks can be set to adjust note velocities as well. (See the Staff MIDI Device and 
Instrument Setting section in the manual for more details.)  How you choose to use these methods 
depends on what the playback device supports.  Fully understanding what is being sent and how it is 
going to be interpreted requires learning a little more about how MIDI works.  
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Note that Garritan Orchestra Libraries uses Controller #2 (Modwheel) for volume control 
information.  Encore automatically looks for devices with “Garritan” in the name and uses Controller 
#2 instead of #7 for those devices. 

Every note in your score contains two velocity messages,  one sent when the note is played (typically 
called the note on velocity), the other sent when the “note off” message (note off velocity).  Most 
synthesizers use the note on velocity value to control a note’s volume.  Encore makes this assumption 
when you use dynamic values and marks to change the velocity.  The note off velocity message is 
always sent, but many synthesizers do not respond to the message.  Note off velocities can be edited 
in the Change Velocity dialog but are not used elsewhere in Encore.

Velocity does not have to change volume for every patch or every synthesizer.  The response to 
velocity depends upon both the manufacturer and the user to decide.  Setting velocity values for 
marks, dynamics and graphics will change the velocity for the affected notes, but may not cause notes 
under fortissimo markings or with attached accents to play any louder.  In some cases, you may even 
hear different instruments or effects played instead.  

The difference between velocity and volume is that velocity is only a number attached to a note 
message in MIDI while volume is a concept we all pretty much agree on.  The reason velocity is used 
to change volume so often is because the MIDI market has been dominated by keyboards, and most 
keyboards use velocity to change volume.  Now, velocity is usually not the actual measurement of 
how hard a key is hit, but the end result is similar enough.  In most cases, velocity actually measures 
how fast a note is played.  The faster the note is played, the higher the velocity value assigned.  
Since striking a key faster usually results in striking the key harder, velocity values have become an 
effective way to communicate louder playing on most keyboards emulating a piano’s response.

This assumption about velocity is just an assumption, however, and many other uses for velocity 
messages exist.  Velocity can change instrument sounds.  Instead of a saxophone sound getting louder, 
higher velocity values could change the saxophone to more of a growling sound, or even switch 
completely to an electric guitar.

Even when velocity changes the volume, the message sent only describes one possible volume level.  
For continuous volume changes, additional messages need to be sent for every change in volume.  
MIDI uses controller messages for this purpose.  Often called “continuous controllers,” these 
messages use two numbers to carry information.  One number defines the function and the other sends 
a value.

All of these numbers have a range.  It is no coincidence that the same number range appears again 
and again when changing MIDI values.  MIDI uses 128 numbers for almost everything:  128 different 
patches or programs can be sent over a channel, velocity ranges from 1 to 127 (0 is a special message 
for velocity), there are 128 controller types and 128 values usable for each controller.   Even the 
number of pitches equals 128.  All of these messages must be sorted and isolated from one another for 
proper interpretation. 

MIDI uses “channels” to specify which notes and controllers are intended for which sound in your 
synthesizer. Just as channels on a TV keep stations separate, channels in MIDI keep notes and 
controllers properly routed. Notes played on channel 1 only respond to volume messages also on 
channel 1.  Notes played on channel 2  only change volume if the volume message is sent on channel 
2.

Each MIDI device has 16 channels.  If you need more than 16 different instrumental sounds simul-
taneously, you must use more than one device.  Keeping track of all the different MIDI channels and 
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making sure the volumes go out on the correct channels could be bewildering if Encore didn’t do 
most of it for you.

Each instrument used in your score requires a different MIDI channel or device to keep note and 
volume information from affecting other instruments.  Perhaps the most confusing aspect of each 
staff is that the channel choices can be different for each voice in each staff  --  very useful when two 
different instruments, such as a trumpet and a trombone, share the same staff.  By using two different 
voices and two different MIDI channels, a single staff can play up to eight instruments at a time.  
Such notation is unlikely, however, and most staves are written for a single instrument.  Even when 
an instrument such as a piano requires using two or more voices, it is usually inappropriate to assign 
different MIDI Channels to each voice unless a special effect is desired. 

Pay careful attention to unused voices for each staff.  Channel selections are not separate from other 
staves.  If you select a “piano” for your top staff and that piano uses channel one, any other staff set 
to channel one will also sound as a piano.  When two staves send out conflicting information on the 
same channel, the last message sent will be used for both staves.  If two staves have different volumes 
or program assignments, but both are set to the same channel, both messages get sent, but the message 
in the lower staff in the Staff Sheet gets sent last and that message gets used.  This means that if you 
do not choose an unused MIDI channel before selecting a new instrument, an instrument on the same 
MIDI channel but on another staff will change as well.  Make sure each instrument uses just one of 
the sixteen MIDI channels for each device.  Encore can send up to 32 unique channels of information 
at the same time.

Volume changes also need to be isolated by MIDI Channel.  When setting the volume in the Staff 
Sheet, the single volume fader changes the volume for every voice and MIDI channel defined for the 
staff.  Volume messages are sent for each voice’s MIDI channel selection, even if a voice is “unused” 
in all other respects.  Check the MIDI channel assignments for each staff and all voices, particularly 
when opening old scores or when importing MIDI and Pro files.  Unless intentional, most staves 
should use the same channel for all voices to avoid confusion.  We added the Change Together 
checkbox in the Choose Channel/Device  for just this purpose.  When checked, quick changes can be 
made simultaneously for all voices with a single selection.

Set gain values of staff voices in the Staff MIDI Device and Instrument Setting dialog. The gain value 
attenuates any volume controller message sent while playing dynamics in the score.  Different voices 
that need different gain values require using a different MIDI channel.   When configuring different 
volume settings for different voices, take care to account for every MIDI Channel in use in the Staff 
Sheet.  If two different voices use the same MIDI Channel, they cannot have different instruments or 
volumes.

MIDI Tool, Controllers,  
and Program Changes

In addition to the gain and program selections in the Staff MIDI Device and Instrument Setting 
dialog, program changes, volume changes and any type of controller message can be added anywhere 
in a score to any staff.  The same cautions mentioned above apply when using the MIDI tool.

When program changes or controller messages are entered with the MIDI tool, each message is 
associated with one of the eight voice layers and the MIDI channel in use for that voice.  When the 
voice selector is set to “Voice -,” controllers and program changes use the same channel as the default 
voice.  This is usually voice 1.  In all other voice layers, the MIDI message uses the same channel 
used by the voice and staff selected.
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General Controller Tips
Understanding how controllers work requires first learning which controller numbers your synthesizer 
will respond to and what parameters can be controlled.  Look for the MIDI Implementation chart in 
the synthesizer documentation for more information.  Besides the standard use of controller 7 for 
volume, many synthesizers use controller 1 for modulation, controller 10 for pan, controller 91 for 
reverb and controller 64 for sustain.

Although every controller uses a range between 0 and 127 for exchanging information, some 
controllers, like sustain, typically use only the high and low values of 0 and 127 to turn an effect on 
and off.  Controller 64 affects sustain on many synthesizers but usually only when a “0” or “127” is 
sent, where “0” means sustain off and “127” means sustain on.  Sustain is not the only controller that 
uses this method to turn an effect on or off.  When in doubt, check your synthesizer documentation.

As you become more familiar with adding program changes and controllers to a staff, consider the 
advantages of hiding the MIDI Events and using either text or a graphic to represent the controller 
message or program change. 

Importing MIDI and  
Master Tracks Pro files
If you import a MIDI File or Master Tracks Pro file into Encore, controller information can be 
imported along with the note data, but Encore will not display the data.  Editing controller changes 
or program changes recorded into a staff is not provided for in Encore.  However, if such information 
is added with the MIDI tool, the added indication can always be removed.  Unless you really need 
extensive controller information in your file, you are better off removing the information before 
scoring the file in Encore.

The Record Setup dialog can be configured to ignore controller information when recording and 
importing MIDI files.  If only Notes is checked in the Record Setup dialog, other information in the 
MIDI file or sent from the synthesizer will be ignored.

Sequencing Tips
For the best results when converting MIDI files in Encore, prepare the MIDI information ahead of 
time. The more time spent defining note durations and timing before Encore uses the file, the more 
accurate the transcription.  Quantize operations greatly increase the accuracy with which Encore can 
translate your files, but may require sacrificing some timing considerations added for better sounding 
playback.  In particular, musical lines played far ahead or behind the beat are best moved onto the 
beat In fact, many sequencers use a “slide” function to move notes forward or backward in time.  For 
notational purposes, it is usually clearer to notate with straight durations and then use either text or 
graphics within the score to indicate the playing style.

Durations should also be considered.  Synthesizer patches may sound better when durations are 
increased and actually overlap, but if the instrument you are notating can play only single melody 
lines, such overlapping durations will not look correct in Encore.  Change the duration times before 
saving the file for Encore and you are likely to get dramatically different results.  Changing the 
duration for an entire piece to 80 or even 75% of the current duration can often “clean up” a part that 
might otherwise require extensive editing in Encore.  Usually, a MIDI sequencing program makes 
such operations simple and quick.

Although staves can be split in Encore, it may also be far easier to separate left and right hand piano 
parts into two different tracks in your sequence before opening the file in Encore.  If the piano part 
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requires cross-staff beaming, you can still turn the top staff into a piano staff and then copy and paste 
the other hand into the correct staff.  This can be easier and faster than trying to revoice and align both 
hands in Encore, starting with a single staff.

MIDI Clock Ticks
This information is provided for those few who wish to know more about what clock tick durations 
will be used for notes when saving an Encore file as a MIDI or Master Tracks Pro file. This 
information is not necessary for most people, and certainly isn’t required to use Encore.

The basic value for most sequencers is the “clock tick” and the common reference for describing 
a sequencer’s “clock resolution” is to describe a quarter note in clock ticks.  Encore and GVOX’s 
Master Tracks Pro™ use 240 clock ticks per quarter note.  MIDI Files are designed to allow each 
program to freely convert a “quarter note” to their own clock duration.  Thus, a quarter note of 240 
clicks in Encore may be translated into greater or fewer clock ticks in other sequencers.  Consult the 
documentation for the sequencer you are using if you are unsure of the clock resolution.

The dotted values for MIDI notes in Encore can be calculated by multiplying the duration by either 
1.5 for a single augmentation dot or 1.75 for the double dot.

The relationship of the tuplet duration to MIDI clock ticks is more complicated but can be calculated 
by applying the following formula:

(Q x R) / L = applied tuplet duration

Where:

Q = Note duration in clock ticks

L = Left side of Tuplet indication

R = Right side of Tuplet indication

Thus, while an eighth note is 120 clock ticks, an eighth note triplet (3:2) is the total of 120 times 2 (or 
240), divided by 3 (240 divided by 3). So, an eighth note triplet is 80 clock ticks in Encore.

For playback, Encore rounds off inserted notes using the pencil or MIDI keyboard step entry to 90% 
of their exact clock tick value.  With this in mind, if you enter an eighth-note triplet (80 clock ticks) 
with the pencil and then export the file to Master Tracks Pro, the note duration would equal 72 clock 
ticks.

The MIDI playback duration (that is, the number of clock ticks) can be altered using the Change 
Duration dialog (Notes menu) for any selection.  The choice is represented as a percentage of the full 
duration.  Align Playback does not affect note durations, only their start times.
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Printing With Encore Chapter Eleven

Although computers are wonderful tools for creating music, the printed page is still easier to share 
witvh the rest of the world. Maybe some day this will change, but for now the final step for a 

score will usually be printing the score and parts out to paper.

Printing and page layout should be considered from the moment you begin to create a new score. The 
choice of paper size and reduction or enlargement factor will all affect the page layout and appearance 
of your score.

Although each score will generate its own requirements, there are some general guidelines that seem 
to apply to many scores. A reduction factor of 80% with staff size 3 is ideal for most piano-vocal 
arrangements. The reduction percentage can be designated in the Page Setup dialog. Larger scores 
can sometimes require additional reduction amounts or a smaller staff size. When extracting parts, 
however, make sure the reduction is still readable. It may be better to have more page turns than 
squinting musicians! See the section on output quality for important information about reductions.

Encore should work with any Windows or Mac printer. Make sure the most recent printer driver is 
installed and that your printer is selected as the default. 

Fonts used when creating a score should also be available when printing. If a font cannot be found 
when a file is being opened, an alert will appear asking you to choose a substitute.

Before printing, carefully check the pages to be printed for spacing and other page layout con-
siderations. Ideally, this should be done as each page is created. If your score is a large orchestral 
arrangement, you may need to consider the spacing for each tiled section as well. The following 
sections explain how Encore uses “tiles” and the printer selection to determine the page margins and 
layout options.

Page Margins and Page Layout
Before you begin working with page margins, you should make sure that the correct printer is 
selected on your computer. The correct paper size and options are selected in the Page Setup dialog 
and are saved with your score.

The Page Setup dialog allows you to choose a margin setting for the score or use the default setting 
for the selected printer. The easiest way to make sure a score’s layout is consistent on multiple 
printers is to select a set width for the page margin. 

After selecting a printer, paper size and entering a reduction or enlargement factor for your score, you 
will need to check the page margins to see how the page layout appears. Open the Show/Hide dialog 
and put a check mark in the box for Page Margins. The page margin is displayed as a broken line 
surrounding the score. The actual size within the margin is determined by the paper size selected.

Left, Right, Top and  
Bottom Page Margins
Systems are set to the current page width by default. You can indent systems on either side, but 
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Encore will not allow you to move a system outside the left or right margins. Top and bottom margins 
do not limit system placement. The bottom page margin in particular, is important when considering 
page layout.

The bottom margin can extend into extra “tiles” used to print additional sections of a score. When 
Encore cannot fit the number of staves or systems within the current page margin, additional “tiles” 
are created automatically.

Print and Print Selection
Encore offers two printing choices in the File menu. 

Print Selection

Selections should be made using the arrow tool. Click and drag around the area you wish to print. 
Only one area should be selected. 

Print
The standard Print menu item is used for printing an entire page or several pages. If there are tiled 
sections for any of the pages specified, those tiles are counted as part of the page specified. Printing a 
page automatically includes all the tiles for the page as well.

Using the Free Encore Demo as a File Viewer
If you would like to share your Encore file with someone who does not have Encore, and you would 
like them to both see and hear your score, tell them to download the free Encore demo available at 
www.gvox.com. The demo does not allow a user to save or print music, however, it will allow the 
user to view and play the file. 

Creating MIDI Files
Another way you can share your Encore files is by exporting them as MIDI files, which you can then 
post on a website or email to friends. This enables others to hear (but not see) your score. To create a 
MIDI file in Encore, go to File>Export, and select MIDI file from the dropdown box. 

Creating MusicXML Files
MusicXML is a way for notation programs to share score files. To create a MusicXML file in Encore, 
go to File>Export, and select MusicXML file from the dropdown box.
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Percussion Staff Chapter Twelve

Encore gives you the ability to create percussion staves with up to eight different note-head types 
on each available staff line.  Each note-head type can be assigned to a specific MIDI note to 

match the note with its intended drum or percussion sound in a MIDI drum machine, sound module, 
or sampler.

When you add a percussion staff, you’ll be prompted to set up a drum map for the staff.  The drum 
map determines how the various percussion sounds in your MIDI sound source are assigned to the 
positions on the percussion staff.  Drum maps also set each sound’s note-head type.

After you choose a drum map, any notes entered into a percussion staff via MIDI will be mapped 
to the appropriate staff position.  Conversely, notes on a percussion staff will be mapped to the 
appropriate MIDI pitches to trigger the assigned sounds on playback. 

Notes can be entered with the mouse, and multiple sounds/note heads can be entered in a staff 
position via a special note pop-up menu (see Entering Notes with the Mouse).

You can edit percussion staves and drum maps.  Dragging and nudging notes up or down changes 
the note-head type as well as the note’s position.  The Change Pitch item in the Notes menu changes 
to Change Drum when you make a percussion staff selection.  This allows you to change from one 
mapped sound to another.  And, of course, the drum maps themselves are fully editable.

We provide a lot of information in this section.  There are a number of different ways to work with 
percussion staves, so this section is very task-oriented.  We recommend that you use the table of 
contents at the beginning of this addendum, the index, and the cross referencing to locate specific 
topics.

For information about converting non-mapped percussion staves created with previous versions of 
Encore, see Entering Notes on a Percussion Staff: Transcribing Sequence Files.

Creating a Percussion Staff
These methods create a percussion staff in Encore.

•	 Use the percussion clef tool in the Clefs palette to change the initial clef in the first measure of any staff.

•	 Choose Add Staff from the Score menu and set the staff type to Percussion. Click the Setup button.

These methods open the Drum Map dialog.

Drum Maps
In a MIDI drum machine or sound module, drum and percussion sounds are usually mapped to 
specific notes.  These drum maps vary from manufacturer to manufacturer or even from one machine 
to another.  (One exception is the General MIDI drum map.)  Many have user-definable mapping.  
From an interface standpoint this makes a lot of sense, since each of the available sounds is associated 
with a unique MIDI pitch.  Each sound is easy to access from a MIDI controller, and drum parts can 
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be easily recorded into a MIDI sequencer. 

The MIDI pitches used for drum sounds pose a special problem for a notation program like Encore.  
Generally speaking, for notating percussion parts, the MIDI pitches and their related sounds are not 
the most readable.  And some types of percussion, like open and closed hi-hats, are notated at the 
same position but with different note heads.

The Drum Map dialog provides the solution to this problem.  This dialog enables you to see your 
drum machine’s or sound module’s drum map and, in turn, to map each of the sounds to a specific 
staff position with one of eight note heads.  It acts as a translator between Encore’s standard 
percussion notation and your MIDI sound source.

Touring the Drum Map Dialog
The Drum Map dialog’s most obvious feature is its table of percussion and note names.  Each cell in 
the table represents one of the 128 notes available to MIDI, from C-2 to G8.  Choosing a drum map 
from the Drum Map pop-up menu displays that map’s percussion sounds in the corresponding cells.  
“Grayed out” cells are unmapped pitches.

Click one of the mapped cells.  Six things happen:

•	 The highlighted cell’s MIDI pitch appears as the Pitch parameter.

•	 The name appears in the Name text box.

•	 The note-head type chosen for that sound appears on the “Show drum as” pop-up menu.

•	 The stem direction (up or down) is displayed.

•	 The staff position that the cell is mapped to is displayed on the small percussion staff graphic.

•	 A note on the selected drum will play.

In addition, if the selected cell represents the default drum for its staff position, the Default Drum 
checkbox will be checked.  You can change the attributes of the selected drum.  Click on the “Show 
Drum” check box to enable or disable the drum.  Use the popup menus to change the note head type 
and stem direction.  Click and drag on the note display to change the drum’s notated location on 
the staff.  If you want the drum to be the default drum for the given staff location, enable “Default 
Drum”.  You can edit the name of the drum in the text edit field at the bottom of the dialog.  Click OK 
to save changes to the drum map.
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Entering Notes on a Percussion Staff
The basic methods for entering music onto a percussion staff are no different than the methods for 
entering notation onto a conventional staff, so rather than go on at great length about note entry, we’ll 
assume you already know how to do that.  What differs is the way the notes display (due to the drum 
map’s “translation” of the pitches you enter) and the editing options unique to percussion staves.

Note:  For information about entering notes with the mouse, see Editing in a Percussion Staff:  
Entering Notes with the Mouse.

Transcribing Sequence Files
As you probably already know, Encore can transcribe either Standard MIDI or Master Tracks Pro 
files.  If you transcribe a sequence file, Encore has no way of knowing which tracks are being used for 
percussion, so those tracks will not initially be transcribed as percussion staves.  But you can convert 
them after they’ve been transcribed.

Note:  The following technique can also be used to convert non-mapped percussion staves to mapped 
percussion staves.  A staff may be non-mapped because you chose to make it that way or because 
you’re opening an older score created with a previous version of Encore.

Entering Notes Via MIDI
A percussion staff’s drum map affects notes entered via MIDI, whether recorded in real time or step 
entered.  The MIDI pitches you play will be mapped to the appropriate staff position with the assigned 
note head.

Note: When you enter notes in a mapped percussion staff via MIDI, un-mapped pitches appear in the 
score with an X drawn through them.

Editing in a Percussion Staff
Perform simple Cut, Copy, and Paste edits in a percussion staff exactly like any other type of staff.  
However, some other edit operations have unique properties in percussion staves.

Dragging Notes
Notes in a percussion staff can be dragged up or down just like in other staves, but with a couple of 
notable differences.

•	 You are limited to the 16 staff positions available to a percussion staff.

•	 Dropping a note on a staff position will cause the note to assume the default note-head type for that position.

Note: See Changing Note Heads in a Percussion Staff for more information.

Entering Notes with the Mouse
We expanded the process of entering notes with the mouse to allow for the entry of multiple 
percussion heads in a staff position.  When entering notes in the “normal” manner, the note-head type 
for the default drum in any available staff position will appear.  If you have the option key down, a 
popup menu appears when you click on the score and allows you to choose among the drums assigned 
to the specific staff location.
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Note: Encore will not allow you to enter notes in unmapped staff positions or outside the 16 available 
positions.

Changing Note Heads  
in a Percussion Staff
You can use the Note Attributes item in the Notes menu to change the appearance of a note 
just as you would in any other staff.  The change is purely superficial. The note still maps to 
the original sound/pitch.  Why would you want to do this?  Maybe you’ve got two different 
closed hi hat sounds that you’d like to use to make the playback sound more realistic, but 
you want them to print with the same note-head type.

What if you’ve dragged a note and you want to change a note from its default?  You can use 
the Nudge Up and Nudge Down commands to access the other sounds/note heads mapped 
to a staff position.

To nudge notes in a percussion staff:

•	 Select a note or notes.

•	 Use the Nudge Up or Nudge Down command or keyboard shortcut. 
Encore will increment through all of the available note-head types for each of the selected staff positions before nudging the 
note to the next position.

Changing Drums
When you make a selection in a percussion staff, the Change Pitch item in the Notes menu changes 
to Change Drum.  The Change Drum dialog allows you to change a selected note or notes from one 
mapped sound to another, with the appropriate change in note head and staff position.
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To change drums:

•	 Select a note or notes in a mapped percussion staff.

•	 Choose Change Drum from the Notes menu. 
The Change Drum dialog appears.  Each of the two list boxes contains the names of all the mapped drum and percussion 
sounds used in that staff, as well as the unmapped pitches.

•	 Select a drum name in the From list box. 
That sound’s MIDI pitch appears in the From parameter box.

•	 Select the sound to change to in the To list box. 
That sound’s MIDI pitch appears in the To parameter box.

•	 Click OK. 
Any occurrence of the “From” sound in the selected region will be replaced by the “To” sound, with the appropriate note 
head and staff position.

What if you want to create a percussion staff and you don’t care whether the notes are mapped or not?  
You can create a non-mapped staff or “un-map” an existing staff.

To create a non-mapped staff:

•	 Choose Add Staff from the Score menu. 
The Add Staff dialog appears.

•	 Click the Percussion radio button.

•	 Click OK. 
A new, non-mapped percussion staff appears.

or...

•	 Choose the percussion clef tool from the Clefs palette.

•	 Click on the initial clef in the first measure of an existing, conventional (non-percussion) staff. 
The Drum Map dialog appears.

•	 Click Cancel. 
The staff becomes a non-mapped percussion staff.

To un-map an existing percussion staff:

•	 Choose the percussion clef tool from the Clefs palette.

•	 Click on the initial clef in the first measure of a mapped percussion staff. 
The Drum Map dialog appears.

•	 Click Cancel. 
The staff becomes a non-mapped percussion staff.
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Key Cap
Chart Shortcuts 

Mac Windows
File Menu
New [z]+[N] [Ctrl]+[N]
New Default Score [Ctrl]+ [X]+[N] 
Open [z]+[O] [Ctrl]+[O]
Close [z]+[W] [Ctrl]+[W]
Save [z]+[S] [Ctrl]+[S]
Save as [z]+[X]+[S] [Ctrl]+[X]+[S]
Revert To Saved [z]+[R] [Ctrl]+[R]
Print/Print Selection [z]+[P] [Ctrl]+[P]
Page Setup [Ctrl]+[X]+[P]
Quit/Exit [z]+[Q] [Alt]+[F4]

Edit Menu
Undo [z]+[Z] [Alt]+BkSp] or [Ctrl]+[Z]
Cut [z]+[X] [X] +[Del] or [Ctrl]+[X]
Copy [z]+[C] [Ctrl]+[Ins] or [Ctrl]+[C]
Paste [z]+[V] [X] + [Ins] or [Ctrl]+[V]
Clear [Del] [Del]
Select All [z]+[A] [Ctrl]+[A]
Nudge Left [z]+[ [ ] [Ctrl]+[ [ ]
Nudge Right [z]+[ ] ] [Ctrl]+[ ] ]
Nudge Up [z]+[=] [Ctrl]+[X] +[ ] ]
Nudge Down [z]+[ - ] [Ctrl]+[X] +[ [ ]

Notes Menu
Note Attributes [z]+[I] [Ctrl]+[I]
Set note to voice n* [z]+[n] [Ctrl]+[n]
Enharmonic [z]+[E] [Ctrl]+[E]
Simplify Enharmonic [z]+ [X] +[E] [Ctrl] +[X] +[E]
Stem Up [z]+[U] [Ctrl]+[U]
Stem Down [z]+[D] [Ctrl]+[D]
Add Mark [Ctrl]+[.] [Ctrl]+[9]
Remove Mark [Ctrl]+[X]+[.] [Ctrl]+[X]+[9]
Tie Notes [z]+[T] [Ctrl]+[T]
Flip Tie Direction [z]+[X]+[T] [Ctrl]+[X]+[T]
Slur Notes (above) [z]+[L] [Ctrl]+[L]
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Mac Windows
Slur Notes (below) [z]+[X]+[L] [Ctrl]+[X]+[L]
Beam Group [z]+[X]+[B] [Ctrl]+[M] or [Ctrl]+[X]+[B]
Beam On Beat [z]+[B] [Ctrl]+[B]
Flatten Beam [z]+[X]+[F] [Ctrl]+[X]+[F]
Change Pitch [Ctrl]+[X] [Ctrl]+[Alt]+[X]
Change Duration [Ctrl]+[D] [Ctrl]+[Alt]+[D]
Change Velocity [Ctrl]+[V] [X]+[right click] or [Ctrl]+[Alt]+[V]
Make Chord [Ctrl]+[C] [Ctrl]+[Alt]+[C]
Make Grace/Cue [Ctrl]+[G] [Ctrl]+[Alt]+[G]
Make Tablature [Ctrl]+[Z] [Ctrl]+[Alt]+[Z]
Guess Durations [z]+[G] [Ctrl]+[G]
Raise Pitch [z]+[+] [Ctrl]+[+]
Lower Pitch [z]+[-] [Ctrl]+[-]
Raise Pitch by octave [z]+[X]+[+] [Ctrl]+ [X]+[+]
Lower Pitch by octave [z]+[X]+[-] [Ctrl]+ [X]+[-]
*The variable n represents a number from 1 to 8.

Measures Menu
Add Measure [Ctrl]+[M] [Ctrl]+[Alt]+[M]
Delete Measure [Ctrl]+[X]+[M] [Ctrl]+[Alt]+[X]+[M]
Tempo [Ctrl]+[Q] [Ctrl]+[Alt]+[Q]
Time Signature [Ctrl]+[T] [Ctrl]+[Alt]+[T]
Key Signature [Ctrl]+[K] [Ctrl]+[Alt]+[K]
Barline Type [Ctrl]+[B] [Ctrl]+[Alt]+[B]
Endings [Ctrl]+[E] [Ctrl]+[Alt]+[E]
Coda Phrases [Ctrl]+[A] [Ctrl]+[Alt]+[A]
Measure Numbers [Ctrl]+[N] [Ctrl]+[Alt]+[N]
Compress Rests [Ctrl]+[R] [Ctrl]+[Alt]+[R]
Align Spacing [z]+[J] [Ctrl]+[J]
Align Playback [Ctrl]+ [J] [Ctrl]+[Alt]+ [J]
Swing Playback [Ctrl]+[X]+ [J] [Ctrl]+[Alt]+[X]+ [J]
Bypass Auto Space - Barline [Ctrl]+Drag [Alt]+Drag
Bypass Auto Space - Notes Click on note and hold then 

[Alt]+Drag
Click on note and hold then 
[Alt]+Drag

Bypass Auto Space - Staves  [Ctrl]+Drag  [Alt]+Drag

Score Menu
Add Page [Ctrl]+ [P] [Ctrl]+[Alt]+ [P]
Remove Page [Ctrl]+[X] [P] [Ctrl]+[Alt]+[X]+[P]
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Mac Windows
Add Staff [Ctrl]+ [S] [Ctrl]+[Alt]+[S]
Delete Staff [Ctrl]+[X] [S] [Ctrl]+[Alt]+[X]+[S]
Split Staff [Ctrl]+ [F] [Ctrl]+[Alt]+[F]
Tab Staff [Ctrl]+ [3] [Ctrl]+[Alt]+ [3]
Drum Map [Ctrl]+ [=] [Ctrl]+[Alt]+[=]
Connect Staves [Ctrl]+ [ [ ] [Alt]+ [ [ ]
Center Staves [Ctrl]+ [X]+[U] [Ctrl]+[Alt]+ [X]+[U]
Center Systems [Ctrl]+ [U] [Ctrl]+[Alt]+ [U]
Systems per Page [Ctrl]+ [Y] [Ctrl]+[Alt]+ [Y]
Measures per System [Ctrl]+ [W] [Ctrl]+[Alt]+ [W]
One Less Measure on System [ [ ] [ [ ]
One More Measure on System [ ] ] [ ] ]
Text Elements [Ctrl]+ [H] [Ctrl]+[Alt]+ [H]
MIDI Device/Instrument [Ctrl]+ [I] [Ctrl]+[Alt]+ [I]
MIDI Playback [Ctrl]+ [L] [Ctrl]+[Alt]+ [L]
Open VST Player [z]+[X]+[V] [Alt]+[V]

View Menu
Show/Hide [z]+[;] [Ctrl]+[H]
Show/Hide Control Points [z]+[ ’ ] [Ctrl]+[ ’ ]
Linear View [z]+[Y] [Ctrl]+[Y]
Floating Windows [z]+[K] [Alt]+[K]

Windows Menu
Palettes:
Notes [z]+[Opt]+ [X]+[N] [Alt]+ [X]+[N]
Clefs [z]+[Opt]+ [X]+[C] [Alt]+ [X]+[C]
Graphics [z]+[Opt]+ [X]+[L] [Alt]+ [X]+[L]
Tools [z]+[Opt]+ [X]+[T] [Alt]+ [X]+[T]
Dynamics [z]+[Opt]+ [X]+[D] [Alt]+ [X]+[D]
Marks 1 [z]+[Opt]+ [X]+[M] [Alt]+ [X]+[M]
Marks 2 [z]+[Opt]+ [X]+[.] [Alt]+ [X]+[.]
Symbols [z]+[Opt]+ [X]+[S] [Alt]+ [X]+[S]
Guitar [z]+[Opt]+ [X]+[G] [Alt]+ [X]+[G]
Expressions [z]+[Opt]+ [X]+[E] [Alt]+ [X]+[E]
Color [z]+[Opt]+ [X]+[O] [Alt]+ [X]+[O]
Staff Sheet [z]+[ / ] [Ctrl]+[ / ]
Keyboard [z]+[K] [Ctrl]+[K]
Tempo [z]+[0] [Ctrl]+[0]



Shortcuts258

Mac Windows
Toolbar [z]+[\] [Ctrl]+[Q]
Tile [X]+[F4]
Cascade [X]+[F5]

Setup Menu
Click On/Off [z]+[F] [Ctrl]+[F]
Auto Guess/Beam [z]+[X]+[G] [Ctrl]+[X]+[G]
Auto Space [z]+[X]+[A] [Ctrl]+[X]+[A]

Score Window Toolbar
Note:  For the voice commands, press the [V] key followed immediately by the indicated letter or number;  do 
not press both keys at once.  The variable n represents a voice number from 1 to 8.
Show all voices [V], [A] or [V], [ - ] [V], [A] or [V], [ - ]
Show voice n [V], [n] [V], [n]
Arrow Tool [A or P] Toggle or [Esc] [A or P] Toggle or [Esc]
Eraser Tool [E] [E]
Pencil Tool [P or A] Toggle [P or A] Toggle
Record [Enter] (if option is enabled) [Enter] (if option is enabled)
Play [Space Bar] [Space Bar]
Stop [Space Bar] [Space Bar]
Jump To Measure [M] [M]
Zoom In [Z] [Z] + [Click]
Zoom Out [X]+[Z] [Z]
Magnify Zoom In [X]+[Z]+ [Click]
Go to Page Click Page Number Icon Click Page Number Icon
Go to Page without scrolling to top [X]+Click Page Number Icon [X]+Click Page Number Icon

Notes Palette
Double whole note [0] [0]
Whole note [1] [1]
Half note [2] [2]
Quarter note [3] [3]
Eighth note [4] [4]
Sixteenth note [5] [5]
32nd note [6] [6]
64th note [7] [7]
128th note [8] [8]
Change note value without MIDI 
change

[X]+[ n ] [X]+[ n ]

Rest [R] [R]
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Mac Windows
Sharp [S] [S]
Double sharp [X]+[S] [X]+[S]
Flat [F] [F]
Double flat [X]+[F] [X]+[F]
Natural [N] [N]
Courtesy Accidental [X]+[N]
Cautionary Accidental [Opt] while adding [Ctrl] while adding
Dot [D] [D]
Double dot [X]+[D] [X]+[D]
Tuplet [T] [T]
Close All Other Palettes [Opt] Close

Layout
Flow measures out of system [ [
Flow measures into system ] ]
Stretch notes in a measure [Ctrl]+Drag [Ctrl]+Drag w/Right-Click
Adjust position of all subsequent 
staves/systems

[Ctrl]+ drag [Ctrl]+ drag 

Move all Endings [Opt]+ drag

Lyric Entry
Hyphen between notes [-] [-]
Hyphen within lyric word [Opt]+[ - ] [Ctrl]+[ - ]
Melisma [X]+[ _ ] [X]+[ _] 
Move to next note [Space Bar] [Space Bar] or [-] 
Move to tied note [X]+[Space Bar] [X]+[Space Bar]
Select next lyric [Tab] [Tab]
Select previous lyric [X]+[Tab] [X]+[Tab]
Space within lyric [Ctrl]+[Space Bar] [Ctrl]+[Space Bar]
Reposition all lyric lines in score [Opt] while dragging arrow [Ctrl] while dragging arrow

QWERTY Note Entry
QWERTY Mode On/Off [Q] [Q]
Rest [ , ] [ , ]
Dot [ . ] [ . ]
Double Dot [X]+[ . ] [X]+[ . ]
Tuplet [ / ] [ / ]
Tie notes [X]+[ / ] [X]+[ / ]
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Mac Windows

Drums
Toggle current drum on/off [Tab]
Percussion note head pop-up:  Hold [Ctrl] when using the mouse to enter a note in a mapped percussion staff to 
see a pop-up menu of the head types available for that staff position.
Select Drum [Opt] while adding note

Note Selection
Select note [X]+Click [X]+Click
Select note to the L/R of cursor [z] + [L/R Arrow]
Add L/R note to Selection [z]+[X]+[L/R Arrow]
Select L/R Measure’s notes [z] + [Opt]+[L/R Arrow]
Adds L/R measure’s notes to selec-
tion

[z] + [X]+[Opt]+[L/R Arrow]

Set corners of Selection Region [X]+Click [X]+Click

Tools
Draw “3-Point” Slur Slur tool+ [X] Slur tool+ [X] 
Right Thumb Bracket [X] during draw or drag [X] during draw or drag
Place Mark Below [Opt]+ Click [Ctrl]+ Click
Place Mark Above [Opt]+ [z]+ Click [Alt]+ [Ctrl]+ Click
Flip Hairpin [X] during draw or drag [X] during draw or drag

Chord Dialog
Major [M] [M]
Minor [m] [m]
Aug [+/=] [+/=]
Dim [o ](letter) [o ](letter)
7th [7] [7]
Maj 7th [&] [&]
9th [9] [9]
11th [1] [1]
5 [5] [5]
6 [6] [6]
Root [a-g [a-g
Bass root [A-G [A-G
Sharp root 3 3
Flat root 4 4



Shortcuts261

Mac Windows
Sharp bass root # #
Flat bass root $ $

Miscellaneous
Move Cursor to first measure [home] or [return] [home] 
Move Cursor to last measure [end] [end]
Scroll by page [page up/ page down] [page up/ page down]
Move to Previous Page [Opt]+[page up] [Crtl]+[page up]
Move to Next Page [Opt]+[page down] [Crtl]+[page down]
Move Cursor directionally [Arrows] [Arrows]
Move directionally in MIDI and 
Drum Maps

[Arrows] [Arrows]

Delete note to left of Cursor or 
selection

[Delete] [Delete]

Reposition window in background Click on window title bar + [z] 
Auditioning notes:  Click on staff + [z] Right Click on staff 
Note name Click on note + [z] Right Click on staff
MIDI Velocity setting Click on note +[z]+[X]
Other solo tracks off [Opt] while selecting [Crtl] while selecting
Move Slur/Bend/Release as a unit [X]+Drag [X]+Drag
Accidental Spacing: Click on note +[X] Click on note +[X] 
Marks Spacing: Click on note +[X] Click on note +[X] 
Align Spacing Use Previous Set-
tings

[z] +[X]+J [Ctrl] +[X]+J

Add Chord Options while Chord 
Parsing

[Opt] [Opt]

Copying notes/rests/graphic objects:   [Opt] and drag  [Ctrl] and drag 
Step-entering tied notes:  Enter a note from your MIDI controller, press [X]+[T], and then enter another note of 
the same pitch.
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New File

Open File

Save

Print

Undo

Cut

Paste

Clear

Select All

Nudge Left

Nudge Right

Nudge Right

Nudge Up

Nudge Down

Revert to Saved

Extract Part

Note Attributes

Beam Attributes

Rest Attributes

Enharmonics

Accidentals to 
Sharps

Accidentals to 
Flats

Stems Up

Stems Down

Stems Normal

Tie Notes

Slur Notes

Beam Group

Beam on Beat

Sub Group Beam

Transpose Pitch

Change Duration

Toolbar Icons

Change Velocity

Make Chord

Make Grace/Cue

Make Tab

Revert to Raw

Guess Durations

Font Selection

Font Size

Font Bold

Font Italic

Font Underlined

Font Outlined

Font Shadow

Align Text Left

Center Text

Align Right
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Add Measure

Delete Measure

Tempo

Time Signature

Key Signature

Barline Type

Endings

Coda Phrases

Measure 
Numbers

Compress Rests

Align Playback

Swing Playback

Align Spacing

Text Elements

Add Page

Delete Page

Add Staff

Remove Staff

Split Staff

Connect Staves

Center Staves

Center Systems

Measures per 
System
Systems per 
Page

Show/Hide

Show Staff

Hide Staff

Linear View

Click on/off

Follow Playback

Auto Guess and-
Beam

Auto Space

Staff Split Point

Transcription 
Value

Redraw Screen

Gvox Online 
Support
Handwritten 
Style

Add Mark

Remove Mark

Flatten Beam

Page Setup

Show Control 
Points
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OptiFingering™ analyzes a musical score and generates optimal fingering for stringed 
instruments.It is integrated with Gvox’s music notation software products and is offered as 

an add-on product.  OptiFingering is serial number enabled. It is installed when the music notation 
software is installed but functionality is enabled only with a serial number provided when you buy the 
add-on product.  If you install the music notation software with a serial number that does not enable 
OptiFingering, the OptiFingering menu will be visible, but sub menu items will be disabled and 
grayed out.

OptiFingering Features 
OptiFingering supports the following features:

	 Fingering computed based on analysis of the entire composition to optimize hand movement

	 Selectable alternate fingering 

	 Use open strings when possible

	 Minimum and maximum fret to use in fingering

	 Polyphonic (multi-voice) music

	 Capo support

	 Crossover optimization

OptiFingering supports the following stringed instruments:

	 Guitar—standard tuning

	 Guitar—open G tuning

	 Electric Bass

	 Violin

	 Viola

•	 Cello

•	 Double Bass

•	 Mandolin

•	 Banjo

•	 Ukulele

OptiFingering™ Chapter 
Fourteen
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Using OptiFingering™
If you use the Play button to step through the score, it will move along based on the tempo set for the 
score (See Measures / Tempo menu item).  In this mode, the fingering will be shown for each note 
or chord on which the Play Marker pauses.  The Play Marker steps through the score one beat at 
a time.  In the case where there are notes or chords that have a shorter duration than one beat, the 
fingering for those notes or chords might not be shown (even though there will be MIDI playback for 
those notes).  To see the fingering for the notes or chords skipped in this mode, step through the score 
using the [Ctrl] L/R Arrow keys. 

OptiFingering is very easy to use.  To see how to play a score 

	 Open the score (or enter it) 

	 Use the Fingering Setup menu item to select the desired instrument and the staff you want to 		
		  see the fingering for, 

	 Use the Fingering menu item to make the fingerboard visible, 

	 Position the cursor in the selected staff where you want to start, 

	 Step through the staff using the [Ctrl] L/R Arrow keys or press the Play button on the Score 		
		  Window Tool Bar (or press the space key);

If you use the [Ctrl] L/R Arrow keys to step through the score, you will be able to move through the 
score at your own pace.  You will be able to stay at any position in the score for as long as you need to 
try the fingering on your instrument.

 If you use the Play button to step through the score, it will move along based on the tempo set for 
the score (See Measures / Tempo menu item).  In this mode, the fingering will be shown for each 
note or chord on which the Play Marker pauses.  The Play Marker steps through the score one beat 
at a time.  In the case where there are notes or chords that have a shorter duration than one beat, the 
fingering for those notes or chords might not be shown (even though there will be MIDI playback for 
those notes).  To see the fingering for the notes or chords skipped in this mode, step through the score 
using the [Ctrl] L/R Arrow keys.

The OptiFingering Menu 
This is the OptiFingering menu:
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Fingerboard 
This menu item allows the user to toggle between showing and hiding the fingerboard.  When the 
fingerboard is visible, there will be a check mark on the left side of the menu item and a window 
will show a fingerboard for the stringed instrument currently selected.  Here is an example of the 

fingerboard for the standard guitar:For more information about marks, see the section on the Marks 
palettes.

The fingerboard window is movable and resizable.

Recompute Fingering 
If you change the score after it has been opened, you will need to use this menu item to recompute 
the fingering.  OptiFingering will then re-analyze the score and compute the fingering including the 
changes you made.

Fingering Setup 

Fingering Setup is used to configure OptiFingering.  When you select this menu item, the following 
dialog is displayed:.
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When you change the Fingering Setup, the score is re-analyzed and fingering is recomputed based on 
the new setup

Select Instrument
The current selected instrument is shown in Select Instrument.  If you want to select a different 
instrument, click the arrow on the right side of this field to see a pull down menu of the supported 
instruments.  Select the instrument you want to use.  The fingering window will now show the 
fingerboard of the newly selected instrument, the score will be re-analyzed and the fingering will be 
computed for the new instrument.  If the score contains notes that are outside the note range of the 
newly selected instrument, they will be mapped to be within its note range. 

The value for the maximum note position on fingerboard is set to the highest note position for the 
newly selected instrument.

Staff and Sub-Staff to use for fingering
Use this field to select which staff in the score you want to use to compute the fingering.  The staff 
value corresponds the staff numbers shown in the Staff Sheet.

A piano staff is a special combined staff that appears as only one item in the Staff Sheet but is actually 
made up of multiple staves.  The Sub-Staff value is the staff number within the piano staff that is used 
to compute the fingering.  Sub-Staff numbers start at one.

Maximum note position on fingerboard
The default value for this field is the highest note position supported by the selected instrument.  If 
you want to avoid fingerings that are played high on the fingerboard, use this field to limit the notes 
that are considered when the fingering is computed.  Notes played at a higher position than specified 
by this field will not be considered when the fingering is computed.

Minimum note position on fingerboard
The default value for this field is zero, meaning notes in the first position will be considered when the 
fingering is computed.  If you want to play higher on the fingerboard, use this field to limit the notes 
that are considered when the fingering is computed.  Notes played at a lower position than specified 
by this field will not be considered when the fingering is computed.

Capo position

When this field is non zero, a capo is drawn at that note position and notes played at a lower position 	
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than the capo are not considered when the fingering is computed.  If this field is zero, the capo support 
is disabled.  Here is an example of the standard guitar with a capo at the 4th position:

Use Open Strings when possible
The same notes can be played in multiple places on stringed instruments.  The notes that correspond 
to the open strings of the instrument can also be played higher on the fingerboard on higher numbered 
strings.  

The default algorithm in computing fingering is to select the position for the note closest to where 
the hand is on the fingerboard.  In some cases it might be desirable to play notes that correspond to 
open strings as open strings instead of higher on the fingerboard.  This field is used to configure the 
fingering algorithm to use open strings whenever possible, regardless of where the hand is positioned.

Draw note position lines for fretless instruments
Many of the instruments supported by OptiFingering are fretless.  When the fingering is shown, 
the finger position is calculated to be exactly where it should be on the fingerboard given the 

size and proportions of fingerboard image.  To aid in associating the finger positioning shown by 
OptiFingering to a real instrument, note position lines can drawn on fretless instruments.  Use this 
field to enable them.

Here is an example of a viola fingerboard with note position lines:

Enable crossover optimization
The default algorithm for computing the fingering minimizes hand movement up and down the neck.  
In some cases, where a long sequence of notes goes from very low on the fingerboard to very high on 
the fingerboard, it might be desirable to move the hand more often but for smaller distances.  Use this 
field to direct the fingering algorithm to compute gradual, more frequent movements up and down the 
fingerboard instead of fewer, longer movements.
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